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Preface 

Thanks for choosing the 3672 series vector network analyzer produced by China Electronics Technology 

Instruments Limited Company. Please read this User Manual carefully for your convenience. 

We devote ourselves to meeting your demands, providing you high-quality measuring instrument and the best after-

sales service. We persist with ―superior quality and considerate service‖, and are committed to offering 

satisfactory products and service for our clients. 

Manual No. 

AV2.733.1036SSEN 

Version 

A.2  2017.9 

China Electronics Technology Instruments Limited Company 

Manual Authorization 

The information contained in this User Manual is subject to change without notice. The power to interpret the 

contents of and terms used in this Manual rests with China Electronics Technology Instruments Company. 

China Electronics Technology Instruments Co. Ltd owns the copyright of this User Manual which should not be 

modified or tampered by any organization or individual, or reproduced or transmitted for the purpose of making 

profit without its prior permission, otherwise China Electronics Technology Instruments Company will reserve the 

right to investigate and affix legal liability of infringement. 

Product Quality Assurance 

The warranty period of the product is 18 months from the date of delivery. The instrument manufacturer will 

repair or replace damaged parts according to the actual situation within the warranty period. The user should return 

the product to the manufacturer and prepay mailing costs. The manufacturer will return the product and such costs 

to the user after maintenance. 

Product Quality Certificate 

The product meets the indicator requirements of the manual at the time of delivery. Calibration and measurement 

are completed by the measuring organization with qualifications specified by the state, and relevant data are 

provided for reference. 

Quality/Environment Management 

Research, development, manufacturing and testing of the product comply with the requirements of the quality and 

environmental management system. The 41st Institute has the qualifications and has been certified by the 

ISO9001 and ISO14001 management system. 

Precautions 

 
Warning 

―Warning‖ indicates danger. It reminds the user to pay attention to a certain operation process, operation method or 

similar situations. Noncompliance with the rules or improper operation may result in personal injuries. You must 

fully understand the warning and all the conditions in it shall be met before the next step. 

Attention 

―Attention‖ indicates important prompts and no danger. It reminds the user to pay attention to a certain operation 

process, operation method or similar situations. Noncompliance with the rules or improper operation may result in 

damage to the instrument or loss of important data. You must fully understand the caution and all the conditions in 

it shall be met before the next step. 
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1. Manual Guide 

This chapter summarizes the functions, structure and main contents of the user manual of 3672 vector network 

analyzers, and the related documents for the user. 

● About the manual ········································································································································· 1 

● Related documents ······································································································································· 2 

1.1 About the Manual 

The manual describes the purposes, performance indicators, basic operating theory, operating method, 

operation precautions, etc. 3672 vector network analyzers produced by China Electronics Technology 

Instrument Ltd. Co., to help you rapidly get familiar with and understand key points of the instrument 

operation and use. Please read this User Manual carefully and follow its guidance. 

Due to the limit of time and knowledge of the writer, there may be some omission or error, and you are welcome to 

correct any such error. We are sorry for the flaws which may cause your inconvenience. 

The user manual includes the following chapters. 

● Overview 

The chapter provides an overview of the characteristics and operation precautions of 3672 vector network 

analyzers, mainly including a product overview and a safe operation guide. 

● Introduction 

This chapter describes the preparations before operation of 3672 vector network analyzers, routine 

maintenance of the system and instrument, overview of the front panel and the rear panel, operation interface, 

analyzer menus, traces, channels, windows, and analysis and saving of measurement data. 

● Measurement setting 

This chapter describes various settings of the network analyzer in operation, including resetting of the analyzer, 

selection of measurement parameters, setting of the frequency range, setting of the signal power level, setting of 

sweep, selection of the trigger mode, selection of the data format and scale, viewing of several traces, opening of 

several channels, and setting of the analyzer display. 

● Menu 

This chapter describes the menu structure and items according to functional categories to facilitate query and 

reference. 

● Measurement optimization 

This chapter describes how to optimize the measurement accuracy by means of proper settings, including reduction 

of accessory impacts, improvement of the reflection accuracy of the low-loss double-port device, increase of the 

dynamic range, improvement of the measurement results of the electrical length and the measurement accuracy of 

the phase, reduction of the trace noise and receiver crosstalk, increase of data points, improvement of the 

measurement stability, sweep velocity, multi-state measurement efficiency and rapid data transmission, use of 

macros, etc. 

● Calibration 

This chapter introduces the calibration type and method of 3672 vector network analyzers to improve the 

accuracy of measurement. 

● Network measurement basics 

This chapter describes the basic concepts and related theories of senior network parameter measurement. 

● Remote control 

This section outlines the remote control of the instrument, so that the user can rapidly get to know how to remotely 

control the instrument. It is divided into four sections: the program control basics describe the concepts related 

to program control, software configuration, program-controlled port, SCPI commands, etc.; instrument port 
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configuration describes the connection and software configuration of the program-controlled port of 3672 

vector network analyzers; basic programming of VISA interface provides an example of basic programming 

with text illustration and example codes, so that the user can rapidly get to know the programming method; 

and I/O function library describes the basic concepts of the instrument drive and the basic installation and 

configuration requirements of the IVI-COM/IVI-C drive. 

● Fault diagnosis and repair 

This section describes the overall operating theory, fault diagnosis and troubleshooting, and errors and repair. 

● Technical indicators and test methods 

This section describes the main technical indicators of 3672 analyzers and the recommended test instructions 

for the user. 

● Appendix 

This section lists the instructions on software accessories of 3672 vector network analyzers. 

1.2 Related Documents 

The documents related to 3672 series vector network analyzer include: 

● User Manual 

● Program control document 

● Quick Start Guide 

● Online help 

User Manual 

This manual introduces the functions and operation methods of the instrument in details, including configuration, 

measurement, program control, maintenance, etc. It aims to guide the user to comprehensively understand the 

functional characteristics and common test methods of the instrument. It mainly includes the following chapters: 

● Manual Navigation 

● Overview 

● Introduction 

● Measurement setting 

● Menu 

● Measurement optimization 

● Calibration 

● Network measurement basics 

● Remote control 

● Fault diagnosis and repair 

● Technical indicators and measurement method 

● Appendix 

Program control document 

This manual introduces the remote programming basis, SCPI basis, SCPI commands, programming examples, 

I/O drive function library, etc. It aims to guide the user to rapidly and comprehensively know the program control 

commands and methods of the instrument. It mainly includes the following chapters: 

● Remote control 

● Program control commands 

● Programming examples 
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● Error illustration 

● Appendix 

Quick Start Guide 

This manual introduces the basic operations of configuration, start-up and measurement of the instrument, aiming 

to help the user rapidly know the characteristics of the instrument and understand basic settings and operations. It 

mainly includes the following chapters: 

● Preparation for use 

● Typical application 

● Help 

Online help 

Online help is integrated in the instrument to provide rapid text navigation help and facilitate local and remote 

operation. Hard keys on the front panel of the instrument and tool bars of the user interface can be activated with 

corresponding shortcut keys. Main chapters are the same as those in the user manual. 
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2 Overview 

This chapter describes the main performance characteristics, purposes and technical indicators of 3672 

analyzers. It also includes the precautions for proper operation, electrical safety, etc. 

● Product overview ········································································································································· 4 

● Safe operation guide ····································································································································· 8 

2.1 Product Overview 

3672 series vector network analyzers are a new generation of vector network analyzer, launched by China 

Electronics Technology Instruments Ltd Co. In the hardware, new design concept and technical schemes are 

adopted, thus significantly improving key technical performance indicators such as the overall sweep velocity 

and dynamic range. In the software, the embedded computer with high-performance microprocessor chip and 

platform environment based on Windows7 operating system are applied, thus greatly improving the overall 

interconnection and usability. 

3672 series vector network analyzers have multiple calibration modes such as frequency response, single port, 

response isolation, enhanced response, double ports and electrical calibration, and multiple display modes 

such as the logarithmic amplitude, linearity amplitude, standing wave, phase, group delay and Smith chart. It 

is equipped with various standard interfaces, such as USB, LAN, GPIB and VGA. In addition to all 

measurement functions of the traditional vector network analyzer, the instrument can be used to test 

comprehensive parameters of multiple functions such as the mixer/converter, active intermodulation distortion 

and harmonic distortion, gain compression and two-dimensional sweep and S-parameter of the pulse network, 

and accurately measure the amplitude frequency characteristics, phase frequency characteristics and group 

delay characteristics of the microwave network. 

The instrument can be widely applied in measurement of the transmission/reception (T/R) module, dielectric 

material properties, microwave pulse characteristics and photoelectric properties. It is an indispensable tester 

in research and production of the phased array radar, communication, RF microwave device and other systems. 

Product Features: 

 12.1-inch high-resolution touch screen; 

 Windows operating system; 

 Multiple calibration modes such as the frequency response, single port, frequency isolation, double ports, 

TRL and electrical calibration; 

 16 display windows capable of displaying 8 traces at the same time, and 64 independent measurement 

channels to rapidly implement complex test solutions; 

 Record/run (one-button operation), greatly simplifying the measurement setting steps and improving the 

working efficiency; 

 Multiple display formats such as the logarithmic amplitude, linearity amplitude, standing wave, phase, 

group delay, Smith chart and polar coordinates; 

 USB, GPIB, LAN and VGA interface; 

 Two options: single-source stimulus type double-port vector network analyzer and double-source stimulus 

type four-port vector network analyzer; 

 Multiple functions such as the pulse measurement, time domain measurement, mixer measurement, 

active intermodulation distortion measurement, gain compression and two-dimensional sweep 

measurement, millimeter wave spreading, antenna and RCS measurement reception. 

1) Simple and intuitive humane user interface, facilitating operation and improving the test efficiency. 

The touch screen, panel keys and mouse can be used to effectively guide the user to properly operate the 

instrument. The operation can be made quick and intuitive in the Windows system, thus greatly improving the 

test efficiency. 
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3672 series vector network analyzers are equipped with a 12.1-inch 1280*800 touch screen, as shown in Fig. 

2.1, to facilitate operation. 

Fig. 2.1 12.1-inch 1280*800 Touch Screen 

  

The soft panel can be set on 

the left side or  right side of 

the screen or hided to 

facilitate operation.

 

Fig. 2.2 Soft Panel Interface 

 

The favorite keys can be set 

together among soft shortcut 

keys to simplify operation 

steps and facilitate operation.
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Fig. 2.3 Soft Shortcut Keys 

2) Multi-window multi-channel measurement display 

3672 series vector network analyzers support up to 64 channels and as many as 16 measurement windows can 

be displayed at the same time. Up to 8 test traces can be displayed in each window, and frequent state 

recalling is not required to measure several parameters of the DUT, thus simplifying the test process. 

 

Fig. 2.4 Multi-window Multi-channel Measurement Display 

3) Wide dynamic range 

3672 series vector network analyzers are designed based on fundamental wave mixed reception, thus 

effectively expanding the dynamic range of the overall test and meeting increasing test demands for the wide 

dynamic range. 
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Fig. 2.5 Filter Measurement Results 

4) Automatic test 

The automatic test can help to save a lot of time and effectively reduce the test cost in a flexible automation 

environment. 

1) The vector network analyzer is controlled with SCPI commands to complete automatic tests. 

2) Codes are directly executed from the vector network analyzer or external PC through a LAN or GPIB 

interface. 

3) The application program can be directly run in the instrument, with no external PC. 
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Fig. 2.6 Automatic Test 

5) GPIB interface 

3672 series vector network analyzers are equipped with a 24-pin D-type female GPIB connector, which 

conforms to the IEEE-488 standard and is used to send and receive GPIB/SCPI commands. 

6) USB Interface 

3672 series vector network analyzers are equipped with nine high-velocity USB interfaces (eight A-type 

interfaces and one B-type interface) to facilitate the connection to the keyboard, mouse, printer, electronic 

calibrator and other peripherals with USB interfaces. 

7) Printing function 

3672 series vector network analyzers have a powerful printing function, and are able to output or print the 

contents of the measurement display into a specified file through a printer. A local or network printer with a 

LAN or USB interface can be used. Measurement results can be printed after the printer is added to the 

Windows 7 operating system. 

2.2 Safe Operation Guide 

Please carefully read and strictly follow the notes for attention below!  

We will spare no effort to ensure that all production stages conform to the latest safety standards to guarantee the 

highest safety for users. The design and test of our product and ancillary equipment thereof have been up to 

relevant standards of security; quality assurance system has been established to monitor the product quality to 

ensure the consistency with such standards. Precautions proposed in this User Manual should be followed to keep 

equipment intact and operations safe. Please do not hesitate to consult us if you have any questions. 

However, it is your responsibility to operate the product in a correct way. Please read and follow the safety 

instructions carefully before operating the instrument. The instrument is applicable to the industrial and laboratory 

environment or field measurement. Pay attention to the limitations for proper operation to avoid personal injury or 

property damage. We will not take any responsibility for any misuse or inconsistency as required, and you are 

The user can send test results to the local/online 

printer or a remote data processing server terminal 

for subsequent analysis and processing. 
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liable for any risks incurred by. Therefore follow the safety instructions to prevent from personal injury or 

property damage. Please keep the basic safety instructions and product documentation safe and submit them to 

end users. 

● Safety signs ·················································································································································· 9 

● Operation state and location ························································································································ 10 

● Power safety ··············································································································································· 10 

● Operation precautions ································································································································· 11 

● Maintenance ··············································································································································· 11 

● Battery and power supply module ··············································································································· 12 

● Transportation ············································································································································ 12 

● Waste disposal/environment protection ······································································································· 12 

2.2.1 Safety Signs 

2.2.1.1 Product-related Signs 

The safety signs of the instrument are as follows (Table 2.1). 

Table 2.1 Instrument Safety Signs 

Symbol Meaning Symbol Meaning 

 

Caution: the user should pay attention to the information. The 

user should pay attention to the operation information or 

instructions. 
 

Power on/off 

 

Caution: handle heavy equipment. 

 

Standby indication 

 

Danger! Be careful of electric shock! 

 

Direct-current (DC) 

power 

 

Warning! Be careful of surface heat. 

 

Alternating-current 

(AC) power 

 

Protect the conductive terminal. 

 

Direct-

current/alternating-

current power (DC/AC) 

 

Grounding 

 

Instrument reinforcement 

and insulation protection. 

 

Earthing Terminal 

 

EU mark of battery and 

accumulator. 

For details, refer to 1 of 

―2.2.8 Waste 

disposal/environment 

protection‖. 

 

Caution: electrostatic sensitive device. Be careful. 

 

EU mark for electronic 

parts to be collected 

separately For details, 

refer to 2 of ―2.2.8 Waste 

disposal/environment 

protection‖. 

 

Warning! Radiation. For details, refer to 7 of 2.2.4 ―Operation 

Precautions‖ of this section. 

  

2.2.1.2 Manual-related Signs 
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The following safety warning signs are used in the product manual to remind the user to operate the instrument 

safely and pay attention to relevant information. 

 

 
Danger 

Danger sign: personal injury and equipment damage may be caused if no 

attention is paid. 

 

 
Warning 

Warning sign: personal injury and equipment damage may be caused if no 

attention is paid. 

 

 
Caution 

Caution sign: minor or moderate personal injury and equipment damage may 

be caused if no attention is paid. 

Attention 
 

Attention sign: it indicates important prompts but no danger. 

Prompt 
 

Prompt sign: information of the instruction and operation. 

2.2.2 Operation State and Location 

Pay attention to the following items before operation: 

1) Unless otherwise stated, 3672 series vector network analyzers should be placed steadily and operated indoor 

with protection of IP 2X. The maximum altitude must not exceed 2,000m in operation and 4,500m in transportation. 

The actual power supply voltage may be the indicated voltage ± 10%, and the power supply frequency may be the 

indicated frequency ± 5%. Both the overvoltage protection and the pollution intensity are Class 2. 

2) Do not place the instrument on a wet surface, vehicle, cabinet, table and other objects which are not fixed and do 

not conform to the load conditions. Place the instrument steadily and fix it on the solid object surface (such as the 

anti-static workbench). 

3) Do not place the instrument on a heat dissipating surface (such as a radiator). The operating temperature must 

not exceed the specified range of relevant indicators of the instrument. Overheating may result in electric shock, 

fire, etc. 

2.2.3 Power Safety 

Precautions for the power supply of the instrument: 

1) Ensure that the actual power supply voltage is the same as that marked on the instrument before powering-on. If 

the power supply voltage is changed, replace the fuse of the instrument. 

2) Refer to the power supply requirements on the rear panel of the instrument. Use three-core power cords. Ensure 

that the power cord is grounded reliably. Floating or improper grounding may result in damage to the instrument 

and even operator injuries. 

3) Do not damage the power cord; otherwise, electrical leakage may be caused, resulting in instrument damage and 

even operator injuries. If any, check the external power cord or terminal block before operation to ensure the power 

safety. 

4) If the power socket is not equipped with any ON/OFF switch, the power plug can be directly pulled off to power 

off the instrument. In this case, ensure it is easy to plug and unplug the power line. 

5) Do not use any damaged power cord. Before connecting the power cord to the instrument, check the power cord 

for integrity and safety. Reasonably place the power cord to avoid the impact from human activities. For example, 

the operator may fall over if the power cord extends over long distances. 

6) The TN/TT power network is required. The maximum rated current of the fuse should be 16A (contact the 

manufacturer if a fuse of higher current is required). 

7) Keep the socket clean and the plug and the socket in good and firm contact. 

8) The socket and power cord must not be overloaded; otherwise, fire or electric shock may be caused. 

9) If the voltage Vrms is higher than 30V in the test, take appropriate protective measures (such as use of the 

appropriate test instrument and fuse, limitation of the current, electrical isolation and insulation, etc.) to avoid 

damage to the instrument. 

10) The instrument shall conform to IEC60950-1/EN60950-1 or IEC61010-1/EN61010-1 so as to realize the 

connection to a PC or industrial personal computer. 
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11) Unless specially permitted, the instrument shell must not be opened; otherwise, internal circuits and parts may 

be exposed, resulting in unnecessary damage. 

12) If the instrument needs to be fixed in a test place, the protective ground wire should be installed between the 

test place and instrument by the electrician with qualifications. 

13) Take appropriate overload protection measures to avoid instrument damages or personal injuries caused by 

overload voltage (arising from lightning, etc.). 

14) If the instrument shell is opened, unnecessary parts must not be placed into the shell; otherwise, short circuiting, 

instrument damages and even personal injuries may be caused. 

15) Unless otherwise stated, the instrument is not subject to waterproof protection. Therefore, the instrument must 

not contact with liquid to prevent damages and even personal injuries. 

16) The instrument must not be placed in a place where mist can be easily produced. For example, if the instrument 

is handled in an environment with temperature fluctuation, hazards such as electric shock may be caused by water 

drops produced on the instrument. 

2.2.4 Operation Precautions 

1) The instrument operator must have certain professional and technological knowledge, good psychological 

quality and emergency response capability. 

2) Refer to relevant requirements in ―2.2.7 Transportation‖ before handling or transporting the instrument. 

3) Allergic substances (such as nickel) are produced inevitably during instrument production. If the operator shows 

any allergic symptom (such as rash, frequent sneezing, red eye, breathing difficulty, etc.), immediately seek 

medical help to eliminate the symptoms. 

4) Refer to relevant requirements in ―2.2.8 Waste disposal/environmental protection‖ of this section before 

removing and disposal of the instrument. 

5) RF instruments may result in high-intensity electromagnetic radiation. The pregnant women and operators with 

heart pacemaker must be protected particularly. If the degree of radiation is high, take appropriate measures to 

remove the radiation source so as to prevent personal injury. 

6) If a fire occurs, toxic substances will be released by the damaged instrument. In this case, the operator should 

wear appropriate protective equipment (such as the protective mask and clothing) for protection. 

7) The laser product should be marked with warnings according to the laser category, as personal injuries may be 

caused as a result of laser radiation and high electromagnetic power of such products. 8) If the instrument is 

integrated with any laser product (such as a CD/DVD drive), no additional function should be added, except the 

settings and functions described in the manual, in order to prevent personal injuries caused by laser beams. 

8) The electromagnetic compatibility should conform to the EN55011/CISPR11, EN55022/CISPR22 and 

EN55032/CISPR32 standards. 

-Class A equipment:  

Applicable to any place except in residential areas and a low-voltage power supply environment. 

Note: Class A equipment is suitable for the industrial operating environment. As wireless communication 

disturbance may be caused to residential areas, the operator should take appropriate measures to reduce disturbance. 

-Class B equipment: 

It is applicable to the residential area and low-voltage power supply environment. 

2.2.5 Maintenance 

1) The instrument chassis must be opened by an authorized operator who has received special technical training. 

The power cord should be disconnected before operation, so as to avoid instrument damages and even personal 

injuries. 

2) The instrument should be repaired, replaced and maintained by special electronic engineers of the manufacturer, 

and the replaced or maintained parts must be subject to safety tests to ensure the safety of subsequent operation. 
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2.2.6 Battery and Power Supply Module 

Carefully read relevant information before using the battery and power supply module, so as to avoid explosion, 

fire and even personal injuries. In some cases, waste alkaline batteries (such as lithium batteries) should be 

disposed in accordance with the EN62133 standard. Precautions for battery use: 

1) Do not damage the battery. 

2) The battery and power supply module must not be exposed to flame and other heat sources. They must be 

prevented from direct sunlight and should be kept clean and dry in storage. Clean the connection port of the battery 

or power supply module with clean and dry soft cloth. 

3) Do not make the battery or power supply module short-circuited. As the short circuit may be easily caused by 

mutual contact or contact with other conductors, several batteries or power supply modules must not be stored in 

the same carton or drawer. Do not remove the original package until the battery and power supply module are 

required. 

4) The battery and power supply module must be prevented from mechanical impact. 

5) The leaky battery must not contact with the skin or eyes. In case of contact, rinse with plenty of clean water and 

immediately seek medical help. 

6) Use the standard battery and power supply module provided by the manufacturer. Any improper replacement or 

charging of alkaline batteries (such as lithium batteries) may easily result in explosion. 

7) The waste battery and power supply module should be recovered and disposed separately with other wastes. The 

battery contains toxic substances. It must be discarded or recycled according to the local provisions. 

2.2.7 Transportation 

1) The heavy instrument must be handled carefully. If necessary, use tools (such as the crane) to move the 

instrument to prevent damage to the body. 

2) The instrument handle is applicable to handling by individuals. The instrument must not be fixed on the transport 

equipment during transportation. In order to prevent damage to the property and body, observe the manufacturer‘s 

safety provisions on instrument transportation. 

3) If the instrument is operated on the transport vehicle, the driver should drive carefully to ensure the 

transportation safety. The manufacturer will not be responsible for emergencies in transportation. Do not operate 

the machine during transportation. Take reinforcement and protection measures to ensure the safety of 

transportation. 

2.2.8 Waste Disposal/Environmental Protection 

1) Do not dispose the equipment with the battery or accumulator mark along with other unclassified wastes. Instead, 

such equipment should be collected separately and discarded or disposed in the appropriate collection place or by 

the customer service center of the manufacturer. 

2) Do not dispose the discarded electronic equipment with other unclassified wastes. Such electronic equipment 

should be collected separately. The manufacturer has the right and responsibility to help end users to dispose waste 

products. If necessary, contact the customer service center of the manufacturer for corresponding disposal to avoid 

damage to the environment. 

3) Toxic substances (heavy dust such as lead, beryllium, nickel, etc.) may be released in machining or thermal 

reprocessing of the instrument or internal parts. In this case, the instrument or internal parts must be removed by 

technical personnel who have received special training and relevant experience, so as to avoid personal injuries. 

4) Toxic substances or fuel released by the instrument in reprocessing should be disposed in the specified method, 

with reference to the safety operation rules put forward by the manufacturer, so as to avoid personal injuries. 

3 Introduction to Use 

This chapter introduces the operation precautions, front and rear panel browsing, commonly used basic 

measurement methods, data file management, etc. of 3672 series vector network analyzers, so that the user has a 

preliminary understanding of the instrument and measurement process.  
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3.1.1 Pre-operation Preparation 

This chapter introduces the precautions for initial setting and operation of 3672 series vector network analyzer. 

 
Warning 

Prevent damage to the instrument. 

In order to avoid electric shock, fire and personal injury: 

 Do not open the casing without permission. 

 Do not disassemble or modify any part which is not described in this manual. Disassembly may result in 

declining of the electromagnetic shielding performance, damage to parts in the instrument, etc., thus affecting 

the product reliability. In this case, we will not provide free maintenance services even within the warranty 

period. 

 Carefully read the relevant contents in ―2.2 Safe Operation Guide‖ of this manual, and the safety precautions 

listed below. At the same time, pay attention to the specific operating environment requirements on the page 

of data. 

 

Attention 

Electrostatic protection 

Pay attention to anti-static measures in the workplace to prevent damage to the instrument. For details, refer to the 

relevant contents of ―2.2 Safe Operation Guide‖ of this manual. 

Attention 

Pay attention to the following requirements before operation: 

The improper operation location or measurement setting may result in damage to the instrument or the connected 

instrument. Pay attention to the following requirements before powering on the instrument: 

 The fan blades and ventilation holes are not blocked, and the instrument is at least 10cm away from the wall. 

 Keep the instrument dry. 

 Horizontally and reasonably arrange the instrument. 

 The ambient temperature meets the requirements on the page of data. 

 The input signal power of the port is within the specified range. 

 The signal output port is properly connected and not overloaded. 
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Prompt 

Influence of electromagnetic interference (EMI): 

Electromagnetic interference will affect measurement results, therefore: 

 Select the appropriate shielded cable. Example: use the dual-shielded radio-frequency/network connection 

cable. 

 Please promptly close the cable connection port which is open and not used temporarily or the connection port 

connected to the matching load. 

 Refer to the electromagnetic compatibility (EMC) level on the data page. 

3.1.1.1 Unpacking 

1) Appearance inspection 

Step 1: check whether the outer packing box and shockproof package are damaged. In case of any damage, 

keep the outer package for future use. Continue inspection according to the following steps. 

Step 2: unpack the box and check whether the host and accompanying articles are damaged. 

Step 3: carefully check the above articles according to Table 3.1. 

Step 4: Do not turn on the power supply of the instrument if the outer package, instrument and accompanying 

article is damaged or any error exists. Contact our service consultation center at the service consultation hotline 

on the cover. We will rapidly repair or replace the instrument, depending on the actual situation. 

Attention 

Handling: the heavy instrument and packing box must be handled by two persons and placed carefully. 

2) Model confirmation 

Table 3.1 List of Accompanying Articles of 3672 

Name Quantity Function 

Host computer:   

 3672 Series 1 — 

Standard:   

 Three-core power cord 1 — 

 USB mouse 1 — 

 USB keyboard 1 — 

 User Manual 1 — 

 Packing list 1 — 

 Quality Certificate 1 — 

Options:   

 201 2-port program-controlled step 

attenuator 

1 Expand the output power range and receiving 

power range of the receiver. 

 400 4-port measuring device 1 Expanded to the four-port vector network 

analyzer. 

 401 4-port program-controlled step 

attenuator 

1 Expand the output power range and receiving 

power range of the receiver. 

 008 pulse measurement 1 Used for measuring the RF S-parameter of pulse. 

 S10 time domain measuring device 1 Used for measuring the time domain, and 

determining and analyzing the discontinuous 

locations of appliances, clamps or cables. 
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 S80 frequency offset measuring device 1 Used for measuring the frequency offset, in 

millimeter wave THz, expandable. 

 S82 mixer scalar measuring device 1 Used for measuring the mixer scalar parameter. 

 S83 mixer vector measuring device 1 Used for measuring the mixer vector parameter. 

 S84 embedded local oscillator converter 

measuring device 

1 Used for measuring the embedded local 

oscillator converter. 

 S86 gain compression and two-dimensional 

sweep measuring device 

1 Used for gain compression and two-dimensional 

sweep measurement. 

 S87 active intermodulation distortion 

measuring device 

1 Used for measuring the active intermodulation 

distortion signal. 

3672A/B accessory: 

 31121 calibrating device 

 FB0HA0HB025.0 

 B0HA0HC025.0 

 

1 

1 

1 

 

Used for overall calibration. 

3.5mm amplitude-stabilized phase-compensated 

cable, used for overall measurement. 

3.5mm amplitude-stabilized phase-compensated 

cable, used for overall measurement. 

3672C accessory: 
 31123 calibrator 

 FE0BN0BM025.0 

 FE0BN0BL025.0 

 

1 

1 

1 

 

Used for overall calibration. 

2.4mm amplitude-stabilized phase-compensated 

cable, used for overall measurement. 

2.4mm amplitude-stabilized phase-compensated 

cable, used for overall measurement. 

3672D accessory: 

 31123A calibrator 

 FE0BN0BM025.0 

 FE0BN0BL025.0 

 

1 

1 

1 

 

Used for overall calibration. 

2.4mm amplitude-stabilized phase-compensated 

cable, used for overall measurement. 

2.4mm amplitude-stabilized phase-compensated 

cable, used for overall measurement. 

3.1.1.2 Environmental Requirements 

The operation place of 3672 series vector network analyzers should conform to the following environmental 

requirements. 

1) Operating environment 

The operating environment should conform to the following requirements. 

Table 3.2 Operating Environment Requirements of 3672 

Temperature 0°C-40°C 

Temperature range of error 

adjustment 

23°C±5°C (allowable temperature deviation in error adjustment: <1°C) 

Humidity If the temperature is lower than +29°C, the measurement range of the humidity 

meter should be 20% to 80%, without condensation. 

Altitude 0-2,000m (0-6,561 feet) 

Vibration Max. 0.21G, 5-500Hz 

 

Attention 

The above requirements are for the operating environment of the instrument and not the range of technical 

indicators. 

2) Heat dissipation requirements 
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In order to keep the operating temperature of the instrument within the specified temperature range, the heat 

dissipation space of the instrument should conform to the following requirements. 

Table 3.3 Heat Dissipation Requirements of 3672 

Instrument Part Heat Dissipation Distance 

Rear side ≥ 180mm 

Left and right side ≥ 60mm 

3) Electrostatic protection 

Static electricity is destructive to electronic components and devices. Generally, two anti-static measures can be 

taken: combination of conductive table mat and wrist strap; and combination of conductive floor mat and ankle 

strap. Anti-static effect will be better when two measures are used at the same time. If used independently, only the 

former can make sure the safety. In order to ensure the user safety, the ground isolation resistance of anti-static 

components must be 1MΩ at least. 

The follow anti-static measures should be taken to reduce static damage: 

 All instruments must be properly grounded to prevent static electricity. 

 The internal and external conductor of the cable should respectively contact with the ground temporarily 

before the coaxial cable and instrument are connected. 

 Workers must wear the anti-static wrist strap or take other anti-static measures before contact with the 

connector or wire or any assembly. 

 
Warning 

Voltage range 

The above anti-static measures are not suitable for the places with the voltage higher than 500V. 

3.1.1.3 On/Off 

1) Precautions before powering-on 

Check the following items before powering on the instrument. 

a) Confirm the power supply parameters. 

3672 series vector network analyzers are equipped with a three-core power line interface and conform to the 

international safety standards. Confirm that the protective ground wire of the power supply socket is grounded 

reliably before inserting the power line into the standard three-core socket to power on the instrument. Floating or 

improper grounding may result in damage to the instrument and even personal injuries. Do not use the power line 

with no protective measure. Table 3.4 lists the requirements of the external power supply for normal operation of 

the network analyzer. 

Table 3.4 Parameters of Working Power Supply of 3672 

Power supply parameter Applicable range 

Voltage,  frequency 220V±10% and 50-60Hz 

Rated output current >3A 

Power consumption >600W 

 

Prompt 

Prevent mutual interference of various power supplies. 

In order to prevent mutual interference of power supplies of various devices, especially the instrument hardware 

damage caused by peak pulse interference of high-power equipment, it is recommended to use the 220V AC 



3 Introduction to Use 

3.1 Preparation before Use 

 17 

 

voltage-regulated power supply to power on the network analyzer. 

b) Confirm and connect the power line. 

3672 series vector network analyzers are equipped with the three-core power line interface and conform to national 

safety standards. Confirm that the protective ground wire of the power line of the network analyzer is reliably 

grounded before powering on the network analyzer. Floating or improper grounding may result in instrument 

damage and even operator injuries. Do not use the power line with no protective ground wire. When the appropriate 

power socket is connected, the instrument shell will be grounded through the power line. The rated voltage of the 

power line should be no less than 250V, and the rated current should be no less than 6A. 

Connection of the power line to the instrument: 

Step 1: confirm that the power line is not damaged. 

Step 2: connect the power socket on the rear panel of the instrument to the well grounded three-core power 

socket through the power line. 

 
Warning 

Grounding 

Improper/wrong ground might lead to instrument destroy or even personal injury. Ensure that the protective ground 

wire and the ground wire of the power supply are in good contact before powering-on to start the network analyzer. 

Use the power socket with protective ground wire. Do not use the external cable, power line or autotransformer 

subject to no grounding protection instead of the protective ground wire. If required, connect the common end of 

the autotransformer to the protective ground wire of the power connector. 

2) Initial power-on 

The method and precautions of initial power-on are as follows. 

a) Connection of power supply 

Check the power supply parameters and power cord before initial powering-on. For details, refer to the precautions 

before powering-on in 3.1.1.3 of the user manual. 

Step 1: connect the power line. Connect one end of the supporting power line of the network analyzer or the 

three-core power line conforming to the requirements in the packing box to the power socket (as shown in Fig. 

3.1) on the rear panel of the network analyzer. The voltage indicator of the network analyzer is marked beside 

the power socket to remind the user that the applied voltage should conform to the requirements. Connect the 

other end of the power cord to the required AC power supply. 

Step 2: turn on the power switch on the rear panel. As shown in Fig. 3.2, check whether the standby 

indicator above the power switch on the front panel (as shown in Fig. 3.3) is ON and yellow. 

Step 3: turn on the power switch on the front panel, as shown in Fig. 3.3. Do not connect any device to the 

network analyzer before start-up. Start the instrument under normal conditions. After start-up, the indicator 

above the power switch on the front panel will turn green. 

Fig 3.2 Switch on Rear Panel of 3672 Fig 3.3 Power Switch on Front Panel of 3672Fig 3.1 3672 Power Socket
 

   

b) Start-up/shutdown 
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i. Start-up 

Step 1: turn on the power switch (―|‖) on the rear panel. 

Step 2: turn on the power switch in the lower left corner of the front panel. Check whether it is pressed ( ). 

In this case, the power indicator above the power switch will turn green from yellow. 

Step 3: about one minute is required for the network analyzer to start the Windows 7 system. After a series of 

self-inspection and adjustment procedures, the main measurement program will be run. 

Then the instrument can be operated. 

Prompt 

Preheating for cold start of the instrument 

In order to meet the performance indicators of 3672 series vector network analyzer in cold start, preheat it more 

than 30 minutes before measurement. 

Prompt 

Run the analyzer application program. 

The application program will be automatically run after the network analyzer is started. After exiting the 

application program, you can run the measurement program again according to the following method. 

Method 1: click [Start] of the task bar in the lower left corner of the screen. Point to [Program] in the Start menu and 

then [Vector network analyzer] in the program sub-menu. Click [Vector network analyzer] in the pop-up sub-menu. 

Then the measurement application program will be run in the analyzer. You can also double-click the shortcut key on the 

desktop to run the program. 

Method 2: press [Reset] in the functional key zone. Then the application program of the 3672 series vector network 

analyzer will be run. 

ii. Shutdown 

Step 1: turn off the power switch in the lower left corner of the front panel (as shown in Fig. 3.3). In this case, 

the shutdown process is started (the power supply will be shut down after processing of software and 

hardware). After dozens of seconds, the instrument will be powered off. The power indicator above the power 

switch will turn yellow from green. 

Step 2: turn off the power switch (―O‖) on the rear panel, or disconnect the power supply of the instrument. 

Thus the instrument is shut down. 

Attention 

Shutdown of Instrument 

The instrument in normal operation must be shut down by operating the power switch of the front panel. Do not 

directly operate the power switch of the rear panel or directly cut off the power supply of the instrument; 

otherwise, the instrument cannot be shut down normally and may be damaged, or the current state/measurement 

data may be lost. Shut down the instrument properly. In case of failure of normal shutdown caused by the 

anomaly of the operating system or application program, press [Power/Standby] key four seconds at least to shut 

down the analyzer. 

c) Cutoff of power supply 

In order to prevent personal injury under abnormal conditions, the power supply of the network analyzer requires 

emergency cutoff. In this case, pull off the power cord (from the AC power socket or the power socket of the rear 

panel of the instrument). Therefore, sufficient operating space should be reserved for direct cutoff of the power 

supply if necessary. 

3.1.1.4 Proper Use of Connector 
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The connector is always required in various tests of the network analyzer. Although the connectors of the calibrator, 

test cable and analyzer measurement port are designed and manufactured according to the highest standards, the 

service life is limited. Inevitable wear in normal operation may result in declining of performance indicators of the 

connector and failure to meet measurement requirements. Proper connection of the connector in maintenance and 

measurement can help to obtain accurate and repeatable results, prolong the service life of the connector, and 

reduce the measurement cost. Pay attention to the following items in actual operation. 

1) Inspection of connector 

Wear the anti-state wristband in connector inspection. It is recommended to use the magnifying lens to check the 

following items. 

1) Check whether the plating surface is worn or deeply scratched. 

2) Check whether threads are deformed. 

3) Check whether there are metal particles on the connector threads and joint surfaces. 

4) Check whether the internal conductor is bent or cracking. 

5) Check whether the connector screw is tightened properly. 

 
Caution 

Prevent damage to the instrument port in connector inspection. 

Any damaged connector may result in damage to the connector in good conditions even in the first measurement 

connection. In order to protect each interface of the network analyzer, the connector must be checked before 

connection. 

2) Cleaning of connector 

Wear the anti-static wrist strap before cleaning the connector. Clean the connector according to the following steps. 

1) Remove loose particles on the connector threads and joint plane with clean low-pressure air. Thoroughly check 

the connector. If required, further clean the connector according to the following steps. 

2) Soak the lint-free cotton swab with isopropyl alcohol (not thoroughly soaked). 

3) Clean the dirt and debris on the joint plane and threads of the connector with the swab. Do not apply force on the 

internal conductor at the center during cleaning of the internal surface. Do not leave the swab fibers on the central 

conductor of the connector. 

4) Evaporate alcohol and purse the surface with compressed air. 

5) Check the connector for particles and residues. 

6) If the connector defect is still visible after cleaning, it indicates that the connector may be damaged and must not 

be used. Find the causes of damage before measurement connection. 

3) Connection method 

Check and clean the connector before measurement connection. Ensure that the connector is clean and intact. Wear 

the anti-static wristband in connection. The correct connection method and steps are as follows. 

Step 1: as shown in Fig. 3.4, align the axes of two connectors to be interconnected, and ensure that the pin of 

the male connector can concentrically slide into the jack of the female connector. 

 

Fig. 3.4 Alignment of Axes of Interconnected Connectors 

Step 2: as shown in Fig. 3.5, horizontally move two connectors to make them connected smoothly. Tighten 

the connector nut by means of rotation (do not rotate the connector). Avoid relative rotation of connectors 

during connection. 
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Fig. 3.5 Connection Method 

Step 3: as shown in Fig. 3.6, complete the final connection by tightening with the torque wrench. Note that the 

torque wrench must not be beyond the initial break point. Use the auxiliary wrench to prevent the connectors 

from rotation. 

 

Fig. 3.6 Final Connection with Torque Wrench 

4) Disconnection method 

Step 1: support the connectors to prevent any kind of force which may result in distortion, shaking or bending. 

Step 2: use the open-end wrench to prevent the connector body from rotation. 

Step 3: use another wrench to loosen the connector nut. 

Step 4: rotate the connector nut by hand to complete final disconnection. 

Step 5: horizontally separate two connectors. 

5) Use of torque wrench 

The use of the torque wrench is shown in Fig. 3.7. Pay attention to the following items. 

 Check whether the torque of the torque wrench is set properly before use. 

 Ensure that the angle between the torque wrench and the other wrench (used to support the connector or cable) 

is less than 90° before applying force. 

 Carefully grip the handle end of the torque wrench, and apply force in the direction vertical to the handle to 

reach the break point of the wrench. 

 

Fig. 3.7 Use of Torque Wrench 

6) Operation and storage of connectors 

1) Connectors should be protected with covers if not in use. 

2) Do not place various connectors, air lines and standard calibrators in one box in a messy manner. This is one of 
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common causes of connector damage. 

3) Keep the connectors and analyzer at the same temperature. Hold and clean connectors with compressed air to 

greatly increase the temperature. Do not calibrate the connectors until the temperature is stable. 

4) Do not connect the joint planes of connectors. The skin oil and dust particles cannot be easily removed from 

joint planes. 

5) Do not place the contact surfaces of connectors down to the hard table. Any contact with solid surfaces may 

cause damage to the electric plating and joint planes of connectors. 

6) Wear the anti-static wrist band and operate the instrument on the grounded conductive workbench mat to protect 

the analyzer and connectors from the influence of static release. 

7) Use of adapter 

If the type of the measurement port of the analyzer is not applicable to the applied connector, use the adapter in 

measurement connection. In addition, it is a good choice to use an adapter even if the connector type of the 

measurement port of the analyzer is the same as that of the port of the DUT. The measurement port can be 

protected in these two cases, to prolong the service life and reduce the maintenance costs. Carefully check and 

clean the adapter before connection to the measurement port of the analyzer. Use the high-quality adapter to reduce 

the influence of mismatch on the measurement accuracy. 

8) Joint plane of connector 

One important concept of microwave measurement is a reference surface, which is the benchmark surface for all 

measurements of the analyzer. The reference plane is defined as a joint plane of the measurement port and standard 

calibrator in the calibration process. Good connection and calibration depends on the complete and smooth contact 

at all points of the joint planes of connectors. 

 

Fig. 3.8 Calibration Plane 

3.1.2 System Recovery and Installation Procedures of Analyzer 

3.1.2.1 System Recovery of Network Analyzer 

Abnormal shutdown of software, infection of viruses or use of other kinds of software in the analyzer may result in 

anomaly of the operating system of the analyzer. In this case, system recovery is recovered. Recover default 

settings of the analyzer according to the following steps: 

1) Shut down the analyzer and connect the keyboard to the USB interface. 

2) Press the [Power/Standby] key in the lower left corner of the front panel of the analyzer. When the indicator of 

the external keyboard is ON and the screen shown in Fig. 3.9 appears, immediately press [↑] and [↓], select 

―System Recovery‖, and press [Enter] of the keyboard to automatically recover the system. 

 

Fig. 3.9 Start-up Screen 
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Fig. 3.10 System Recovery Screen 

3) If the screen shown in Fig. 3.10 appears, system recovery is started. About 10min is required in the whole 

process of system recovery. Restart the analyzer after recovery. 

3.1.2.2 Updating of Network Analyzer Program 

To update program files or install a new program in an 3672 series vector network analyzer, double-click ―D:\3672 

program installation‖. According to the guidance of the menu [Program installation of 3672 series vector 

network analyzer], directly press [Next]. When [Select installation type] appears, select [Complete]. If any other 

menu appears, directly click [Cancel]. Then double-click the icon of 3672 series vector network analyzer on the 

desktop or press [Reset] to start the program. 

Specific steps are shown in Fig. 3.11 to 3.17. 
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Fig. 3.11 Start Interface of Installation Program 

 

Fig. 3.12 License Protocol Interface 
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Fig. 3.13 User Information Input Interface 

 

Fig. 3.14 Interface of Installation Directory Selection 
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Fig. 3.15 Interface of Installation Type Selection 

 

Fig. 3.16 Installation Waiting Interface 
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Fig. 3.17 Interface of Installation Completion 

3.1.3 Routine Maintenance 

This section describes the routine maintenance of 3672 series vector network analyzers. 

3.1.4.1 Cleaning 

1) Cleaning of instrument surface 

Clean the instrument surface according to the following steps: 

Step 1: turn off the instrument by disconnecting the power line connected to the instrument. 

Step 2: carefully wipe the surface with dry or slightly wet soft cloth. Do not wipe the inside of the instrument. 

Step 3: do not use any chemical cleaner, such as alcohol, acetone or any cleaner which may be diluted. 

2) Cleaning of display 

Clean the display after a certain period of use. Follow the steps below: 

Step 1: turn off the instrument by disconnecting the power line connected to the instrument. 

Step 2: soak clean soft cloth with cleaner, and carefully wipe the display panel. 

Step 3: dry the display with clean and soft cotton cloth. 

Step 4: Connect the power line after the cleaner is thoroughly dry. 

Attention 

Clean the display. 

There is anti-static coating on display surface, do not use fluoride-bearing detergent or acidic/alkaline detergent. Do 

not spray detergent on display panel directly, otherwise it may penetrate into and damage the instrument. 

3.2 Front Panel & Rear Panel 

This chapter introduces the elements and functions of the front panel, rear panel and operation interface of 3672 

series vector network analyzer. 
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3.2.1 Front Panel 

This section describes the structure and functions of the front panel of 3672 series vector network analyzers. The 

front panel is shown in Fig. 3.18. 

Fig. 3.18 Front Panel of 3672 

1) Input key zone 

The keys are used to enter measurement settings, as shown in Fig. 3.19. 

 

Fig. 3.19 Input Key Zone of 3672 

a) [OK] key 

Confirm the settings and input values in the dialog box and close the dialog box, equivalent to the ―OK‖ button in 

the dialog box. 

b) [Cancel] key 

Ignore the settings and input in the dialog box and close the dialog box, equivalent to the ―Cancel‖ button in the 

dialog box. 

c) [Soft Key] key 

Recall the soft keyboard of the Windows 7 system. 

d) [BkSp/←] key 

Move the marker back and delete the original input after entering. 
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e) Number keys 

Include 0-9. Enter the numbers in measurement setting and press the corresponding unit keys to complete input. 

f) Unit keys 

End the number input and distribute a unit to each input value. The unit corresponding to each key is as follows: 

[G/n] G/ns (109/10-9) 

[M/μ] M/μs (106/10-6) 

[k/m] k/ms (103/10-3) 

 
Basic units include dB, dBm, degree, second, Hz or dB/GHz. The keys can also be used to input 

values with no unit and have the functions of the ―Enter‖ key. 

2) Adjustment key zone 

Include navigation keys and knobs, as shown in Fig. 3.20. 

 

Fig. 3.20 Adjustment Key Zone of 3672 

a) Knob 

Rotate the knob to adjust the set value in the current active input box. 

b) [← Tab] and [→ Tab] key 

 Move left or right to select the menu. 

 Switch the active options in the dialog box. 

c) [↑] and [↓] key 

Move up and down in the menu to select the menu item. They also have the following functions in the dialog box: 

changing the value, selecting the item of the drop-down list, and selecting the desired option in a group of option 

buttons. 

3) Setup key zone 

The zone includes6 commonly used keys, as shown in Fig. 3.21. 
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Fig. 3.21 Setup Key Zone of 3672 

a) [Freq] key 

Shortcut key to set the frequency. The start frequency, stop frequency, center frequency, frequency span and 

frequency offset can be set in the normal mode. The frequency corresponding to measurement can be set in the 

multi-function option measurement. 

b) [Power] key 

Shortcut key to set the power. The power level, power state ON/OFF, power, power attenuation and power slope 

can be set in the normal mode. The power corresponding to measurement can be set in the multi-function option 

measurement. 

c) [Meas] key 

Shortcut key for measurement. It‘s used to set up measurement parameters of current trace. It can set up S-

parameter and receiver in ordinary mode and can set up measurement parameters of corresponding mode in multi-

function option measurement. For instance, it can set up ―compression gain CompGain21‖ in the measurement 

mode of amplifier gain compression. 

d) [Sweep] key 

Shortcut key for sweep setup. It can set up sweep time, point, type and other parameters.  

e) [Trigger] key 

Shortcut key for trigger setup. It can set up trigger modes at remain, single time, group sweep, continuous sweep 

and  so on.  

f) [Scale] key 

Shortcut key for scale setup. It can set up the scale of current trace, reference value and position, which makes trace 

observation easy and convenient.  

4) Menu Key Zone 

The Menu Zone includes 9 Menu Setup keys except for [Help], as shown in Fig. 3.22.  



3 Introduction to Use 

3.2 Front Panel & Rear Panel 

30  

 

 

Fig. 3.22 3672 Menu Key Zone 

a) [File] key 

Open the main file menu. The primary menu will be displayed in the auxiliary menu bar: ―Save‖, ―Recall‖, ―Print‖, 

―Minimize application program‖ and ―Exit‖. 

b) [Trace] key 

Open the main trace menu. The primary menu will be displayed in the auxiliary menu bar: ―New trace‖, ―Delete 

trace‖, ―Select trace‖, ―Move trace‖, ―Trace title‖ and ―Maximize trace‖. 

c) [Channel] key 

Open the main channel menu and the current channel will be selected automatically. The primary menu will be 

displayed in the auxiliary menu bar: ―Channel 1/2/3/4‖, ―Open channel‖, ―Close channel‖, ―Select channel‖, ―Copy 

channel‖ and ―Hardware setting‖. 

d) [Stimulus] key 

Open the main stimulus menu. The primary menu will be displayed in the auxiliary menu bar: ―Frequency‖, 

―Power‖, ―Sweep‖ and ―Trigger‖. 

e) [Response] key 

Open the main response menu. The primary menu will be displayed in the auxiliary menu bar: ―Measurement‖, 

―Format‖, ―Scale‖, ―Display‖ and ―Average‖. 

f) [Cal] key 

Open the main calibration menu. The primary menu will be displayed in the auxiliary menu bar: ―Calibration‖, 

―Correction ON/OFF‖, ―Interpolation ON/OFF‖, ―Port extension‖, ―Fixture‖, ―Edit calibrator‖, ―Attribute‖ and 

―Power calibration‖. 

g) [Marker] key 

Open the main marker menu. The primary menu will be displayed in the auxiliary menu bar: ―Marker‖, ―Marker 

function‖, ―Marker search‖, ―Marker attribute‖ and ―Marker display‖. If no marker is enabled at present, the 

marker 1 will be enabled automatically in the default mode. If a marker is enabled, the current marker will be 

selected automatically. 

h) [Analysis] key 

Open the main analysis menu. The primary menu will be displayed in the auxiliary menu bar: ―Save‖, ―Test‖, 

―Trace Statistics‖, ―Gate‖, ―Window‖, ―Time Domain‖, ―Structural Return Loss‖ and ―Equation Editor‖. 

i) [System] key 

Open the main system menu. The primary menu will be displayed in the auxiliary menu bar: ―Configuration‖, 

―Record/Run‖, ―Spread Spectrum‖, ―Windows Task Bar‖, ―Reset‖, ―Custom User State‖ and ―Language‖. 
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5) Function Key Zone 

The Function Key Zone includes 4 commonly used keys, which are set on the left of the scree, as shown in 

Fig. 3.23. 

 

Fig. 3.23 3672 Function Key Zone 

a) [Help] key 

Open the main help menu. The primary menu will be displayed in the auxiliary menu bar: ―User manual‖, 

―Programming manual‖, ―Technical support‖, ―Error information‖ and ―About‖. 

b) [Macro/Local] key 

If the analyzer is programmed, press this key to switch to the macro state. If the analyzer is not programmed, press 

this key to open the macro menu. 

c) [Record/Run] key 

It is a shortcut key to enable the recording/running function of the analyzer. Press the key to automatically start 

recording. If recording is completed, press this key to automatically start running. This key is only effective for 

Record/Run 1, and cannot be used to control Record/Run 2. 

d) [Preset] key 

It is a shortcut key to preset the analyzer. If the user has saved the preset state and the item ―Enable user preset state‖ 

is ticked, press this key to recover the state saved by the user; otherwise, the system reset state will be recovered. 

6) USB Interface 

The USB interface can be connected with the keyboard, mouse and other USB devices. The front panel is equipped 

with four USB interfaces in total and conforms to the USB2.0 specifications. The interface jack is of A type (four 

embedded contacts; Contact 1 on the left side). The features of each interface are as follows: 

 Contact 1: Vcc, 4.75V-5.25V; maximum output current: 500mA. 

 Contact 2: data -. 

 Contact 3: data +. 

 Contact 4: ground. 
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Fig. 3.24 USB Interface 

7) Display screen 

As shown in Fig. 3.25, the display screen of the analyzer is a TFT LCD screen. Technical indicators are as follows: 

 12.1-inch touch screen 

 Resolution: 1280×800 

 Vertical refresh rate: 60Hz 

 Horizontal refresh rate: 48.4Hz 

For the function and setting details of each display element of the screen, refer to ―4.9 Setup of analyzer display‖. 

 

Fig. 3.25 Display Screen of Analyzer 

8) [Start/Standby] key and indicator 

The [Start/Standby] key and indicator are shown in Fig. 3.26. The power switch is used to start the analyzer 

or enable the standby state of the analyzer. 

 The indicator is green when the analyzer is started. 

 The indicator is orange when the analyzer is in the standby state. 

 Press the power button to start the analyzer. Then the Windows 7 operating system will be run automatically 

and the measurement application program will be loaded. 

 When the power button is pressed in the standby state, the analyzer will automatically exit the application 

program. When the power supply will be turned off, the standby state will be enabled. 

 This is only a standby switch. It cannot be directly connected with the external power supply or used to cut off 

the connection between the instrument and external power supply. The external power supply of the analyzer 

can be shut down by the power switch on the rear panel. The connection between the analyzer and external 

power supply can be fully cut off by removing the power line. 
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Fig. 3.26 [Start/Standby] Key and Indicator 

9) Test port 

As shown in Fig. 3.27, the test is equipped with two 50Ω and 3.5mm/2.4mm/1.85mm (male) test ports for 

switching between the RF source and receiver, so as to measure the DUT in two directions. The yellow light is used 

to indicate the source output port. 

 

Fig. 3.27 Test Ports of Analyzer 

3.2.2 Rear panel 

This section describes the structure and functions of the rear panel of 3672 series vector network analyzers. The 

rear panel is shown in Fig. 3.26. 

 

Fig. 3.28 Rear Panel of Network Analyzer 

1) 10MHz reference connector 

 

Fig. 3.29 10MHz Reference Connector 
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a) 10MHz Ref In 

As shown in Fig. 3.29, the BNC (female) connector can be used for connection between the analyzer and external 

reference signal. The 10MHZ external reference signal detected by the port will be used as the reference frequency 

of the instrument, instead of the internal reference frequency. The 10MHz reference input port has the following 

features: 

 Input frequency: 10MHz±1ppm 

 Input level: -15dBm to +20dBm 

 Input impedance: 200Ω 

b) 10MHZ Ref Out 

The reference signal with the following features can be provided for the outside through the BNC (female) 

connector. 

 Output frequency: 10MHz±1ppm 

 Signal type: sine wave 

 Output level: 13dBm±4dBinto50Ω 

 Output impedance: 50 Ω 

2) GP-IB connector 

As shown in Fig. 3.28, this is a 24-pin D-type female connector, meeting the IEEE-488 standards. It is used to 

transmit and receive GPIB/SCPI commands. 

 

Fig. 3.30 General-interface Bus Connector 

3) LAN connector 

As shown in Fig. 3.29, this is a 10/100/1000BaseT Ethernet connector of standard 8-pin structure, and three data 

rates can be selected. 

 

Fig. 3.31 LAN Connector 

4) USB connector 

As shown in Fig. 3.32, the connector jack is of Type A (four embedded contacts; with Contact 1 on the left side) 

and Type B. Type A connector can be connected to the USB mouse, keyboard or other USB interface devices. The 

rear panel is equipped with four interfaces in total. The interface features are as follows: 

 Contact 1: Vcc, 4.75V-5.25V, max. 500mA 

 Contact 2: data - 

 Contact 3: data + 

 Contact 4: ground 
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Type B connector is mainly used for control. The network analyzer can be connected to the external computer or 

remote device through SCPI control. The rear panel is equipped with one interface. 

 

Fig. 3.32 USB Connector (B-type on the left and A-type on the right) 

5) Video graphic adapter (VGA) output connector 

As shown in Fig. 3.31, this is a 15-pin D-sub female connector to be connected with the external VGA display of 

corresponding resolution. In this case, the user can observe the internal and external display at the same time. 

 

Fig. 3.33 Output Connector of Video Graphic Adapter (VGA) 

Right-click the mouse on the Windows desktop. Confirm the multi-display mode by the right-click menu, as shown 

in Fig. 3.34. 

 

Fig. 3.34 Configuration of Multi-display Mode 

 If [Monitor] is ticked, only the external VGA display to observe the measurement results, and the internal 

LCD display of the analyzer will be ineffective. 

 If [Built-in Display] is ticked, only the internal LCD display of the analyzer is used to observe the 

measurement results, and the external VGA display will be ineffective. 

 If [Monitor + Built-in Display] is ticked, the internal LCD display and external VGA display can be used as 

the same time to observe the measurement results. 

6) Lo Out and RF Out connector 

As shown in Fig. 3.35 the 3.5mm female interface is used for LO output and RF output. The LO interface is used 

for internal LO signal output, and RF interface for RF source signal output. The connector can be used for fault 

detection and millimeter wave spreading. The interface features are as follows: 

 Frequency range of LO output signal: 

12.535MHz-13.507606GHz/26.507606GHz 
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 Power range of LO output signal: -4dBm to 6dBm 

 Frequency range of RF output signal: 3.2GHz-13.5GHz/26.5GHz 

 RF output signal power: -3dBm±2dB 

 

Fig. 3.35 LO and RF Output Connector 

7) Pulse I/O connector 

As shown in Fig. 3.36, this is a 15-pin D-type female connector. The working state of the internal pulse generator 

can be monitored synchronously through this interface. In addition, 

Electrical features are as follows: 

 Pulse width range: 33ns to 60s 

 Pulse transition time: 30ns 

 Input impedance: 1KOhm 

 DC input: ＜5.5V 

 Drive voltage: 0V (off)+3.3V (on) 

 

Fig. 3.36 Pulse I/O Connector 

The pin definition and description are as follows. 

Table 3.5 Pin Specifications of Pulse Input/Output Connector 

Pin Function description 

1~5 intermediate-frequency pulse gate input A/B/C/D/R (TTL) 

6, 9, 15 Reference ground 

7 Input of pulse synchronization trigger 

8 Input of source pulse modulation drive 

10~13 Pulse output 1-4 (TTL) 

14 Vacancy 

8) Ext IF Input connector 

As shown in Fig. 3.37, five SMA interfaces are used for external IF input of the vector network. The 2-port model 

is marked with A, B, R1 and R2, and the four-port with A, B, C, D and R. Features are as follows: 

 Input impedance: 50Ω 

 RF input: ＜23dBm 

 DC input: ＜5.5V 

 0.1dB compression point: -9dBm 
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Fig. 3.37 External Medium-frequency Input Connector 

9) Automatic test interface connector 

As shown in Fig. 3.38, this interface is a 36-pin female connector. The network analyzer and material handler can 

exchange signals through this interface to provide a stable and reliable automatic test environment for the user. 

 

Fig. 3.38 Automatic Test Interface Connector 

The port is composed of TTL array and has the following electrical features: 

a) Input voltage range: -0.5V to 5.5V 

High level of TTL: 2.0V to 5.0V 

Low level of TTL: 0V to 0.5V 

b) Output current/voltage range: -10mA to 10mA 

Output current 

High level of TTL: -5mA 

Low level of TTL: 3mA 

Output voltage: 

High level of TTL: 2.0V to 3.3V 

Low level of TTL: 0V to 0.8V 

The pin definition and description are as follows. 

Table 3.6 Pin Specifications of Automatic Test Interface Connector 

Pin Function description 

1 (lower left corner) ground 

2 Input 1 

3, 4 Input 1 and 2 

5-12 Output port A0-A7 

13-17, 19 Output port B0-B5 

22-25 Input/output port C0-C3 

26-29 Input/output port D0-D3 

18 external triggering 

20 Output port B6/Index signal 

21 Output port B7/Trigger Ready 

30, 31 Port C/D State 

32 Output port OK 

33 Pass/Fail state information 

34 End of sweep 

35, 36 +5V and Pass/Fail state information confirmation 

10) Extension interface connector 

As shown in Fig. 3.39, this interface is a 9-pin D-type female connector. 
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Fig. 3.39 Extension Interface Connector 

The pin definition and description are as follows. 

Table 3.7 Pin Specifications of Extension Interface Connector 

Pin Name Function description 

1 and 2 (lower left 

corner) 

+15V, -15V 15V@400mA 

3, 4 Analog output port 1 and 2 The +/-10V@100mA output resolution can be controlled 

to be 2.44mV by means of internal setting. 

5 ACOM Ground wire of system 

6 GndSence Ground wire of analog input/output detector 

7, 8 Analog input port 1 and 2 Analog input +/-10V@1.22mV resolution 

9 Power switch Power switch input 

11) External tester interface connector 

As shown in Fig. 3.40, this tester interface is a DB-25 female interface, including 13 addresses and data 

multiplexing lines, three control lines and one interruption control line, and is used to control the external tester 

(such as the external spread spectrum controller). 

 

Fig. 3.40 External Tester Interface Connector 

Table 3.8 Pin Specifications of Interface Connector of External Test Instrument 

Pin Name Function description 

1, 15, 16 and 18 (with 

Pin 1 in the lower left 

corner) 

Address selection bit 

of test device 

The initial bit of grounding is the lowest. Once an external device 

is connected successfully, the bit will be increased by 1. 

2 Waiting for sweep Use the program-controlled sweep switch to trigger and introduce 

the time delay mode. 

3~6, 9~11, 17, 19~23 Address bit AD0-

AD12 

Used to output the data address or receive/send data information. 

7, 12 ground Reference ground wire 

8 Address switch LAS The low level means that the address information is transmitted at 

present. 

24 Data switch LDS The low level means that the data information is transmitted at 

present. 

25 Reading and writing 

prompt RLW 

The low level indicates output, while high level indicates data 

input. 

13 Input interruption Read the TTL input state according to the program. 
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14 Unconnected Maximum range: +22V100mA 

12) Trigger input/output interface connector 

As shown in Fig. 3.41, this interface is an external and auxiliary trigger input/output interface. Specific functions 

are as follows: 

 External trigger input-if it is enabled, the vector network analyzer will be triggered according to the connector 

signal. 

 External trigger ready-if it is enabled, the vector network analyzer will send a ―Ready‖ signal to the external 

device through this interface. 

 Auxiliary trigger input 1/2-if it is enabled, the external device will send an ―OK‖ signal (meaning the external 

device is ready to receive trigger signal) to the vector network analyzer through this interface. 

 Auxiliary trigger output 1/2-if it is enabled, the vector network analyzer will send an ―OK‖ signal through this 

interface before (or after) one measurement. 

 

Fig. 3.41 Trigger Input/Output Interface Connector 

13) 28V (BNC) interface connector 

As shown in Fig. 3.40, this BNC (female) connector can be used to drive a noise source. 

 

Fig. 3.42 28V (BNC) Interface Connector 

3.3 Analyzer Interface 

The analyzer interface is used to guide the user to use and set the analyzer, and includes the front panel interface 

and user interface. 

● Front panel interface ··································································································································· 39 

● Mouse interface ·········································································································································· 40 

3.3.1 Front Panel Interface 

As shown in Fig. 3.43, the user can use the keys of the front panel to set and operate the analyzer according to the 

above two methods. The analyzer can be rapidly set by the following steps. 

 Press the corresponding front panel key to activate the auxiliary menu bar. 

 Observe the functional items of the auxiliary menu bar. 

 Press the corresponding panel for required function. 

 Enter the value (if required). 
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Fig. 3.43 Front Panel Interface 

3.3.2 Mouse Interface 

As shown in Fig. 3.44, the mouse can be used to realize the following operations. 

 Click the menu bar to display the drop-down menu. 

 Click the input toolbar to adjust the entered number. 

 Click the cursor toolbar to use the marker. 

 Click the measurement toolbar to add the measurement trace. 

 Click the scanning toolbar to control sweep of the analyzer. 

 Click the excitation toolbar to set sweep stimulus. 

 Click the time domain toolbar to set time domain. 

 Right-click the mouse on the screen to display the right-click menu. 

 Click the trajectory bar to select the current activate trace. 

 Right-click the mouse on the trace bar to set the current active trace in the right-click menu. 

 Click the auxiliary menu bar and shortcut toolbar to perform corresponding settings. 
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Fig. 3.44 Display Screen of Analyzer 

3.4 Trace, Channel and Window of Analyzer 

● Trace ·························································································································································· 41 

● Channel ······················································································································································ 41 

● Window ····················································································································································· 42 

3.4.1 Trace 

The trace is a series of measurement data points. Trace settings will affect the mathematical operation and display 

of measurement data. Only the settings of the active trace can be changed. Click the corresponding trace state 

button to active the trace. For detailed setting, refer to ―Change trace activation state‖ of ―4.2 Selection of 

Measurement Parameter‖. Trace settings include: 

 Measured parameters 

 Display format 

 Scale 

 Trace operation 

 Marker 

 Electrical delay 

 Phase deviation 

 Smoothing 

 Time domain transformation 

3.4.2 Channel 

The channel includes the trace. The analyzer supports 64 channels in total. Channel settings are associated with 

measurement of the trace in the channel. The same channel settings are applicable to traces in the same channel. 

Only the settings of the active channel can be changed. Once the trace in the channel is activated, the channel will 

also be activated. For detailed settings of the active trace, refer to ―Change trace activation state‖ of ―4.2 Selection 

of Measurement Parameter‖. Channel settings include: 

 Frequency span 
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 Power 

 Standard data 

 Intermediate-frequency bandwidth 

 Number of sweep points 

 Sweep setting 

 Average 

 Trigger (for some settings) 

3.4.3 Window 

The window is used to observe the measurement trace. The analyzer supports 32 windows at most, and eight traces 

can be displayed at most in each window. Set the window display by the [View] menu. For details, refer to ―4.9 

Stup of Analyzer Display‖. 

1) Create a new window. 

Menu path: [Response] > [Display] > [Window] > [New window]. Then a new window will be created. The 

default setting of the trace in the window is S11, indicating Channel 1. 

 

Fig. 3.45 Creation of New Window 

2) Use the full screen window. 

If several windows are opened at the same time, the trace will be unclear as a result of too small window size. In 

this case, one window can be displayed in the full screen so as to better observe the trace in the window. 

Use the mouse to display one window in the full screen according to the following three methods. 

 If the title bar is opened, click the ―Maximize‖ button in the title bar of the window. 

 If the title bar is closed, double-click the mouse in the window to be maximized. 
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 Menu path: [Display] > [Window] > [Maximize]. 

3.5 Data Analysis 

● Marker ······················································································································································· 43 

● Trace operation and statistics ······················································································································ 52 

● Limit test ···················································································································································· 54 

● Ripple test ·················································································································································· 56 

● Bandwidth test ··········································································································································· 58 

● Equation editor ··········································································································································· 61 

3.5.1 Marker 

Use the marker to read the measurement data, search the values of specific type or change the stimulus settings. 

Nine normal markers and one reference marker can be used at most for each trace. 

3.5.1.1 Create marker 

1) Use of marker functions 

a) Marker toolbar 

Menu path: [Response] > [Display] > [Toolbars]. Click [Markers] in the toolbar sub-menu to display the 

marker toolbar. 

Select the marker to be opened in the [Markers] box. 

Set the marker stimulus value in the [Stimulus] box. 

Click the [Open] check box. 

 

Fig. 3.46 Creation of Marker by Marker Toolbar 

b) Marker menu 

Menu path: [Marker] > [Marker]. The marker sub-menu will be displayed. 

Click the marker to be opened in the sub-menu. 
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Fig. 3.47 Creation of Marker by Marker Menu 

c) Marker dialog box 

Menu path: [Marker] > [Marker] > [Marker...]. The marker dialog box will be displayed. 

Select the marker to be opened in the [Marker] box. 

Set the marker stimulus value in the [Stimulus] box. 

Click the [Open] check box. 

 

Fig. 3.48 Creation of Marker by Marker Dialog Box 

 

2) Marker dialog box 

a) [Marker] box 

Select the marker to be defined. 

b) [Stimulus] box 

Define the stimulus value of X-axis of the selected marker. 

c) [Open] check box 

Select it to open the marker in the marker dialog box and clear it to close the marker in the marker dialog box. 

d) [Delta] check box 

Select it to display the relative values of the selected marker and Reference marker. If the marker R is not opened, 

select the check box to automatically open the reference marker. 
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e) [Advanced marker...] button 

Click it to display the advanced marker dialog box. 

f) [All Off] button 

Click it to close all the opened markers. 

3.5.1.2 Move marker 

1) Activate the marker to be moved in one of the above three methods. 

2) Move the marker in one of the following methods. 

a) Click the [Stimulus] box in the marker dialog box and move the marker in the following method. 

i. Directly enter the marker stimulus value. 

ii. Rotate the knob to move the marker. 

iii. Click the [↑] or [↓] in the [Stimulus] box to change the marker stimulus value. 

iv. Press [↑] or [↓] in the adjustment key zone to change the marker stimulus value. 

b) Click the [Stimulus] box in the marker toolbar and move the marker in the following method. 

i. Directly enter the stimulus value. 

ii. Rotate the knob to move the marker. 

iii. Click the [↑] or [↓] in the [Stimulus] box to change the marker stimulus value. 

iv. Press [↑] or [↓] in the adjustment key zone to change the marker stimulus value. 

c) Move the marker in the input toolbar in the following method. 

i. Directly enter the stimulus value. 

ii. Rotate the knob to change the stimulus value. 

iii. Press [↑] or [↓] in the adjustment key zone to change the marker stimulus value. 

iv. Click the Up and Down arrow in the input box to change the marker stimulus value. 

3.5.1.3 Marker search 

Search the specific measured value with the marker searching function. If no matching measurement data are found, 

the marker will remain unchanged in the current position. 

1) Marker search method: 

Menu path: [Marker] > [Marker search]. 

Set the marker search in the dialog box. Click [Execute] to execute marker search and [OK] to close the dialog box. 

 

Fig. 3.49Marker Search 
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2) Marker search dialog box 

a) Marker zone 

Select the marker to be defined for search. 

b) Search range zone 

Define the range of marker search. The default search range is the full bandwidth. In addition, the instrument 

supports the search of nine user settings. The user setting to be selected must be defined in the user range. The 

search ranges set by users are allowed to be overlapping. Various markers can be applied in one search range. Fig. 

3.48 shows a group of search ranges set by users. 

 

Fig. 3.50 Schematic Diagram of Search Domains Set by Marker Users 

c) User span 

The [Start] box and [End] box within the user span are used to define the search range set by the user. 

d) Search type zone 

Define the type of marker search. The analyzer supports the following 10 search types: 

 Minimum: search the minimum measurement data point. 

 Maximum: search the maximum measurement data point. 

 Right peak: search next effective peak value on the right side of the marker. The peak must be defined at 

first. 

The peak is defined according to [Threshold] and [Offset]. The minimum peak point is defined in the [Threshold] 

box. The effective peak point must be above the threshold value, and the valley points on both sides may be less 

than the threshold value. The minimum vertical distance between the peak value and valley value is defined in the 

[Offset] box. The vertical distance between the effective peak value and valley values on both sides must be more 

than the offset value. The analyzer settings in Fig. 3.49 are as follows: 

Threshold: -50dB 

Offset: 10dB 

Scale: 10dB/grid 

i. Peak A is effective, and the threshold and peak value conform to the requirements. 

ii. Peak B is not effective, and the offset does not conform to the requirements. 

iii. Peak C is not effective, and the threshold does not conform to the requirements. 
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Fig. 3.51 Schematic Diagram of Peak in Marker Domain 

 Left peak: search next effective peak value on the left side of the marker. The peak must be defined at 

first. 

 Next peak: search next peak lower than the current marker amplitude. The peak must be defined at first. 

 Target: enter the search target value in the [Log] box and click [Execute]. The marker will move to the 

first target value on the right side of the current marker location. Then continuously click [Execute], and 

the marker will move to next target value on the right side until it reaches the maximum stimulus value. 

In this case, the marker will return to the lowest stimulus value to search the target value. 

①If the [Discrete] is selected in the [Advanced] dialog box, the marker will move to the discrete data point 

corresponding to the target value. 

②If the [Discrete] is cleared in the [Advanced] dialog box, the marker will move to the interpolation data 

point corresponding to the target value. 

 Left target: only search the target value on the left side of the current marker. 

 Right target: only search the target value on the right side of the current marker. 

 Bandwidth: if the bandwidth searching function is selected, set the level (default: -3dB) below the peak 

in the level box and measure the bandwidth at the set level, as shown in Fig. 3.52. Use Marker 1-4 for 

measurement. Marker 1 is used to search the maximum peak value, Marker 2 to search the point of specified 

level on the left side of the peak, Marker 3 to search the point of specified level on the right side of the peak, 

and Marker 4 to search the center of the bandwidth. The following information will be displayed after 

measurement. 

Bandwidth: frequency difference between the right and left cutoff frequency point. 

Center: frequency of the middle point between the right and left cutoff frequency point. 

Q: value calculated by dividing the center frequency by the bandwidth. 

Loss: value measured at the center frequency point of the bandwidth. 

Left cutoff: minimum frequency of two points below the specific bandwidth level of the signal peak. 

Right cutoff: maximum frequency of two points below the specific bandwidth level of the signal peak. 
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Fig. 3.52 Bandwidth Search 

 Filter test: the analyzer has a special shortcut function to test the filter, and all test parameters will be 

automatically displayed on the screen so that the user can directly observe measurement results. As 

manual setting in the test is eliminated, the velocity of filter test is greatly increased. As shown in Fig. 3.51. 

Eight parameters of the filter test are displayed in the upper left corner of the trace. When the filter test is started, 

bandwidth search will be automatically enabled, and six parameters of the bandwidth test will be displayed in the 

upper right corner at the same time. 

Level of Bandwidth 1: set the level of Bandwidth 1 in the input box. 

Level of Bandwidth 2: set the level of Bandwidth 2 in the input box. 

Percentage frequency offset: set the percentage of frequency offset in the input box.  
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Fig. 3.53 Filter Test 

e) [Execute] button 

Click the [Execute] button to execute one marker search of specified type. 

f) [Tracking] check box 

If [Tracking] is selected, the search function will be executed after each sweep according to the current search type 

and range setting. In this case, the marker will be in the desired position after each sweep. 

3.5.1.4 Marker function 

1) Use of marker functions 

Some settings of the instrument can be changed according to the marker activation position, such as the start 

frequency, stop frequency, etc. The setting method is as follows. 

Menu path: [Marker] > [Marker Functions]. 

 

Fig. 3.54 Measurement Setting by Marker Function Dialog Box 

Prompt 

Soft key toolbar of marker function 

The soft key toolbar of the marker function can be used to set the start frequency, stop frequency, center frequency, 

reference frequency and delay. 

2) Marker function dialog box 

a) [Marker> Start] button 

Click it to set the sweep start value to be equal to the stimulus value of the active marker. 

b) [Marker> Stop] button 

Click it to set the sweep end value to be equal to the stimulus value of the active marker. 

c) [Marker> Center] button 

Click it to set the sweep center value to be equal to the stimulus value of the active marker. 
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d) [Marker> Ref] button 

Click it to set the sweep reference value to be equal to the stimulus value of the active marker. 

e) [Marker> Delay] button 

Click it and the electrical delay of the reception path will be adjusted according to the phase slope of the active 

marker. In this case, the phase trace near the active marker will be flattened. This function can be used to measure 

the electrical length and phase offset. It is only applicable to ratio measurement. 

f) [Marker> Span] button 

Click it to set the sweep span value to be equal to the stimulus difference (△marker) between the active marker and 

reference marker. This button is effective only when the △marker function of the active marker is enabled. 

3.5.1.5 Advanced marker option setting 

1) Use of advanced marker option function 

Menu path: [Marker] > [Marker] > [Marker...]. The marker dialog box will be displayed. 

Click the [Advanced marker...] button. The advanced marker dialog box will appear. 

 

Fig. 3.55 Advanced Marker Dialog Box 

2) Advanced marker option dialog box 

a) [Marker] box 

Select the marker to be set. 

b) [Open] check box 

If this check box is selected, the corresponding marker will be displayed on the screen. If this check box is cleared, 

the marker display will be shut down. 

c) [Discrete] check box 

If this check box is selected, the data of the actual measurement point will be displayed. If this check box is cleared, 

the interpolation data point between measurement points is still displayed. 

d) [Format] box 

Select the marker data format. The marker data format may be different from the format of trace data on the screen. 

The above formats are identical in the default mode. 

e) Marker type zone 

i. [Normal] option box 

The X-axis location of the standard marker is fixed, while the Y-axis location changes with the trace data amplitude. 

The marker can be moved right and left on the X-axis by changing the stimulus value. 

ii. [Fixed] option box 

The X-axis and Y-axis coordinates of the marker set to be of fixed type remain fixed on the trace and do not change 

with the trace data amplitude. The marker can be moved on the X-axis by changing the stimulus value, however, 

the Y-axis coordinate remains unchanged. This kind of marker is mainly used to observe changes of trace data. For 
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example, the fix marker can be used to compare insertion loss changes before and after filter tuning. 

3.5.1.6 Marker list 

1) Marker list 

All marker data of the active data can be displayed by opening the marker list, in the format specified for the 

corresponding data. The marker list will be opened and closed in the following method. 

2) Open/Close method 

Menu path 1: [Marker] > [Marker] > [Show Table] to open the marker list or [Hide table] to close the marker 

list. 

 

Fig. 3.56Marker List Setting by Marker Menu 

Menu path 2: [Response] > [Display] > [Tables] > [Marker Table]. 

If ―√‖ is marked, the marker list will be opened; otherwise, the marker list will be closed. 
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Fig. 3.57Marker List Setting by ―Display‖ Menu 

 

3.5.2 Trace Operation and Statistics 

The analyzer supports four kinds of mathematical operation of the current active trace and the trace in the memory. 

In addition, the analyzer has three functions of trace statistics: average, offset and peak-peak value. 

3.5.2.1 Trace Operation 

1) Setting the method of trace operation 

One trace must be stored in the memory before setting the method of trace operation or performing any kind 

of trace operation. Trace operation is a kind of vector operation based on plural data before display formatting. 

It is set in the following method. 

Menu path: [Analysis] > [Memory] > [Math/Memory...]. Then the operation/storage dialog box will appear. 

 

Fig. 3.58 Setting of Trace Operation 

2) Operation/storage dialog box 

a) [Data > Memory] button 

Save the current measurement data into the memory. 

b) [Trace View Options] box 

The [Trace View Options] box is used to select the type of trace operation. The analyzer supports the 

following operations. 

i. Data 

No mathematical operation. 

ii. Data+memory 

The displayed trace data are the measured data plus memory data. 

iii. Data-memory 

The displayed trace data are the measured data minus memory data. This function can be used for simple correction 

of errors. At first, store the measured vector error into the memory, and then reduce the measurement data of the 

DUT by the measured error. 

iv. Data * memory 

The displayed trace data are the measured data multiplied by the stored trace data. 

v. Data/ memory 

The displayed trace data are the measured data divided by the stored trace data. This function is mainly used to 
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measure the ratio, such as the gain and attenuation. 

c) Data display selection zone 

i. [Data Trace] option box 

Only display the data trace. 

ii. [Memory Trace] option box 

Only display the memory trace. 

iii. [Data and Memory Trace] option box 

Display the data and memory trace at the same time. 

3.5.2.2 Trace Statistics 

The analyzer has three functions of trace statistics: average, offset and peak-peak value. The statistical values can 

be calculated within the whole stimulus bandwidth or user-defined bandwidth. Each channel supports nine user 

setting ranges, which are the same as the search ranges set by user in the function of marker search. The same 

memory address is applied, so the same stimulus settings are shared. If the search range to be set by the channel 

user is defined by marker search, the same stimulus settings can be recalled by selecting the corresponding user 

settings in trace statistics. The ranges of user settings are allowed to be overlapping. 

It is not required to search the maximum and minimum value in the function of trace statistics, and the peak-peak 

value of passband ripple can be measured easily. The statistical values of traces are calculated according to the data 

display format. 

 Rectangular coordinate format: the statistical values of trace are calculated according to the displayed 

scalar data. 

 Polar coordinate and Smith chart format: the statistical values of trace are calculated according to the 

value displayed in the log magnitude format. 

1) Activation of trace statistics 

Menu path: [Analysis] > [Trace Statistics]. The dialog box of trace statistics will appear. 

 

Fig. 3.59 Dialog Box of Trace Statistics 

2) Dialog box of trace statistics 

a) [Statistics > Peak to Peak, Mean, Standard Deviation, Max, Min] check box 

If this check box is selected, the function of trace statistics will be enabled. If this check box is cleared, the function 

of trace statistics will be disabled. 

b) [Span] box 

Set the span of trace statistics. Nine user settings can be selected within the whole bandwidth or customized, or the 

user settings can be customized through the marker search dialog box. 

c) User range definition zone 
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i. [Start] box 

Customize the start value of the user range. 

ii. [Stop] box 

Customize the stop value of the user range. 

3.5.3 Limit Test 

The limit test function is used to compare the measured data and defined constraints (limits). The limits defined by 

the user are intuitively displayed on the screen in the limit line form. The limit lines have the following advantages: 

 Provide intuitive indicators for the device commissioning personnel. 

 Provide the standards of characteristic indicators of the device. 

 Provide the intuitive comparison between the measured data and indicators of the device. 

The limit test function is used to compare the measured data and defined limits, and provide PASS and FAIL 

information. Each trace supports up to 100 separate limit segments for accurate definition. 

3.5.3.1 Creating and Editing of Limit Line 

The analyzer supports creating of limit lines for all measured traces. The limit line is composed of several separate 

segments which are respectively determined by four coordinate values: X-axis start and stop stimulus value and Y-

axis start and stop response value. It is created and edited according to the limit table. 

1) Menu path: [Analysis] > [Test] > [Limit Test]. The test dialog box will appear. 

2) Click [Show Table] in the dialog box to display the limit table. 

3) Click [OK] to close the dialog box. 

4) Click [Limit Type] in the limit test dialog box and select the limit test type in the drop-down box. 

 

Fig. 3.60 Limit Test 

3.5.3.2 Limit Table 

 Type Start stimulus Stop stimulus Start response Stop response Limit type 

1 MAX 100.000kHz 100.000kHz -100.000dB -100.000dB SLOP 

2 MIN 100.000kHz 3.000GHz -100.000dB -100.000dB FLAT 

3 OFF 100.000kHz 3.000GHz -100.000dB 100.000dB SLOP 

Fig. 3.61 Limit Table 

“Type” box 

The ―Type‖ box is used to set the limit test type: 

 MAX: the limit test fails if the trace is above the limit segment. 

 MIN: the limit test fails if the trace is below the limit segment. 
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 OFF: disable the test of the limit segment. 

“Start stimulus” box and “Stop stimulus” box 

Set the start and stop stimulus value of the limit segment (i.e. X-axis start and stop coordinates of the limit 

segment). 

“Start response” box and “Stop response” box 

Set the start and stop response value of the limit segment (i.e. Y-axis start and stop coordinates of the limit 

segment). 

“Limit type” box 

Set the limit line display mode of the limit test: 

 SLOP: display the slope limit line. 

 FLAT: display the flat limit line. 

 POINT: display the point limit line. 

3.5.3.3 Setup of Limit Test 

After creating the limit line, select the mode of displaying or hiding the limit line of one trace. Even if the limit line 

is hided, the corresponding limit test is still effective. The limit test is not applicable to the stored trace. You can 

select to send the warning sound and display the failure sign (FAIL) in case of the failure of limit test. When the 

limit test function is enabled, the trace of the faulty part is red in the default mode. You can change the limit 

failure color in the ―Color setting‖ of the right-click menu of the mouse, and the trace color of the passing part 

remains unchanged. 

1) Setting method 

a) Menu path: [Analysis] > [Test] - [Limit Test]. The test dialog box will appear. 

b) Set the limit test in the dialog box. 

c) Click [OK] to close the dialog box. 

The limit test can only be done at the actual sweep measurement point. The instrument can still pass the limit test if 

only a few sweep points are applied and the performance indicators of the DUT may not conform to the 

requirements. Therefore, sufficient sweep points should be applied in actual measurement of the limit test. 

2) Limit test dialog box 

[Limit Test on/OFF] check box 

If this check box is selected, the limit test of the active trace will be enabled. If this check box is cleared, the limit 

test of the active trace will be disabled. 

[Limit Line on/OFF] check box 

If this check box is selected, the limit line of the active trace will be displayed on the screen. If this check box is 

cleared, the limit line display of the active trace will be turned off, however, the limit test function will not be 

affected. 

[Sound on Fail] check box 

If this check box is selected, the buzzer will send the warning sound in case of failure of the trace data point test. 

[Fail Sign on/OFF] check box 

If this check box is selected, the FAIL sign will be displayed on the screen in case of failure of the trace data point 

test. 

[Point] option box 

If this box is selected, the discrete limit value corresponding to the measurement data point will be indicated with 

the symbol ―v‖ (measurement type: MAX) and ―^‖ (measurement type: MIN). 

[Line] option box 
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If this box is selected, all the discrete limit setting points will be connected through a line. 

[Show Table] button 

Click it to display and edit the limit table. If the limit table is opened, this button will be disabled. 

[Hide Table] button 

Click it to close the limit table display. If the limit table is closed, this button will be disabled. 

[Export table] button 

Click it and the storage dialog box will pop up. You can select the storage path, and the file will be saved in the 

―*.csv‖ format. 

[Import Table] button 

Click it and the storage dialog box will pop up. Select the storage path of the file to be opened, and the file will be 

opened in the ―*.csv‖ format. 

[Limit test type] drop-down option box 

Click this drop-down option box to select the limit test type. Four types are provided in total: multi-type limit line, 

slope limit line, single-point limit line and flat limit line. 

3.5.4 Ripple Test 

The conformity of test results can be evaluated by setting the ripple limit of the ripple test. The measured data and 

defined ripple limit are compared in the test. The PASS and FAIL information will be provided, and the 

measurement results will be intuitively displayed on the screen. Each trace supports 12 separate limit segments at 

most. You can set the start stimulus, stop stimulus and maximum fluctuation of each limit segment. The stimulus 

settings of different segments may be overlapping. 

3.5.4.1 Creating and Editing of Ripple Limit Line 

The ripple limit test can be done to several traces at the same time. The ripple limit can be set after the trace is 

activated. 

1) Setting method 

a) Menu path: [Analysis] > [Test] > [Ripple test]. The test dialog box will appear. 

b) Click the [Table] button in the dialog box to open the ripple limit table. 

 
 

Fig. 3.62 Ripple Test Dialog Box 

2) Ripple limit table 

 Type Start stimulus Stop stimulus Maximum fluctuation 

1 ON 100.000kHz 2.000GHz 5.000dB 

2 ON 2.000GHz 3.000GHz 10.000dB 

3 OFF 100.000kHz 3.000GHz 100.000dB 
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Fig. 3.63 Ripple Limit Table 

“Type” box 

The ―Type‖ box is used to set the limit test type: 

ON: enable the test of the limit segment. 

OFF: disable the test of the limit segment. 

“Start stimulus” box and “Stop stimulus” box 

Set the start and stop stimulus value of the ripple limit segment. 

“Maximum fluctuation” box 

Set the maximum fluctuation of the test line of the ripple limit segment test. 

3.5.4.2 Setup of Ripple Test 

After creating the ripple limit line, select the mode of displaying or hiding the ripple limit line of one trace. Even if 

the limit line is hided, the corresponding ripple test is still effective. You can select to send the warning sound and 

display the failure sign (FAIL) in case of the failure of ripple test. When the ripple test function is enabled, the trace 

of the failure part is red in the default mode. You can change the limit failure color in the ―Color setting‖ of the 

right-click menu of the mouse, and the trace color of the passing part remains unchanged. 

Menu path: [Analysis] > [Test] - [Ripple test]. The test dialog box will appear. 

The ripple test can only be done at the actual sweep measurement point. The instrument can still pass the ripple test 

if only a few sweep points are applied and the performance indicators of the DUT may not conform to the 

requirements. Therefore, sufficient sweep points should be applied in actual measurement of the limit test. 

Ripple test dialog box 

[Ripple Test on/OFF] check box 

If this check box is selected, the ripple test of the active trace will be enabled. If this check box is cleared, the ripple 

test of the active trace will be disabled. 

[Ripple Line on/OFF] check box 

If this check box is selected, the ripple line of the active trace will be displayed on the screen. If this check box is 

cleared, the ripple line display of the active trace will be deactivated, however, the ripple test function will not be 

affected. 

[Sound on Fail on/OFF] check box 

If this check box is selected, the buzzer will send the warning sound in case of failure of the trace data point test. 

[Fail Sign on/OFF] check box 

If this check box is selected, the FAIL sign will be displayed on the screen in case of failure of the trace data point 

test. 

[Show Table] button 

Click it to show and edit the ripple table. If the ripple table is opened, this button will be disabled. 

[Hide Table] button 

Click it to close the ripple table display. If the ripple table is closed, this button will be disabled. 

[Export…] button 

Click it and the storage dialog box will pop up. You can select the storage path, and the file will be saved in the 

―*.csv‖ format. 

[Import…] button 

Click it and the storage dialog box will pop up. Select the storage path of the file to be opened, and the file will be 

opened in the ―*.csv‖ format. 
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[Value type] drop-down option box 

Click this drop-down option box to select the limit test type: none, absolute value and allowance. The default 

value is the absolute value after start-up of the instrument. 

[Ripple Band] drop-down option box 

Click the drop-down option box to select the number of ripple limit segments to be opened. At most 12 segments 

can be opened. 

3.5.4.3 Display of Ripple Test Results 

If the measurement results of ripple test conform to the requirements, ―PASS‖ will be displayed in the upper left 

corner of the screen; otherwise, ―FAIL‖ will be displayed. ―PASS‖ and ―FAIL‖ of each trace will be respectively 

displayed if several traces are tested at the same time. The stimulus ranges of different ripple limit segments are 

allowed to be overlapping, and various ripple limits can be set. 

 

Fig. 3.64 Ripple Test Results 

3.5.5 Bandwidth Test 

The bandwidth test function is mainly used to test the bandwidth of the bandpass filter. 

The signal peak within the passband can be found in the bandwidth test. Two points are respectively located at the 

specific amplitude on both side of the passband. The amplitude is lower than the signal peak and can be adjusted by 

setting the NdB point (default setting: 3dB). The frequency range between the two points is the bandwidth of the 

tested filter. 

The minimum bandwidth and maximum bandwidth allowed by the user can be set before the bandwidth test. 

The actual bandwidth will be automatically compared with the above two values. In case of nonconformity, the 

FAIL information will be provided on the screen or the sound will be utters, so that the user can intuitively check 

whether the properties of the DUT conforms to the requirements. 

3.5.5.1 Enabling and Setting of Bandwidth Test 

Set the bandwidth threshold (NdB point), maximum bandwidth and minimum bandwidth before the bandwidth test. 

Several traces can be set. 
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1) Menu path: [Analysis] > [Test] > [BW Test]. The test dialog box will appear. 

2) Tick the [Bandwidth Test on/OFF] check box in the dialog box to enable the bandwidth test. 

3) Tick the [Bandwidth Value on/OFF] check box in the dialog box to display the tested bandwidth on the screen. 

4) Tick the [Bandwidth Marker on/OFF] check box in the dialog box. The bandwidth location mark will be 

displayed on the screen. 

5) Click the [NdB Point] box to set the bandwidth threshold. 

6) Click the [Min Width] box to set the minimum bandwidth. 

7) Click the [Max Width] box to set the maximum bandwidth. 

8) Tick the [Sound ON Fail on/OFF] check box in the dialog box. The sound prompt will be provided in case of 

failure of the bandwidth test. 

9) Tick the [Fail Sign on/OFF] check box in the dialog box. The FAIL prompt will be provided in case of failure 

of the bandwidth test. 

10) Click [OK]. Thus the bandwidth test setting is completed. 

 

Fig. 3.65 Dialog Box of Bandwidth Test 

3.5.5.2 Display of Bandwidth Test Results 

Bandwidth test results will be displayed in the upper left corner of the trace. If the test results are acceptable, 

―PASS‖ will be displayed. The red T-type bandwidth marks will appear on both sides of the bandwidth. 
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Fig. 3.66 Display of Bandwidth Test Results  
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3.5.5.3 Shutdown of Bandwidth Test 

1) Click [Analysis] > [Test] > [BW Test]. The test dialog box will appear. 

2) Click the [Bandwidth Test (on/OFF)] check box and remove the tick to shut down the bandwidth test. 

3) Click the [Bandwidth Value (on/OFF)] check box and remove the tick to shut down the test bandwidth value 

display. 

4) Click the [Bandwidth Marker (on/OFF]] check box and remove the tick to shut down the bandwidth position 

mark display. 

5) Click [OK] to shut down the bandwidth test. 

3.5.6 Equation Editor 

3.5.6.1 Overview 

In order to facilitate illustration, the following two terms should be defined at first. 

Reference trace: a trace used as data in the equation. 

Equation trace: a current active trace after equation operation. 

The user is allowed to enter an algebraic expression in the equation editor. The algebraic expression can be used for 

mathematical operation of measurement data. Operation results can be displayed in the data trace form. 

Measurement data of the equation trace are the data of one or more channel(s). The mathematical expression 

entered by the user is composed of the basic operator, built-in function and parameters. Measurement parameters or 

trace data used in the equation are provided by the vector network analyzer. If a calculation equation is entered into 

the equation input box and the activation box is ticked, the current active trace will become an equation trace. The 

equation trace data are the data after operation, and the equation trace curve can be updated with data changes in a 

real-time manner. Take the input equation S21/(1-S11) as an example. The value of each point on the equation 

trace is calculated by S21/(1-S11) of the corresponding point. If the trace includes 201 points, the operation will be 

done 201 times by the expression, that is, once for each point. 

Measurement of a three-port device is not conventional for the analyzer, but can be done through the equation 

editor. If the user expects to obtain a logarithmic equation trace, the following expression can be used: S21+S23-

S13. However, the data used in the equation editor are plural data with no format requirements. The user needs to 

enter the following equation: S21*S23/S13 as shown in Fig. 3.67. After the equation is entered, Eq=S12*S23/S13 

will be displayed on the current active trace of the vector network analyzer, as shown in Fig. 3.68. 

 

Fig. 3.67 Dialog Box of Equation Editor 
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Fig. 3.68 Display of Equation Trace 

3.5.6.2 Use of Equation Editor 

1) Open the equation editor dialog box. 

Click the [Analysis] > [Equation Editor] in the menu of the vector network analyzer to open the equation editor 

dialog box, as shown in Fig. 3.69. 

 

Fig. 3.69 Equation Editor Menu 

2) How to enter the equation in the equation editor dialog box 

a) Function input 

Click the function list under [Function and constants] in Fig. 3.65 and enter the function in the equation input box, 

or directly enter the function through the keyboard. 

b) Operator input 

Click the operator list under [Operator] and enter the operator in the equation input box, or enter the operator 
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through the keyboard. 

c) Trace and channel input 

Click the mouse to enter the trace and channel parameters among the options in the drop-down list of [Trace] or 

[Channel], as the equation parameters or variables, or enter the operator through the keyboard. 

d) Data input 

Enter the numbers through the number keys on the right side, or enter the operator through the keyboard. 

2) “Activation” check box 

The ―Activation‖ check box is ticked in the default mode. The equation entered by the user will be judged only 

when this check box is ticked. If the equation is applicable to calculation, operation will be started. The expression 

Eq=XXX of the current equation will be displayed on the active trace of the current active window of the vector 

network analyzer. If this check box is not ticked, operation will not be started no matter whether the entered 

expression is applicable to calculation. In addition, if this check box is ticked but the entered equation is not 

applicable to calculation (such as the case of ―2+1+‖), the check box will be gray. 

4) Equation saving and deleting 

Click [Save equation] to save any expression entered by the user in the equation input box, the equation will be 

saved in the drop-down menu of the equation input box. Click the right drop-down arrow of the equation input box 

and select the equation in the drop-down list. 

In addition, the user can click [Delete equation] to delete the equation in the equation input box. 

5) Backspace button 

[<-Backspace]: used to delete one character in front of the marker. If there is no character on the left side, the 

marker position will remain unchanged. 

6) Leftward and rightward movement of marker 

[<-]: used to move the current marker left for one character but not to delete the left character. If there is no 

character on the left side, the marker position will remain unchanged. 

[->]: used to move the current marker right for one character but not to delete the right character. If there is no 

character on the right side, the marker position will remain unchanged. 

7) Selection of functions and variables 

The built-in function library is set in the default mode, including the commonly used equations and constants to be 

selected by clicking. The functions/constants are shown in Table 3.10. If the parameter of one function is of plural 

type, the scalar can be used as the parameter. The scalar is a plural, with 0 as the imaginary part. 

Table 3.10 List of Functions/Constants 

acos(scalara) Return to the ACOS value of the parameter a in radian. The parameter a is a scalar. 

asin(scalara) Return to the ASIN value of the parameter a in radian. The parameter a is a scalar. 

atan(scalara) Return to the Atan value of the parameter a in radian. The parameter a is a scalar. 

atan2 Return to the phase of the plural a in radian. 

Two parameter types can be applied: 

atan2(complexa): return to the phase in radian. The parameter a is a scalar. 

atan2(scalara and scalarb): return to the phase in radian. The parameter a and b are scalars. 

conj(complexa) Return to the conjugate complex of the plural a. 

cos(complexa) Calculate the cosine value of the plural a. The real part and imaginary part of a are in radian. 

cpx(scalara,scalarb) Return to a plural (a+jb). The parameter a and b are scalars. 

getNumPoints() Return to the number of the current sweep points. 

im(complexa) Return to the imaginary part of the parameter a. 

kfac(rComplexa, 

rComplexb, 

rComplexc, 

Return value k=(1-|a|^2-|d|^2+|a*d-b*c|^2)/(2*|b*c|). The parameter a, b, c and d are plurals. 
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rComplexd) 

ln(complexa) Return to the natural logarithm of the plural a. 

log10(complexa) Return to the logarithm of 10 corresponding to the plural a. 

mag(complexa) Return to the modulus of the plural a. The parameter a is a plural. 

mu1(complexa,com

plexb, 

complexc,complexd) 

Return value mu1=(1-|a|^2)/(|d-conj(a)*(a*d-b*c)|+|b*c|). The parameter a, b, c and d are 

plurals. 

mu2(complexa,com

plexb, 

complexc,complexd) 

Return value mu2=(1-|d|^2)/(|a-conj(d)*(a*d-b*c)|+|b*c|). The parameter a, b, c and d are 

plurals. 

phase(complexa) Return to atan2(a), i.e. calculation phase, in radian. The parameter is a plural. 

PI Constant Pi, 3.141592. 

re(complexa) Return to the real part of the plural a. The plural a is a plural. 

sin(complexa) Return to the sine value of the plural a. The parameter a is a plural, in radian. 

sqrt(complexa) Return to the square root of the modulus of the plural a. The parameter a is a plural. 

tan(complexa) Return to the tangent value of the plural a. The parameter a is a plural, in radian. 

8) Operator selection 

Operations are shown in Table 3.11. The user can click the mouse to select the required operator, such as four basic 

operators, i.e. ―+‖, ―-‖, ―*‖ and ―/‖, as well as the left bracket and right bracket. In addition, the equation editor also 

supports direct input of plural data for operation. To enter the plural constant 2+j3, the user should enter <2:3> into 

the equation editor to indicate the plural constant 2+j3. To enter the (2+j3)*S11, the user should enter the 

expression <2:3>*S11 for operation. 

Table 3.11 List of Operators 

+ Addition operator 

- Subtraction operator 

* Multiplication operator 

/ Division operator 

( Left bracket 

) Right bracket 

, Comma, used to separate several parameters. 

< Start symbol to enter the plural. 

: Used to separate the real part and imaginary part of the plural. 

> Ending symbol to enter the plural. 

9) Trace data 

The user can select the trace or trace data in the list below, but the current active trace cannot be selected. 

10) Channel parameter data 

The user can only select the S-parameter of the current active channel as the parameter data of the entered 

expression. 

11) Number key zone 

The user can enter numbers by clicking number keys in the number key zone, the positive and negative symbol by 

clicking [+/-] and the decimal point by clicking [•]. 

3.5.6.3 Data and Precautions of Use of Equation Editor 

The data of each point of the equation trace can be calculated according to the data of the corresponding point on 

the reference trace. If the trace includes 201 points, the calculation will be done 201 times by the equation, i.e. once 

for each data point. If the current trace is Tr4 and the equation is Tr2+S11, Tr4 will be the equation trace. Tr1 and 
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S11 are the reference traces of the equation trace. In addition, the current active trace Tr4 in the display window of 

the vector network analyzer will be displayed as Tr4Eq=Tr2+S11. As shown in Fig. 3.70. 

Attention 

Precautions for use of equation vector 

1) If the equation is active and can be used for calculation, the original parameter will not be displayed on the 

current active trace. Instead, the equation trace will be displayed. For example, if the current active trace is Tr4 S22 

and the equation Tr2+S11 is entered, the equation trace Tr4 Eq=Tr2+S11 will be displayed. However, if the entered 

equation cannot be used for calculation, the original trace name will be displayed. For example, if ―Tr2+S11+‖ is 

entered, the original Tr4 S22 will be displayed on the current active trace. 

2) The current active trace cannot be used as the reference trace of the equation trace. For example, the current 

active trace is Tr4, Tr4 cannot be used as a parameter of the equation. 

3) The reference trace can be selected from the S-parameter and memory traces. Ensure that the memory trace 

exists before using it as a parameter; otherwise, the equation cannot be used for calculation. 

4) The reference trace must be the displayed trace if the trace of another channel is used as the reference trace. The 

trace must be used in the Trx form. The numbers of data points of the reference trace and equation trace should be 

identical. For example, if the number of data points of the reference trace is 201, the number of data points of the 

equation trace should also be 201. 

 

Fig. 3.70 Equation trace Display Window 

3.5.6.4 Saving of Equation Editor Data 

Equation data can be saved in the ―.cti‖, ―*.prn‖ and ―*.dat‖ format. However, the original names of measurement 

parameters are kept in the saved file. For example, if the original name of Tr2 is S22 and the entered equation is 

10+S22, the saved measurement parameter name will remain unchanged, i.e. S22. The data will become the value 

of 10+S22. The equation trace cannot be saved as a data file in the ―*.snp‖ format.  
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3.6. Data output 

● Saving and recalling of file ························································································································· 66 

● Printing of measurement data ····················································································································· 69 

3.6.1 Saving and Recalling of File 

3672 series vector network analyzer supports the saving and recalling of files in various formats. 

3.6.1.1 Saving of File 

1) Saving method 

Menu path: [File] > [Save] > [Save]/[Save as...]. 

 

Fig 3.71 Saving of File 

2) File menu item: [Save] 

Click [Save] to save the instrument state and calibration data int the default file (defaut.cst) of the specified 

directory. If the default file exists, the dialog box to confirm whether to cover will appear. 

3) File menu item: [Save as...] 

Click [Save as...] to save the file in the dialog box. 

a) [Save as] drop-down box 

Display and set the saving path. 

b) [File list] box 

Display the holder under the current path and all files matching with the saving type. Click one file to set its name. 

Click the holder to change the current path. 

c) [File name] box 

Display the entered file name or the file name clicked in the file list box. 

d) [Save as type] box 

Select the saving type. The analyzer supports the following file types: 

i. cst file 

Save the instrument state and calibration data. 

ii. sta file 

Only save the instrument state data. 
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iii. cal file 

Only save the instrument calibration data. 

iv. dat file 

In this mode, the [Data save setting] dialog box will be opened, and the trace data file will be saved according to 

the user‘s requirements. 

v. Prn 

Only save the current active trace data. 

vi. bmp file 

Save the screen display information in the bitmap form. 

3.6.1.2 Recalling of File 

1) Recall state and calibration data: 

a) sta file 

The state data of the instrument are saved in the sta file, including the settings, trace data, limit line and marker. 

b) cal file 

Calibration data are saved in the cal file, excluding state data. The correction accuracy of calibration data is 

associated with the state setting. To realize the highest accuracy of measurement, the instrument settings should be 

identical in file recalling and calibration; otherwise, the accuracy of calibration will not be guaranteed. 

c) cst file 

All measurement state and calibration data of the instrument are saved in the cst file, therefore, the cst file can be 

recalled to save time. 

2) File recalling: 

Menu path: [File] > [Recall...]. The dialog box will appear. 

Select the load file type in the [File type] box. 

Set the recall file directory through the [Search range] box and the [File list] below. 

 

Fig. 3.72 File Recalling 

The file is recalled by the following methods: 

i. Double-click the file to be recalled in the [File list] box. 

ii. Click the file to be recalled in the [File List] box and then click [Open]. 

iii. Enter the name of the file to be recalled in the [File Name] box and then click [Open]. 



3 Introduction to Use 

3.6. Data output 

68  

 

3.6.1.3 Data File 

Measurement results are saved in the ASCII format in data files. Data files can be edited with the text editing 

software and spreadsheet software, but cannot be recalled by the analyzer. Three types of data files can be saved in 

the analyzer: 

1) dat file 

The ―dat‖ file is used for saving measurement data of the active trace or all traces in the formatted or unformatted 

form. Define the data saving mode in the [Data save setting] dialog box. 

The ―dat‖ file is saved by the following methods: 

a) Menu path: [File] > [Save as...]. The [Save as...] dialog box will appear. 

b) Set the file saving type as the data file (*.dat) in the [Save as type] box. 

c) Set the saving directory in the [Save in] box and [File List] box. 

d) Set the name of the file to be saved in the [File Name] box. 

e) Click [Save]. The [Data Save Setting] dialog box will appear. 

f) Set the contents and format of the file to be saved. Click [Formatted data] or [Unformatted] to save the data 

file. Close the dialog box. 

 

Fig. 3.73 [Data save setting] Dialog Box 

[Save contents] zone 

Define the trace data to be saved into the file. 

a) [Default] radio box 

Save the data of active traces in all windows. 

b) [One trace] radio box 

Save the data of the current active trace. 

c) [Window trace] radio box 

Save the data of all trace in the current active window. 

d) [All trace] radio box 

Save the data of all trace. 

[Saving format] zone 

a) [Auto] radio box 

Save the trace data according to the actual display format. 

b) [Log] radio box 

Save the trace data in the logarithmic amplitude format. 

c) [Linear format] radio box 

Save the trace data in the linear amplitude format. 

d) [Real part format] radio box 
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Save the trace data in the real part format. 

e) [Imaginary part format] radio box 

Save the trace data in the imaginary part format. 

[Formatted data] button 

Save the trace data in the format set in the [Saving format] zone. 

[Unformatted] button 

Save the trace data in the real/imaginary part format. 

2) snp (s1p and s2p) file 

The ―snp‖ file is a kind of data output file. It can be recalled by the CAE (computer aided engineering) software 

(such as ADS of Agilent), but cannot be recalled by the analyzer. The ―s1p‖ file is used to save the characteristics 

of single-port devices, only including one S parameter (S11 or S22). The ―s2p‖ file is used to save the characteristics 

of double-port devices, including four S parameters. If the full double-port correction is started, four S parameters 

will be saved in the ―s2p‖ file. If the full double-port correction is shut down, measurement data will be saved in 

the ―s2p‖ file as much as possible. Example: if the full double-port correction is shut down, the current active trace 

is S11, but S21 is still measured in the channel, measurement results of S11 and S21 will be saved in the ―s2p‖ file. 

As no effective measurement data of S22 and S12 are provided, the corresponding data in the ―s2p‖ file are 0. 

The ―snp‖ file is saved by the following method: 

a) Menu path: [File] > [Save] > [Save as...]. The [Save as] dialog box will appear. 

b) Set the saving type as the data file (*.s1p or *.s2p) in the [Save as type] box. 

c) Set the saving directory in the [Save in] box and [File list] box. 

d) Set the file name in the [File name] box. 

e) Click [Save] to save data. 

3) prn file 

The prn file is used to save the measurement data of the active trace in lines and rows. Each line corresponds to one 

measurement point. The first row corresponds to the stimulus value, while the second row corresponds to the 

response value. The rows are separated by the comma (,). The format is as follows: 

S11LogMag 

LIN_SWEEP (Hz), LOG_FORMAT (dB) 

3.000000e+005, -9.232986e+000 

7.502250e+008, -3.219671e-001 

1.500150e+009, -6.892332e+000 

2.250075e+009, -1.146303e+000 

3.000000e+009, -1.245240e+001 

The ―prn‖ file is saved in the following method: 

Menu path: [File] > [Save] > [Save as...]. The [Save as...] dialog box will appear. 

Set the saving type as the list file (*.prn) in the [Saving type] box. 

Set the saving directory in the [Save in] box and [File list] box. 

Set the file name in the [File name] box. Click [Save] to save the file. Close the dialog box. 

3.6.2 Printing of Measurement Contents 

The analyzer supports the output of measurement contents through the printer or printing into the specified file. The 

local or network printer can be used. The printer can be of parallel, serial or USB interface type. Add the printer in 

the WINDOWS operating system. 
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3.6.2.1 Print Setting 

Method of print setting 

Menu path: [File] > [Print] > [Page Setup]. Then the page setting dialog box will appear. 

 

Fig. 3.74 Print Setting 

[Page Setup] dialog box 

1) [Window information] zone 

a) [Print] check box 

If this check box is selected, the window trace information will be printed. If this check box is cleared, the window 

trace information will not be printed. The following two check boxes are effectively only when the above check 

box is selected. 

b) [Print one window on each page] check box 

If this check box is selected, only the information of one window will be printed. If this check box is cleared, the 

information of all windows will be printed continuously, with no page breaks. 

c) [Print active window] radio box 

If this box is selected, only the information of the current active window will be printed. 

d) [Print all windows] radio box 

If this box is selected, only the information of the current active window will be printed. 

2) [Other Information] zone 

a) [Print] check box 

If this check box is selected, the channel setting information will be printed. The following check boxes are 

effectively only when this check box is selected. 

b) [Segment Table], [Limit Table], [Marker Table], [Channel Statue] and [Time] check box 

Select to print the corresponding information. 

3) [Separately print window and other information] check box 

If this check box is selected, the window and other information will be printed separately. If this check box is 

cleared, the above information will be printed together. 

3.6.2.2 Printing 

After the printer is added and the print contents are set, measurement information can be output through the printer, 

as shown below: 

Menu path: [File] > [Print] > [Print...]. The print setup dialog box will appear. 
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Fig. 3.75 Printing of Measurement Information 

3.6.2.3 Printing into File 

The analyzer supports the output of print contents into the bitmap (bmp) file. To print several pages, various BMP 

files will be created automatically, respectively corresponding to each page. The other files are identified in the 

―file name (number).bmp‖ format, such as amp.bmp, amp(1).bmp and amp(2).bmp. The printing method is as 

follows: 

Menu path: [File] > [Print] > [Print to File...]. 

Set the file directory and name in the dialog box. 

Click [Save] to save the file. 
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4 Measurement Setting 

This chapter mainly describes the operation of 3672 series network analyzers in measurement, creation of the 

measurement of the known state by analyzer resetting, selection of measurement setting, adjustment of the analyzer 

display so as to better observe measurement results, specifically including: 

● Resetting of analyzer ·································································································································· 72 

● Selection of measurement parameter ··········································································································· 76 

● Setting of frequency range ·························································································································· 79 

● Setting of signal power level ······················································································································· 80 

● Setting of sweep ········································································································································· 82 

● Trigger mode·············································································································································· 86 

● Setting of data format and scale ·················································································································· 91 

● Observation of multiple traces and opening of multiple channels································································· 95 

● Setting of analyzer display ·························································································································· 98 

4.1 Resetting of Analyzer 

● Default reset state ······································································································································· 72 

● User reset state ··········································································································································· 74 

● Resetting of analyzer ·································································································································· 75 

4.1.1 Default Reset State 

Press the [Reset] on the front panel to return to the known default state, i.e. reset state. The reset state is set as 

follows: 

1) Measurement parameter: S11 

2) Frequency setup: 

a) Start frequency: 10MHz 

b) Stop frequency: 13.5GHz/26.5GHz/43.5GHz/50GHz/67GHz 

c) CW frequency: 2GHz 

3) Power setup: 

a) Test port power: -5dBm 

b) Coupling port power: open 

c) Attenuation: auto 

d) Attenuation values: 0dB 

e) Power slope: closed 

f) Slope: 0dB/GHz 

4) Sweep setup: 

a) Sweep type: linear frequency 

b) Sweep time: automatic 

c) Number of sweep points: 201 

5) Segment sweep setup: 

a) Number of open segments: 1 
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b) Start frequency: 10MHz 

c) Stop frequency: 13.5GHz/26.5GHz/43.5GHz/50GHz/67GHz 

d) Number of points: 21 

e) Power: -5dBm 

f) Intermediate frequency bandwidth: 1kHz 

6) Trigger setup: 

a) Trigger source: internal 

b) Trigger type: continuous sweep 

7) Display format: 

Format: logarithmic amplitude 

The details of various formats are shown in Table 4.1. 

Table 4.1 Default Format Setting of 3672 Series Vector Network Analyzers 

Format Scale Reference position Reference value 

Logarithmic amplitude ≤10 dB 5 0dB 

phase 45o 5 0o 

Group delay 10ns 5 10fs 

Linear amplitude 100mU 5 500mU 

Standing wave ratio 1U 5 6U 

Real part 2U 5 0U 

Imaginary part 2U 5 0U 

Polar coordinate 1U None 1U 

Smith chart 1U None 1U 

8) Response setup: 

a) Number of channels: 1 

b) Intermediate frequency bandwidth: 1kHz 

c) Average: closed 

d) Average factor: 1 

e) Smoothing: closed 

f) Smoothing factor: 2.49% of the value range 

g) Electrical delay: 0s 

h) Velocity factor: 1 

i) Phase shift: 0° 

j) Track display: data 

9) Calibration setup: 

a) Correction: closed 

b) Interpolation: open 

c) Calibration type: none 

d) Calibration kit number: current calibration kit number 

e) System impedance: 50Ω 

f) Port extension: closed 
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g) Port extension value: 0s 

10) Marker setup: 

a) Initial frequency: full range of center frequency 

b) Reference marker R: closed 

c) Discrete marker: closed 

d) Format: trace format 

e) Type: standard 

f) Marker search type: minimum 

g) Search range: full bandwidth 

h) Marker table: empty 

11) Limit test setup: 

a) Limit test: closed 

b) Limit line display: closed 

c) FAIL sound warning: closed 

12) Limit table setup: 

a) Type: OFF 

b) Initial stimulus: 10MHZ 

c) Stop stimulus: 13.5GHz/26.5GHz/43.5GHz/50GHz/67GHz 

d) Initial response: -100dB 

e) Stop response: 100dB 

13) Time domain transformation setup (optional): 

a) Time domain transformation: closed 

b) Transformation mode: bandpass 

c) Transformation start: -5ns 

d) Transformation end: 5ns 

e) Kaiser window β factor: 6.0 

f) Gate state: closed 

g) Gate start value: -5ns 

h) Gate stop value: 5ns 

i) Gate shape: standard 

j) Gate type: bandpass 

14) Full display setup: 

a) Track state: open 

b) Frequency/stimulus: open 

c) Marker reading: open 

d) State bar: closed 

4.1.2 User Reset State 

The analyzer can be reset into the known default state or user-defined state. In the default mode, the analyzer is 

reset into the default state. It can be reset into the user-defined state by means of setting. Specific steps of setting 
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the user reset state are as follows. 

1) Menu path: [System] > [Define User State...]. Then the [Define User State...] dialog box will appear. 

2) Click [Enable User Reset State] and tick the check box. 

Notes: a) If you tick [Save final state as user preset], the final state before exiting the program will be saved as 

the user reset state. 

b) Click [Save current state as user state]. Then the current settings of the analyzer will be saved as the user 

reset state. 

c) To use the known state, click [Load exist file as user reset state]. Select the state in the dialog box, and 

open the file. Then the selected file will be used as the user reset state file of the analyzer. 

 

Fig. 4.1 Definition of User Reset State 

4.1.3 Resetting of Analyzer 

Menu path: [System] > [Preset] 

If the user reset state has been set, click [Preset]. 

 

Fig. 4.2 Resetting of Analyzer 
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Prompt 

[Reset] shortcut key 

The [Reset] shortcut key is set in the functional key zone and shortcut menu bar. 

4.2 Selection of Measurement Parameter 

The following parameters can be set in an 3672 series vector network analyzer to measure the electrical 

characteristics of devices. 

 S parameter (fixed ratio) 

 Any ratio (custom ratio for measurement) 

 Non-ratio power measurement (absolute power measurement) 

● S parameter ················································································································································ 76 

● Any ratio ···················································································································································· 78 

● Non-ratio power measurement ···················································································································· 78 

● Change of trace measurement type·············································································································· 79 

4.2.1 Parameter S 

1) Overview of Parameter S 

The parameter S (scattering parameter) is used to describe the change of input signal and the reflection and 

transmission characteristics of the DUT. The S-parameter is shown in the prescribed digit row, and indicates the 

proportion of two complex vectors, i.e. Soutput/input, including the amplitude and phase information. The output refers 

to the output signal port number of the DUT, and the input refers to the input signal port number of the DUT. The 

analyzer is equipped with four test ports to test single-port, double-port, three-port and four-port devices. 

For example, when one double-port device is connected to Port 1 and 2, four parameters (S) can be measured at the 

same time. 

In this case, the four parameters (S) of the double-port device are respectively S11, S12, S21 and S22. Fig. 4.3 

further shows the parameter S, where: 

 a refers to the stimulus signal from the input to DUT. 

 b refers to the reflection and transmission signal (response signal) of the DUT. 

The parameter S is a plural linear value. The measurement accuracy depends on the indicators of the calibrator and 

the adopted technology of measurement connection, and is also associated with the connection of the non-

measurement port (non-excited port). 

2) Application of parameter S 

The following parameters can be measured with S. 

a) Reflection measurement: SXX (X=1, 2, 3, 4) 

i. Return loss 

ii. Standing wave ratio (SWR) 

iii. Reflection coefficient 

iv. Impedance 

v. S11, S22, S33 and S44 

b) Transmission measurement: SXY (X=1, 2, 3, 4; Y=1, 2, 3, 4; X≠Y) 

i. Insertion loss 
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ii. Transmission coefficient 

iii. Gain 

iv. Group delay 

v. SXY 

The measurement of the double-port device with Port 1 and 2 is taken as an example below to introduce the 

parameter S. 

 

Fig. 4.3 Definition of Parameter S 

3) New S measurement trace 

Menu path: [Trace] > [New Trace]. Click the S-parameter in the dialog box. 

 

Fig. 4.4 Definition of Parameter S 
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4) [New Trace] dialog box 

a) [Parameter selection] zone 

Select the S parameter measurement trace to be created. 

b) [Receivers] button 

Open the dialog box to create any ratio or non-ratio power measurement trace. 

c) [Balance parameter] button 

Open the dialog box to create the balance parameter measurement trace. 

d) [Channel Number] box 

Select the channel where the new trace is located. 

e) [Create in new window] check box 

If this check box is selected, a trace will be created in the new window. If this check box is cleared, a trace will be 

created in the current active window. 

4.2.2 Any Ratio 

The input signal and reference signal are selected from the receiver A, B, C, D, R1, R2, R3 or R4 for ratio 

measurement. 

1) Create measurement trace of any ratio 

Menu path: [Trace] > [New Trace]. Click ―Receivers‖ in the dialog box. 

 

Fig. 4.5 Definition of S-Parameter 

4.2.3 Non-ratio Power Measurement 

The absolute power of the receiver A, B, C, D, R1, R2, R3 and R4 can be measured in the non-ratio power 

measurement mode, however, the phase, group delay and other items under the ―average‖ function cannot be 

measured. 

1) New non-ratio power measurement trace 

Menu path: [Trace] > [New Trace]. Click ―Receivers‖ in the dialog box. 

2) [New Trace] dialog box (any ratio and non-ratio power measurement) 
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a) [Active] check box 

Tick it to create a new trace. 

b) [Numerator] zone 

Select the numerator of any ratio measurement or the receiver for non-ratio power measurement. 

c) [Denominator] zone 

Select the denominator of any ratio measurement. The value is 1 in non-ratio power measurement. 

d) [Source] box 

Select the source signal output port of the analyzer. 

e) [Channel Number] box 

Select the channel for the new trace. 

f) [Create in new window] check box 

If this check box is selected, a trace will be created in the new window. If this check box is cleared, a trace will be 

created in the current active window. 

g) [Auto-Create Window] check box 

If this check box is ticked and the number of traces in the window exceeds 8, excessive traces will be automatically 

created in a new window. 

If this check box is cleared and the number of traces in the window exceeds 8, excessive traces will not be created. 

4.2.4 Measurement mode of trace change 

The trace must be activated before setting and modification. 

1) Change the trace state 

Click the [Track state] button in the window. The corresponding trace will be activated. 

 

Fig. 4.6 Change of Track Activation State 

2) Change the measurement parameter of active trace 

Menu path: [Response] > [Measure]. The measure sub-menu will appear. Or, right-click the trace title bar, and 

click [Measure] in the menu, as shown in Fig. 4.7. 

 

Fig. 4.7 Setting of Parameter S Measurement Mode of Activated Trace 

4.3 Setting of Frequency Range 

Frequency range: 10MHz-13.5GHz/26.5GHz/43.5GHz/50GHz/67GHz 

Frequency resolution: 1Hz 

1) Two ways of frequency range setting 
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a) Specify the start and stop frequency. 

b) Specify the center frequency and frequency span. 

2) Setting of start and stop frequency 

Menu path: [Stimulus] > [Freq] 

 

Fig. 4.8 Setting of Start and Stop Frequency 

3) Setting of center frequency and frequency span 

Menu path: [Stimulus] > [Freq] 

 

Fig. 4.9 Setting of Center Frequency and Frequency Span 

Prompt 

[Frequency] shortcut key 

The frequency can be rapidly set with the [Frequency] shortcut key in the functional key zone of the front panel. 

4.4 Setting of Signal Power Level 

The power level refers to the power level of the output signal of the test port. The power level indicators of the port 

of 3672 series vector network analyzer are as follows. 

Table 4.2 Power Level Indicators of Source Output Signal 

Frequency range Source frequency 

range (dBm) 

Configuration 

10MHz ~ 13.5GHz/26.5GHz/43.5GHz/50GHz/67GHz -25 ~ +20 Standard configuration 

10MHz ~ 13.5GHz/26.5GHz -95 ~ +20 Option: program-controlled 

step attenuator 

10MHz ~ 43.5GHz/50GHz -85 ~ +20 Option: program-controlled 

step attenuator 

10MHz ~ 67GHz -75 ~ +20 Option: program-controlled 

step attenuator 

 

1) Setting of power level 

Menu path: [Stimulus] > [Power]. Also, the [Power] shortcut key is set in the functional key zone of the front 
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panel and the shortcut menu bar. 

 

 

Fig. 4.10 Setting of Power Level 

2) Cutoff of port power 

Menu path: [Stimulus] > [Power] > [Power ON/off]. Or, switch the power by changing the setting of the [Power 

ON/off] check box in the [Power setting] dialog box. 

3) Manual setting of attenuation 

Menu path: [Stimulus] > [Power] > [Power and Attenuators...]. The [Power and Attenuators] will appear. 

Click to clear the [Auto] zone check box. Click the [Attenuation] input box and enter the attenuation value. 

4) Setting of power slope 

Menu path: [Stimulus] > [Power] > [Power...]. The [Power] dialog box will appear. Click [Slope] check box. 

Click the [Slope] input box and enter the power slope. 

5) [Power] dialog box 

a) [Power ON/off] check box 

If this check box is ticked, the port will normally output the power. If this check box is cleared, the port output 

power will be cut off. 

b) [Power-port 1] 

Set the power level of the port 1. 

c) [Channel Power Slope] check box 

Tick the [Channel Power Slope] check box and enter the slope value in the [Slope] input box to enable the power 

slope function. 

The power slope is used to compensate the power loss of the cable and test fixture as a result of frequency increase. 

 If the power slope function is enabled, the output power of the test port will increase (or decrease) with the 

increase of sweep frequency. 

 Unit of power slope: dB/GHz. 
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 Power slope setting range: -2 to +2. 

6) [Power and Attenuator] dialog box 

a) [Power ON/off] check box 

If this check box is ticked, the port will normally output the power. If this check box is cleared, the port output 

power will be cut off. 

b) [Port Powers Coupled] check box 

If the [Port Powers Coupled] check box is ticked in the default mode, the power level settings of two ports of the 

analyzer will be identical. However, different power levels are required for ports in some measurement applications. 

For example, the power of each port must be set separately to measure the gain and reverse isolation of one high-

gain amplifier, as the power of the input port of the amplifier is lower than that of the output port. If the [Port 

Powers Coupled] check box is cleared, the power level of each port can be set separately in the analyzer. 

c) [State] bar 

It is [Auto] in the default mode. In this case, the power ON/OFF state can be switched according to the 

measurement needs. [ON] indicates the port power is always ON, while [OFF] indicates the port power is always 

OFF. 

d) [Port Power] bar 

Set the port power. 

e) [Automatic] bar 

If this check box is ticked, any power level can be set within the allowable range of the instrument. If this check 

box is cleared, the source power and attenuation can be set manually for certain measurement, such as the reflection 

amplifier (oscillator or unsteady-state amplifier) measurement. In this case, the matching source impedance (better 

than the return loss of 20dB) should be set within a wide frequency range. 

f) [Attenuator] bar 

Set the attenuator. 

g) [Leveling Mode] bar 

Set the leveling mode, including [Internal], [Receiver] and [Open loop]. The amplitude is not fixed in the [Open 

loop] mode. 

h) [Channel Power Slope] check box 

Tick the [Channel Power Slope] check box and enter the slope value in the [Slope] input box to enable the power 

slope function. The power slope is used to compensate the power loss of the cable and test fixture as a result of 

frequency increase. 

 If the power slope function is enabled, the output power of the test port will increase (or decrease) with the 

increase of sweep frequency. 

 Unit of power slope: dB/GHz. 

 Power slope setting range: -2 to +2. 

i) Attenuator Settings and power range 

The programmable attenuator is used to cover the whole power range. It can adjust the power level of the DUT 

while the power level of the reference path of the analyzer remains unchanged. Thus, higher accuracy and 

characteristic indicates and more accurate matching of source output signals can be realized. 

The fully accurate error correction can be done at the power point for measurement calibration. If the power level is 

changed in the same attenuator settings as those of measurement calibration, the accuracy of error correction is 

higher in ratio measurement but poorer in non-ratio measurement. 

4.5 Setting of Sweep 

Sweep refers to the process of continuously measuring data points according to the stimulus values in the specified 
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sequence. 

● Overview of sweep types ···························································································································· 83 

● Setting of sweep type ································································································································· 83 

● Sweep time ················································································································································ 85 
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4.5.1 Overview of Sweep Types 

The network analyzer supports six sweep types shown below. 

1) Linear frequency 

This is the default sweep type of the instrument. The whole frequency range is covered continuously by the 

frequency linearity. 

2) Logarithmic frequency 

In the logarithmic frequency mode, the source frequency increases in logarithmic steps, and the frequency ratio of 

every two adjacent frequency points is identical. 

3) Power sweep 

The power is swept at the point frequency. The maximum sweep range is 50dB. The default frequency sweep range 

is -25dBm to +20dBm. 

4) Point frequency 

In the point frequency sweep mode, a single sweep frequency is set in the analyzer, measurement data are 

accurately and continuously samples at the intervals determined according to the sweep time and the number of 

measurement points, and changes of measurement data with time are displayed. 

5) Segment sweep 

Segment sweep aims to start sweep of several segments. The power level, intermediate frequency bandwidth and 

sweep time of each segment can be set independently. After calibration of all segments, one or several segment(s) 

can be measured according to the calibrations. Segments are defined according to the frequency increase sequence, 

and the frequency range must be prevented from overlapping. The attenuator settings of the power levels of all 

segments must be identical to prevent damage caused by frequent switching of the attenuator. If the attenuator 

settings of the current segment and defined segment are different, the analyzer will automatically change the power 

level and attenuator settings of the defined segment. 

6) Phase sweep 

Sweep the phase of one or several source(s) relative to another source. The measured value is -360° to +360°. 

4.5.2 Setting of Sweep Type 

1) Setting of sweep type 

Menu path: [Stimulus] > [Sweep] > [Sweep Type]. 

Select the corresponding sweep type in the auxiliary menu bar or in the [Setting of sweep type] dialog box. 

 

Fig. 4.11 Setting of Linear Frequency Sweep Type 

2) Setting of segment sweep type 
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Menu path: [Stimulus] > [Sweep] > [Sweep Type]. 

Auxiliary menu bar: click [Segment Sweep] or select [Segment Sweep] in the [Sweep Type] dialog box. 

 

Fig. 4.12 Setting of Segment Sweep Type 

Dialog box setting instructions: 

a) [Independent Power Levels] check box: tick it to set the independent power level of each segment. In this case, 

the attenuator settings must be identical. 

b) [Independent IF Bandwidth] check box: tick it to set the independent intermediate frequency bandwidth of 

each segment. 

c) [Independent Sweep Time] check box: tick it to set the independent sweep time of each segment. 

d) [Show Table] button: click it to create and edit the sweep table. 

e) [Hide Table] button: click it to hide the segment sweep table. 

3) Segment insertion and deletion 

Only the displayed segment table can be edited. 

Menu path: [Stimulus] > [Sweep] > [Segment Table] > [Show Table]. The segment table sub-menu will appear. 

Tick [Show Table] in the segment table sub-menu. Click [Insert Segment] in the segment table sub-menu to add 

a new segment in front of the selected segment. Click [Delete Segment] in the segment table sub-menu to delete 

the selected segment. Click [Delete All Segments] to delete the whole segment table. 

 

 
Fig. 4.13 Segment Insertion and Deletion 

4) Editing of segment table 

a) Double-click the [State] box of the segment and select ―ON‖ or ―OFF‖ to open or close the segment. 

b) Double-click the [Start] box of the segment and enter the start frequency of the segment. 

c) Double-click the [Stop] box of the segment and enter the stop frequency of the segment. 

d) Double-click the [Points] box of the segment and enter the number of sweep points of the segment. 

e) Double-click the [Power Level] box of the segment and enter the power level of the segment (the independent 

power level option is opened). 
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f) Double-click the [IF Bandwidth] box of the segment and enter the intermediate frequency bandwidth of the 

segment (the intermediate frequency bandwidth option is opened). 

g) Double-click the [Sweep Time] box of the segment and set the sweep time (the independent sweep time option is 

opened). 

4.5.3 Sweep Time 

After setting of measurement, the minimum sweep time will be adopted by the analyzer. The sweep time can be 

increased to meet certain requirements of measurement. If the sweep time is set as 0, the minimum sweep time will 

be adopted automatically by the analyzer. If the sweep is no less than 300ms, a sweep indicator will be displayed 

on the analyzer, indicating the point-to-point measurement sweep. The measurement indicator is a small upward 

arrow, showing the point at which measurement is just completed on the trace. 

1) Setting of sweep time 

Menu path: [Stimulus] > [Sweep] > [Sweep Time...]. The dialog box of sweep time will appear. 

Enter the sweep time directly in the [Sweep Time] box. For setting of the sweep time with the keys and auxiliary 

menu bar, directly enter the sweep time in the input toolbar. 

 

Fig. 4.14 Setting of Sweep Time 

4.5.4 Setting of Sweep 

1) Sweep setting 

Menu path: [Stimulus] > [Sweep] > [Sweep Setup...]. The [Sweep Setup] dialog box will appear. 

 

Fig. 4.15Sweep Setting 

2) [Sweep Setup] dialog box 

a) [Channel] box 

Select the channel applicable to sweep setting. 

b) [Stepped Sweep] check box 

In the step sweep mode, the source is tuned to a frequency point and the frequency point is measured after the 

specified dwell time. Then the source is tuned to next frequency point. A device of long electrical delay can be 

accurately measured. If this check box is cleared, the analyzer may work in the analog sweep or step sweep mode, 

depending on the setting of the sweep time and intermediate frequency bandwidth. 
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c) [Dwell time] input box 

Set the dwell time at each point before obtaining the measurement data. This is only applicable to the step sweep 

mode. 

d) [Sweep Delay] input box 

Set the waiting time of the analyzer before obtaining the measurement data. It refers to the delay before 

measurement of the first point. 

e) [Fast Sweep] check box 

If the [Fast Sweep] check box is selected, analog sweep will be started. Data are collected in the sweep process, 

thus reducing the waiting time of sweep. 

4.6 Trigger Mode 

The trigger signal is used to enable measurement sweep of the analyzer. The sweep mode and time to stop sweep 

and return to the holding state are determined by trigger settings. The vector network analyzer has high flexibility 

in trigger setting. 

● Simple trigger setting ································································································································· 86 

● Detailed trigger setting ······························································································································· 86 

● [Trigger] dialog box ··································································································································· 87 

4.6.1 Simple Trigger Setting 

Only the trigger mode of the current active channel can be set by simple trigger setting. 

Menu path: [Stimulus] > [Trigger]. The trigger sub-menu will appear. 

Click [Continuous], [Single] or [Hold] in the sub-menu and select the trigger mode. 

 

Fig. 4.16 Simple Trigger Setting 

4.6.2 Detailed Trigger Setting 

Menu path: [Stimulus] > [Trigger] > [Trigger...]. The trigger dialog box will appear. 
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Fig. 4.17 Trigger Sub-menu 

 

Fig. 4.18 Trigger Setting Dialog Box 

4.6.3 [Trigger] Dialog Box 

1) Trigger setting options 

a) Trigger source zone 

The source of the channel trigger signal is determined by trigger source setting of the trigger source zone. The 

effective trigger signal is generated when sweep is not done by the vector network analyzer. Three trigger sources 

can be selected: internal, manual and external. The set trigger source will be used as the trigger source of all 

channels. 

 [Internal] (default) 

1) Trigger signal generation is controlled automatically by the analyzer. 

2) One trigger signal is generated immediately after one measurement. 

 [Manual] 

The manual trigger signal is generated in the following methods. 



4 Measurement Setting 

4.6 Trigger Mode 

88  

 

1) Click the [Manual] button in the [Trigger] dialog box. 

2) Click the [Manual item in the [Trigger] sub-menu under the [Stimulus] menu of the menu bar. 

 [External] 

1) The trigger signal is input by [External] of the BNC connector on the rear panel. 

2) The signal is TTL level. 

3) Level trigger: the high or low level can be set in the [External] dialog box. 

4) The pulse width is 1μs at and must not be longer than the sweep time (otherwise, the trigger may be enabled 

several times). 

b) Range zone 

The measurement channel receiving the trigger signal is determined by trigger range setting. Two types of trigger 

range can be set: global and channel. 

 [Global] 

This is the default setting of the analyzer. Except the channel in the holding mode, all channels can receive the 

trigger signal. 

 [Channel] 

Next channel which is not in the holding mode will receive the trigger signal. After the current channel is measured, 

next channel will be selected automatically. Except the channel in the holding mode, all channels will be selected 

in sequence. The trigger source should be set in the manual mode to make the above setting effective. Set the 

[Channel] to enable the spot sweep function. 

c) Trigger setting zone 

The number of trigger signals to be received by one channel is determined by trigger setting. Four channel 

triggering states are provided: 

 [Continuous] 

The channel will receive a number of trigger signals. Sweep will be done continuously. 

 [Groups] 

The channel will only receive the trigger signals, the number of which is set in the [Group] input box. Sweep will 

be done for the set times, and then the channel will enter the holding mode. 

 [Single] 

The channel will receive one trigger signal. Sweep will be done once, and then the channel will enter the holding 

mode. 

 [Hold] 

The channel will not receive the trigger signal, and sweep will be stopped. 

 [Spot] ([Trigger mode] check box) 

The spot sweep mode can be selected only when the trigger source is manual or external and the trigger range 

is the channel. In the spot sweep mode, next data point will be measured in sweep after the channel receives the 

trigger signal. The channel will continuously receive the trigger signal until all measurements in the channel are 

done. Then next channel which is not in the holding mode will be triggered. 

 [Channel] ([Trigger mode] check box) 

All traces in the channel will be triggered. 

 [Sweep] ([Trigger mode] check box) 

The sweep trigger mode can be selected only when the trigger source is manual or external and the trigger 

range is the channel. The traces sharing one source port in the channel will be triggered. 

2) Measurement Trigger options 
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a) Main trigger input zone 

Set the nature of the external trigger signal to be received in the trigger input zone. 

 [Global/channel Trigger Delay] 

[Delay]: Enter the delay time in the delay input box. When the instrument receives the external trigger signal, 

sweep will be started after the delay time. 

 [Source] 

Set the external trigger signal input interface, including the BNC interface and automatic test interface (18-pin). 

 [Level/Edge] 

Set the trigger mode of the external trigger signal, including high level, low level, rising edge and falling edge. 

 [Accept trigger before armed] 

If this item is ticked, corresponding sweep will be executed immediately after the vector network analyzer receives 

the trigger signal; otherwise, all the received trigger signals will be ignored. 

 [Ready for Trigger Indicator] 

The trigger READY signal is sent by the BNC interface and automatic test interface (21-pin). High level and low 

level of the signal are optional. 

 

Fig. 4.19 Measurement Trigger Dialog Box 

3) Auxiliary 1/2 trigger option 

a) Auxiliary trigger output zone 

 [Enable] 

Tick the check box to open the external trigger output of the corresponding channel; otherwise, the external trigger 

output will be closed. 

 [Polarity] 

Set the polarity of the trigger output signal in the radio box: [Positive pulse] or [Negative pulse]. 

 [Position] 

Set the time to send the trigger output signal in the radio box: [Before data capturing] or [After data capturing]. 
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 [Pulse Duration] 

Input the pulse duration of the trigger output signal in the input box. 

 [Enable Wait-for-Device Handshake] 

If this check box is ticked, data will not be captured until the vector network analyzer receives the specific level 

from the auxiliary trigger input (1&2) connector of the rear panel. This signal indicates that the external device is 

ready and the network analyzer is allowed to capture data. Otherwise, the network analyzer will not wait. However, 

a trigger signal will be sent when the network analyzer is ready. This signal cannot be used to trigger the network 

analyzer. It is generated by the internal, manual or external source. 

 [Aux Trig] 

When the network analyzer is ready, a confirmation signal will be sent to the auxiliary 1 & 2 connection port. The 

signal can be in the rising edge, falling edge, high level or low level form. 

 [Delay] 

When the network analyzer receives the holding signal, data will be captured after the corresponding delay time. 

 

Fig. 4.20 Auxiliary 1/2 Trigger Dialog Box 

4) Pulse trigger options 

a) Synchronous pulse input zone 

Select the internal or external source to synchronize the internal pulse generator of the analyzer. 

 [Pulse Sync Trigger] 

1) Internal: the pulse generator is synchronized according to the periodic signal generated in the analyzer, and 

the output pulse train period is determined according to the pulse repetition period in the pulse measurement 

interface. 

2) External: the pulse repetition period specified by the user is ignored. One pulse train will be output once an 

effective external pulse synchronization signal is detected by the analyzer. The delay and width of the pulse 

generator can be set respectively in the pulse measurement interface. The external pulse synchronization input 

signal will be input through the pulse input/output interface of the rear panel of the analyzer. The configurable 

synchronization trigger signal can be input to the analyzer according to the pulse synchronization input signal. If 

the level is trigger, the analyzer will output a pulse train. If the level is continuously effective, the analyzer will 
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continue to output another pulse train. If the edge is triggered, the analyzer will be triggered by one effective edge 

signal to output a pulse train. The pulse train length is the maximum value (delay + width) in all the enabled pulse 

generators. 

 [Level/Edge] 

Set the characteristics of the effective external pulse synchronization input signal to be received by the analyzer: 

high level, low level, rising edge or falling edge. 

b) Receiver output zone 

 [Synchronize receiver to pulse] 

It is used to measure the broadband synchronization pulse. When this function is enabled, the pulse generator 

output and data collection are allowed to be synchronized. 

 [Delay] 

Set the delay time before collection of AD data. 

 

Fig. 4.21 Pulse Trigger Dialog Box 

4.7 Setting of Data Format and Scale 

The data format refers to the display of measurement data in the graphical form. Select the data format which is the 

most favorable to understand the characteristics of the DUT. This section introduces nine data formats and the 

method of scale setting so as to better display the measurement information. 

● Data format ················································································································································ 91 

● Data format setting ····································································································································· 94 

● Scale ·························································································································································· 94 

4.7.1 Data Format 

1) Rectangular coordinate format 

Seven of nine formats of measurement data are in the rectangular coordinate form. This format is also known as the 

Cartesian format, X/Y format or linear format and is suitable to display the frequency response information of the 
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DUT. For example, the rectangular coordinates in Fig. 4.23 show the following information. 

 Stimulus value (frequency, power or time) in the linear scale form on the X-axis in the default mode. 

 Response value corresponding to the stimulus value on the Y-axis. 

 

Fig. 4.22 Rectangular Coordinate Format 

a) Logarithmic amplitude format 

 Display the amplitude information (no phase information). 

 Y-axis unit: dB 

 Applicable typical measurement: return loss, insertion loss and gain. 

b) Phase format 

 Display the phase information (no amplitude information). 

 Y-axis unit: phase (degree) 

 Applicable typical measurement: linear phase deviation. 

c) Group delay format 

 Display the signal transmission time through the DUT. 

 Y-axis unit: time (second) 

 Applicable typical measurement: group delay. 

d) Linear amplitude format 

 Only display the positive value. 

 Y-axis: no unit (U) in ratio measurement and milliwatt (mW) in non-ratio measurement. 

 Applicable typical measurement: reflection and transmission coefficient (amplitude) value and time domain 

transformation 

e) Standing wave ratio format 

 Display the reflection measurement data calculated by the equation (1+ρ)/(1-ρ), where ρ is the reflection 

coefficient. 

 Effective in reflection measurement. 

 Y-axis: no unit. 

 Applicable typical measurement: standing wave ratio. 
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f) Real part format 

 Display the real part of the measurement complex. 

 It is similar to the linear amplitude format, but both the positive value and negative value can be displayed. 

 Y-axis: no unit. 

 Applicable typical measurement: time domain and auxiliary input voltage for maintenance purposes. 

g) Imaginary part format 

 Only display the imaginary part of measurement data. 

 Y-axis: no unit. 

 Applicable typical measurement: impedance measurement in design of matching network. 

2) Polar coordinate format 

The polar coordinate format shown in Fig. 4.24 includes the amplitude and phase information. The vector value can 

be read in the following method. 

a) The amplitude of any point is determined by the displacement of this point relative to the central point (or zero 

point). In the default mode, the amplitude is a linear scale, and the excircle scale is set as 1. 

b) The phase of any point is determined by the angle relative to the X-axis. 

c) The frequency information can only be read through the marker. The default marker format includes the real part 

and imaginary part. The marker dialog box can be opened in the marker/analysis menu. Other formats can be 

selected in the advanced marker menu. 

 

Fig. 4.23 Polar Coordinate Format 

3) Smith chart format 

Smith chart shown in Fig. 4.25 is a tool to map the reflection measurement data of the DUT into impedance. Each 

point of the chart represents the complex impedance composed of the real resistance (R) and virtual reactance (±jX). 

The resistance, reactance, equivalent capacitance and inductance can be read through the marker. 
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Fig. 4.24 Smith Chart Format 

a) The horizontal axis of the center of Smith chart represents the pure resistance, and the center of the horizontal 

axis represents the system impedance. The leftmost resistance on the horizontal axis is zero, indicating a short 

circuit. The rightmost resistance of the horizontal axis is infinite, indicating an open circuit. 

b) The points on the intersecting circle of Smith chart and horizontal axis have the same resistance. 

c) The points on the tangent of Smith chart and horizontal axis have the same reactance. 

d) The reactance of the upper part of Smith chart is positive. Therefore, the upper part is the sensitive zone. 

e) The reactance of the lower part of Smith chart is negative. Therefore, the lower part is the capacitive zone. 

4.7.2 Data Format Setting 

Menu path: [Response] > [Format]. The format sub-menu will pop up. 

 

Fig. 4.25 Setting of Data Format 

4.7.3 Scale 

The scale refers to the scale of the vertical part of the display grid. In the polar coordinate and Smith chart format, 

the scale refers to the full scale of the excircle. The display mode of measurement data on the screen are determined 
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by scale and format settings. In the log format, the scale setting range is 0.001dB/grid to 500dB/grid. 

1) Scale setting 

Menu path: [Response] > [Scale]. The scale sub-menu will pop up. 

Set the appropriate scale, reference location and reference level by clicking the corresponding input zone or keys. 

 

Fig. 4.26 Setting of Scale 

2) Scale setting dialog box 

a) Scale zone 

 [Scale] box 

Enter the set scale value. 

 [Auto] button 

Click the [Auto] button. The analyzer will automatically select the vertical scale to better display the active trace in 

the vertical grid of the screen. The stimulus value will not be affected, and only the scale value and reference value 

are changed. 

i. An appropriate scale factor will be selected so that data are displayed in 80% of the screen. 

ii. The center value of the trace on the screen will be selected as the reference value. 

 [Auto All] button 

Click the [Auto All] button. The analyzer will select appropriate scales of all traces in the window so that the traces 

are better displayed in vertical grids of the window. 

b) Reference setting zone 

 [Position] button 

The reference position refers to the position of the reference line in the rectangular coordinate figure. The position 

of the bottom line in the figure is 0, the position of the top line is 10, and the default value of the reference position 

is 5. 

 [Level] button 

The reference value refers to the value of the reference line in the rectangular coordinate format, and the value of 

the excircle in the polar coordinate and Smith chart format. The setting range is -500dB to +500dB in the 

logarithmic amplitude format. 

4.8 Observation of Multiple Tracks and Opening of Multiple Channels 

A convenient method is provided in the pre-configuration function of the analyzer for multi-trace, multi-channel 

and multi-window measurement. The analyzer has four preconfigured measurement settings. If one kind of setting 

is selected, the current trace and window will be closed, and a new trace and window will be created. The window 

arrangement of four pre-settings is as follows. 
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Fig. 4.27 Preconfigured Window Arrangement 

 Setup A 

Four traces will be created in Window 1: S11, S21, S12 and S22, in the logarithmic format in Channel 1. 

 Setup B 

Four traces will be created in four windows, in the logarithmic format in Channel 1. S11 will be displayed in 

Window 1, S21 in Window 2, S12 in Window 3 and S22 in Window 4. 

 Setup C 

Three traces will be created in three windows of Channel 1. S11 will be displayed in the Smith chart format in 

Window 1, S22 in the Smith chart format in Window 2 and S21 in the logarithmic format in Window 3. 

 Setup D 

Four traces will be displayed in two windows, in the logarithmic format in two channels. S11 and S21 will be 

displayed in Window 1 of Channel 1, and S12 and S22 in Window 2 of Channel 2. 

1) Preconfigured measurement setting 

Menu path: [Response] > [Display] > [Meas Setups...]. The measurement setup dialog box will appear. 

Select the preconfigured measurement setting in the dialog box. 
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Fig. 4.28 Preconfigured Measurement Setting 

2) Window arrangement 

a) Several methods of window adjustment are provided in the analyzer. 

 Use the mouse to move and adjust the window. 

 Arrange the windows of the analyzer by the [Title], [Cascade], [Maximize] and [Minimize] items of the 

window menu. 

 Arrange the windows by the [Overlap 1X], [Stack 2X], [Split 3X] and [Quad 4X] items of the display menu. 

 Use the [Minimize], [Maximize/reduce down] and [Close] button in the top right corner of the window to 

adjust or hide the window. 

b) The display menu of the analyzer provides four kinds of window arrangement. The existing traces are distributed 

into different windows according to a certain algorithm. 

 One-window arrangement 

All traces are displayed in one window in a cascading manner. 

 Two-window arrangement 

All traces are displayed in two windows which are vertically overlapped. 

 Three-window arrangement 

All traces are displayed in three windows. Two of the three windows are arranged in the upper part, and the other in 

the lower part. 

 Four-window arrangement 

All traces are displayed in four windows which respectively cover one fourth of the screen. 

c) Setting of window arrangement 

Menu path: [Response] > [Display]. The display sub-menu will pop up. Select the window arrangement mode in 

the display sub-menu. 
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Fig. 4.29 Setting of Window Arrangement 

4.9 Setting of Analyzer Display 

You can use the display menu of the analyzer to display or hide the display elements and customize the screen. 

These display elements are usable for measurement observation, setting and modification, including the state bar, 

toolbar, list, measurement display, data trace, memory trace and title bar. 

● State bar ····················································································································································· 98 
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4.9.1 State Bar 

 

1) The opened state bar will be displayed at the bottom of the screen, including the following contents: 

 Current active channel 

 Measurement parameter of active trace 

 Mathematical operation of active trace 

 Error correction state of active trace 

 If the average function is enabled, the average factor of the current active channel and the average times will 

be displayed. 

 If the smoothing function is enabled, the number of smoothing points will be displayed. 

 If the function of time domain transformation is enabled, ―TRANSFORM: ON‖ will be displayed. 

 If the gate setting function is enabled, ―GATE: ON‖ will be displayed. 

 GPIB state: LOCAL or REMOTE. 

 Reference (REF) signal state: INT or EXT 

2) Display of trigger status bar 

Menu path: [Response] > [Display]. Tick [Status Bar] in the display sub-menu to open the status bar display and 
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clear [Status Bar] to close the status bar display. Or, press the status bar opening/closing item of the auxiliary 

menu bar to open or close the status bar. 

 

Fig. 4.30 Display of Trigger Status Bar 

4.9.2 Tool bar 

1) Six different toolbars can be displayed at the same time. Measurement can be easily set through the 

toolbar. 

a) Input toolbar 

 

Input the value through the input toolbar to set the measurement parameter. 

b) Marker toolbar 

 

Set and modify the marker, including: 

 Marker number 

 Marker ON/OFF check box 

 Stimulus value 

 Marker function: △marker, maximum/minimum value, start/stop value and center/span value. 

Click the [Stimulus] value of the marker toolbar and rotate the knob on the front panel to change the marker 

position. 

c) Measurement toolbar 

 

The measurement toolbar is used to create the S parameter trace in the current active window or new window. If the 

left button of the measurement toolbar is lifted ( ), the S parameter trace will be created in the current active 

window. If this button is pressed ( ), the S parameter trace will be created in a new window. 
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d) Sweep control toolbar 

 

The buttons of the sweep control toolbar are respectively used to set the following modes of the active channel in 

sequence: 

 Holding mode 

 Single sweep 

 Continuous sweep 

e) Stimulus toolbar 

 

f) The stimulus toolbar is used to observe, set and modify the sweep stimulus, including: 

 Start stimulus value (CW frequency in the CW mode) 

 Stop stimulus value (time in the CW mode) 

 Number of sweep points 

g) Time domain toolbar 

 Time domain ON/OFF check box 

 Gate ON/OFF check box 

 Sweep type 

 Start stimulus value 

 Stop stimulus value 

 More 

2) Trigger toolbar display 

Menu path: [Response] > [Display]. Point to the toolbar in the display sub-menu. 

Click the toolbar item to be set in the toolbar sub-menu. Tick the item to open the toolbar display and clear it to 

close the toolbar display. 

 

Fig. 4.31 Trigger Toolbar Display 
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4.9.3 List 

1) Display the marker, limit and segment table so that the user can observe and modify the settings (except 

the marker table). The list is displayed in the lower part of the window. Only one table can be displayed in 

each window. 

a) Marker table 

 

Fig. 4.32Marker Table 

The marker table is used to display the marker parameters, including: 

 Marker number 

 Reference marker (for relative measurement) 

 Stimulus value 

 Response value 

b) Limit table 

 

Fig. 4.33 Limit Table 

The limit table is used to display, set and modify the limit test parameters, including: 

 Type (minimum, maximum or closed) 

 Start and stop stimulus value 

 Start and stop response value 

c) Segment table 

 

Fig. 4.34 Segment Table 

The segment table is used to display, set and modify the segment sweep parameters, including: 

 State (ON/OFF) 

 Start and stop stimulus value 

 Number of sweep points 

 Power level (separately set for each segment) 

 Intermediate frequency bandwidth (separately set for each segment) 

 Sweep time (separately set for each segment) 

2) Triggering of table display 

Menu path: [Response] > [Display]. Point to the [Tables] in the display sub-menu. 
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Click the table to be triggered in the sub-menu. Tick this item to display the table and clear it to hide the table. 

 

Fig. 4.35 Triggering of Table Display 

4.9.4 Display Contents 

1) Six kinds of measurement information can be displayed or hided so that the user can observe the current 

measurement state, including: 

 Title 

 Track state 

 Frequency/stimulus state 

 Marker display 

 Display time state 

a) Title 

One title can be set for each window. The title will be created through the title input dialog box, and the entered 

title will be displayed in the upper left corner of the window. If required, delete the title through the [Input] box of 

the title input dialog box. Click [OK] to close the dialog box. 

 

Fig. 4.36 Title Input Dialog Box 

b) Track state 

The trace state will be displayed in the upper left corner of each window on the screen, including: 

 Measured parameters 
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 Format 

 Scale 

 Reference value 

The trace state button can be used to set the corresponding trace as the current active trace so as to set the trace. 

Point to the button and right-click the mouse. Delete the trace or set the trace scale, color and line through the right-

click menu. 

c) Frequency/stimulus state 

The frequency/stimulus information will be displayed under each window on the screen. The display can be hided 

for security purposes. The following information will be displayed. 

 Channel number 

 Start stimulus value 

 Stop stimulus value 

d) Marker display 

The marker display information includes the marker reading ON/OFF, trace marker ON/OFF, large font ON/OFF, 

leftward movement of display position, and downward movement of display position. The marker reading 

information is displayed in the upper right corner of each window on the screen. The following information will be 

displayed: 

 Marker number 

 Stimulus value 

 Response value 

e) Display time state 

If the display time is ON, the system time will be displayed in the upper right corner of the screen. 

2) Triggering of display items 

Menu path: [Response] > [Display]. Point to [Display Items] in the display sub-menu. 

Tick or click the auxiliary menu bar in the drop-down menu of the menu bar to display or hide the corresponding 

contents. 

 

Fig. 4.37 Triggering of Display Contents 

4.9.5 Title bar 

The title bar includes the application program title bar and window title bar, including the title name and window 
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control button. Click [Hide title bar] to hide all title bars on the screen. In this case, the display of measurement 

results on the screen can be maximized. 

Triggering of title bar display 

Menu path: [Response] > [Display]. Click [Title Bars] in the display sub-menu. Tick this item to display the title 

bar and clear it to hide the title bar. 

  



5 Menu 

5.1 Menu structure 

 105 

 

5 Menu 

The menu is used to operate and set the vector network analyzer. 3672 series vector network analyzers are 

configured with a complex menu system and setting dialog boxes under the menus at all levels. Be familiar with the 

menu system of the network analyzer to facilitate operation. The menu system of 3672 series vector network 

analyzers is divided into the main menu, primary menu, secondary menu, etc. The analyzer can be directly and 

partially set and operated through the menus at all levels. The setting and input dialog boxes under the menus at 

various levels should be opened for some settings and operations. 

● Menu structure ········································································································································· 127 

● Menu description ······································································································································ 147 

5.1 Menu structure 

The menus at various levels are as follows: 

● File ·························································································································································· 105 
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5.1.1 File 
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Note: Press the menu with an ellipsis (...) to open the corresponding dialog box, the same below. 

Fig. 5.1 File Menu 
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5.1.2 Track 

 

Fig. 5.2 Track Menu 
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5.1.3 Channel 

 

Fig. 5.3 Channel Menu 

  



5 Menu 

5.1 Menu structure 

 109 

 

5.1.4 Excitation 

 

Fig. 5.4 Excitation Menu I 
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Fig. 5.5 Excitation Menu II 
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Fig. 5.6 Excitation Menu III 
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5.1.5 Response 

 

Fig. 5.7 Response Menu I 
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Fig. 5.8 Repsonse Menu II 
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Fig. 5.9 Response Menu III 

 

Fig. 5.10 Response Menu V 
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Fig. 5.11 Response IV 
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5.1.6 Calibration 

 

Fig. 5.12 Calibration Menu 
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5.1.7 Marker 

 

Fig. 5.13 Cursor Menu I 
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Fig. 5.13 Cursor Menu II 
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Fig. 5.15Marker Menu III 
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5.1.8 Analysis 

 

Fig. 5.16 Analysis Menu I 
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Fig. 5.17 Analysis Menu II 
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Fig. 5.18 Analysis Menu III 
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5.1.9 System 

 

Fig. 5.19 System Menu I
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Fig. 5.20 System Menu I  
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5.1.10 Help 

 

Fig. 5.21 Help Menu 

1) Main menu 

3672 series vector network analyzers are configured with 10 main menus. 

 File: used to save, recall and print test data, minimize the window and exit the program. 

 Trace: used for relevant operations of traces. 

 Channel: used for relevant operations of channels. 

 Stimulus: used for relevant setting of the excitation signal. 

 Response: used for signal reception and measurement display setting. 

 Cal: used for analyzer calibration and calibration setting. 

 Marker: used for relevant operations of the marker system. 

 Analysis: used for analysis and statistics of test results and relevant setting of the time domain function. 

 System: used for relevant configuration setting, macro setting, pulse function setting, language setting, 

resetting and other settings of the analyzer. 

 Help: used to recall the user manual, program control manual and technical support, and view the error 

log and software version information. 

2) Sub-menu 

The sub-menu of the main menu is the primary menu, the sub-menu of the primary menu is the secondary menu, 

and so on. In principle, the menu of higher level should be opened before opening the menu of lower level. For 

convenience, the commonly used secondary menus are displayed in parallel to the menus of higher level. 
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3) Menu opening 

Menus at various levels can be opened in the following three methods. 

 By the menu bar: click the main menu, and the primary menu will appear. Click the corresponding menu, and 

the menu of lower level or corresponding dialog box will appear. 

 By keys of the front panel: press the main menu key in the functional key zone of the front panel, and the 

auxiliary menu bar will pop up, displaying the primary menu. Click the corresponding menu in the auxiliary 

menu bar, and the menu of lower level or corresponding dialog box will appear. 

 For convenience, the shortcut menu bar is set on the right side of the auxiliary menu bar, including the 

commonly used menus. Drag the shortcut bar push-pull button on the left side of the auxiliary menu bar to 

display and hide the shortcut menu bar and auxiliary menu bar. 

Prompt 

In order to facilitate introduction, the screenshots used in the manual are for menu opening by the menu 

bar. 

5.2. Description of menu 

This section introduces the details of the functions, parameters, etc. of menu items. 

● File ·························································································································································· 126 
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5.2.1 File 

Press the [File] key on the front panel or the menu item [File] on the user interface. The file-related menu will pop 

up, including [Save>>], [Call>>] and [Print>>]. The specific description of menu items is as follows. 

5.2.1.1 Save>> 

This menu is used to save data. Click it to enter the menu of lower level. The specific menu includes: 

Table 5.2 Save 

Menu 

 Save 

 Save As... 

 Save data as… 

 Automatic saving 

1) Save 

Function description: 
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Save user settings and calibration information in the data (*.CST) file. 

The current user settings and calibration information will be saved in the latest user data file. If this item is clicked, 

the [Whether to cover previous data] dialog box will pop up. Click ―Yes‖ to cover previous data and save current 

data; and click ―No‖ to abandon saving. 

Parameter description: 

None 

2) Save as… 

Function description: 

Save the data file required by the user. 

The data required by the user will be saved in different types of files. The user can set the file name. File types 

include: state and calibration file (*.CST), state file (*.STA), calibration file, (*CAL), data file (*.DAT, *.CTI and 

*.S1P), bitmap file (*.BMP), etc. 

Parameter description: 

None 

3) Save data as… 

Function description: 

Save the file required by the user. 

The parameters required by the user will be saved in different types of files. The user can set the file name. File 

types include the data file (*.DAT, *.CTI, *.S1P and *.S2P) and list file (*.PRN). 

Parameter description: 

None 

4) Automatic saving 

Function description: 

Save user settings and calibration information in the data (*.CST) file. 

If this item is clicked, a new state and calibration (*.CST) file will be created, and the current user settings and 

calibration information will be saved in the file. 

Parameter description: 

None 

5.2.1.2 Call>> 

This menu is used to call the saved data. Click it to enter the menu of lower level. The specific menu includes: 

Table 5.3 Call 

Menu 

 Call 

1) Call 

Function description: 

Call the saved state file or calibration file. 

If this item is clicked, a state file or calibration file will be recalled. File types includes the state and calibration file 

(*.CST), state file (*.STA), calibration file (*CAL) and data file (*.DAT, *.CTI and *.S1P). 

Parameter description: 

None 
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5.2.1.3 Print>> 

This menu is used to print data. Click it to enter the menu of lower level. The specific menu includes: 

Table 5.4 Print 

Menu 

 Print 

 Print into file 

 Page Setup 

1) Print 

Function description: 

Click this menu to enter the printer setting page. 

Set the printer options, paper and direction according to the prompts. 

Parameter description: 

None 

2) Print into file 

Function description: 

Click this menu to save the test curve as a figure. 

The test curve can be saved in the figure (*.BMP and *.JPJ) form according to the prompts. 

Parameter description: 

None 

3) Page Setup 

Function description: 

Click this menu to enter the page setting interface. 

The window information and other information can be set on this page. Window information includes: ―Print active 

window‖, ―Print all windows‖ and ―Print one window on each page‖. Other information includes: printing of the 

segment table, limit table, marker table, channel state and time. The user can print the corresponding page 

information according to the needs. 

Parameter description: 

None 

5.2.2 Trace 

Press the [Track] key on the front panel or click the [Track] menu item on the user interface. The trace-related 

menu will pop up. Specific items include: [New Trace], [Delete trace>>], [Select trace], [Move trace], [Trace title] 

and [Trace maximization ON/OFF]. The specific description of menu items is as follows. 

Prompt 

Track setting 

The trace refers to a series of measurement data point. Track setting affects the mathematical operation and display 

of measurement data. Only the active trace can be set. Click the corresponding trace state button to activate the 

trace. 

5.2.2.1 New trace 

Function description: 
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Click this menu, and the [New Trace] dialog box will pop up. The user can select different trace types, including S-

parameter (S11, S12, S22 and S21) and receiver (R1, R2, A and B). 

Parameter description: 

None 

5.2.2.2 Delete trace>> 

This menu is used to delete the trace. Click it to enter the menu of lower level, as shown in the following table. 

Table 5.5 ―Delete trace‖ 

Menu 

 Delete trace 1 

 Delete trace 2 

 Delete trace 3 

 Delete trace 4 

 Delete active trace 

 Delete trace… 

1) Delete trace 1-Delete trace 4 

Function description: 

Click it to rapidly delete the existing data trace (the existing trace is highlighted if displayed and dark if deleted). 

Parameter description: 

None 

2) Delete active trace 

Function description: 

Click this menu to delete the current active trace (click once to delete one active trace, until all active traces are 

deleted). 

Parameter description: 

None 

3) Delete trace… 

Function description: 

Click this menu, and the trace deletion list will pop up, showing the existing traces. Select the trace to be deleted, 

click [Apply] to delete the trace and continue the above operation. Click [OK] to exit the program. 

Parameter description: 

None 

5.2.2.3 Move trace 

Function description: 

Click this menu, and the trace movement list will pop up, showing the existing windows. The user can move the 

current active trace into any window (if [New window] is selected, a new window will be created). Click [Apply] to 

move the trace and continue the above operation. Click [OK] to exit the program. 

Parameter description: 

None 

5.2.2.4 Track title 
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Function description: 

Click this menu to change the default name of the current active curve. Enter the curve title, select the [Enable] 

check box and click [OK]. Thus the trace title is changed. 

Parameter description: 

None 

5.2.2.1 Track maximization ON/OFF 

Function description: 

Click this menu to maximize the current active trace and hide other trace curves. Click once to maximize the trace, 

and [Track maximization ON/OFF] will appear. Click again to recover all traces, and [Track maximization 

ON/OFF] will appear. 

Parameter description: 

OFF [OFF|ON]. 

5.2.3 Channel 

Press the [Channel] key on the front panel or the [Channel] menu item on the user interface, and the channel-related 

menu will pop up for setting of channel parameters. Specific items include: [Open channel], [Close channel], 

[Select channel], [Copy channel] and [Hardware setting]. The specific description of menu items is as follows. 

Prompt 

Channel and trace 

The channel includes the trace. The analyzer supports 64 channels in total. Tracks in one channel are subject to the 

same channel settings. Only the settings of the active channel can be changed. Once the trace in the channel is 

activated, the channel will also be activated. 

5.2.3.1 Open channel 

Function description: 

Click this menu, and the [Open channel] list will pop up, showing the closed channels. The user can select the 

channel to be opened (if [New window] is selected, a new window will be created). Click [Apply] to open the 

channel and continue the above operation. Click [OK] to exit the program. 

Parameter description: 

None 

5.2.3.2 Close channel 

Function description: 

Click this menu, and the [Close channel] list will pop up, showing the open channels. The user can select one 

channel, click [Apply] to close the channel and then click [OK] to exit the program. 

Parameter description: 

None 

5.2.3.3 Select channel 

Function description: 

Click this menu, and the [Select channel] list will pop up, showing the existing channels. The user can select the 

channel to be activated, click [Apply] to select the channel and then click [OK] to exit the program. 

Parameter description: 

None 

5.2.3.4 Copy channel 
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Function description: 

Click this menu, and the [Copy channel] list will pop up. The user can select the target channel from the existing 

channels in the drop-down menu of [Copy channel], click [Apply] to copy the channel and then click [OK] to exit 

the program. 

Parameter description: 

None 

5.2.3.5 Hardware setting 

This menu is used for hardware setting. Click it to enter the menu of lower level, as shown in the following table. 

Table 5.6 Hardware Setting 

Menu 

 Path configuration 

 Graphic configuration 

1) Path configuration 

Function description: 

Click this menu to configure the corresponding RF path. 

Parameter description: 

None 

2) Graphic configuration 

Function description: 

Click this menu to configure the filter/high power mode of the source and the reference mixer switch. 

Parameter description: 

None 

5.2.4 Excitation 

Press the [Excitation] key on the front panel or the [Excitation] menu item on the user interface, and then 

excitation-related menu will pop up for setting of excitation parameters. Specific items include: [Frequency], 

[Power], [Sweep] and [Trigger]. The specific description of menu items is as follows. 

5.2.4.1 Frequency 

This menu is used to set the frequency. Click it to enter the menu of lower level. The specific menu includes: 

Table 5.7 Frequency 

Menu 

 Freq Start 

 Freq Stop 

 center frequency 

 Frequency span 

 Frequency offset 

 CW 

 CW ON/OFF 
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Prompt 

Frequency unit 

All the frequency parameters are in Hz. The digital input must be ended with four frequency units (GHz, MHz, kHz 

or Hz). When input ends, new frequency value is displayed in appropriate unit. 

 

Attention 

The stop frequency must not exceed the start frequency. 

The sweeper can only sweep upward under stepped sweep mode, so the stop frequency must be not less than start 

frequency. If the start frequency is more than stop frequency, the stop frequency should be equal to the start 

frequency; and if the stop frequency is less than the start frequency, the start frequency should be equal to the stop 

frequency. 

1) Freq Start 

Function description: 

Set the start point of the sweep frequency. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping keys on the front panel. 

Parameter description: 

10MHz[10MHz ~ 13.5GHz/26.5GHz/43.5GHz/50GHz/67GHz]. 

2) Freq Stop 

Function description: 

Set the stop point of sweep frequency. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping keys on the front panel. 

Parameter description: 

13.5GHz/26.5GHz/43.5GHz/50GHz/67GHz[ 10MHz ~ 13.5GHz/26.5GHz/43.5GHz/50GHz/67GHz 

3) Center Frequency 

Function description: 

Set the center point of sweep frequency. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping keys on the front panel. 

Parameter description: 

6.755GHz/13.255GHz/21.755GHz /25.005GHz /33.505GHz 

[ 10MHz ~ 13.5GHz/26.5GHz/43.5GHz/50GHz/67GHz ]. 

4) Frequency span 

Function description: 

Set the span of frequency. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping keys on the front panel. 

Parameter description: 

13.49GHz/26.49GHz/43.49GHz/49.99GHz/66.99GHz 

[ 10MHz ~ 13.5GHz/26.5GHz/43.5GHz/50GHz/67GHz]. 
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5) Frequency offset 

Function description: 

Set the frequency offset. 

This menu is used for relevant settings of the frequency offset. See details in ―Appendix 3: Frequency Offset 

Measurement‖. 

Parameter description: 

None 

6) CW 

Function description: 

Set the CW frequency. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping keys on the front panel. 

Parameter description: 

2GHz [ 10MHz ~13.5GHz/26.5GHz/43.5GHz/50GHz/67GHz]. 

7) CW ON/OFF 

Function description: 

Activate dot frequency to set frequency of dot frequency. 

Parameter description: 

OFF [OFF|ON]. 

5.2.4.2 Power 

This menu is used to set the power. Click it to enter the menu of lower level. The specific menu includes: 

Table 5.8 Power 

Menu 

 Power 

 Power and attenuation 

 

Prompt 

Power unit 

All power parameters are in dBm. Click [OK] on the panel after entering. Thus the power setting is completed. 

1) Power 

Function description: 

Set the power ON/OFF, power level, sweep start/stop power and power slope. 

Parameter description: 

None 

2) Power and Attenuator 

Function description: 

Set the power attenuator mode, leveling mode, etc. 

Parameter description: 
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None 

5.2.4.3 Sweep 

This menu is used for sweep setting. Click it to enter the menu of lower level. The specific menu includes: 

Table 5.9 Sweep: Segment Table 

Menu Sub-menu 

 Sweep time 

 Points 

 Sweep type 

 Sweep setup 

 Phase control 

 Pulse 

 Segment table>> 

 

 

 

 

 

 

Segment table ON/OFF 

Add segment 

Insert segment 

Delete segment 

Independent power levels ON/OFF 

Independent IF bandwidth ON/OFF 

Independent sweep time ON/OFF 

1) Sweep time 

Function description: 

Set the total time of sweep from the start frequency to stop frequency. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping keys on the front panel. 

Reference note: (201points) 

198ms [198ms-86400s]. 

2) Points 

Function description: 

Set the total point number of sweep from the start frequency to stop frequency. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping keys on the front panel. 

Parameter description: 

201[1~32001]. 

3) Sweep type 

Function description: 

Set the sweep type. 

Optional sweep types include: linear frequency, logarithmic frequency, power sweep, CW, segment sweep and 

phase sweep. 

Parameter description: 

None 

4) Sweep setting 

Function description: 

Set the sweep function. 

The sweep functions include the step sweep, quick sweep, dwell time and sweep delay. 
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Parameter description: 

None 

5) Phase control 

Function description: 

Set the phase of the test port, including the start phase, stop phase, phase ON/OFF, etc. 

Parameter description: 

0°[0°-360°] 

6) Pulse 

Function description: 

Set the pulse measurement function. See details in ―Appendix 4: Pulse Measurement‖. 

Parameter description: 

Pulse width: 33ns-60s 

Pulse rising/falling time: 30ns 

7) Segment table 

This menu is used for relevant setting of the segment table. Click it to enter the menu of lower level. The specific 

menu includes: 

Table 5.10 Segment Table 

Menu 

 Segment table ON/OFF 

 Add segment 

 Insert segment 

 Delete segment 

 Independent power levels ON/OFF 

 Independent IF bandwidth ON/OFF 

 Independent sweep time ON/OFF 

a) Segment table ON/OFF 

Function description: 

If this menu is selected, all menu items will be lit, allowing the user to set the segment sweep function. 

Parameter description: 

OFF [OFF|ON]. 

b) Add segment 

Function description: 

Add a new segment behind the existing segment. 

Parameter description: 

None 

c) Insert segment 

Function description: 

Insert a new segment in front of the selected segment. 
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Parameter description: 

None 

d) Delete segment 

Function description: 

Delete the selected segment. 

Parameter description: 

None 

e) Independent power levels ON/OFF 

Function description: 

Allow to set different power levels for different segments. 

Parameter description: 

OFF [OFF|ON]. 

f) Independent IF bandwidth ON/OFF 

Function description: 

Allow to set different IF bandwidths for different segments. 

Parameter description: 

OFF [OFF|ON]. 

g) Independent sweep time ON/OFF 

Function description: 

Allow to set different periods of sweep time for different segments. 

Parameter description: 

OFF [OFF|ON]. 

5.2.4.4 Trigger 

This menu is used for trigger setting. Click it to enter the menu of lower level. The specific menu includes: 

Table 5.11 Trigger 

Menu 

 Hold 

 Single 

 Groups 

 Continuous  

 Re-sweep 

 Manual trigger 

 Trigger 

1) Hold 

Function description: 

If this menu is selected, the system will stop sweep and be kept at the current CW. 

Parameter description: 

None 
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2) Single 

Function description: 

If this menu is selected, the system will automatically enter the holding mode after sweep once. 

Parameter description: 

None 

3) Groups 

Function description: 

If this menu is selected, the system will automatically enter the holding mode after the set sweep process. 

Parameter description: 

None 

4) Continuous 

Function description: 

If this menu is selected, the system will restart sweep after sweep once. 

Parameter description: 

None 

5) Re-sweep 

Function description: 

If this menu is selected, the system will restart sweep from the start frequency. 

Parameter description: 

None 

6) Manual trigger 

Function description: 

Set the trigger menu to light up this menu. If this menu is selected, manual triggering will be done once. 

Parameter description: 

None 

7) Trigger 

Function description: 

Select this menu to enter the trigger function setting interface. See details in ―4.6 Trigger Mode‖. 

Parameter description: 

None 

5.2.5 Response 

Press the [Response] key on the front panel or the [Response] menu item on the user interface, and the response-

related menu will pop up. Specific items include: [Measurement], [Format], [Scale], [Display] and [Average]. The 

specific description of menu items is as follows. 

5.2.5.1 Measurement 

This menu is used to set measurement. Click it to enter the menu of lower level. The specific menu includes: 

Table 5.12 Measurement 

Menu 
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 Measurement S-parameter 

 Measurement balance parameter 

 Measuring type 

 Receivers 

1) Measurement S-parameter 

Function description: 

Select this menu to select the S-parameter. 

Parameter description: 

None 

2) Measurement balance parameter 

Function description: 

Select this menu to select the balance parameter. 

Parameter description: 

None 

3) Measuring type 

Function description: 

Select this menu to enter the multi-functional measurement option setting interface, such as the mixer measurement. 

See details in ―Appendix 6: Mixer Measurement‖. 

Parameter description: 

None 

4) Receivers 

Function description: 

Select this menu to select the receiver parameter, such as R1, R2, A, B, etc. 

Parameter description: 

None 

5.2.5.2 Format 

This menu is used to set measurement. Click it to enter the menu of lower level. The specific menu includes: 

Table 5.13 Format 

Menu 

 Log Mag 

 Phase 

 Group Delay 

 Smith Chart 

 Unwrapped Phase 

 Lin Mag 

 SWR 

 Real 
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 Imaginary 

 Polar 

 Positive phase 

 Imped 

 Format 

1) Log Mag 

Function description: 

Select this menu to sweep in the logarithmic format. 

Parameter description: 

None 

2) Phase 

Function description: 

Select this menu to display the phase curve. 

Parameter description: 

None 

3) Group Delay 

Function description: 

Select this menu to display the group delay curve. 

Parameter description: 

None 

4) Smith Chart 

Function description: 

Select this menu to display the Smith chart curve. 

Parameter description: 

None 

5) Unwrapped Phase 

Function description: 

Select this menu to display the linear phase curve. 

Parameter description: 

None 

6) Lin Mag 

Function description: 

Select this menu to display the linear amplitude curve. 

Parameter description: 

None 

7) SWR 

Function description: 

Select this menu to display the standing wave ratio curve. 
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Parameter description: 

None 

8) Real 

Function description: 

Select this menu to display the real part curve. 

Parameter description: 

None 

9) Imaginary 

Function description: 

Select this menu to display the imaginary part curve. 

Parameter description: 

None 

10) Polar 

Function description: 

Select this menu to display the polar coordinate curve. 

Parameter description: 

None 

11) Positive phase 

Function description: 

Select this menu to display the positive phase curve. 

Parameter description: 

None 

12) Imped 

Function description: 

Select this menu to display the impedance curve. 

Parameter description: 

None 

13) Format 

Function description: 

If this menu is selected, the display format table will pop up. Multiple format curves can be selected. 

Parameter description: 

None 

5.2.5.3 Scale 

This menu is used to set the scale. Click it to enter the menu of lower level. The specific menu includes: 

Table 5.14 Format 

Menu 

 Autoscale 

 Autoscale All 
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 Scale 

 Electrical Delay 

 Phase Deviation 

 Amplitude Deviation 

 Scale Coupling 

1) Autoscale 

Function description: 

If this menu is selected, the vertical scale will be selected automatically so that the active trace can be better 

displayed in the vertical grid of the screen. The stimulus is not affected, and only the scale value and reference 

value are changed. 

The appropriate scale factor will be selected so that data can be displayed in 80% of the screen. 

Select the center value of the trace on the screen according to the reference value. 

Parameter description: 

None 

2) Autoscale All 

Function description: 

If this menu is selected, the appropriate scale will be set for all traces in the window so that the trace can be better 

displayed in the vertical grids of the window. 

Parameter description: 

None 

3) Scale 

Function description: 

Select this menu and enter the set scale value. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping keys on the front panel. 

Parameter description: 

10dB[0.001dB-500dB]. 

4) Electrical delay 

Function description: 

Select this menu to set the electrical delay. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping keys on the front panel. 

Parameter description: 

0s[-1000s to 1000s]. 

5) Phase deviation 

Function description: 

Select this menu to set the phase deviation. Set and adjust the parameter by the mouse/keyboard or the knob, 

number keys and stepping keys on the front panel. 

Parameter description: 

0°[-1000° to 1000°]. 

6) Amplitude deviation 
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Function description: 

Select this menu to set the amplitude deviation. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping keys on the front panel. 

Parameter description: 

0dB [-1000dB~1000dB]。 

7) Scale coupling 

Function description: 

Select this menu to set scale coupling. 

Parameter description: 

None 

5.2.5.4 Display 

This menu is used to set the scale. Click it to enter the menu of lower level. The specific menu includes: 

Table 5.15 Format 

Menu 

 1-window/2-window/3-window/4-window 

 Window 

 Measurement setup 

 Display Items 

 Soft key calibration ON/OFF 

 Hide soft key 

 Minimize application program 

 Toolbar 

 Title bar ON/OFF 

 State bar ON/OFF 

 Table 

1) 1-window/2-window/3-window/4-window 

Function description: 

Select this menu for one-window/two-window/three-window/four-window display. 

Parameter description: 

None 

2) Window 

Function description: 

Select this menu to create more windows and close unnecessary windows. 

Parameter description: 

None 

3) Measurement setup 

Function description: 

This menu includes various default system setup. 
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Four traces will be created in Window 1: S11, S21, S12 and S22, in the logarithmic format in Channel 1. 

Four traces will be created in four windows, in the logarithmic format in Channel 1. S11 will be displayed in 

Window 1, S21 in Window 2, S12 in Window 3 and S22 in Window 4. 

Three traces will be created in three windows of Channel 1. S11 will be displayed in the Smith chart format in 

Window 1, S22 in the Smith chart format in Window 2 and S21 in the logarithmic format in Window 3. 

Four traces will be displayed in two windows, in the logarithmic format in two channels. S11 and S21 will be 

displayed in Window 1 of Channel 1, and S12 and S22 in Window 2 of Channel 2. 

Parameter description: 

None 

4) Display items 

Function description: 

Select this menu to control part of display items, such as the title, trace state, frequency/stimulus state, marker 

display, display time, etc. 

Parameter description: 

None 

5) Soft key calibration ON/OFF 

Function description: 

Select this menu to calibrate keys in the soft keyboard form to facilitate the user of old users. 

Parameter description: 

OFF [OFF|ON]. 

6) Hide soft key 

Function description: 

Select this menu to hide the soft keyboard on the right side of the display. The curve will be displayed in the whole 

screen. 

Parameter description: 

None 

7) Minimize application program 

Function description: 

Select this menu to minimize the soft key in operation in the vector network analyzer. 

Parameter description: 

None 

8) Toolbar 

Function description: 

Select this menu to control the toolbar display, such as the input toolbar, marker toolbar, measurement toolbar, 

sweep toolbar, stimulus toolbar and time domain toolbar. 

Parameter description: 

None 

9) Title bar ON/OFF 

Function description: 

Select this menu to display the title bar. 
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Parameter description: 

None 

10) Status bar ON/OFF 

Function description: 

Select this menu to display the status bar. 

Parameter description: 

None 

11) Table 

Function description: 

Select this menu to display the marker table, limit table and segment table. 

Parameter description: 

None 

5.2.5.5 Average 

This menu is used to set the scale. Click it to enter the menu of lower level. The specific menu includes: 

Table 5.16 Format 

Menu 

 Restart Average 

 Average factor 

 Average ON/OFF 

 Smoothing 

 IF bandwidth 

1) Restart Average 

Function description: 

Select this menu for a group of new average sweep. 

Parameter description: 

None 

2) Average factor 

Function description: 

Select this menu to set the average times of curve sweep. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping keys on the front panel. 

Parameter description: 

1[1~1024]. 

3) Average ON/OFF 

Function description: 

Select this menu to open the trace averaging function. 

The more times averaging is done, the more noise will be reduced, and the larger the dynamic range will be. 

The noise reduction effect of sweep averaging is the same as that of reduction of the intermediate frequency 

bandwidth. 
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Parameter description: 

OFF [OFF|ON]. 

4) Smoothing 

This menu is used for smoothing setting. Click it to enter the menu of lower level. The specific menu includes: 

Table 5.17 Smoothing 

Menu 

 Smoothing ON/OFF 

 Smoothing percentage 

 Number of smoothing points 

a) Smoothing ON/OFF 

Function description: 

Select this menu to enable the smoothing function. 

The smoothing function is used to reduce the peak-peak noise of bandwidth measurement data. 

Data averaging is done for part of the displayed trace. The number of adjacent data points averaged at the same 

time is also known as the smoothing aperture. The aperture can be defined as the number of data points or the 

percentage of X-axis span. 

Parameter description: 

OFF [OFF|ON]. 

b) Smoothing percentage 

Function description: 

Select this menu to set the smoothing percentage. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping keys on the front panel. 

Parameter description: 

0 [0-25%]. 

c) Points 

Function description: 

This menu is used to set the number of smoothing points. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping keys on the front panel. 

Parameter description: 

0[0~N (total point number)*25%]. 

5) Group delay aperture 

Function description: 

Select this menu to set point/percentage/frequency range of group delay aperture. The setting is only effective for 

group delay measurement. The parameters can be adjusted through mouse/keyboard/knob on the front 

panel/number key/step key.  

Parameter description: 

Point: 11[ 2 ~ Nsweep point] 

Percentage: 5% [ 1% ~ 100% ] 

Frequency range: Ffrequency span[ Ffrequency span between two points ~ Ffrequency span]. 
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6) IF bandwidth 

Function description: 

Select this menu to set the intermediate frequency bandwidth. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping keys on the front panel. 

Parameter description: 

1kHz[1Hz~5MHz]. 

5.2.6 Calibration 

Press the [Cal] key on the front panel or the [Cal] menu item on the user interface. The calibration-related menu 

will pop up. Specific items include: [Cal], [Correction ON/OFF], [Interpolation ON/OFF], [Port extension], 

[Fixture>>], [Edit calibration kit], [Attribute] and [Power calibration]. The specific description of menu items is as 

follows. 

5.2.6.1 Calibration 

Function description: 

Select this menu to enter the calibration interface, including three calibration types: guided calibration, non-guided 

calibration and electronic calibration. Select the appropriate calibration method according to the measurement type 

and accuracy requirements. See details in 6.3 ―Calibration Guide‖. 

Parameter description: 

None 

5.2.6.2 Correction ON/OFF 

Function description: 

Select this menu to enable the correction function and add calibration data. 

Parameter description: 

OFF [OFF|ON]. 

5.2.6.3 Interpolation ON/OFF 

Function description: 

Select this menu to enable the interpolation function. 

Parameter description: 

OFF [OFF|ON]. 

5.2.6.4 Port Extension 

Function description: 

Select this menu to move the measurement reference plane in an electrical manner. Thus, other kinds of calibration 

can be avoided. 

Add a cable after calibration. The port extension function is used to ―tell‖ the length of the cable added to the 

specific port of the analyzer. In case of failure of direct calibration, the delay (phase shift) caused by the clamp can 

be compensated by port extension. For the method of port extension setting, refer to the section of port extension in 

5.5 ―Improvement of Phase Measurement Accuracy‖. 

Parameter description: 

None 

5.2.6.5 Fixture>> 

This menu is used to set the fixture function. Click it to enter the menu of lower level. The specific menu includes: 

Table 5.18 Fixture 
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Menu 

 Fixture enabling ON/OFF 

 Port matching 

 2-port de-embedding 

 Port Z conversion 

 4-port Embed/De-embed 

1) Fixture enabling ON/OFF 

Function description: 

Select this menu to enable the fixture simulator function. The functions of the fixture simulator are effective only in 

this mode. 

Parameter description: 

OFF [OFF|ON]. 

2) Port matching 

Function description: 

Select this menu to enable the port matching function. For setting of port matching, refer to ―7.9.3 Port matching‖ 

in ―7.9 Fixture Compensation Calibration‖. 

Parameter description: 

None 

3) 2-port de-embedding 

Function description: 

Select this menu to enable the double-port fixture de-embedding function. For setting of double-port fixture de-

embedding, refer to ―7.9.4 Double-port fixture de-embedding‖ in ―7.9 Fixture Compensation Calibration‖. 

Parameter description: 

None 

4) Port Z conversion 

Function description: 

Select this menu to enable the port impedance conversion function. For setting of port impedance conversion, refer 

to ―7.9.5 Port Z conversion‖ in ―7.9 Fixture Compensation Calibration‖. 

Parameter description: 

None 

5) Four-port fixture de-embedding/embedding 

Function description: 

Select this menu to enable the four-port fixture de-embedding/embedding function. For setting of port z conversion, 

refer to ―7.9.6 4-port de-embedding/embedding‖ in ―7.9 Fixture Compensation Calibration‖. 

Parameter description: 

None 

5.2.6.6 Editing of Calibration Kit 

Function description: 

Select this menu to define and edit the calibration kit information. For calibration kit editing, refer to ―7.6.3 Edit 

calibration kit‖ in ―7.6 Definition of Calibration Kit Editing‖. 
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Parameter description: 

None 

5.2.6.7 Attribute 

Function description: 

This menu is effective after calibration of the instrument. Select this menu to display the current calibration 

attribute, such as the channel, calibration time, calibration type, frequency, number of sweep points, sweep time, 

port power, sweep type, etc. 

Parameter description: 

None 

5.2.6.8 Power Calibration 

Function description: 

Select this menu to set the source power, receiver calibration, etc. For power calibration setting, refer to ―Port 

power calibration‖ in ―6.3 Calibration of scale mixer measurement‖ of ―Appendix 6 Mixer Measurement‖. 

Parameter description: 

None 

5.2.7 Marker 

Press the [Marker] key on the front panel or click the [Marker] menu item on the user interface. The marker-

related menu will pop up. Specific items include: [Marker], [Marker function], [Marker search], [Marker attribute] 

and [Marker display]. The specific description of menu items is as follows. 

5.2.7.1 Marker 

This menu is used to set the marker. Click it to enter the menu of lower level. The specific menu includes: 

Table 5.19 Marker 

Menu 

 Marker 1/2/3 

 Reference marker 

 More markers 

 Close marker 

1) Marker 1/2/3 

Function description: 

Select this menu to enable the function of Marker 1/2/3. Read the measurement data, search the value of specific 

type or change the stimulus setting. 

Parameter description: 

None 

2) Reference marker 

Function description: 

Select this menu to enable the reference marker function for relative measurement. 

Parameter description: 

None 

3) More markers 

Function description: 
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Select this menu to enter the ―More markers‖ page. The system is configured with Marker 4, Marker 5, Marker 6, 

Marker 7, Marker 8 and Marker 9. 

Parameter description: 

None 

4) Close marker 

Function description: 

Select this menu to close the corresponding marker. 

Parameter description: 

None 

5.2.7.2 Marker function 

This menu is used to set the marker function. Click it to enter the menu of lower level. The specific menu includes: 

Table 5.20 Marker Function 

Menu 

 Marker→start 

 Marker→stop 

 Marker→center 

 Marker→span 

 Marker→reference 

 Marker→delay 

1) Marker→start 

Function description: 

Select this menu to set the frequency of the active marker as the start frequency. 

Parameter description: 

None 

2) Marker→stop 

Function description: 

Select this menu to set the frequency of the active marker as the stop frequency. 

Parameter description: 

None 

3) Marker→center 

Function description: 

Select this menu to set the frequency of the active marker as the center frequency. 

Parameter description: 

None 

4) Marker→span 

Function description: 

Select this menu to set the active Δ marker frequency as the frequency span. 

Parameter description: 
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None 

5) Marker→reference 

Function description: 

Select this menu to set the power of the active marker as the power reference value. 

Parameter description: 

None 

6) Marker→delay 

Function description: 

Select this menu to normalize the group delay of active marker points into 0. 

Parameter description: 

None 

5.2.7.3 Marker search 

This menu is used to set marker search. Click it to enter the menu of lower level. The specific menu includes: 

Table 5.21 Marker search 

Menu 

 Maximum value 

 Minimum value 

 Peak value 

 Target value 

 Bandwidth search 

 Marker search 

 Tracking ON/OFF 

 Filter statistics 

 Filter test 

1) Maximum value 

Function description: 

Select this menu for marker search of the maximum measurement data point. 

Parameter description: 

None 

2) Minimum value 

Function description: 

Select this menu for marker search of the minimum measurement data point. 

Parameter description: 

None 

3) Peak value 

This menu is used to set the peak search. Click it to enter the menu of lower level. The specific menu includes: 

Table 5.22 Peak Value 
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Menu 

 Next peak value 

 Right peak value 

 Left peak value 

 Peak/valley type 

 Threshold 

 Offset 

a) Next peak value 

Function description: 

Select this menu to search next peak value lower than the current marker amplitude value. 

Parameter description: 

None 

b) Right peak value 

Function description: 

Select this menu to search next effective peak value on the right side of the marker position. 

Parameter description: 

None 

c) Left peak value 

Function description: 

Select this menu to search next effective peak value on the left side of the marker position. 

Parameter description: 

OFF [OFF|ON]. 

d) Peak/valley type 

Function description: 

Select this menu to select the peak type. 

Parameter description: 

Peak [Valley|Peak]. 

e) Threshold 

Function description: 

Select this menu to define the minimum peak value. The effective peak value must be more than the threshold. The 

valley values on both sides may be less than the threshold. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping keys on the front panel. 

Parameter description: 

-100dB[-500dB to 500dB]. 

f) Deviation 

Function description: 

Select this menu to define the minimum vertical distance between the peak value and valley value. The vertical 

distance between the effective peak value and valley values on both sides must be more than the deviation. 
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Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping keys on the front panel. 

Parameter description: 

3dB[-500dB~500dB]. 

4) Target value 

Function description: 

Select this menu and enter the search target value. If this menu is clicked once, the marker will move to the first 

target value on the right side of the current marker position. Continue the above operation to reach to the highest 

stimulus value. Then return to the minimum search target value of stimulus. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping keys on the front panel. 

Parameter description: 

0dB[-500dB~500dB]. 

5) Bandwidth search 

This menu is used to as the bandwidth search. Click it to enter the menu of lower level. The specific menu includes: 

Table 5.23 Bandwidth 

Menu 

 Bandwidth ON/OFF 

 Bandwidth level 

 Track ON/OFF 

a) Bandwidth ON/OFF 

Function description: 

Select this menu to enable the bandwidth search function. 

Parameter description: 

OFF [OFF|ON]. 

b) Bandwidth level 

Function description: 

Select this menu to set the levels of both sides, falling from the peak. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping keys on the front panel. 

Parameter description: 

-3dB[-500dB~500dB]. 

c) Tracking ON/OFF 

Function description: 

Select this menu to enable the bandwidth search tracking function. The search function will be executed according 

to the current search type and range settings after each sweep, so as to ensure that the marker is in the expected 

position after each sweep. 

Parameter description: 

OFF [OFF|ON]. 

6) Marker search 

Function description: 

Select this menu to enter the shortcut menu of marker search. 
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Parameter description: 

None 

7) Tracking ON/OFF 

Function description: 

Select this menu to enable the marker search tracking function. 

Parameter description: 

OFF [OFF|ON]. 

8) Filter statistics ON/OFF 

Function description: 

Select this menu to enable the function of filter statistics. 

Parameter description: 

OFF [OFF|ON]. 

9) Filter test 

This menu is used to set the filter test. Click it to enter the menu of lower level. The specific menu includes: 

Table 5.24 Filter Test 

 

Menu 

 Filter test ON/OFF 

 Bandwidth level 

 Frequency difference percentage 

 Track ON/OFF 

a) Filter test ON/OFF 

Function description: 

Select this menu to enable the filter test function. 

Parameter description: 

OFF [OFF|ON]. 

b) Bandwidth level 

Function description: 

Select this menu to set the filter bandwidth level. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping keys on the front panel. 

Parameter description: 

-3dB [-500dB~500dB]. 

c) Frequency difference percentage 

Function description: 

Select this menu to set the frequency difference percentage. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping keys on the front panel. 

Parameter description: 

10%[0% to 100%]. 
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d) Track ON/OFF 

Function description: 

Select this menu to enable the marker tracking function for the filter test. 

Parameter description: 

OFF [OFF|ON]. 

5.2.7.4 Marker attribute 

This menu is used to set the marker attribute. Click it to enter the menu of lower level. The specific menu includes: 

Table 5.25 Marker Attribute 

Menu 

 ΔMarker ON/OFF 

 Discrete ON/OFF 

 Type Normal/Fixed 

 Coupling ON/OFF 

Advanced 

1) ΔMarker ON/OFF 

Function description: 

Select this menu to enable the Δ marker function. 

Parameter description: 

OFF [OFF|ON]. 

2) Discrete ON/OFF 

Function description: 

Select this menu to enable the discrete marker function. The marker will be moved to the discrete data point 

equivalent to the target value. 

Parameter description: 

OFF [OFF|ON]. 

3) Type Normal/Fixed 

Function description: 

Select this menu to select the marker type. 

Normal: the X-axis position of the standard marker is fixed, and the Y-axis position changes along with the 

amplitude of trace data. The marker can be moved right and left on the X-axis by changing the stimulus value. 

Fixed: the X-axis and Y-axis coordinates of the marker remain unchanged, no matter whether the amplitude of 

trace data changes. The marker can be moved on the X-axis by changing the stimulus value, but the Y-axis 

coordinate remains unchanged. 

Parameter description: 

Normal [Normal|Fixed]. 

4) Coupling ON/OFF 

Function description: 

Select this menu to enable the marker coupling function. 

Parameter description: 
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OFF [OFF|ON]. 

5) Advanced 

Function description: 

Select this menu to enter the shortcut menu of advanced marker. 

Parameter description: 

None 

5.2.7.5 Marker display 

This menu is used to set the marker display. Click it to enter the menu of lower level. The specific menu includes: 

Table 5.26 Marker Display 

Menu 

 Marker reading ON/OFF 

 One marker for one trace ON/OFF 

 Large font ON/OFF 

 Decimal place 

 Rightward movement of display position 

 Downward movement of display position 

1) Marker reading ON/OFF 

Function description: 

Select this menu to enable the marker reading function. 

Parameter description: 

ON [ON|OFF]. 

2) One marker for one trace ON/OFF 

Function description: 

Select this menu to enable the function of one marker for one trace. 

Parameter description: 

OFF [OFF|ON]. 

3) Large font ON/OFF 

Function description: 

Select this menu to enable the function of large font display of the marker. 

Parameter description: 

OFF [OFF|ON]. 

4) Decimal place 

Function description: 

Select this menu to set the number of decimal places of marker display. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping keys on the front panel. 

Parameter description: 

2[0~4]. 

5) Rightward movement of display position 
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Function description: 

Select this menu to set the horizontal position of the marker. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping keys on the front panel. 

Parameter description: 

80%[-200% to 200%]. 

6) Downward movement of display position 

Function description: 

Select this menu to set the vertical position of the marker. 

Set and adjust the parameter by the mouse/keyboard or the knob, number keys and stepping keys on the front panel. 

Parameter description: 

80%[-200% to 200%]. 

5.2.8 Analysis 

Press the [Analysis] key on the front panel or the [Analysis] menu item on the user interface. The analysis-related 

menu will pop up. Specific items include: [Save], [Test], [Track statistics], [Gate], [Window], [Time Domain], 

[Structural return loss] and [Equation editor]. The specific description of menu items is as follows. 

5.2.8.1 Save 

This menu is used to save the settings. Click it to enter the menu of lower level. The specific menu includes: 

Table 5.27 Save 

Menu 

 Data→Memory 

 Normalization 

 Trace operation 

 Data trace 

 Memory trace 

 Data and memory 

 Hide trace 

1) Data>Memory 

Function description: 

Select this menu to save the current test curve data into the memory. 

Parameter description: 

None 

2) Normalization 

Function description: 

Select this menu to save the current test curve data into the memory and perform data/memory operation. 

Parameter description: 

None 

3) Trace operation 

Function description: 
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Select this menu to execute four types of mathematical operation of the current active trace and memory trace, 

including the data/memory, data*memory, data+memory and data-memory. 

Parameter description: 

None 

4) Data trace 

Function description: 

Select this menu to display the data trace curve. 

Parameter description: 

None 

5) Memory trace 

Function description: 

Select this menu to display the memory trace curve. 

Parameter description: 

None 

6) Data and memory 

Function description: 

Select this menu to display the data trace and memory trace curve. 

Parameter description: 

None 

7) Hide trace 

Function description: 

Select this menu to hide the data trace and memory trace. 

Parameter description: 

None 

5.2.8.2 Test 

This menu is used to set the test. Click it to enter the menu of lower level. The specific menu includes: 

Table 5.28 Test 

Menu 

 Limit test 

 Ripple test 

 Bandwidth test 

1) Limit test 

This menu is used to set the limit test. Click it to enter the menu of lower level. The specific menu includes: 

Table 5.29 Limit Test 

Menu 

 Limit test ON/OFF 

 Limit line display ON/OFF 
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 Sound ON Fail ON/OFF 

 Limit table ON/OFF 

 Fail Sign ON/OFF 

a) Limit test ON/OFF 

Function description: 

Select this menu to enable the limit test function. Clear this menu to close the function of limit test of the active 

trace. 

Parameter description: 

OFF [OFF|ON]. 

b) Limit line display ON/OFF 

Function description: 

Select this menu to enable the limit line display function. Clear this menu to close the function of limit line display 

of the active trace. 

Parameter description: 

OFF [OFF|ON]. 

c) Limit table ON/OFF 

Function description: 

Select this menu to enable the limit table function. 

Parameter description: 

OFF [OFF|ON]. 

2) Ripple test 

This menu is used to set the ripple test. Click it to enter the menu of lower level. The specific menu includes: 

Table 5.30 Ripple Test 

Menu 

 Ripple test ON/OFF 

 Ripple display ON/OFF 

 Ripple value 

 Ripple limit segment 

 Edit ripple limit table 

 Fail Sign ON/OFF 

a) Ripple test ON/OFF 

Function description: 

Select this menu to enable the ripple test function. Clear this menu to close the function of ripple test of the active 

trace. 

Parameter description: 

OFF [OFF|ON]. 

b) Ripple display ON/OFF 

Function description: 
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Select this menu to enable the ripple display function. Clear this menu to close the ripple line display of the active 

trace, however, the ripple test function must not be affected. 

Parameter description: 

OFF [OFF|ON]. 

c) Ripple value 

Function description: 

Select this menu to set the ripple type. Optional ripple type: none, absolute value and allowance. 

Parameter description: 

None 

d) Ripple limit segment 

Function description: 

Select this menu to select the number of ripple limit segments to be opened. Up to 12 segments can be opened. 

Parameter description: 

None 

e) Edit ripple limit table 

Function description: 

Select this menu to edit the ripple limit table. The ripple limit table can be added, deleted and edited. 

Parameter description: 

None 

f) Fail Sign ON/OFF 

Function description: 

Select this menu to enable the FAIL sign function. In case of failure of the trace data point test, the FAIL sign will 

appear on the screen. 

Parameter description: 

OFF [OFF|ON]. 

3) Bandwidth test 

This menu is used to set the bandwidth test. Click it to enter the menu of lower level. The specific menu includes: 

Table 5.31 Bandwidth Test 

Menu 

 Bandwidth test ON/OFF 

 Bandwidth display ON/OFF 

 Bandwidth marker ON/OFF 

 NdB point 

 Minimum bandwidth 

 Maximum bandwidth 

Fail Sign ON/OFF 

a) Bandwidth test ON/OFF 

Function description: 
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Select this menu to enable the bandwidth test function to test the bandwidth of the bandpass filter. 

Parameter description: 

OFF [OFF|ON]. 

b) Bandwidth display ON/OFF 

Function description: 

Select this menu to enable the bandwidth display function. The tested bandwidth will be displayed on the screen. 

Parameter description: 

OFF [OFF|ON]. 

c) Bandwidth marker ON/OFF 

Function description: 

Select this menu to enable the bandwidth marking function. The bandwidth position mark will be displayed on the 

screen. 

Parameter description: 

OFF [OFF|ON]. 

d) NdB point 

Function description: 

Select this menu to adjust the NdB point and determine the amplitude difference between two frequency points and 

the signal peak value of the passband. 

Parameter description: 

-3dB[-500dB~500dB]. 

e) Minimum bandwidth 

Function description: 

Select this menu to set the allowable minimum bandwidth. If the test bandwidth is less than the minimum value, the 

prompt of bandwidth test failure (FAIL) will appear on the screen, or the prompt sound will be sent, so that the user 

can directly observe whether the characteristics of the DUT meet the requirements. 

Parameter description: 

10kHz[0Hz~300kHz]. 

f) Maximum bandwidth 

Function description: 

Select this menu to set the allowable maximum bandwidth. If the test bandwidth exceeds the maximum value, the 

prompt of bandwidth test failure (FAIL) will appear on the screen, or the prompt sound will be sent, so that the user 

can directly observe whether the DUT meet the requirements. 

Parameter description: 

300kHz[300kHz~∞]. 

g) Fail Sign ON/OFF 

Function description: 

Select this menu to enable the FAIL sign function. In case of failure of the trace data point test, the FAIL sign will 

appear on the screen. 

Parameter description: 

OFF [OFF|ON]. 

5.2.8.3 Track Statistics 
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This menu is used to set trace statistics. Click it to enter the menu of lower level. The specific menu includes: 

Table 5.32 Trace Statistics 

Menu 

 Trace statistics ON/OFF 

Curve trace statistics 

1) Trace statistics ON/OFF 

Function description: 

Select this menu to enable the function of trace statistics. It is not required to search the maximum value and 

minimum value so as to easily measure the peak-peak value of passband ripple. 

Parameter description: 

OFF [OFF|ON]. 

2) Curve trace statistics 

Parameter description: 

Select this menu to enter the interface of curve trace statistics. Three functions of trace statistics are provided: 

average value, deviation value and peak-peak value, so as to calculate the statistical values within whole stimulus 

bandwidth or user-defined bandwidth. 

Parameter description: 

None 

5.2.8.4 Gate 

This menu is used to set the gate. Click it to enter the menu of lower level. The specific menu includes: 

Table 5.33 Gate 

Menu 

 Gate ON/OFF 

 Gate: start 

 Gate: stop 

 Gate: center 

 Gate: span 

Gate setup 

1) Gate ON/OFF 

Function description: 

Select this menu to enable the gate function. Select or remove one response in the time domain through the gate 

function, and then change into the frequency range for observation. 

Parameter description: 

OFF [OFF|ON]. 

2) Gate: start 

Function description: 

Select this menu to set the start value of the gate. 

Parameter description: 
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-10ns [-14.825797ns~14.825797ns] 

3) Gate: stop 

Function description: 

Select this menu to set the stop value of the gate. 

Parameter description: 

10ns [-14.825797ns~14.825797ns] 

4) Gate: center 

Function description: 

Select this menu to set the center value of the gate. 

Parameter description: 

0ns [-14.825797ns~14.825797ns] 

5) Gate: span 

Function description: 

Select this menu to set the span value of the gate. 

Parameter description: 

20ns[0ns-29.651594ns]. 

6) Gate: setup 

Function description: 

Select this menu to enter the window of time domain transformation function. The time domain transformation, 

gate, window and options can be set. 

Parameter description: 

None 

5.2.8.5 Window 

Function description: 

Select this menu to enter the window of time domain transformation function. The time domain transformation, 

gate, window and options can be set. 

Parameter description: 

None 

5.2.8.6 Time domain 

This menu is used to set the time domain. Click it to enter the menu of lower level. The specific menu includes: 

Table 5.34 Time Domain 

Menu 

 Time domain ON/OFF 

 Start date 

 Stop time 

 Center time 

 Time span 

 Time domain transformation 
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 Time domain window 

 Coupling 

 Time domain toolbar 

1) Time domain ON/OFF 

Function description: 

Select this menu to enable the time domain function. 

Parameter description: 

OFF [OFF|ON]. 

2) Start time 

Function description: 

Select this menu to set the start time. 

Parameter description: 

-10ns [-14.825797ns~14.825797ns] 

3) Stop time 

Function description: 

Select this menu to set the stop time. 

Parameter description: 

10ns [-14.825797ns~14.825797ns] 

4) Center time 

Function description: 

Select this menu to set the center time. 

Parameter description: 

0ns [-14.825797ns~14.825797ns] 

5) Time span 

Function description: 

Select this menu to set the time span. 

Parameter description: 

20ns[0ns-29.651594ns]. 

6) Time domain transformation 

Function description: 

Select this menu to enter the window of time domain transformation function. The time domain transformation, 

gate, window and options can be set. 

Parameter description: 

None 

7) Time domain window 

Function description: 

Select this menu to enter the window of time domain transformation function. The time domain transformation, 

gate, window and options can be set. 

Parameter description: 
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None 

8) Coupling 

Function description: 

Select this menu to enter the window of coupling function. 

Parameter description: 

None 

9) Time domain toolbar 

Function description: 

Select this menu to enable the time domain toolbar function so as to clearly observe the influence of setting changes 

on measurement. 

Parameter description: 

OFF [OFF|ON]. 

5.2.8.7 Structural Return Loss 

This menu is used to set the structural return loss. Click it to enter the menu of lower level. The specific menu 

includes: 

Table 5.35 Structural Return Loss 

Menu 

 SRL ON/OFF 

 Port connector 1/2/3/4 

 Automatic Z ON/OFF 

 Z Cutoff frequency 

 Manual Z 

1) SRL ON/OFF 

Function description: 

Select this menu to enable the SRL function. 

Parameter description: 

OFF [OFF|ON]. 

2) Port connector 1/2/3/4 

Function description: 

Select this menu to set the length and capacity of the port connector 1/2/3/4. 

Parameter description: 

None 

3) Automatic Z ON/OFF 

Function description: 

Select this menu to enable the automatic Z function. 

Parameter description: 

OFF [OFF|ON]. 

4) Z cutoff frequency 
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Function description: 

Select this menu to set the Z cutoff frequency. 

Parameter description: 

210MHz[10MHz~26.5GHz]. 

5) Manual Z 

Function description: 

Select this function to enable the manual Z function. 

Parameter description: 

OFF [OFF|ON]. 

5.2.8.8 Equation Editor 

Function description: 

Select this menu to enter the equation editor interface. Parameter description: 

Parameter description: 

OFF [OFF|ON]. 

5.2.9 System 

Press the [System] key on the front panel or the [System] menu item on the user interface. The system-related menu 

will pop up. Specific items include: [Configuration], [Record/Run 1], [Record/Run 2], [Windows task bar], [Reset], 

[Custom user reset state], [Language: CN/EN] and [Spread spectrum]. The specific description of menu items is as 

follows. 

5.2.9.1 Configuration 

This menu is used to set the configuration. Click it to enter the menu of lower level. The specific menu includes: 

Table 5.36 Configuration 

Menu 

 GPIB address 

 Control panel 

 System impedance 

 User configuration 

 IF options 

 Millimeter wave module configuration 

 Expansion to 16 ports 

 Touch screen 

1) GPIB address 

Function description: 

Select this menu to configure the GPIB address. 

Parameter description: 

16[0~30]. 

2) Control panel 

Function description: 

If this menu is selected, the control panel menu will pop up. The user can set the operating system. 
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Parameter description: 

None 

3) System impedance 

Function description: 

Select this menu to set the system impedance. The system impedance must be changed in measurements of devices 

except those of 50Ω, such as waveguide devices. 

Parameter description: 

50Ω [0Ω-1kΩ]. 

4) User configuration 

Function description: 

If this menu is selected, the user can configure it. Configurable options include: ―Enable touch screen‖, ―Save 

calibration file in the current time name‖, ―Not automatically save after calibration‖, ―Display marker on all the 

existing traces‖, ―Display limit test on all the existing traces‖, ―Press the UP/DOWN key to change the marker 

point by point‖, ―Install anti-virus software‖, ―Multi-port calibration‖ and ―Identify port sweep state‖. 

Parameter description: 

None 

5) IF options 

Function description: 

Select this menu to select the intermediate frequency, including the internal intermediate frequency and external 

intermediate frequency. 

Parameter description: 

None 

6) Millimeter wave module configuration 

Function description: 

Select this menu to configure the millimeter wave module, including the model selection, port setting and 

frequency setting. 

Parameter description: 

None 

7) Expansion to 16 ports 

Function description: 

Select this menu to expand the instrument to 16 ports. 

Parameter description: 

None 

8) Touch screen 

Function description: 

Select this menu to enable the touch screen function and calibrate the touch screen. 

Parameter description: 

None 

5.2.9.2 Record/Run 1 

Function description: 
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Select this menu to automatically start recording. If recording has been done, press this key to automatically start 

running. 

Parameter description: 

None 

5.2.9.3 Record/Run 2 

Function description: 

Select this menu to automatically start recording. If recording has been done, press this key to automatically start 

running. 

Parameter description: 

None 

5.2.9.4 Windows Task Bar 

Function description: 

Select this menu to open the operating system task bar. 

Parameter description: 

None 

5.2.9.5 Reset 

Function description: 

Select this menu to run the application program of the 3672 series vector network analyzer. 

Parameter description: 

None 

5.2.9.6 Reset User State 

Function description: 

Select this menu to customize the user state interface. The user can customize the user reset state. 

Parameter description: 

None 

5.2.9.7 Language CN/EN 

Function description: 

Select this menu to select the operating language (CN|EN). 

Parameter description: 

CN [CN|EN]. 

5.2.9.8 Spread Spectrum 

Function description: 

Select this menu to select 364X series spread spectrum function. 

Parameter description: 

None 

5.2.10 Help 

Press the [Help] key on the front panel or the [Help] menu item on the user interface. The help-related menu will 

pop up. Specific items include: [User manual], [Programming manual], [Technical support], [Error information] 

and [About]. The specific description of menu items is as follows. 

5.2.10.1 User Manual 
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Function description: 

Select this menu to open the ―User Manual of 3672 Series Vector Network Analyzers‖. 

Parameter description: 

None 

5.2.10.2 Programming Manual 

Function description: 

Select this menu to open the ―Program Control Manual of 3672 Series Vector Network Analyzers‖. 

Parameter description: 

None 

5.2.10.3 Technical Support 

Function description: 

Select this menu to enter the home page of the 41st Institute of China Electronics Technology Group Corporation. 

Parameter description: 

None 

5.2.10.4 Error Information 

Function description: 

Select this menu to select the error parameter and view the error log. 

Parameter description: 

None 

5.2.10.5 About 

Function description: 

Select this menu to view the basic information of the instrument and the company information. 

Parameter description: 

None 
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6 Measurement Optimization 

The following methods can be applied to adjust the setting and optimize the measurement accuracy. 

● Reduction of accessory influence ·············································································································· 169 

● Improvement of reflection accuracy of low-loss 2-port device ··································································· 170 

● Increase of dynamic range ························································································································ 172 

● Improvement of measurement results of electrical long device ·································································· 174 

● Improvement of phase measurement accuracy ·························································································· 175 

● Reduction of trace noise ··························································································································· 180 

● Increase of data point number ··················································································································· 183 

● Improvement of measurement stability ····································································································· 184 

● Improvement of sweep velocity ················································································································ 186 
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6.1 Reduction of Accessory Influence 

Some accessories may affect the measurement results of the DUT. Select one of two characteristics of the analyzer 

to reduce the accessory influence. In order to reduce the accessory influence, you can select the most suitable 

method to test the configuration. 

1) Compensate the cable loss with the power slope. 

If a long cable or other kind of accessory is used in measurement configuration, the power loss will be generated 

within the whole band. In this case, the power slope function should be applied. The defined ratio (dB/GHz) can be 

used in this function to increase the source power of the analyzer. The process of cable loss compensation is as 

follows. 

Menu path: [Stimulus] > [Power...]. 

If the power slope function is not activated, tick the [Power Slope] check box. Input the ratio to be increased in 

frequency sweep of the source power in the [dB/GHz] box. 

2) Selectively remove the response gate (only for the time domain). 

a) The gate is one of the time domain characteristics. It is used to remove the response mathematically. The gate of 

reflection response or transmission response can be set, but different results will be obtained. 

 Gate reflection response: the desired response (such as the return loss of the filter) can be separated 

from the undesired response (such as the adapter reflection or connector mismatch) by reflection response 

of the gate. 

 Gate transmission response: the specific path of large electrical length in the multi-path device can be 

separated by transmission response of the gate. 

In order to apply the gate in the time domain mode, the transformation can be disconnected, and the existing gate 

pulse can be used in study of the frequency response of the device. The time filter gate pulse has the following 

shapes and features: 

 Band pass shape: the response beyond the passband zone can be removed. 

 Trap shape: unnecessary response in the frequency zone can be removed. 

b) Removal of unnecessary response 

Menu path: [Analysis] > [Time Domain] > [Time Domain Transformation...]. 
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Click the [Transform] check box in the [Transform] dialog box to activate the transformation mode. Click the 

required transformation mode: low-pass impulse, low-pass step and band pass. Click [Frequency: low pass] to 

select the low pass mode. Click the drop-down list in the gate type box to select the gate type: band pass and trap. 

Set the gate threshold by setting the start value, stop value, center value or span. Click [Transform] in the trace 

menu. 

6.2 Improvement of Reflection Accuracy of Low-loss 2-port Device 

In order to realize accurate reflection measurement in one-port calibration, connect the unmeasured port. This 

method is particularly suitable for low-loss two-way devices, such as the filter passband and cable. The direction, 

source matching and frequency response error can be corrected by means of one-port calibration. The load 

matching error cannot be calibrated. Therefore, the load matching error must be minimized. 

Connect the unmeasured port in the following methods: 

 Connect the unmeasured port of the DUT to one high-performance terminal load (the calibration kit is also 

allowed). The measurement accuracy of this method is close to that of 2-port calibration. 

 Connect the unmeasured port of the DUT directly to the analyzer. Insert one 10dB precision attenuator 

between the device output and analyzer. The effective load matching of the analyzer can be improved by once 

based on the measured value of the attenuator, i.e. 20dB. 

Prompt 

Matched load 

No consideration should be given to load matching in measurement of the device of high reverse isolation, such as 

the amplifier. 

Fig. 6.1 shows the instability of measurement of the DUT with or without 10dB precision attenuator at the end. 

 

Fig. 6.1 Comparison of Instability 

 Refer to the filter reflection. 

 Refer to the instability of measurement without 10dB precision attenuator. 

 Refer to the instability of measurement with 10dB precision attenuator. 

Fig. 6.2 shows the accurate reflection measurement of the 2-port device. The following calculation shows the 

improvement of loading matching with one high-quality 10dB attenuator. 
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Fig. 6.2 Accurate Reflection Measurement of 2-port Device 

Attention 

The corresponding linear values are given in the brackets. 

 

Analyzer: Load matching (NALM)=18dB (.126) 

Direction (NAD)=40dB (.010) 

Filter: Insertion loss (FIL)=1dB (.891) 

Return loss (FRL)=16dB (.158) 

Attenuator: Insertion loss (AIL)=10dB (.316) 

SWR (ASWR)=1.05 (.024) Return loss: 32.26dB 

Calculation: without attenuator with attenuator 

 

 
Error in the worst case (EWC) NA =NA+Attn. 

=.1 =.01+.019 

 =.029 

Upper limit of instability=-

20log{(FRL)+(EWC)+(NAD)} 
=-20log{(FRL)+(EWC)+(NAD)} 

=-20log{(.158)+(.100)+(.010)} =-20log{(.158)+(.029)+(.010)} 

=11.4dB =14.1dB 

Lower limit of instability=-20log{(FRL)-(EWC)-

(NAD)} 
=-20log{(FRL)-(EWC)-(NAD) 

=-20log{(.158)-(.100)-(.010)} =-20log{(.158)-(.029)-(.010)} 

=26.4dB =18.5dB 

Therefore, one of the following methods can be applied to obtain accurate results in reflection measurement of the 

low-loss 2-port device. 

 Connect one high-quality load to the output end of the DUT after one-port calibration. 

 Insert one 10dB attenuator between the output of the DUT and the analyzer after one-port calibration. 

 Directly connect the output of the DUT to the analyzer after 2-port measurement calibration. 
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6.3 Increase of Dynamic Range 

The dynamic range refers to the difference between the maximum power allowed to be input into the analyzer and 

the minimum power (base noise) which can be tested. To make the measurement correct and effective, the input 

signal must be within the dynamic range. In order to greatly change the signal amplitude of measurement, such as 

the filter passband and stop-band, it is important to increase the dynamic range. Fig. 6.3 is a typical dynamic range 

of measurement. 

 

Fig. 6.3 Dynamic Range 

In order to reduce the instability of measurement, the dynamic range of the analyzer should be larger than the 

response of the DUT. For example, the accuracy can be improved if the response of the DUT is at least 10dB more 

than the base noise. The following methods can help to increase the dynamic range. 

Attention 

Dynamic range and measurement time 

As some analyzers have the characteristics of alternating sweep, the dynamic range can be increased so as to 

increase the measurement time. 

6.3.1 Increase of Input Power of Device 

1) The input power of the DUT can be increased so that the output power of the DUT can be accurately tested and 

measured by the network analyzer. 

2) If the input of the receiver is too high, compression distortion may be caused. If the input reaches to a certain 

degree, the receiver may be damaged. 

 
Warning 

If the input level reaches +15dBm, the receiver may be damaged. 

 

Attention 
 

Do not apply the maximum source output power. 

If the test equipment has gain, the maximum source output power cannot be applied; otherwise, the receiver may be 

damaged. 

Menu path: [Stimulus] > [Power]. The power shortcut key is set on the auxiliary menu bar and front panel. 

Input the power value directly in the input toolbar, or click [Power...] to set the power in the dialog box. 

6.3.2 Reduction of Base Noise of Receiver 

The following methods can be applied to reduce the base noise and increase the dynamic range of the analyzer. 

a) Reduce the intermediate frequency bandwidth. 
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b) Use the sweep average value. 

Prompt 

Reduction of crosstalk between receivers 

When the measurement signal is close to the base noise of the analyzer, the crosstalk between receivers should be 

reduced. 

1) Reduction of intermediate frequency bandwidth 

As shown in Fig. 6.4, the intermediate frequency bandwidth has influence on measurement results. 

 The bandwidth of the intermediate frequency receiver can be reduced so as to reduce the influence of random 

noise in measurement. Once the intermediate frequency bandwidth is reduced by 10 times, the base noise will 

be reduced by 10dB. However, the smaller the intermediate frequency bandwidth is, the longer the sweep time 

is. 

 The network analyzer can change the received signal from the RF/microwave frequency into the intermediate 

frequency (7.606MHz). The bandwidth of the intermediate frequency band pass filter can be reduced from 

5MHz to 1Hz (min.). 

 The intermediate frequency bandwidth can be independently set for each channel or each segment in segment 

sweep. 

 

Fig. 6.4 Influence of Intermediate Frequency Bandwidth on Measurement Results 

a) Setting of intermediate frequency bandwidth 

Menu path: [Response] > [Avg] > [IF Bandwidth]. 

Input the intermediate frequency bandwidth value in the input toolbar or directly input the value in the [IF 

Bandwidth] dialog box or select a value with the arrow button. 

2) Increase or change of the average value of sweep 

a) Increase or change of the average value of sweep 

 Sweep averaging is a method to reduce the influence of random noise in measurement. 

 Each data point is calculated based on the average value of several continuous sweep procedures. 

 The more times averaging is done, the more noise will be reduced, and the larger the dynamic range will be. 

As shown in Fig. 6.5, sweep averaging has influence on measurement results. 
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Fig. 6.5 Influence of Sweep Averaging on Measurement Results 

Prompt 

Reduction of random noise 

 The average value of measurement can be independently set for each channel. 

 The total measurement time increases along with the increase of averaging times. 

 General noise can be minimized by setting the average value and intermediate frequency bandwidth. 

 In order to minimize the low-frequency noise, measurement averaging is more effective than reduction of the 

system bandwidth. 

b) Setting of sweep average value 

Menu path: [Response] > [Avg]. Set the average value by the [Average] key in the auxiliary menu bar or in the 

[Average] dialog box. Enable or disable the averaging function by [Average on/OFF]. Directly enter the value or 

press the arrow button to increase/decrease the averaging times according to the average factor. 

Attention 

Select [Restart Average] to start a group of new average sweep. 

6.4 Improvement of Measurement Results of Long Device of Each Point 

The frequency of the signal from the DUT may be different from the frequency of the signal into the DUT at the 

given time. This may result in inaccurate measurement results sometimes. The following contents can help to 

understand why inaccurate measurement results are obtained and how to compensate. 

Why are inaccurate results produced as a result of delay? 

 The source and receiver can be locked at the same time, and sweep can be done for one frequency interval 

with the vector network analyzer. 

 The signal through the DUT (DUT) represents different colors corresponding to different frequencies. 

 If the stimulus frequency passes through the DUT and the analyzer is tuned to new frequency before the signal 

reaches the receiver, inaccurate measurement results will be produced. 

As shown in Fig. 6.6, if a long cable is measured by the analyzer, the signal frequency of the cable end will lag 

behind the source frequency of the analyzer. If the frequency offset (typically dozens of kHz) is obvious relative to 

the intermediate frequency test bandwidth of the network analyzer, measurement results may be wrong due to the 

roll-down characteristics of the intermediate frequency filter. 



6 Measurement Optimization 

6.5 Improvement of Phase Measurement Accuracy 

 175 

 

 

Fig. 6.6 Schematic Diagram of Test of Long Cable 

The delay of the electrical long device can be compensated in the following methods. 

1) Reduction of sweep velocity 

The sweep velocity can be reduced by increasing the sweep time, reducing the intermediate frequency bandwidth or 

increasing the number of sweep points. 

a) Increase the sweep time. 

Menu path: [Stimulus] > [Sweep] > [Sweep Time...]. 

Enter the time or select the time with the arrow. 

b) Reduce the intermediate frequency bandwidth. 

Menu path: [Response] > [Avg] > [IF Bandwidth...]. 

Directly enter the value or select the time with the arrow. 

c) Increase the number of sweep points. 

Menu path: [Stimulus] > [Sweep] > [Points]. 

Directly click the required point number in the sub-menu or click [Custom...]. Enter the value in the [Points] 

dialog box or select the value with the arrow. 

2) Use of step sweep. 

Change analog sweep into step sweep so that the source can step over each test point. In this case, the sweep 

velocity of the analyzer can be reduced. The dwell time of each step or test point can also be set. 

Menu path: [Stimulus] > [Sweep] > [Sweep Setup...]. 

Tick the step sweep. Directly enter the dwell time in the [Dwell time] box or select the required dwell time of each 

test point. 

6.5 Improvement of Phase Measurement Accuracy 

The following characteristics of the analyzer can be applied to improve the accuracy of phase measurement. 

● Electrical delay ········································································································································· 175 

● Port extension ·········································································································································· 176 

● Phase deviation ········································································································································ 178 

● Frequency point interval ··························································································································· 178 

● Specific operation ····································································································································· 179 

6.5.1 Electrical Delay 

 The electrical delay can be applied to compensate the linear phase deviation of the DUT so as to highlight the 

linear phase deviation of the DUT. 

 The electrical delay is a kind of mathematical function. The transmission line of no loss and adjustable length 

can be simulated. 
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 The electrical delay which is not associated with each measurement trace can be set. 

6.5.2 Port Extension 

1) The measurement reference plane can be moved electrically by means of port extension after calibration. Thus, 

other kinds of calibration can be avoided. Port extension is introduced in the following two cases. 

a) Decide whether to add one cable in the measurement configuration after calibration. The port extension 

characteristics can be applied to ―tell‖ the analyzer to increase the cable length to the specific port. 

b) If calibration cannot be done directly on the DUT in the test fixture, port extension can be applied to compensate 

the delay (phase deviation) arising from the fixture. 

2) Use of port extension function 

a) If the electrical length of the tested fixture or added cable is known, enter the value in the [Time] box. 

b) If the physical length of the tested fixture or added cable is known, enter the value in the [Distance] box. 

c) If the above two items are unknown, the open-circuit device or short-circuit device can be used instead of the 

DUT on the reference plane after extension. Generally, the new reference plane is regarded in the open-circuit state 

after removal of the DUT. 

3) The appropriate port extension value can be obtained in the following methods. 

a) Select the S11 measurement after calibration and set the phase format as the display format. 

b) Connect the open-circuit device or short-circuit device to the calibration plane and check whether the displayed 

phase curve is within the measurement frequency range and around 0°. 

c) Connect the fixture or transmission cable and use the open-circuit device or short-circuit device instead of the 

DUT (the circuit is regarded as an open circuit if the DUT is removed). Adjust the value of the [Time] or [Distance] 

box in the [Port extension] dialog box until the phase trace is flat. 

d) If the loss characteristics of the extension part are known, compensation can be done in the one-dimensional or 

two-dimensional manner in the [Loss compensation] part. 

Attention 

Nonzero delay 

The nonzero delay is specified in the majority of short circuit standards and can be applied to adjust the error which 

is twice that of short-circuit calibration as a result of port extension and further view the definition of the calibration 

kit so as to determine the appropriate extension value. 

4) Setting of port extension 

Menu path: [Cal] > [Port Extension]. 

 

 

Fig. 6.7 Setting of Port Extension 

The [Port Extension] dialog box will appear. Tick the [Port extension] check box. Then the port extension 
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function will be effective for all ports. 

 [Port]: select the current extension port in the drop-down box. The port extension settings are effective 

for all measurements of active channels on the current port. 

 [Dist]: display the port extension toolbar. 

 [Time]: set the delay time of port extension. 

 [Distance]: set the physical length of the delay time of port extension. 

 [Unit]: set the calculation unit of port extension distance: meter, foot or inch. 

 [Loss @DC]: set the deviation of the whole frequency band. 

 [Loss][@Freq]: set the loss and frequency. If only [Loss 1] is selected, the compensation equation is as 

follows: 

Loss (f)=Loss 1* (f/ frequency 1)^0.5 

If Loss 1 and 2 are selected, the compensation equation is as follows: 

Loss (f)=Loss 1* (f/ frequency 1)^n, where: 

n=log10 (|Loss 1/Loss 2|)/log10 (Frequency 1/ Frequency 2) 

 [Velocity Factor]: set the velocity factor. Note that this velocity factor is the same as that of the system. 

 [Coaxial]: set the coaxial characteristics of the current port extension. 

 [Waveguide] and [Cutoff Freq]: set the waveguide characteristics of the current port extension. In this 

case, the cutoff frequency of waveguide can be set. Note that the set medium type is the same as that of the 

system. 

 [Reset]: recover the default mode of the system. Note that the port extension state remains unchanged. 

 [Auto Ext]: recall the [Auto Ext] dialog box. 

Manual port extension can be done automatically in the automatic port extension mode. If the extension plane is 

connected with an open-circuit device or short-circuit device, the system will automatically calculate the delay time 

and loss of port extension, and the measurement end face will be compensated to the extension part. 

Steps of automatic port extension: 

1) Connect the new transmission line or fixture and then connect the open-circuit device or short-circuit device to 

the new measurement end face. Generally, no connection with the calibration kit is equivalent to the open-circuit 

state. 

2) Click [Automatic Ext…] in the port extension toolbar and then click [Show configuration] to view more 

options. 

3) Click [Meas] to start the port extension calculation. The calculated delay time and loss value will be 

automatically displayed in the toolbar. 

 

Fig. 6.8 Automatic Port Extension 
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 [Open circuit] and [Short circuit]: connect the open-circuit device or short-circuit device to the port 

requiring automatic extension. 

 [Show configuration] and [Hide configuration]: display and hide the configuration of automatic port 

extension. 

 Measure On Port Number: select the port to be subject to automatic extension calculation. 

 Method: set the frequency range of the data collected for automatic port extension calculation. 

[Current Span]: the same as the frequency range of current measurement. 

[Active Marker]: use the data between the active marker and the part of the highest frequency to calculate the 

automatic port extension. 

[User Span]: the user enters the frequency range of calculation. 

 [Include Loss]: select it to automatically calculate the loss arising from the current port extension. 

 [Adjust for Mismatch]: select it to automatically compensate the error arising from mismatch. 

 [Prompt for Each Standard]: if this item is selected, the [Calculation kit connection] prompt box will 

pop up. 

 [Close]: apply the current calculation results to the active channel and exit the dialog box. 

6.5.3 Phase Deviation 

The phase deviation is a kind of mathematical phase measurement, and the deviation range is 0-360°. Use this 

characteristic in the following methods: 

 Improve the display of phase measurement results. 

This is similar to the improvement of reference level in amplitude measurement. Change the phase response to 

make it at the screen center or on the same straight line as the screen. 

 Simulate the phase deviation determined in measurement. 

For example, if it is known to add a cable and the cable length may result in phase deviation of measurement results, 

the phase deviation can be increased by movement and the measurement of the whole device can be simulated. 

1) Setting of phase deviation 

Menu path: [Response] > [Scale] > [Phase Offset...]. The [Phase Offset] dialog box will appear. 

Set the phase deviation in the [Phase deviation] box. 

 

Fig. 6.9 Automatic Port Extension 

6.5.4 Frequency Point Interval 

1) Sample the data of discrete frequency points, connect each sampling point and form a trace on the screen. 

2) If the phase deviation of two adjacent frequency points of the device is more than 180°, the displayed phase 

slope will look like the reverse phase. This is caused by mixing as a result of insufficient data sampling. 

If the group delay is measured but the phase slope is opposite, the symbol will be changed as a result of the group 
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delay. For example, Fig. 6.10 shows the measurement results of the surface acoustic wave (SAW) bandpass filter. 

a) The first figure shows the measurement results of 51 points, and the group delay is negative. But this is 

impossible in the actual situation, as the response will not be below the reference line (0s). 

b) The second figure shows the measurement results of 201 points, and the group delay is positive, that is, the 

response is above the reference line (0s). 

 

Fig. 6.10 Influence of Frequency Interval on Phase Measurement 

Prompt 

Mixing check 

In order to check mixing in measurement, you can check whether the display data change by reducing the 

frequency interval. You can increase the number of frequency points or reduce the frequency interval to avoid 

mixing. 

6.5.5 Specific Operations 

1) Compensation of linear phase deviation 

Menu path: [Response] > [Scale] > [Electrical Delay...]. 

Enter the required value in the [Electrical Delay] box or select the value with the arrow. 

Enter the value in the [Velocity Factor] box or select the value between 0 and 1.0 with the arrow. 

 1.0 corresponds to the light velocity in vacuum. 

 0.66 corresponds to the typical light velocity in the polyethylene medium. 

 0.70 corresponds to the typical light velocity in the Teflon medium. 

 

Fig. 6.11 Setting of Electrical Delay 

2) Electrical movement reference plane 

Menu path: [Cal] > [Port Extension...]. 

Select the [Port Extension on/OFF] check box. 
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Add the port extension value in the reference plane to be extended. 

Select a value between 0 and 1.0 in the [Velocity Factor] box as the relative velocity of the added cable or medium 

after calibration. Then click [OK]. 

 1.0 corresponds to the light velocity in vacuum. 

 0.66 corresponds to the typical light velocity in the polyethylene medium. 

 0.70 corresponds to the typical light velocity in the Teflon medium. 

Prompt 

You can perform the following operation to check whether the sufficient delay is added: 

 Connect one short-circuit device. 

 Adjust the port extension until the phase correspondingly becomes flat. 

 

Attention 

Determine the deviation delay of the standard short-circuit device. 

The delay time of the majority of short-circuit calibration kits is not zero. Therefore, the delay error caused by this 

method is twice that of the short-circuit device. Determine the deviation delay of the standard short-circuit device 

according to the definition of the inspection standards. 

3) Phase deviation measurement 

Menu path: [Response] > [Scale] > [Phase Offset...]. 

Enter the value in the [Phase Offset] dialog box or select the required value with the arrow. 

4) Inspection of mixing 

Menu path: [Stimulus] > [Sweep] > [Points]. 

Select one value in the list, or click [Custom...], and enter the value smaller than the current value through the 

number keys of the keyboard or input zone. 

The problem of changes of the displayed data can be solved by increasing the number of points or reducing the 

frequency span. 

6.6 Reduction of Trace noise 

Reduce the noise on the measurement trace by the network analyzer function. The following functions of the 

analyzer can help to reduce the influence of trace noise. 

● Sweep averaging ······································································································································ 180 

● Track smoothing ······································································································································ 181 

● Intermediate frequency bandwidth ············································································································ 182 

6.6.1 Sweep Averaging 

1) Sweep averaging 

a) Sweep averaging is a function to reduce the influence of random noise on the measurement. 

b) Each data point is calculated based on the average value of several continuous sweep operations. The times of 

continuous sweep are determined according to the setting of the average factor. 

c) The average value of traces will be applied on all measurements of one channel, and the average number of each 

channel will be displayed. 

d) The noise reduction and dynamic range can be improved by increasing the averaging times. 
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e) The noise reduction effect of sweep averaging is the same as that of reduction of the intermediate frequency 

bandwidth. 

2) Influence of sweep averaging 

As shown in Fig. 6.12, sweep averaging has influence on measurement results. 

 

Fig. 6.12 Influence of Sweep Averaging on Measurement Results 

3) Setting of sweep averaging 

Menu path: [Response] > [Avg] > [Average...]. 

Select [Average on/OFF] to enable the averaging function. 

Directly enter the value in the [Average Factor] box or increase/decrease the averaging times of the analyzer with 

the arrow button. 

 

Fig. 6.13 Setting of Sweep Averaging 

Attention 

Click [Restart Average] in the sub-menu to start a group of new average sweep. 

6.6.2 Track Smoothing 

The smoothing function is used to reduce the peak-peak noise of broadband measurement data. The data of part of 

the displayed trace are averaged by the analyzer. The number of adjacent data points subject to averaging at the 

same time is also known as the smoothing aperture. The aperture can be defined as the number of data point or the 

percentage of X-axis span. 

Prompt 

Use of the smoothing function: 

 Use sufficient points in the display to avoid misleading results. 

 The smoothing function must not be applied to the highly resonant device or the device subject to broad trace 
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changes, as measurement errors may be caused. 

 The smoothing function can be independently set for each trace. 

1) Influence of trace smoothing 

 

Fig. 6.14 Influence of Track Smoothing on Measurement Results 

2) Setting of trace smoothing 

Menu path: [Response] > [Avg] > [Smoothing...]. 

Click [Smoothing] to enable the smoothing function. 

Select the method to specify the value of the smoothing aperture: 

a) Enter the smoothing percentage in the [Percent] box. (Max. 25%) 

b) Enter the number of smoothing points in the [Points] box. (The maximum value is 25% of the total number of 

sweep points of the test.) 

 

Fig. 6.15 Setting of Smoothing 

6.6.3 Intermediate Frequency Bandwidth 

You can reduce the bandwidth of the intermediate frequency receiver so as to reduce the influence of random noise 

in measurement. Once the intermediate frequency bandwidth is reduced by 10 times, the base noise will be 

reduced by 10dB.However, if the intermediate frequency bandwidth is small, the sweep time will be long. The 

signal received by the analyzer will be changed into the intermediate frequency (7.606MHz) from the network 

analyzer can change the received signal from the RF/microwave frequency into the intermediate frequency 

(7.606MHz). The bandwidth of the intermediate frequency band pass filter can be reduced from 5MHz to 1Hz 

(min.). The intermediate frequency bandwidth can be independently set for each channel or in segment sweep. 

1) Reduction of influence of intermediate frequency bandwidth 

The influence of the intermediate frequency bandwidth on measurement results is shown in Fig. 6.16. 
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Fig. 6.16 Influence of Intermediate Frequency Bandwidth on Measurement Results 

2) Setting of intermediate frequency bandwidth 

Menu path: [Response] > [Avg] > [IF Bandwidth...]. 

Directly enter the value in the [Intermediate frequency bandwidth] dialog box or select the value with the arrow 

button. 

 

Fig. 6.17 Setting of Intermediate Frequency Bandwidth 

6.7 Increase of Data Point Number 

The data point or ―point‖ refers to the sampling results of next value after one stimulus. You can define the number 

of measurement points within one sweep. 

 The trace can be swept through a large number of data points so as to better define the device response. 

 The majority of data processing is done between adjacent points. One ―sweep‖ refers to the measurement 

results of a series of continuous data points, corresponding to the stimulus value within one sequence. 

 The default number of points of each sweep is 201. 

The sweep time of the analyzer can be changed according to the number of sweep points and the scale. However, 

the total measurement period will not change according to the number of sweep points and the scale. Instead, it is 

affected by other factors, such as the flyback time, data calculation, formation time, etc. Refer to the technical 

specifications for the influence of the point number and other settings on the sweep time. 

Prompt 

Use of data points 

 In order to obtain the best trace resolution, use the maximum number of data points. 

 In order to realize rapid throughput, use the minimum number of data points, which can help to achieve the 

acceptable accuracy. 

 In order to find the optimal number of data points, find a value with measurement results subject to no 

significant difference from the required number of measurement points. 

 In order to ensure the accurate measurement calibration, the number of calibration points should be the same 
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as that of measurement points. 

1) Specific operations 

Menu path: [Stimulus] > [Sweep] > [Number of Points]. 

Directly click the required point number in the [Number of Points] sub-menu, or click [Custom...], enter the value 

in the [Number of Points] dialog box, or select the value with the arrow. 

 

Fig. 6.18 Setting of Number of Sweep Points 

2) Optimization of measurement results 

One measurement includes several interdependent settings. You can modify the settings to achieve the purposes of 

measurement application: faster throughput or more accurate data. You can balance the settings to optimize 

measurement. 

 Increase the measurement throughput. 

 Improve the measurement accuracy. 

6.8 Improvement of Measurement Stability 

Measurement instability is caused under several conditions. For repeated measurement, you can apply several 

methods to create a stable measurement environment. The following factors have adverse effects on the 

measurement accuracy. 

1) Frequency offset 

The frequency precision of the analyzer depends on the accuracy of the internal 10MHZ oscillator. If high 

frequency accuracy and stability are required in the measurement application, no consideration should be given to 

the internal frequency standard, and a high-stability external frequency source can be created by the 10MHz 

reference input connector on the rear panel. 

2) Temperature deviation 

a) The electrical characteristics of the following components can be changed as a result of thermal expansion and 

contraction. 

 Internal device of analyzer 

 Standard of calibration kit 

 Tester 
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 Cable 

 Adapter 

b) The temperature deviation in measurement can be reduced in the following methods. 

 Apply a temperature-controlled environment. 

 Ensure the temperature stability of the calibration kit. 

 Avoid unnecessary operation of the calibration kit during calibration. 

 Ensure that the difference between the ambient temperature and calibration temperature is ±1℃. 

3) Improper measurement calibration 

Improper measurement calibration may result in failure to detect the correct response of the DUT. You can apply 

the following methods to ensure the proper calibration: 

a) Perform the measurement calibration of the connection of the DUT, i.e. reference plane. 

b) If an additional accessory (cable, adapter or attenuator) is inserted into the DUT after one measurement 

calibration, the additional electrical length and delay time can be compensated by the port extension function. 

c) Apply the calibration standard defined in the calibration process. For more details, see the section about accurate 

measurement calibration. 

4) Equipment connector 

A good connector is necessary in repeated measurement. Good connection can be realized in the following methods: 

a) Check and clean the connectors of all components in the test equipment. 

b) Apply the correct connection method. 

c) Do not move the cable during measurement. 

5) Apply the external reference frequency. 

Input the external frequency reference signal to the rear panel connector. 

a) Input frequency: 10MHz±10ppm 

b) Input level: -15dBm to +20dBm 

c) Input impedance: 200ohms 

6) Control the room temperature. 

a) Run the analyzer for more than 30min before each measurement calibration or equipment measurement. 

b) Measure the equipment in the temperature-controlled environment. All the instructions and characteristics are 

applied at 23℃±3℃ (unless otherwise specified). 

c) Ensure that the difference between the ambient temperature and calibration temperature is ±1℃. 

7) Stabilize the standard temperature of calibration. 

a) Open the calibration kit box and take out the standard kit out of the protective foam one hour before 

measurement calibration. 

b) Avoid unnecessary operation of the calibration kit in each measurement calibration. 

8) Use connectors in good conditions. 

a) Check all connectors with the magnifying glass. Check the following kinds of damage: wear, bending, breakage, 

deep scratch, dent, rounded shoulder, dirt or metal chippings. 

b) Clean all connectors with isopropyl alcohol and swabs. 

 Evaporate alcohol. 

 Gradually dry connectors with compressed air. 
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c) Properly connect the parts. 

 Connect the body and other parts to the ground with anti-static pads and wrist straps. 

 Arrange the connectors in one row. 

 Rotate the connection nuts. 

 Perform final connection with the torque wrench. 

6.9 Increase of Sweep Velocity 

The measurement efficiency can be improved by increasing the sweep velocity. The highest sweep velocity can be 

achieved by optimizing the following settings in measurement. 

1) Sweep setting 

Carefully set the following items to achieve the highest sweep velocity. 

 Frequency span: only measure the frequency range of the DUT. See the setting method in ―4.3 Setting 

of Frequency Range‖. 

 Segment sweep: measure the relevant frequency range by means of segment sweep. See the setting 

method in the instructions of ―Setting of sweep type‖ in ―4.5.2 Setting of sweep type‖ of ―4.5 Setting of 

Sweep‖. 

 Shutdown of step sweep: the step sweep mode must not be used unless permitted in measurement, so as 

to minimize the sweep time. See the setting method in ―4.5.3 Setting of sweep‖ of ―4.5 Setting of Sweep‖. 

 Automatic sweep time: use the default setting time in the current setting to achieve the most rapid sweep. 

See the setting method in ―4.5.3 Sweep time‖ of ―4.5 Setting of Sweep‖. 

 Number of sweep points: use the minimum number required in measurement. See the setting method in 

―6.7 Increase of Data Point Number‖. 

2) Setting of noise reduction 

Reasonably set the following two items to reduce the sweep time but obtain the acceptable measurement results. 

 Intermediate frequency bandwidth: use the largest intermediate frequency bandwidth to ensure the 

acceptable trace noise and dynamic range. See the setting method in ―6.6.3 Intermediate frequency 

bandwidth‖ of ―6.6 Reduction of Trace noise‖. 

 Average: minimize the average factor or shut down the averaging function. See the setting method in 

―6.6.1 Sweep averaging‖ of ―6.6 Reduction of Trace noise‖. 

3) Selection of calibration type 

Apply the most rapid calibration meeting the measurement requirements. The time of sweep measurement is almost 

the same without error correction or with response calibration. The measurement parameters of fully 2-port 

calibration should be updated with error correction by forward and reverse sweep, even if only one S-parameter is 

displayed, so the measurement time is the longest. For calibration type details, see ―6.2 Selection of Calibration 

Type‖. 

4) Shutdown of unnecessary functions 

The information of all active functions must be updated. In order to increase the sweep velocity, the following 

unnecessary functions for measurement should be shut down. 

 Unnecessary trace 

 Unnecessary marker 

 Smoothing 

 Limit test 

 Trace operation 

 Display 
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The sweep velocity of the analyzer depends on measurement settings. Therefore, you should try many times to 

achieve the highest sweep velocity and conforming measurement results. 

a) Delete the unnecessary trace. 

Right-click the mouse on the state bar button used to delete the trace. The right-click menu will appear. 

Click [Delete trace] in the right-click menu. 

 

Fig. 6.19 Deletion of Unnecessary Trace 

b) Close the unnecessary marker. 

Menu path: [Marker] > [Marker] > [Active Marker Off]. 

Select the marker to be closed. 

 

Fig. 6.20 Closing of Unnecessary Marker 

c) Shutdown of smoothing function 

Menu path: [Response] > [Avg] > [Smoothing...]. The [Smoothing] dialog box will appear. 

Click [Smoothing ON/off] to shut down the smoothing function. 
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Fig. 6.21 Shutdown of Smoothing Function 

d) Shutdown of limit test 

Menu path: [Analysis] > [Limit Test...]. The [Limit Test] dialog box will appear. 

Click [Limit Test ON/off] check box to shut down the limit test function. 

 

Fig. 6.22 Shutdown of Limit Test 

e) Shutdown of trace operation function 

Menu path: [Analysis] > [Memory] > [Math/Memory]. 

Select the data in the [Data Math] box. 

 

Fig. 6.23 Shutdown of Track Operation Function 

6.10 Improvement of Efficiency of Multi-state Measurement 

If multiple parameter measurements are required to represent the characteristics of one device, various methods can 

be applied to improve the measurement efficiency. You can try the following methods to find the most suitable 

application solution. 
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● Improvement of measurement efficiency by measurement setting ····························································· 189 

● Automatic change of measurement setting ································································································ 190 

● Rapid recalling of measurement ················································································································ 190 

6.10.1 Improvement of Measurement Efficiency by Measurement Setting 

In order to improve the measurement efficiency of the DUT requiring various parameter measurements, you should 

be familiar with the analyzer operation, which can help to create the optimal application solution. See trace, 

channel and window details related to parameter measurements in ―3.4 Track, Channel and Window of Analyzer‖. 

1) Reasonably arrange one group of measurements. 

Arrange one group of measurements of the DUT in one instrument state. Save the instrument state so as to perform 

the previous group of measurements by recalling. Or, arrange a group of measurements by the preconfigured 

measurement setting function of the analyzer. See details in ―Setting of preconfigured measurement‖ of ―4.8 

Observation of multiple traces and opening of multiple channels‖. 

2) Apply the segment sweep function. 

Segment sweep can be applied to change the following settings to represent multiple parameter measurements of 

one device. 

 Frequency range 

 power level 

 intermediate-frequency bandwidth 

 Number of sweep point 

A group of frequency ranges with respective attributes can be defined in segment sweep. In this case, the DUT with 

multiple measurement settings can be measured by means of one sweep. See segment sweep details in the ―Setting 

of segment sweep type‖ of ―4.5.2 Setting of sweep type‖ of ―4.5 Setting of sweep‖. 

3) Selectively trigger the measurement. 

Set the measurement as follows by triggering. 

 Continuously update the measurement with rapid data changes. 

 Occasionally update the measurement with a few data changes. 

For example, the tuning measurement of one filter can be set by the following settings: 

 One channel is used to measure the passband response of the filter in tuning. 

 One channel is used to measure the out-of-band response of the filter. 

In this case, the turning measurement of the filter can be observed continuously. If all channels are updated 

constantly, the response velocity of the analyzer will be reduced, and the filter cannot be tuned rapidly. 

Measurement setting is introduced as follows. 

 Measurement data of Channel 1 will be updated continuously. 

 Measurement data of Channel 2 will be updated when required. 

a) Use the mouse. 

1) Create the double-channel measurement. 

Menu path: [Response] > [Display] > [Measurement Setup] > [Setting D]. 

2) Set the trigger mode of Channel 1: constantly update measurement data. 

Menu path: [Stimulus] > [Trigger] > [Trigger...]. The [Trigger] dialog box will appear. 

Select the [Internal] radio box in the trigger source zone. 

Click the [Channel] box in the trigger setting zone and select Channel 1. 

Click the [Continuous] radio box in the trigger setting zone. 
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3) Set the trigger mode of Channel 2: update measurement data when required. 

Click the [Channel] box in the trigger setting zone and select Channel 2. 

Click the [Single] or [Groups] radio box in the trigger setting zone. If the group triggering mode is selected, 

enter the group number in the [Groups] input box. 

4) Click [Soft keyboard] in the [System] menu. The [Soft keyboard] dialog box will appear. Click [Stimulus] > 

[Trigger] in the dialog box and the toolbar to trigger the corresponding soft key will appear. 

5) Click the window below to set Channel 2 as the current active channel. 

6) Update the measurement data of Channel 2. 

7) Click the [Single], [Groups] or [Re-sweep] on the trigger soft key toolbar. Measurement data of Channel 2 will 

be updated. 

6.10.2 Automatic Change of Measurement Setting 

Automatically change measurement settings by means of programming to effectively improve the efficiency of 

multi-parameter measurements. 

6.10.3 Rapid recalling of measurement 

The most effective method to recall the measurement is to save a group of measurements as one instrument state. 

 The time difference of recalling the instrument with one or more measurements is little. 

 The corresponding time is required in each recalling. The recalling time can be saved by setting a group of 

measurements. 

6.11 Rapid Data Transmission 

Rapid data transmission can help to improve the measurement efficiency. You can apply the following methods to 

increase the data transmission velocity. 

● Rapid recalling of measurement ················································································································ 190 

● Minimization of transmission data ············································································································ 190 

● Use of real number format ························································································································ 191 

● Use of LAN·············································································································································· 191 

● Use of COM program ······························································································································· 191 

6.11.1 Use of “Single” Trigger Mode 

Use the ―single‖ trigger mode to complete measurement before data transmission. 

Menu path: [Stimulus] > [Trigger] > [Trigger...]. The [Trigger] dialog box will appear. 

Select the [Internal] radio box in the trigger source zone. 

Select the measurement channel for data transmission by clicking the [Channel] box in the trigger setting zone. 

Click the [Continuous] radio box in the trigger setting zone and then click [OK] to close the dialog box. 

Update the measurement results: 

1) Click the corresponding trace state button to set the trace and channel to be updated as the active trace and 

channel. 

2) Click [Soft keyboard] in the [System] sub-menu. Then click [Stimulus] > [Trigger] in the [Soft keyboard] 

dialog box. 

3) Click [Single] in the trigger soft key toolbar. 

6.11.2 Minimization of Transmission Data 

Apply the segment sweep function to reduce the number of trace points, instead of transmission of the whole trace 

with a lot of linear points. 
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6.11.3 Use of Real Number Format 

Select the real number format in automatic measurement using SCPI so as to achieve the highest transmission 

velocity. 

6.11.4 Use of LAN 

Use the LAN to increase the data transmission velocity in the automatic SCPI measurement application. 

6.11.5 Use of COM Program 

Use COM in the automatic measurement program to achieve the highest velocity of data transmission. 

6.12 Use of Macro 

The macro is an executable file installed and run in the analyzer. 3672 series vector network analyzers support up 

to 10 macros. 

● New macro ··············································································································································· 191 

● [Macro setting] dialog box ························································································································ 192 

● [Macro setting window] dialog box ·········································································································· 192 

6.12.1 New macro 

Menu path: [System] > [Macro] > [Macro Setup...]. The [Macro setting] dialog box will appear. 

 

Fig. 6.24 Macro Setting 

Click the [Macro Setup] dialog box to activate the blank line under the macro settings. Click the [Edit...] button 

and the [Macro setting window] dialog box will appear. 

 

Fig. 6.25 [Macro setting] Dialog Box 

 Enter the macro title text in the [Macro Title] box. 
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 Enter the detailed path of the executable file in the [Macro Executable] box, or click the [Browse...] button to 

find the executable file. 

 Enter the character string parameter of the executable file in the [Parameter] box. 

 

Fig. 6.26 [Macro setting window] Dialog Box 

6.12.2 [Macro Setup] Dialog Box 

1) [Macro Name] box 

Display the macro title. If the [Macro/local] key is pressed, the macro title can be displayed in the current toolbar 

button. Click [Macro] in the system menu. The macro title will be displayed in the macro sub-menu. To display 

the complete macro title in the current toolbar button, the number of title characters should not exceed 14. The 

macro title can be associated with the executable file. It is better to describe the macro function so as to easily 

distinguish different macros. For example, the title of the macro to visit the home page of the 41st Institute can be 

named as ―41st Institute Home Page‖. 

2) [Executable File] box 

Display the full path of the executable file. Take the macro to visit the home page of the 41st Institute as an 

example. The path of the executable file is: C:\ProgramFiles\InternetExplorer\IEXPLORE.EXE. 

3) [Parameter] box 

Display the parameter to be transmitted to the executable file and used by the executable file. Take the macro to 

visit the home page of the 41st Institute as an example. The parameter of macro running is: http://www.ei41.com. 

4) [Edit] button 

Click it to display the [Macro editing window] dialog box to set and modify the selected macro. 

5) [Delete] button 

Click it to delete the selected macro. 

6) [UP] button 

Click it to move the selected macro up for one line. It is used to rearrange the macro sequence. The macro sequence 

in the dialog box is the same as that in the current toolbar. Four macros will be displayed in the toolbar each time. If 

[Macro/local] is pressed, four macros will be displayed. 

7) [DOWN] button 

Click it to move the selected macro down for one line. 

6.12.3 [Macro setting window] dialog box 

1) [Macro name] box 

Set the macro title name. 

2) Editing zone 
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a) [Executable file] box 

Set the full path of the executable file. 

b) [Browse...] button 

Browse the drive and director, position the executable file and establish the full path of the executable file. 

c) [Parameter] box 

Used to set the character string parameter to be transmitted to the executable file for reference. 
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7 Calibration 

Calibration can help to reduce the measurement error. This chapter includes the following contents: 

● Calibration overview ································································································································ 194 

● Selection of calibration type ····················································································································· 195 

● Calibration guide ······································································································································ 196 

● High-accuracy measurement calibration···································································································· 199 

● Measurement error ··································································································································· 201 

● Editing of calibration kit definition ··········································································································· 203 

● Calibration standards ································································································································ 212 

● TRL calibration ········································································································································ 213 

● Fixture compensation calibration ·············································································································· 214 

● Electronic calibration ······························································································································· 224 

7.1 Calibration Overview 

Measurement calibration is a process to determine the system errors according to the standards of the existing 

measurement characteristics and then eliminate the influence of system errors during measurement of the DUT. It 

can help to reduce the measurement error and improve the measurement accuracy of the analyzer. 

7.1.1 Definition of Calibration 

Calibration is a process to eliminate one or more system error(s) with the error model. The error item of the error 

model is solved by measurement according to high-quality calibration standards (including the open-circuit device, 

short-circuit device, load and through type part). See system error details in ―7.5.3 System Error‖ of ―7.5 

Measurement Error‖ in this chapter. 

Select the appropriate calibration method according to the measurement type and accuracy requirements. See 

details in ―7.2 Selection of Calibration Type‖. 

Various kinds of calibration can be done according to the calibration guide of the calibration. See details in ―7.3 

Calibration Guide‖. 

The measurement accuracy after calibration depends on the quality of the calibration standard and the model 

definition accuracy of the standard calibration kit in the calibration kit definition file. The calibration kit definition 

file is saved in the analyzer. In order to ensure the measurement accuracy, the actual calibration kit must 

conform to the requirements of the calibration kit definition file. See accurate calibration details in ―7.4 High-

accuracy Measurement Calibration‖. 

The user must correctly define the calibration standard in the calibration kit definition file of the user so as to 

use the custom calibration kit (e.g. for fixture measurement calibration). See details in ―7.6 Editing of 

Calibration Kit Definition‖. 

7.1.2 Significance of Calibration 

It is impossible to make an ideal analyzer requiring no error correction from the perspective of hardware circuit. 

Even if error correction can be ignored in good hardware circuits, the costs will be high. In addition, the 

measurement accuracy of the analyzer is largely influenced by external accessories. The amplitude and phase 

changes of test components such as the connecting cable and adapter will affect response the real response of the 

DUT. Therefore, the best method is to balance the hardware performance and cost, make high-quality hardware as 

practical as possible and improve the measurement accuracy by calibration. 

7.1.3 Applications of Calibration 

 High measurement accuracy is expected. 

 Different types of connector or impedance are used. 
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 A cable is connected between the DUT and the test port of the analyzer. 

 The DUT is measured in a wide frequency range or a device of long electrical delay is measured. 

 An attenuator or similar device is connected to the input or output end of the DUT. 

7.1.4 Simple Calibration Process 

1) Connect the analyzer according to the measurement requirements. 

2) Select the appropriate analyzer to optimize measurement. 

3) Remove the DUT and select the calibration type and kit according to the calibration guide. 

4) Connect the standard calibration kit of the selected type in measurement according to the calibration guide. The 

error is calculated by measurement with the standard calibration kit and saved in the memory of the analyzer. 

5) Reconnect and measure the DUT. If error correction is applied during measurement, the error influence will be 

eliminated. 

7.2 Selection of Calibration Type 

3672 series vector network analyzers support six common calibration types, with details as follows: 

1) Open-circuit response 

a) Calibration accuracy: low to medium. 

b) Measurement parameter: S11, S22, S33 and S44. 

c) Standard calibration kit: open-circuit device. 

d) System error correction: reflection tracking. 

e) Measurement application: reflection measurement of any port. 

2) Short-circuit response 

a) Calibration accuracy: low to medium. 

b) Measurement parameter: S11, S22, S33 and S44. 

c) Standard calibration kit: short-circuit device. 

d) System error correction: reflection tracking. 

e) Measurement application: reflection measurement of any port. 

3) Through type response 

a) Calibration accuracy: medium. 

b) Measurement parameter: S-parameter of transmission measurement. 

c) Standard calibration kit: through type device. 

d) System error correction: transmission tracking. 

e) Measurement transmission measurement in any direction. 

Attention 

The adapter is used as the through type device. 

The through type device is of zero length and loss according to the definition in the calibration kit definition file. If 

the adapter is used as the through type device in calibration, the characteristics of the adapter must be specified in 

the calibration kit definition file to ensure the accuracy of calibration. See details in ―7.4 High-accuracy 

Measurement Calibration‖. 

4) Through type response and isolation 
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a) Calibration accuracy: medium. 

b) Measurement parameter: S-parameter of transmission measurement. 

c) Standard calibration kit: through type device and two load (one respectively for each port). 

d) System error correction: 

 Transmission tracking 

 Crosstalk 

e) Measurement application: 

 Transmission measurement in any direction. 

 Improvement of the dynamic range of the system by means of isolation calibration. 

Attention 

Isolation calibration 

Isolation calibration is not allowed if all the ports are not respectively connected with one load at the same time. 

5) One-port (reflection) 

a) Calibration accuracy: high 

b) Measurement parameter: S11, S22, S33 and S44. 

c) Standard calibration kit: open-circuit device, short-circuit device and load. 

d) System error correction: 

 Direction 

 Source matching 

 Reflection tracking 

e) Measurement application: reflection measurement of any port. 

6) Full 2-port SOLT 

a) Calibration accuracy: high 

b) Measurement parameters: all 

c) Standard calibration kit: open-circuit device, short-circuit device, load and through type device. 

d) System error correction: 

 Direction 

 Source matching 

 Reflection tracking 

 Crosstalk 

 Transmission tracking 

e) Measurement application: 

 Measurement of all S-parameters. 

 Improvement of the measurement accuracy by 12 error corrections. 

7.3 Calibration Guide 

Select the calibration type and perform calibration according to the calibration guide of the analyzer. The through 

type response and isolation calibration are taken as examples below to demonstrate the calibration process (this 
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kind of calibration is effective only in transmission measurement). 

Enable the calibration guide for calibration. 

1) Menu path: [Cal] > [Calibration…]. The [Calibration guide] dialog box will appear. 

 

Fig. 7.1 Enabling of Calibration 

2) Click [Unguided calibration] and [Next]. 

 

Fig. 7.2 Start of Calibration 

3) Click [THRU Resp and Isol] and [Next]. 

 

Fig. 7.3 Selection of Type of Mechanical Calibration 

4) Click [Cal kit Select], and the [Select CalKit] dialog box will appear. Select the calibration kit and click [OK] 

to open the dialog box. Thus the calibration kit is changed. 
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Fig. 7.4 [THRU Resp and Isol] Dialog Box and [Select calibration kit] Dialog Box 

5) Click [Selected Standards], and the [Type information] dialog box will appear. Set the calibration standard 

and click [OK] to close the dialog box. 

 

Fig. 7.5 [Type information] Dialog Box 

6) To directly connect Port 1 and 2 through the cable, click [Through] and [(THRU)]. After connection, click 

[OK]. The standard calibration kit button in the [THRU Resp and Isol] dialog box will become green after 

through type calibration. Modify the frequency range of calibration in the [Min Freq] and [Max Freq] input box. 

 

Fig. 7.6 [Measurement of multiple standard kits] Dialog Box 

7) Respectively connect Port 1 and 2 to the load calibration kit. Click [Load] and the keys of the standard kit type 

and interface type (the display contents vary from calibration types). After selection, click [OK]. Modify the 

frequency range of calibration in the [Min Freq] and [Max Freq] input box. The standard calibration kit button in 

the [THRU Resp and Isol] dialog box will become green after isolation calibration. 
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Fig. 7.7 [Multiple Standards] Dialog Box 

8) Click [OK] in the [THRU Resp and Isol] dialog box after calibration. 

 

Fig. 7.8 [Through type response and isolation calibration] Dialog Box 

Notes: 1. The optional calibration type is associated with the measurement parameters of the current active channel. 

For example, if the measurement parameter is S11, the through type response mode or the through type response 

and isolation calibration mode cannot be selected. 

2. If isolation calibration is not required in the full 2-port calibration, tick the [Ignore isolation (2-port type)] 

check box. 

Attention 

Properly select the calibration standard to realize the highest calibration accuracy. 

The [Measurement of multiple standard kits] dialog box shows the standard connector types, instead of the 

connector types for non-test ports. In order to realize the highest calibration accuracy, the calibration standard must 

be selected properly. 

7.4 High-accuracy Measurement Calibration 

The calibration accuracy depends on the selected calibration type, calibration kit quality and calibration process. 

This section mainly discusses how to perform high-accuracy calibration. 

1) Measurement reference plane 

The DUT is not directly connected to the port of the analyzer in most of measurements. Instead, it is connected 

through the test fixture or cable. The connection point of the DUT must be calibrated to realize the highest 

measurement accuracy. This point is recalled the measurement reference plane. If the measurement reference plane 

is calibrated, the error related to the measurement composition (such as the cable, test fixture and adapter between 

the analyzer port and reference plane) can be measured and eliminated. 

2) Influence of calibration kit 

Under normal conditions, the calibration standard of the calibration kit is the same as the connector type standard of 

the DUT. In some cases, however, the calibration kit corresponding to the connector type of the DUT is not 

provided. For example, the port size of the DUT is 2.4mm, but the connector size of the analyzer and calibration kit 

is 3.5mm. If the 2.4mm calibration kit is used for calibration and the 2.4mm/3.5mm adapter is used in measurement, 

the measurement error will be obvious, especially in reflection measurement, as the adapter is not calibrated. If the 

applied calibration kit is different from the calibration kit specified for calibration, the calibration accuracy will be 

reduced. The degree of accuracy reduction depends on the difference between the specified calibration kit and 
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actual calibration kit. 

3) Accuracy of interpolation measurement 

If the instrument settings are different from calibration settings, calibration data can be automatically interpolated 

into the analyzer. In this case, the measurement accuracy cannot be predicted and may drop greatly or not be 

affected. The measurement error must be determined depending on the actual situation. If the phase shift added by 

two measurement points exceeds 180 degrees, the measurement accuracy will drop greatly as the correct phase data 

cannot be interpolated. Generally, the probability of accuracy reduction may increase as a result of interpolation in 

the following cases: 

 When the frequency span between measurement points is increased; 

 When the frequency span between measurement points is too large; 

 When the measurement frequency is high, especially above 10GHz. 

4) Influence of power level 

The power level must not be changed after calibration in order to realize the highest accuracy of error correction. 

However, if the power level is changed under the same conditions as the attenuator settings in calibration, the 

accuracy of S-parameter measurement only declines a little. If the attenuator settings are changed, the accuracy of 

error correction will decline further. 

5) System impedance 

The system impedance must be changed in measurement of the impedance device (not 50Ω) such as the waveguide 

device. The default system impedance is 50Ω. 

a) Setting of system impedance 

Menu path: [System] > [Configuration] > [Impedance...]. 

Enter the system impedance value in the [Impedance] box and click [OK] to close the dialog box. 

6) Port extension 

The measurement reference plane may be changed as a result of connection of the cbale, adapter or fixture after 

calibration, which may lead to increase of the phase shift. In this case, the additional phase deviation can be 

compensated by means of port extension. Port extension is the simplest method to compensate the additional phase 

shift between the calibration plane and DUT plane, but cannot be used to compensate the loss and mismatch of the 

path between the calibration plane and DUT plane. Therefore, the loss and mismatch should be minimized to 

realize the highest measurement accuracy. For setting of port extension, refer to ―Setting of port extension‖ in ―6.5 

Improvement of Phase Measurement Accuracy‖. 

7) Correct isolation calibration 

Isolation calibration in full 2-port calibration is applied to correct the crosstalk error between ports. It is required 

only in measurement of large insertion loss, such as the out-of-band suppression of the filter, isolation of the switch, 

etc. When the crosstalk signal is close to the base noise of the analyzer, additional noise will be produced in the 

error model as a result of isolation calibration. In order to improve the calibration accuracy, you should: 

 Perform isolation calibration if necessary; 

 Use the narrow intermediate frequency bandwidth; 

 Reduce noise by sweep averaging. 

The test port of the analyzer should be connected with a load in isolation calibration. In order to realize the highest 

calibration accuracy, it is preferred to connect the loads to two measurement ports at the same time for isolation 

calibration. If only one load is provided, connect a well-fitted device to the non-measurement port. 
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7.5 Measurement Errors 

Understanding of the source of measurement error and the way of error correction can help to improve the 

measurement accuracy, as a certain degree of uncertainty still exits no matter how carefully the measurement is 

done. The following kinds of errors may be produced in measurement with the analyzer. 

7.5.1 Drift Errors 

 Drift errors are produced by performance changes of the instrument or test system after calibration. 

 The thermal expansion of the interconnected cables in the instrument and the performance changes of 

microwave mixer are main causes of the drift error. The drift errors can be eliminated by recalibration. 

 The duration of accurate calibration depends on the test environment. The stable environment can help to 

minimize the drift error. 

7.5.2 Random Errors 

The random error cannot be predicted or eliminated by means of calibration. The influence on measurement results 

can be reduced by some methods. Random errors are mainly divided into three types: 

1) Random error of instrument 

a) Electrical disturbance of internal components of the analyzer may result in random noise, mainly including: 

 Low-level noise arising from the base noise within the receiver broadband; 

 High-level noise or data trace jittering, which is mainly caused by the base noise inside the instrument and 

phase noise of the LO source. 

b) The random noise error can be reduced in the following methods: 

 Increase the source power input into the DUT; 

 Reduce the intermediate frequency bandwidth; 

 Apply the function of sweep averaging. 

2) Switch repeatability error 

The switch is used to change attenuator settings of the source. If the switch acts, contact closing may be different 

from previous closing sometimes. In this case, the measurement accuracy will be affected seriously. Therefore, the 

attenuator settings should not be changed in high-accuracy measurement so as to reduce the switch repeatability 

error. 

3) Connector repeatability error 

Connector wear may result in electrical performance changes. Proper connection maintenance can help to reduce 

the connector repeatability error. 

7.5.3 System Errors 

System errors are caused by non-ideal hardware properties and may be repeatable (therefore, it can be predicted). It 

is assumed that system errors do not change over time. System errors can be determined by calibration and 

eliminated by mathematical calculation in measurement. 

System errors cannot be fully eliminated. Due to limitations of the calibration process, some residual errors may 

exist after calibration, mainly resulting from: 

 Non-ideal calibration standard; 

 Connector connection; 

 Interconnected cable; 

 Instrument. 

All measurements are affected by the dynamic accuracy and frequency errors. For reflection measurement, relevant 

residual errors include: 

 Effective direction; 
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 Effective source matching; 

 Effective reflection tracking. 

For transmission measurement, relevant residual errors include: 

 Crosstalk 

 Effective load matching; 

 Effective transmission measurement. 

1) Direction errors 

The directional coupler or bridge is used for reflection measurement. The coupling end of the ideal coupler can 

only output the reflection signal to the receiver for measurement. Actually, a small number of incident signals will 

leak to the coupling port through the main channel of the coupler, which may result in directional errors in 

measurement. Directional errors can be determined and reduced in the following methods. 

 Connect the load to the measurement port during calibration and regard the load port free from reflection. 

 The output signal of the coupling port is the leakage error signal. 

 Reduce the directional error signals in reflection measurement. 

2) Crosstalk errors 

Ideally, only the transmission signal through the DUT can reach the receiver. Actually, a small number of signals 

reach the receiver through other paths in the analyzer. Such signals are known as crosstalk signals. Crosstalk errors 

can be determined and reduced in the following methods. 

 Connect the loads to Port 1 and 2 at the same time during calibration. 

 The signal measured by the measurement receiver is the leakage signal of the analyzer. 

 Eliminate the crosstalk errors by means of error correction during transmission measurement. 

3) Source matching errors 

Ideally, the measurement receiver can receive all signals reflected from the DUT in reflection measurement. 

Actually, parts of the signals reflected by the DUT are reflected by the measurement port back to the DUT. As such 

signals cannot be measured by the measurement receiver, source matching errors will be produced. They can be 

determined and reduced in the following methods. 

 Connect the short-circuit device to the measurement port in calibration. The signals reflected by the short-

circuit device will be measured by the receiver. Measurement results will be saved in the analyzer. 

 Connect the open-circuit device to the port. The signals reflected by the open-circuit device will be measured 

by the receiver. Measurement results will be saved in the analyzer. 

 The measurement results will be compared with the known values of the open-circuit device and short-circuit 

device to determine source matching errors. 

 Eliminate source matching errors by means of error correction in reflection and transmission measurement. 

4) Load matching errors 

In the ideal transmission measurement, transmission signals through the DUT are received by the measurement 

receiver. Actually, some signals are reflected by the test port and cannot be measured, thus resulting in load 

matching errors. The load matching errors can be determined and reduced in the following methods. 

 Directly connect Port 1 and 2, with zero length. 

 If the source is located on Port 1, measurement signals of Receiver A include the reflection signals of Port 2. If 

the source is located on Port 2, measurement signals of Receiver 2 include the reflection signals of Port 2. 

Thus, load matching errors can be determined. 

 Eliminate source matching errors by means of error correction in reflection and transmission measurement. 

5) Reflection tracking errors 
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The signals of Receiver A and R1 or B and R2 are compared in reflection measurement. This is known as ratio 

measurement. In the ideal reflection measurement, the frequency responses of Receiver A and R1 or B and R2 

should be identical. Actually, this is impossible and reflection tracking errors may be produced, i.e. vector sum 

errors caused by test deviations. The error amplitude and phase change with the frequency. Deviations are mainly 

caused by the following factors: 

 Signal separator; 

 Test cable and adapter; 

 Difference between the reference and test signal paths. 

Reflection tracking errors can be determined and reduced in the following methods. 

 Connect the short-circuit device to the measurement port in calibration. The signals reflected by the short-

circuit device will be measured by the receiver. Measurement results will be saved in the analyzer. 

 Connect the open-circuit device to the port. The signals reflected by the open-circuit device will be measured 

by the receiver. Measurement results will be saved in the analyzer. 

 The measurement results will be compared with the known values of the open-circuit device and short-circuit 

device to determine source matching errors. 

 Eliminate reflection tracking errors by means of error correction in reflection and transmission measurement. 

6) Transmission tracking errors 

The signals of Receiver A and R2 or B and R1 are compared in transmission measurement. This is known as ratio 

measurement. In the ideal transmission measurement, the frequency responses of Receiver A and R2 or B and R1 

should be identical. Actually, this is impossible and transmission tracking errors may be produced, i.e. vector sum 

errors caused by test deviations. The error amplitude and phase change with the frequency. Deviations are mainly 

caused by the following factors: 

 Signal separator; 

 Test cable and adapter; 

 Difference between the reference and test signal paths. 

Transmission tracking errors can be determined and reduced in the following methods. 

 Directly connect Port 1 and 2, with zero length. 

 Measure the signals of Receiver A and R2 or B and R1. 

 Determine transmission tracking errors by comparing the signals of two receivers. 

 Eliminate transmission tracking errors by means of error correction in transmission measurement. 

7.6 Editing of Calibration Kit Definition 

The [Edit calibration kit] dialog box is used to edit the definition of the calibration kit or create a user-defined 

calibration kit. 

● Calibration kit definition··························································································································· 204 

● Custom calibration kit ······························································································································ 204 

● Create calibration kit ································································································································ 204 

● Edit calibration kit ···································································································································· 205 

● [Edit calibration kit] dialog box ················································································································ 206 

● [Add connector] dialog box ······················································································································ 208 

● [Type information] dialog box ·················································································································· 209 

● [Add standard] dialog box ························································································································ 209 

● [Open-circuit device] dialog box ··············································································································· 210 
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● [Short-circuit device] dialog box ··············································································································· 211 

● [Load] dialog box ····································································································································· 211 

● [Through type/transmission line/adapter] dialog box ················································································· 212 

7.6.1 Calibration Kit Definition 

Each standard calibration kit (represented by the standard kit ID) is a specific and accurately defined physical 

device. For example, ID1 of 85056A calibration kit means a 2.4mm male open-circuit device. Standard kits are 

divided into four types: open-circuit device, short-circuit device, load and through type device/adapter/air line. 

Each type of calibration kit is has the specific model structure, including the number and physical characteristics of 

the standard kit. The majority of calibration kits are equipped with a group of adapters subject to accurate phase 

matching. The other standard calibration kits must be defined before use. 

7.6.2 Custom Calibration Kit 

Sometimes you may need to edit the calibration kit definition file or create the user-defined calibration kit. In most 

of measurement applications, the default calibration kit model is suitable for accurate calibration. However, the 

user-defined calibration kit should be created in the following applications. 

 The connector type is different from that defined in the calibration kit model. 

 The standard calibration kit different from the defined is used. For example, use three short-circuit devices of 

different deviations instead of the open-circuit device, short-circuit device and load in one-port calibration. 

 Improve the accuracy of the predefined calibration kit model. If the actual properties of the standard 

calibration kit can be described with the model, the calibration will be more accurate. For example, change the 

load impedance into 50.1Ω, instead of the defined 50Ω. 

To create the user-defined calibration kit, first define the connector type, such as APC7, 3.5mm, APC2.4mm (50Ω), 

etc. Although more than one connector type can be defined, it is preferred to define one connector type for each 

kind of calibration kit. The female and male connectors must be defined separately. 

7.6.3 Create Calibration Kit 

1) Click [Cal] >[Edit calibration kit...]. The [Edit calibration kit] dialog box will appear. 

2) Click [Insert new calibration kit]. The [Edit calibration kit] dialog box will appear. 

a) Input the name of the user-defined calibration kit in the [Calibration kit name] box. 

b) Click [Add] in the connector type zone. The [Add connector] dialog box will appear. 

3) In the [Add connector] dialog box: 

a) Enter the connector name in the name box. 

b) Select the connector type of the calibration kit in the connector type zone: [Female], [Male] or [No Gender]. 

c) Set the minimum and maximum working frequency range of the connector in the frequency range zone. 

d) Enter the characteristic impedance (such as 50Ω) of the connector in the impedance zone [Z0]. 

e) Select the connector medium type in the [Medium] box: coaxial or waveguide. 

f) Check the entered contents and click [OK] to close the dialog box. Then it is not allowed to edit connector 

information. 

g) The connector of the other polarity can be added by click [Add] in the connector type zone of the [Edit 

calibration kit] dialog box and repeated the above steps. 

4) Click [Add] under the [Standard kit] box of the [Edit calibration kit] dialog box. The [Add standard kit] 

dialog box will appear. Select the standard kit to be added: [Open-circuit device], [Short-circuit device], [Load], 

[Through type], [Adapter] and [Transmission line]. Click [OK] to close the [Add standard kit] dialog box. At 

the same time, the [Edit] dialog box corresponding to the selected standard kit will appear. 

5) In the [Standard] (such as open-circuit device) dialog box, enter the definition data. For the limited standard kit, 

the frequency range may be different from that of the connector. Set the frequency range according to the actual 
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minimum and maximum frequency of the standard kit, and click [OK] to close the dialog box. 

6) Repeat Step 4) and 5) to define all standard calibration kits among custom calibration kits. 

7.6.4 Edit calibration kit 

1) Click [Cal] > [Edit calibration kit...]. The [Edit calibration kit] dialog box will appear. 

2) Click the calibration kit to be modified in the dialog box. 

3) Click [Edit calibration kit]. The [Edit calibration kit] dialog box will appear. Edit the calibration kit. 

 

Fig. 7.9 [Edit calibration kit] Dialog Box 

4) [Open] button 

Open the calibration kit list and calibration kit definition file. 

5) [Save as] button 

Save the current calibration kit list and calibration kit definition as a file. 

6) [Restore Defaults] button 

Reinstall all calibration kits supported by the network analyzer. 

7) Calibration kit installation zone 

a)[Import Kit] button 

Recall the [Open] dialog box and import the calibration kit definition in the hard disc or other drives. 

b) [Save as] button 

Open the [Save as] dialog box to save the selected calibration kit definition. 

c) [Insert New] button 

Open the [Insert New] dialog box to create a new calibration kit definition. 

d) [Edit Kit] button 

Open the [Edit Kit] dialog box and modify the selected calibration kit definition. 

e) [Delete] button 

Delete the selected calibration kit definition. 

f) [Restore Kit] button 
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Restore the modification of the selected calibration kit into the factor setting state. 

g) [∧] and [∨] button 

Click the [∧] and [∨] button to select the calibration kit. 

7.6.5 [Edit Kit] Dialog Box 

 

Fig. 7.10 [Edit calibration kit] Dialog Box 

1) Calibration kit identification zone 

a) [Kit Number] box 

Display or edit the ID number of the existing calibration kit (or the inserted new calibration kit). 

b) [Kit Name] box 

Display or edit the name of the calibration kit. 

c)[Kit Description] box 

Display or edit the characteristic description of the calibration kit. 

2) Connector type zone 

a)[Connectors] box 

Click the [Connectors] box or arrow button to select the connector type. 

b)[Add] button 

Click the [Add] button. The [Add] dialog box will appear. Add the new connector type of the calibration kit. 

c)[Change] button 

The [Change] dialog box will appear. Modify the connector name. 
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Fig. 7.11 [Change connector name] Dialog Box 

3) Class zone 

a)[Calibration method] box 

Click it to select the calibration method corresponding to the type. 

b)[Edit type] button 

Click it and the [Type information] dialog box to set the type of the calibration kit. 

4) Standard zone 

a) [Cal Kit] box 

Display the ID, name and description of the calibration kit supported by the analyzer at present. 

b) [Add] button 

The [Add standard] dialog box will appear. Add the new definition of calibration standard. 

c) [Edit] button 

Click it and the [Standard (such as the open-circuit device, short-circuit device, load, through type 

connector/air line/adapter)] dialog box will appear. Modify the definition of the selected standard calibration kit. 

d) [Delete] button 

Delete the definition of the selected standard calibration kit. 

e) [Delete All] button 

Delete the definitions of all standard calibration kits. 

f) [∧] and [∨] button 

Select the standard calibration kit. 
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7.6.6 [Add Connector] Dialog Box 

 

Fig. 7.12 [Add connector] Dialog Box 

1) Identification zone 

a) [Connector Family] box 

Define the name of the calibration kit connector. 

b) [Description] box 

Define the characteristic description of the calibration kit connector. 

2) Frequency Range 

a) [Min Freq] box 

Define the allowable minimum frequency of the standard calibration kit in calibration. 

b) [Max Freq] box 

Define the allowable maximum frequency of the standard calibration kit in calibration. 

3) Connector type zone 

Select the connector polarity of the standard calibration kit: [Female], [Male] and [No Gender]. 

4) Impedance zone 

Define the characteristic impedance of the standard calibration kit. 

5) Media zone 

Define the media of the standard calibration kit: [Coax] or [Waveguide]. 
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7.6.7 [Calibration Kit Class] Dialog Box 

 

Fig. 7.13 [Add connector] Dialog Box 

1) Calibration Kit Class zone 

Select the calibration type to be edited or observed. 

2) [>>] and [<<] button 

Click the [>>] and [<<] button to add or delete the standard calibration kit of the selected type or select the standard 

calibration kit in the [Unselected standard] box. Click the [>>] button to add the selected standard calibration kit 

into the [Selected standard] box. Select the standard calibration kit in the [Selected] box. Click the [<<] button to 

delete the standard calibration kit of the selected type. 

3) [∧] and [∨] button 

Adjust the sequence of the standard calibration kits in the [Selected standard] box. All the standard 

calibration kits in the [Selected standard] box will appear in the [Measurement of multiple standard kits] 

dialog box. Select the corresponding standard calibration kit according to the polarity (female or male) of the 

measurement port and the frequency range of the measurement. 

Select the standard calibration kit in the [Selected standard calibration kits] box. Click [∧] or [∨] to 

change the sequence of standard calibration kits. This is usable in the following measurement applications. 

Multiple standard calibration kits are required for one calibration type to cover the whole frequency range. 

The sequence of the standard calibration kits in the [Selected standard calibration kits] box is the same as 

that in the [Measurement of multiple standard kits] dialog box. 

7.6.8 [Add standard] Dialog Box 

 

Fig. 7.14 [Add standard] Dialog Box 
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7.6.9 [Open-circuit device] Dialog Box 

 

Fig. 7.15 [Open-circuit device] Dialog Box 

1) Identification zone 

a) [Standard ID] box 

Display or edit the serial number of the standard calibration kit. 

b) [Label] box 

Display or edit the name of the standard calibration kit. 

c) [Open Description] box 

Display or edit the characteristic description of the standard calibration kit. 

2) Frequency Range 

a) [Min Freq] box 

Define the minimum working frequency of the open-circuit device in calibration. 

b) [Max Freq] box 

Define the maximum working frequency of the open-circuit device in calibration. 

3) Connector zone 

Define the connector polarity of the open-circuit device: male, female or no gender. 

4) Open Characteristics 

Define the fringe capacitance of the open-circuit device with [C0], [C1], [C2] or [C3]. 

5) Delay Characteristics 

a) [Delay] box 

Define the one-way transmission time from the calibration plane to standard calibration kit. 

b) [Loss] box 

Define the energy loss caused by the skin effect of the standard calibration kit, in ohms/S, corresponding to the 

frequency in 1GHz. Respectively measure the loss and delay time of the standard calibration kit at 1GHz and 

calculate the loss by the following equation: 
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c) [ZO] box 

Define the impedance of the standard calibration kit. 

7.6.10 [Short Characteristics] Dialog Box 

 

Fig. 7.16 [Short-circuit device] Dialog Box 

1) Short Characteristics 

Define the residual inductance of the short-circuit device with [L0], [L1], [L2] and [L3]. 

7.6.11 [Load] Dialog Box 

 

Fig. 7.17 [Load] Dialog Box 

 

1) Load type zone 

a) [Fixed Load] radio box 

Select it to set the load type as the fixed load. 

b) [Sliding Load] radio box 

Select it to set the load type as the sliding load. 

c) [Arbitrary Impedance] radio box 

Select it to set the load different from the system impedance Z0. The settings of the complex impedance zone are 

not effective until the [Arbitrary Impedance] radio box is selected. 
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2) Complex impedance zone 

a) [Real] box 

Define the real part of the impedance. 

b) [Imag] box 

Define the imaginary part of the impedance. 

7.6.12 [THRU type/transmission line/adapter] Dialog Box 

 

Fig. 7.18 [THRU/air line/adapter] Dialog Box 

1) Connector zone 

Define the connector types of two ports of the standard calibration kit in the [Port 1] and [Port 2] box 

7.7 Standard Calibration Kit 

This section mainly introduces the basic principle of the calibration kit and some terms in the calibration kit 

definition file. 

1) Calibration kit 

The calibration kit is a set of physical devices known as standard calibration kits. Each standard calibration kit is 

accurately known or predicted according to the frequency change amplitude and phase response. To use the 

definition of the standard calibration kit, the response value must be defined mathematically. Then the calibration 

type corresponding to the error correction model is formed. 

2) Standard calibration kit 

The standard calibration kit is the reference benchmark of error correction measurement. The electrical delay, 

impedance, loss and other characteristics of each standard calibration kit have been accurately defined. The 

definitions are saved in the analyzer and used to calculate various errors of the error model. The analyzer can 

measure the responses of standard calibration kits in calibration, and errors can be calculated by comparing the 

measurement results and the known values of the model. The influence of errors on measurement results is 

eliminated by mathematical operation which is also known as error correction. 

3) Types of standard calibration kit 

Four types of standard calibration kits are provided, corresponding to the structures or types of various definitions. 

The four types are as follows: 

Standard calibration kit Terminal impedance 

Open-circuit device ∞Ω 

Short-circuit device 0Ω 

Load System impedance 

Through type connector/air line/ adapter No terminal impedance 



7 Calibration 

7.8 TRL Calibration 

 213 

 

4) Definition of standard calibration kit 

The definition of the standard calibration kit describes the electrical characteristics and frequency range, including: 

a) Minimum frequency 

Specify the allowable minimum frequency of the standard calibration kit in calibration. 

b) Maximum frequency 

Specify the allowable maximum frequency of the standard calibration kit in calibration. 

c) Z0 

Specify the characteristic impedance of the standard calibration kit, instead of the characteristic impedance of the 

system or the terminal impedance of the standard calibration kit. 

d) Delay 

Specify the uniform length of the transmission line between the defined standard calibration kit and actual 

calibration plane. 

e) Type 

Specify the type of the standard calibration kit: open-circuit device, short-circuit device, load and through type 

connector/air line/adapter. 

f) Loss 

Specify the energy loss caused by skin effects. 

g) Definition of loss model 

The loss unit is ohms/S, corresponding to the frequency unit 1GHz. Respectively measure the loss and delay time 

of the standard calibration kit at 1GHz and calculate the loss by the following equation: 

 

h) Fringe capacitance model of open-circuit device 

The open-circuit device almost has no ideal reflection characteristics as a result of the effects of fringe capacitance 

at high frequency. The phase shift changes with the frequency. Such effects cannot be eliminated. The fringe 

capacitance is defined in the open-circuit device model. The capacitance model is a cubic polynomial function of 

the frequency. The polynomial coefficient is determined according to the actual characteristics of the open-circuit 

device. The equation of the fringe capacitance model is as follows: 

(F refers to the measurement frequency). 

i) Residual inductance model of short-circuit device 

The short-circuit device almost has no ideal reflection characteristics as a result of the effects of residual inductance 

at high frequency. The phase shift changes with the frequency. Such effects cannot be eliminated. The fringe 

inductance is defined in the short-circuit device model. The inductance model is a cubic polynomial function of the 

frequency. The polynomial coefficient is determined according to the actual characteristics of the open-circuit 

device. The equation of the residual inductance model is as follows: 

(F refers to the measurement frequency). 

7.8 TRL Calibration 

TRL (Thru-Reflect-Line) calibration includes a series of calibration technologies, such as TRM (Thru-Reflect-

Match). In the TRL calibration, 12 error coefficients are determined with two standard calibration kits for 

transmission and one standard calibration kit for reflection. In the traditional SOLT calibration, however, 12 error 

coefficients are determined with one standard calibration kits for transmission (T) and three standard calibration 

kits for reflection (SOL). 

1) Why to perform TRL calibration? 



7 Calibration 

7.9 Fixture Compensation Calibration 

214  

 

TRL calibration is accurate and even more accurate than SOLT calibration in some cases. However, only a few 

calibration kits support TRL. TRL calibration is always done when high measurement accuracy is required but the 

calibration kit of the same connector type as the DUT is provided, such as use of the fixture in measurement or use 

of the probe in wafer measurement. In this case, the calibration kit with the same medium as the DUT must be 

created and defined. It is easier to make three TRL standard calibration kits then to make four SOLT standard 

calibration kits. One disadvantage of TRL calibration is that multiple standard calibration kits are required for the 

transmission line in broadband calibration. For example, two standard calibration kits are required for the 

transmission line at 2GHz to 26GHz. The standard calibration kits for the transmission line should be particularly 

long at low frequency. 

2) TRL standard calibration kit 

Three standard calibration kits should be defined for TRL calibration: through type, reflection type and 

transmission type. 

a) Through type standard calibration kit 

The length of the through type can be zero or not zero. The zero-length through type is more accurate as a result of 

no loss or characteristic impedance. The electrical delay of the through type is different from that of the 

transmission type. The through type standard calibration kit with the amplitude and phase defined accurately can be 

used to establish the measurement reference plane. 

b) Reflection standard reflection kit 

The reflection standard calibration kit is a physical device of large reflection coefficient. The reflection standard 

calibration kits connected to two measurement ports must have the same characteristics. If the reflection amplitude 

is not required but the phase is required in calibration, the electrical length of the standard calibration kit must be 

within 1/4 of the wavelength. The reflection standard calibration kit with the amplitude and phase defined 

accurately can be used to establish the measurement reference plane. 

c) Transmission line type standard calibration kit 

The transmission line type standard calibration kit is used to measure the measurement reference impedance after 

calibration. TRL calibration has the following disadvantages as a result of limitations of the transmission line type 

standard calibration kit. 

 The impedance of the transmission line type standard calibration kit must be the same as that of the through 

type standard calibration kit. 

 The electrical length of the transmission line type standard calibration kit must be different from that of the 

through type standard calibration kit. 

 The transmission line type standard calibration kit must have the appropriate electrical length within the whole 

frequency range. The phase difference of the transmission line type standard calibration kit and through type 

standard calibration kit must be between 20° and 160° at each frequency point. Therefore, the actual coverage 

range of a single transmission line is 8:1. In order to cover a wider frequency range, multiple transmission line 

type standard calibration kits are required. 

 The transmission line type standard calibration kit should be particularly long at low frequency. The optimal 

length is 1/4 of the wavelength corresponding to the geometric average frequency (square root of the product 

of the start frequency × stop frequency) within the frequency span. 

d) Matching standard calibration kit 

If the transmission line of specific length or loss cannot be made, use the matching standard calibration kit instead 

of the transmission line. 

 The matching standard calibration kit is a low-reflection terminal to be connected to the port. 

 Use the matching standard calibration kit as the transmission line of high loss and infinite length in calculation 

of the error coefficient of TRL calibration. 

 Change the impedance of the matching standard calibration kit into the reference impedance of measurement. 

7.9 Fixture Compensation Calibration 

The fixture simulator function is used for network port Z conversion, 2-port de-embedding, port matching, and 4-
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port embedding/de-embedding in the mathematical sense. It can be used to simulate various measurements based 

on measurement results in applications, and also rapidly simulate the corresponding measurement results in a real-

time manner. The measurement results of the port with the impedance of 50Ω can be transformed into measurement 

results of any impedance by means of port Z conversion. The double-port fixture de-embedding function can be 

applied to remove any network characteristic between the measurement end face and DUT end face, which is 

defined in the Touchstone data file, so as to extend to the corresponding calibration surface. The port matching 

function is used to transform the original measurement results into the specific simulation result determined by 

inserting the matching circuit between the DUT and test port (one-port). The four-port fixture embedding/de-

embedding function is used to simulate embedding/de-embedding of the four-port fixture, so as to obtain the 

simulation results of the DUT after embedding/de-embedding of part of the network. 

The handling process of the whole fixture simulator is shown in Fig. 7.19. 

 

Fig. 7.19 Handling Process of Fixture Simulator  

Prompt 

S-parameter 

The S-parameter of the fixture or matching circuit can be obtained at first to realize the above functions. It is 

represented by the circuit model or Touchstone data file. Fixture embedding/de-embedding is realized according to 

the known S-parameter of the fixture. 

● Terms of fixture simulator ························································································································ 252 

●  Fixturing On/Off ····································································································································· 252 

● Port matching ··········································································································································· 252 

● Double-port de-embedding ······················································································································· 256 

● Port Z conversion  ···································································································································· 258 

● 4-port embedding/de-embedding ·············································································································· 259 

7.9.1 Terms of Fixtures 

 Fixture 

The fixture refers to a device which is set between the DUT and cable and used to fix the DUT. The S-parameter is 

the key to fixture embedding and de-embedding. However, it is difficult to determine the S-parameter. One of the 

current feasible methods is to establish the fixture model by linear simulation or simulate the fixture with the three-

dimensional electromagnetic structure, and the other method is used to determine the fixture loss and delay time by 

means of port extension. 

 Touchstone data file (SnP file) 

It is a data format created by EEsoft before purchase by HP, or widely known as the S2P format. If multiple ports 

are extended, the file is generally known as the SnP file, where n represents the number of ports. The corresponding 

S-parameters of n ports are saved in this file. 

 Circuit parameter model 
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The impedance of the components and circuits should be matched in the microwave component and circuit design 

phase. Generally, the conjugate matching circuit is composed of the resistance (R), inductance (L), capacitance (C) 

and conductance (G) in the impedance matching design. The parameter form of the conjugate matching circuit is 

referred to as the circuit parameter model. 

7.9.2 Fixturing On/Off 

Menu path: [Cal] > [Fixtures]. Click [Fixturing on/OFF] under [Fixtures]. Then this option will change into 

[Fixturing ON/off]. Thus the fixture simulator function is enabled (in this case, all the functions of the fixture 

simulator are effective). In the default mode, this option is [Fixturing on/OFF], indicating that the fixture function 

is shut down. 

 

Fig. 7.20 Enabling of Fixture Simulation Function 

7.9.3 Port Matching 

This function is used to transform the original measurement results into one characteristic determined by inserting 

the matching circuit between the DUT and test port (one-port). The inserted matching circuit is selected from the 

five preset circuit models or from the circuits defined in the double-port Touchstone file. 

 

Fig. 7.21 Schematic Diagram of Matching Circuit Embedding (take the double-port DUT as an example) 

1) [Port Matching] dialog box 
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Fig. 7.22 [Port Matching] Interface 

a) [Port Matching] drop-down menu 

Select the port number of the matching circuit embedded into the vector network. 

b) [Circuit Parameter] drop-down menu 

Select the embedded matching circuit type. The network analyzer is provided with the following import formats: 

None (with no circuit embedded), 5 circuit parameter models and S2P file. Different schematic diagrams will 

appear in the [Matching Circuit] bar when different types are selected. 

 

Fig. 7.23 [Matching circuit type] Drop-down Menu 
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(1) Series inductance-shunt capacitance (2) Shunt capacitance-series inductance 

   

(3) Shunt inductance-series 

capacitance 

(4) Series capacitance-Shunt 

inductance 

(5) Shunt inductance-shunt 

capacitance 

 

Fig. 7.24 Five Parameter Types of Embedded Matching Circuit 

c) [Custom] button 

This is not available in the default mode. If [User] is selected in the [Matching circuit type] drop-down menu is 

selected, this button will be available. Click this button and select the S2P file for import of fixture S-parameters in 

the pop-up dialog box. After the file is selected, the name of the imported file will be displayed in the box on 

the right side of the [Custom] button. 

 

Fig. 7.25 Selection of S2P File to Be Imported 

d) [Port Reverse] check box 

This is not available in the default mode. If [User] is selected in the [Matching Circuit Type] drop-down menu is 

selected, this check box will be available. Click this check box to turn the port number of the imported S2P file. 
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e) [Circuit parameter mode setting] edit box 

This is not available in the default mode. If one of the five circuit parameter models is selected in the [Matching 

circuit type] drop-down menu, this edit box will be available. Modify the parameter in the edit box to change the 

relevant parameter of the corresponding circuit parameter model. 

f) [Parameter Reset] button 

This is not available in the default mode. If one of the five circuit parameter models is selected in the [Matching 

Circuit Type] drop-down menu, this button will be available. Click this button to reset all the contents in the 

[Circuit Parameter Model Setup] edit box. 

g) [Port matching on/OFF] check box 

Click it to enable the port matching function. 

h) [OK] button 

Click it to make the settings in the dialog box effective for the current active channel. 

2) Steps of port matching 

Menu path: [Cal] > [Fixtures]. Click [Matching Circuit Embedding...] in the [Fixtures] sub-menu. The [Port 

Matching] dialog box will appear. 

Tick [Port matching on/OFF] in the dialog box to enable the port matching function. 

Click the [Port selection] drop-down menu and select the port matching port. 

Select the type of the embedded circuit in the drop-down menu on the right side of [Port selection]. The network 

analyzer is configured with five circuit parameter models and custom mode. The schematic diagram is shown in 

the [Circuit] box. 

If the circuit parameter model is selected as the circuit type, edit the corresponding capacitance, inductance, 

resistance and conductance in the corresponding circuit parameter bar. Click [Parameter Reset] to recover the 

default parameter. If ―User-defined‖ is selected as the circuit type, the [Custom] button will be available. Click the 

[Custom] button and select the S2P file to be used in the pop-up dialog box. The file name will be displayed in the 

lateral square box. Thus the [Port Reverse] check box will appear. Click this check box to customize port turning 

in the S2P file. 

Click [OK] to complete the setting. 

7.9.4 2-port De-embedding 

The network de-embedding function can be used to eliminate the characteristics of any network defined by the 

Touchstone data file between the measurement end face and DUT end face, so as to extend the corresponding 

calibration plane. 
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Fig. 7.26 Schematic Diagram of Fixture De-embedding (take the double-port DUT as an example) 

1) [2-port De-embedding] dialog box 

a) [Port selection] drop-down menu 

Select the vector network port number of the fixture to be de-embedded. 

b) [De-embedding Type] drop-down menu 

Select the de-embedding type in the drop-down menu on the right side of [Port selection]. The network analyzer is 

configured with the user-defined de-embedding type. The contents in the schematic diagram will change if different 

types are selected. 

c) [Load File] button 

This is not available in the default mode. If [User] is selected in the [De-embedding Type] drop-down menu, this 

button will be available. Click this button and select the S2P file for import of the fixture S-parameter in the pop-up 

dialog box (as shown in Fig. 7.25). After the file is selected, the file name will be display in the box on the right 

side of the [Load File] button. At the same time, the relevant maximum/minimum frequency will be updated on the 

frequency range display bar of the vector network port and file. 

 

Fig. 7.27 [Double-port fixture de-embedding] Interface 

d) [Port Reverse] check box 

This is not available in the default mode. If [User] is selected in the [De-embedding type] drop-down menu, this 

check box will be available. Click this check box to turn the port number of the imported S2P file. 

e) [De-embedding on/OFF] check box 
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Click it to enable the double-port fixture de-embedding function. 

f) [OK] button 

Click it to make the settings in the dialog box effective for the current active channel. 

2) Steps of double-port fixture de-embedding 

Menu path: [Cal] > [Fixtures]. Click [2-port De-embedding...] in the [Fixtures] sub-menu. The [Double-port 

Fixture De-embedding] dialog box will appear. 

Click the [De-embedding on/OFF] button in the dialog box to enable the double-port fixture de-embedding 

function. 

Click the [Port selection] drop-down menu and select the port for fixture de-embedding. 

Select the de-embedding type in the drop-down menu on the right side of [Port] selection. The network analyzer is 

configured with the user-defined de-embedding type. 

If [User] is selected in the [De-embedding Type] drop-down menu, this button will be available. Click the [Load 

File] button and select the S2P file to be used in the pop-up dialog box. The file name will be displayed in the 

lateral square box. The vector network frequency information and file frequency information will be updated. 

Click the [Port Reverse] check box to turn the power in the custom S2P file. The corresponding schematic 

diagram will change accordingly. 

Click [OK] to complete the setting. 

7.9.5 Port Z Conversion 

The measurement result with the port impedance as the system impedance can be transformed into the 

measurement result of any impedance. 

 

Fig. 7.28 [Port Z Conversion] Interface 

1) [Port Z Conversion] dialog box 

a) [Port selection] drop-down menu 

Select the number of the vector network port for impedance transformation. 

b) [Real] edit box 

Modify the parameter in the edit box to set the impedance value to be obtained by transformation. 

c) [Z Conversion on/OFF] check box 
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Select it to enable the port Z conversion function. 

d) [OK] button 

Click it to make the settings in the dialog box effective for the current active channel. 

2) Steps of port Z conversion 

Menu path: [Cal]> [Fixtures]. Click [Port Z Conversion...] in the [Fixtures] sub-menu. The [Port Z Conversion] 

dialog box will appear. 

Tick the [Impedance Conversion on/OFF] button in the dialog box to enable the port Z conversion function. 

Click the [Port Selection] drop-down menu and select the port for impedance transformation. 

Edit the real part and imaginary part of the impedance to be transformed in the [R (real part of impedance)] and 

[jX (imaginary part of impedance)] edit box. 

Click [OK] to complete the setting. 

7.9.6 4-port Embed/De-embed 

Simulate embedding/de-embedding of the four-port fixture to obtain the simulation results of the DUT after 

embedding/de-embedding of part of the network. 

1) [4-port Embed/De-embed] dialog box 

 

Fig. 7.29 [Four-port fixture embedding/de-embedding] Interface 

a) [Type] drop-down menu 

Select the fixture embedding/de-embedding mode. The vector network analyzer is configured with three network 

models (Mode A, B and C). 
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Fig. 7.30 Three Modes of Fixture Embedding/De-embedding 

b) [Network] drop-down menu 

The network embedding/de-embedding type is the first item of the drop-down menu of Network 1 (Network 

2 is enabled in Mode C). The drop-down menu includes three options: none, de-embedding and embedding. 

c) [Load File] button 

Click this button and select the S4P file for import of the fixture S-parameter in the pop-up dialog box (as shown in 

Fig. 7.25). After the file is selected, the file name will be display in the box on the right side of the [Load File] 

button. 

d) [Port Matching] drop-down menu 

The port selection part includes the vector network port and fixture port. The [Fixture port] drop-down menu is not 

displayed in the default mode. The selected mode and network embedding/de-embedding type will be displayed in 

the schematic diagram. Select the corresponding port relationship to determine the number of the embedding/de-

embedding port and the corresponding relationship to the port for file import. 

e) [Enable on/OFF] check box 

Select this check box to enable the fixture embedding/de-embedding function. 

f) [OK] button 

Click it to make the settings in the dialog box effective for the current active channel. 

2) Steps of 4-port embedding/de-embedding 

Menu path: [Cal] > [Fixtures]. Click [4-port Embed/De-embed...] in the [Fixtures] sub-menu. The [4-port 

Embed/De-embed] dialog box will appear. 

Tick the [Enable on/OFF] button in the dialog box to enable the four-port fixture embedding/de-embedding 

function. 

Click the [Mode selection] drop-down menu and select the embedding/de-embedding network model. The vector 

network analyzer is configured with three network models (Mode A, B and C). 
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Select the embedding/de-embedding type of Network 1 in the drop-down menu of Network 1 (Network 2 is 

enabled in Mode C). 

If embedding or de-embedding is selected, the [Load File] button will be available. Click the [Load File] button 

and select the S4P file to be used in the pop-up dialog box. The file name will be displayed in the lateral square box. 

Click [OK] to complete the setting. 

7.10 Electronic Calibration 

Electronic calibration is a process to obtain system errors by means of standard measurements of the electronic 

calibration kit through the network analyzer and calculation according to the fixed value of the electronic 

calibration kit. The accuracy of electronic calibration is close to that of mechanical calibration. At the same time, 

artificial errors arising from connection of the standard calibration kit in calibration of the vector network analyzer 

can be reduced, thus improving the calibration accuracy, calibration velocity and calibration result consistency and 

reducing the losses of the test port and expensive test cable. 

Each electronic calibration kit is configured with a unique S-parameter saved in the internal memory. In the 

calibration process, the vector network analyzer can recall the standard S-parameter of the electronic calibration kit 

to obtain the vector error coefficient by means of complex measurement and calculation. 

Compared with mechanical calibration, electronic calibration has obvious advantages: 

1) High velocity and automatic operation. All the calibration can be completed by one connection, thus reducing 

the times of calibration kit connection, menu button selection operations, operation time, connector wear and costs 

for maintenance of the test port connector of the test instrument and the calibration kit connector. 

2) Low risk and high measurement accuracy. The requirements for operators are low, and the possibility of errors 

caused by operators is reduced, which is conducive to the promotion of the network analyzer in the military, 

research and production applications. 

3) New technology and high quality. New calibration and error correction technologies are applied to make the 

accuracy higher than that of mechanical calibration. 

 

 

Prompt 

Electronic calibration kit and electronic calibration: 

For more details, refer to the User Manual of 2040X Electronic Calibration Kit. 

 

Attention 

Precautions of electronic calibration: 

1. Do not disconnect or insert or connect the USB interface equipment during communication with the USB 

interface. Do not pull down the USB cable immediately after calibration, as data communication may not be over. 

2. Do not change the cable connection during calibration. Keep the ambient temperature stable in calibration; 

otherwise, calibration indicators will be affected. 
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Fig. 7.31 [Electronic calibration kit] Interface 

Process of electronic calibration: 

A. Connect one end of the USB cable to the USB interface of the electronic calibration kit and the other end to the 

USB interface of the front panel or rear panel of the vector network analyzer. Run the vector network analyzer to 

preheat it for 30min at least. At the same time, the red WAITING indicator of the electronic calibration kit will be 

lit, indicating that preheating of the electronic calibration kit is started. Generally, the double-port electronic 

calibration kit should be preheated for 10min, and the four-port electronic calibration kit for 18min. When the 

internal temperature of the electronic calibration kit reaches the set temperature, the red READY indicator will be 

ON (the preheating time is related to the ambient temperature). 

B. According to the characteristics of the DUT, set the frequency range, intermediate frequency bandwidth, power 

level and other stimulus information of the vector network analyzer. 

C. After preheating, connect the port of the electronic calibration kit to the test port of the vector analyzer through 

the test cable, and execute the required calibration according to the prompts of the vector network analyzer. 

Calibration steps are as follows: 

Step 1: select [Calibration (V)…] in the menu. 
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Fig. 7.32 Calibration Menu 

Step 2: Select [Use Electronic Calibration (ECal)] and click [Next] to enter the electronic calibration function. 

 

Fig. 7.33 Selection of Calibration Type 

Step 3: Select the module and characteristic data of the electronic calibration kit with the [Cal Type Selection…] 

button, as shown in the following figure. 

 

Fig. 7.34 Selection of Electronic Calibration Kit and Characteristic Data 

 

Attention 

Selection of electronic calibration kit and characteristic data: 

If only one electronic calibration kit is connected to the vector network analyzer, the following calibration steps can 

be directly performed without calibration kit selection. 

Step 4: Select the multi-port or one-port calibration in the [Cal Type Selection], as shown in the following figure. 

 

Fig. 7.35 Calibration Port Setting 

Step 5: Tick the [Auto Check] function. 

You can select whether to tick the [Auto Check] function in the ―calibration selection‖ combined box. If this option 

is ticked (default), the vector network analyzer can test the connection of the port of the electronic calibration kit 
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and the measurement port of the vector network analyzer, as shown in the following figure. If this option is not 

ticked, calibration will be done directly according to the set connection mode. (If the frequency measurement range 

set in the vector network analyzer is beyond the frequency range of the electronic calibration kit, the information 

shown in the following figure will appear. Exit the window, reset the calibration frequency range and repeat the 

electronic calibration process). 

  

Fig. 7.36 [Auto Check] Option 

Step 6: Click [Meas] to start the measurement of electronic calibration. If necessary, click the [Abort Sweep] to 

interrupt sweep. 

 

  

Fig. 7.37 Start and Abortion of Sweep 

Step 7: Click [OK] to save calibration results after measurement. 

  

Fig. 7.38 Completion of Calibration 

Step 8: Connect the test cable and check the through curve (S21) after calibration. You can roughly observe 

whether calibration is successful. If the vector network analyzer has good hardware performance, the amplitude of 

the through curve will be within plus or minus 0.2dB. Remove the test cable from the port of the electronic 

calibration kit and connect the DUT to start measurement. 
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8 Basis of Network Measurement 
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8.1 Reflection Measurement 

Reflection measurement is an important part of network measurement. At first, the reflection measurement will be 

introduced. In order to better understand reflection measurement, the optical wave is applied to simulate the 

traveling wave transmission along the transmission line. 

If any optical element such as the lens is set, part of light will be reflected by the lens, but the majority of light will 

be transmitted continuously through the lens. If the surface of the optical element is a mirror, the majority of light 

will be reflected, and only a little light will be transmitted or no light will be transmitted. 

 

1. Incident light 2. Reflected light 3. Transmitted light 

Fig. 8.1 Light Reflection and Transmission 

The RF signal will be reflected if the impedance of two connectors is different from each other. Reflection 

measurement is a process to measure the ratio of the reflected signal and incident signal. The incident signal is 

measured by Receiver R, and the reflected signal is measured by Receiver A. Therefore, the result of reflection 

measurement is a ratio of A and R (i.e. A/R). The reflection characteristic of the DUT can be fully quantified with 

the signal amplitude and phase information of Receiver A and R. Among the S-parameter terms, S11 represents the 

reflection of Port 1 (input port) of the DUT and S22 represents the reflection of Port 2 (input port) of the DUT. 

Reflection measurement aims to ensure the efficient transmission of RF energy. If energy is reflected, only a little 

energy will be transmitted to the expected place. In addition, if too much energy is reflected, the device may be 

burnt, such as the output power amplifier. 

● Reflection measurement expression ·········································································································· 228 

● Summary of reflection measurement expression ······················································································· 230 

8.1.1 Reflection Measurement Expression 

The data of reflection measurement can be expressed in various methods according to the requirements. Various 

expressions are based on the same reflection measurement data and can be respectively displayed in one or more 

graphic format(s). See details in ―4.7 Selection of Data Format and Scale‖. 

8.1.1.1 Return Loss 

A simple way to express reflection data is the return loss, which is a scalar in dB. The return loss refers to the dB 
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difference between the reflected signal and incident signal. If the impedance matches exactly, the return loss will be 

infinite. For the open, short or no-loss reactive circuit, the return loss is 0dB. For example, if the logarithmic format 

is applied in measurement, the reflection measurement data will be -18dB, indicating that the return loss is 18dB 

(ignoring the minus sign). 

8.1.1.2 Standing Wave Ratio 

The standing wave will be produced if two groups of waves are transmitted in the opposite directions along one 

transmission line. In this case, the voltage standing wave ratio (VSWR or SWR for short) can be applied. SWR is 

defined as the ratio of the maximum RF envelope voltage and minimum RF envelope voltage at the given 

frequency. It is a scalar. If the impedance matches exactly, SWR is 1. For the open, short or no-loss reactive circuit, 

SWR is infinite. 

8.1.1.3 Reflection Coefficient 

Another way to express reflection measurement is the reflection coefficient (Γ), including the amplitude and phase 

information. The amplitude part of Γ is referred to as ρ. The reflection coefficient is a ratio of the reflection voltage 

and incident voltage. The ρ value range is 0-1. If the transmission line is connected with characteristic impedance, 

all the energy will be transmitted to the load, with no energy reflection. ρ＝0. If the transmission line is connected 

through the open-circuit device or short-circuit device, all the energy will be reflected. ρ＝1. There is no unit of 

measurement for ρ. 

Below is the phase information of reflection. If the signal wavelength is larger than the conductor length at high 

frequency, the reflected wave can be regarded as the wave transmitted in the direction opposite to the incident wave. 

The standing wave will be produced in case of mixing of the incident and reflected wave. In this case, the voltage-

enveloped amplitude will change along with the transmission line position. 

If the transmission line is connected with characteristic impedance, with no reflection signal, the energy will be 

transmitted in one direction along the transmission line, and all the energy of the incident signal will be transmitted 

to the load, as shown in the following figure. 

 

Fig. 8.2 Signal Transmission of Transmission Line Connected through Load 

If the transmission line is connected through the short-circuit device, all the energy will be reflected to the signal 

source, and the amplitude of the reflected wave will be the same as that of the incident wave (ρ=1), and the voltage 

of both ends of the short-circuit device is 0. The phase of the reflected voltage wave of the short-circuit point is the 

same as that of the incident voltage wave (180-degree difference), and the voltage will be counterbalanced. 

 

Fig. 8.3 Signal Transmission of Transmission Line Connected through Short-circuit Device 

If the transmission line is connected through the open-circuit device, all the energy will be reflected to the signal 

source, the amplitude of the reflected wave is the same as that of the incident wave (ρ＝1), no current flows 

through the open-circuit device, and the reflected voltage wave is the same as the incident voltage wave. 
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Fig. 8.4 Signal Transmission of Transmission Line Connected through Open-circuit Device 

If the transmission line is connected through a 25Ω resistor, part of the energy will be absorbed, and part of the 

energy will be reflected to the signal source. The amplitude of the reflected wave is 1/3 of that of the incident wave. 

The voltage is subject to 180-degree difference at the resistor. The phase relationship changes with the distance of 

the end resistor along the transmission line. The valley of the standing wave figure is not approaching zero, and the 

peak is smaller than that of the open-circuit device and short-circuit device. 

 

Fig. 8.5 Signal Transmission of Transmission Line Connected through 25Ω Resistor 

8.1.1.4 Impedance 

The impedance is another way to express the reflection data. For impedance details, refer to the ―Smith Chart 

Format‖ section of ―4.7 Selection of Data Format and Scale‖. 

8.1.2 Summary of Reflection Measurement Expression 

Various kinds of reflection data are calculated based on the same measurement data. The data relationship is shown 

in Fig. 8.6. 

 

Fig. 8.6 Relationship of Reflection Expressions 

8.2 Phase Measurement 

8.2.1 What is phase measurement? 

It is important to understand the amplitude and phase information of the DUT to integrate high-level devices. 

Similar to the amplitude measurement, the S-parameter is also applied in phase measurement. Phase measurement 
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is a kind of relative (ratio) measurement instead of absolute measurement. The phase of the signal into the device 

(incident signal) and the response signal are compared in phase measurement. The response signal may be reflected 

signal or transmitted signal. Given that the analyzer is accurately calibrated, the phase difference (i.e. phase shift) 

of two signals is the measurement result of phase characteristics of the DUT. The following figure shows the phase 

deviation between the incident signal and transmitted signal observed through the oscilloscope. 

 

Fig. 8.7 Phase Shift between Signals 

8.2.2 Why to perform phase measurement? 

Phase measurement is an important function of the vector network analyzer. Fig. 8.8 shows the reasons for accurate 

measurement of the amplitude and phase. 

 

Fig. 8.8 Reasons for Accurate Amplitude and Phase Measurement 

If the element and circuit are used to transmit signals in the communication system, signal distortion must be within 

the normal limits. The signal distortion can be divided into two types. 

1) Linear distortion: refer to the failure to keep the flat amplitude and linear phase shift within the relevant 

frequency range as a result of frequency changes. 

2) Nonlinear distortion: refer to the new spectrum component of the circuit, such as AM-PM transformation. 

It is important to accurately measure the amplitude and phase characteristics of the element or circuit, so as to 

ensure the efficient transmission or adsorption of energy in the circuit and prevent the distortion in signal 

transmission. A good example to prevent distortion is to measure the complex impedance of the antenna. 

8.2.3 Use of Phase Format of Analyzer 

The phase format of the analyzer is used to display the phase changes over the frequency or power. The phase 

difference beyond ±180° between the reference signal and response signal cannot be measured by the analyzer. If 

the phase value varies from +180° to -180°, the sawtooth type phase measurement trace will be displayed on the 

analyzer. The sawtooth waveform may not reach +180° or -180° sometimes in measurement at the discrete 

frequency points. The data points of +180° and -180° may not be the points of sweep measurement. 
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Phase Format 

 

Fig. 8.9 Phase Format of Analyzer 

8.2.4 Type of Phase Measurement 

1) Complex impedance: the complex impedance data such as the resistance, reactance, amplitude and phase can be 

determined by S11 and S22 measurement and observed in the Smith chart and polar coordinate format. See details in 

―8.4 Complex Impedance‖. 

2) AM-PM transformation: the unexpected phase deviation may be caused by system amplitude changes in the 

AM-PM transformation measurement, defined as the output phase change of each 1dB increase of the power input 

into the amplifier, in degree/dB. Measurement is done at the 1dB gain compression point. See details in ―8.7 AM-

PM Transformation‖. 

3) Linear phase deviation: refer to the phase distortion produced in measurement of the DUT. Ideally, the phase 

shift of the DUT is linear to the frequency. The deviation produced relative to the theoretical phase deviation is 

referred to as the linear phase deviation (also known as the phase linearity). See details in ―8.9 Linear Phase 

Deviation‖. 

4) Group delay: it is another way to measure the phase distortion of the device. The transition time of the signal of 

specific frequency through the device is measured, and the group delay is calculated according to the derivative of 

the measured phase response. See details in ―8.5 Group Delay‖. 

8.2.5 Linear Phase Deviation and Group Delay 

The linear phase deviation and group delay are phase information of the measurement device but for different 

purposes. 

1) Advantages of linear phase deviation measurement: 

a) The noise is lower than that of group delay measurement. 

b) The characteristics of the device transmitting phase-modulated signals can be better represented. In this case, it is 

more appropriate to use the phase as the unit instead of the second. 

2) Advantages of group delay measurement: 

a) Compared with the linear phase deviation measurement, phase distortion can be explained more easily. 

b) The characteristics of the DUT can be represented accurately. The phase ripple slope is calculated by the 

analyzer in group delay measurement and depends on the ripple quantity within the unit frequency. Phase responses 

with the same phase ripple peak-peak value are compared. Large phase slope response may result in large group 

delay changes and signal distortion. 

8.3 Amplifier Parameter Specifications 

This section introduces the measurement parameters of the amplifier. 

8.3.1 Gain 

The gain refers to the ratio between the output power (to the characteristic impedance load) and input power (from 

the characteristic impedance source) of the amplifier and can be calculated by the following equation. 
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The output power of the amplifier is proportional to the input power in the case of small signal. The small-signal 

gain is within the linear zone. With the power level of the input signal increasing, the amplifier will be saturated, 

and the output power will reach the limit, leading to gain decline. The large signal gain is within the nonlinear zone. 

See details in ―Appendix 5 Gain Compression Measurement of Amplifier‖. 

8.3.2 Gain Flatness 

The gain flatness refers to the gain change of the amplifier within the working frequency range. See details in ―8.10 

Small Signal Gain and Flatness‖. 

8.3.3 Reverse Isolation 

Reverse isolation is applied to measure the transmission between the output end and input end. Similar to gain 

measurement, only the stimulus signal is applied to the output end of the amplifier. See details in ―8.9 Reverse 

Isolation‖. 

8.3.4 Gain Drift Changes over Time (temperature and bias) 

The gain drift refers to the maximum gain change over time, with the other parameters unchanged. It is a function 

of the time. The gain drift related to other parameters can be measured, such as the gain deviation over the 

temperature, humidity and bias voltage. 

8.3.5 Linear Phase Deviation 

Refer to the deviation of linear shifts. Ideally, the phase shift of the amplifier is a linear function of the frequency. 

See details in ―8.8 Linear Phase Deviation‖. 

8.3.6 Group Delay 

The group delay refers to the transition time of the signal through the amplifier. It is a function of the frequency. 

The ideal linear phase shift has a constant change rate over the frequency. In this case, the group delay is a constant. 

In the actual measurement, the group delay is calculated by the following equation: 

 

See details in ―8.5 Group Delay‖. 

8.3.7 Return Loss (standing wave ratio, ρ) 

The return loss refers to the reflection matching of the amplifier relative to the system impedance Z0 in 

measurement of the input or output port. It can be calculated by the following equation: 
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8.3.8 Complex Impedance 

The amount of energy reflected by the device is associated with the complex impedance of the device. The complex 

impedance is composed of the resistance component and reactance component and can be calculated with the 

system characteristic impedance and reflection coefficient by the following equation: 

 

See details in ―8.4 Complex Impedance‖. 

8.3.9 Gain Compression 

The amplifier is configured with one gain zone, in which is the gain is not associated with the input power level (i.e. 

small signal gain). When the power level increases to a certain value, the amplifier will be saturated, which may 

result in gain declining. 

Gain compression is determined by measuring the 1dB gain compression point of the amplifier. The 1dB gain 

compression point refers to the output power at which the amplifier gain decreases by 1dB relative to the small 

signal gain. Generally, the measured value is used to describe the power output capacity of the amplifier. See 

details in ―Appendix 5 Gain Compression Measurement of Amplifier‖. 

8.3.10 AM-PM Transformation Coefficient 

The output signal phase change arising from the input signal amplitude change is measured in AM-PM 

transformation. The unit of AM-PM transformation is degree/dB. Measurement is done at the 1dB gain 

compression points. See details in ―8.7 AM-PM Transformation‖. 

8.4 Complex Impedance 

The complex impedance data can be observed in S11 or S22 measurement of the DUT, including the phase and 

amplitude information such as the series resistance, series reactance and impedance, in the Smith chart or polar 

coordinate format. 

8.4.1 What is complex impedance? 

The complex impedance data can be determined according to the S11 or S22 measurement results of the DUT. The 

reflection power of the DUT is associated with the impedance of the device and measurement system. For example, 

the complex reflection coefficient (Γ) will not be 0 unless the impedance of the device and system is fully identical 

(that is, the efficiency of power transmission from the source to load is the highest). Each Γ value corresponds to 

the unique complex impedance of the device. The complex impedance is a function of the frequency. 

 

Where, ZL is the impedance of the DUT, and Z0 is the characteristic impedance of the measurement system. The 

Smith chart format and polar coordinate format are the most suitable for impedance measurement. See details in the 

―Smith chart format‖ and ―Polar coordinate format‖ of ―4.7 Selection of Data Format and Scale‖. 

8.4.2 Improvement of Impedance Measurement Accuracy 

1) If the full scale value is 1, Smith chart is the easiest to understand. 

2) If the marker is used in the Smith chart or polar coordinate format, the discrete marker mode can be applied to 

obtain higher measurement accuracy. 

3) The uncertainty of reflection measurement is influenced by the following factors: 

a) Direction 

b) Reflection tracking 

c) Source matching 

d) Load matching 

The influence of these factors can be reduced in the full double-port calibration. If the output end of the DUT is 
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connected with a high-quality load, the same measurement accuracy can be achieved by means of one-port 

calibration. 

 

Fig. 8.10 Connection in Impedance Measurement 

1) If the DUT is connected between two ports of the analyzer after one-port calibration, it is recommended to 

connect a 10dB attenuator to the output end of the DUT to improve the measurement accuracy. If the full double-

port calibration has been done, the attenuator is not required as the load matching error is modified in the full-port 

calibration. 

2) If the double-port device is connected to one port of the analyzer after one-port calibration, a high-quality load 

(such as the standard load of the calibration kit) must be connected to the output port of the device. 

8.4.3 Steps of Complex Impedance Measurement 

1) Reset the analyzer. 

2) Set and calibrate the analyzer. 

3) Connector shown in Fig. 8.10 for S11 or S22 measurement. 

4) Observe the impedance data: 

a) Select the Smith chart format. 

b) Set the scale of the displayed measurement results to facilitate observation. 

c) Open the marker, and move the marker along the trace to read the resistance and reactance component of the 

complex impedance of the data point. 

d) Print or save the data. 

5) Observe the admittance data (if necessary): 

a) Open the marker and select the G+jBmarker format to read the admittance data. 

b) Set the scale of the displayed measurement results to facilitate observation. 

c) Move the marker along the trace to read the conductance and susceptance component of the complex admittance 

of the data point, in siemens (S). 

d) Print or save the data. 

6) Observe the amplitude and phase of the reflection coefficient: 

a) Select the Smith chart or polar coordinate format. 

b) Open the marker and select the logarithmic/phase or linear/phase format. 

c) Set the scale of the displayed measurement results to facilitate observation. 

d) Move the marker along the trace to read the amplitude and phase information of the data point. 

e) Print or save the data. 
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8.5 Group Delay 

The phase distortion of the DUT is measured in group delay measurement. The group delay refers to the actual 

transition time of the signal through the DUT and changes over the frequency. The aperture of group delay 

measurement must be specified to describe the group delay indicator. 

8.5.1 What is group delay? 

The group delay refers to: 

1) Measure of phase distortion of the device. 

2) Relationship between the signal transition time through the device and the frequency. 

3) Derivative of the phase characteristic of the device relative to the frequency. 

 

Fig. 8.11 Phase Shift and Group Delay 

Group delay 
 

Φ is in radian, ω in radian/second, θ in degree and f in Hz. 

The phase characteristic of the device includes the linear phase shift component and high-order phase shift 

component. 

1) Linear phase shift component: refer to the average transition time of the signal, indicating the electrical length of 

the device. 

2) High-order phase shift component: refer to the transition time change over the frequency, a cause of signal 

distortion. 

 

Fig. 8.12 Group Delay 

In the group delay measurement: 

1) The linear phase shift component represents the average group delay. 

2) The high-order phase shift component represents the average group delay deviation (group delay ripple). 

3) Similar to the linear phase deviation resulting in distortion, the group delay deviation will also result in signal 

distortion. 

4) The trace of group delay measurement indicates the passing time of each frequency signal through the DUT. 

The group delay of the analyzer is calculated in the following methods: 

Group delay 
 

Φ is in radian, ω in radian/second, θ in degree and f in Hz. 
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1) Calculate the phase change (-dΦ) according to the phase data. 

2) Use the specified frequency aperture as the frequency change (dω). 

3) Using the above two values, calculate the approximate value of the phase change rate over the frequency. The 

approximate value is the group delay (assuming that the phase changes linearly within the specified frequency 

aperture). 

8.5.2 Why to measure the group delay? 

 

The group delay is more accurate than the linear phase deviation to represent the phase distortion, as shown in Fig. 

8.13. 

Fig. 8.13 Comparison of Group Delay and Linear Phase Deviation 

1) The upper half part of the figure shows the measurement results of the linear phase deviation of Device 1 and 2. 

Although the trace shape varies, the linear phase deviations of both devices are identical. 

2) The lower half part of the figure shows the measurement results of the group delay of Device 1 and 2. The group 

delay of Device 1 is different from that of Device 2, as it is calculated by the analyzer according to the phase ripple 

slope. The phase ripple slope depends on the ripple quantity within the unit frequency. 

8.5.3 What is the aperture of group delay? 

The analyzer will measure the phase of two adjacent frequency points and calculate the phase slope in group delay 

measurement. The frequency interval (frequency interval) between two phase measurement points is referred to as 

the aperture. Different group delay values can be obtained by changing the aperture. This is why the aperture of 

measurement must be known before comparison of group delay data. 

The default aperture of group delay of the analyzer is the frequency interval of two adjacent sweep points. Apply 

the following two methods to change the aperture: 

1) Change the number of measurement points or the frequency span. 

a) Increase the number of points or reduce the frequency span to narrow the aperture. 

b) Decrease the number of points or increase the frequency span to widen the aperture. 

 

Fig. 8.14 Influence of Group Delay Aperture on Measurement Results 

Attention 

Relationship of the aperture and group delay: 
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If the aperture is too wide and the phase shift of adjacent frequency points is more than 180°, errors will occur in group 

delay calculation. 

2) Apply the smoothing function of the analyzer. 

Perform sweep once, enable the smoothing function and change the value percentage in smoothing settings. This is 

similar to change of the frequency interval between sweep points. This method allows a wider group delay aperture, 

and the phase shift is allowed to exceed 180° within the smoothing aperture. 

Group delay measurement can be done in the following sweep types: 

a) Linear frequency; 

b) Logarithmic frequency; 

c) Segment sweep. 

The group delay aperture depends on the frequency interval and the sweep point density, therefore, it changes in the 

logarithmic frequency and segment sweep mode. 

8.5.4 Improvement of Measurement Accuracy of Group Delay 

It is important to keep the phase difference of adjacent measurement points less than180° during group delay 

measurement; otherwise, the phase and group delay information will be incorrect, as shown in Fig. 8.15. 

Insufficient sampling may occur in measurement of the device of long electrical delay. Adjust the following 

settings until the measurement trace does not change so as to ensure that the phase difference of two adjacent points 

is less than 180°. 

1) Increase the number of points. 

2) Reduce the frequency span. 

 

Fig. 8.15 Influence of Insufficient Sampling on Group Delay Measurement 

The frequency response is a main error of group delay measurement. This error can be significantly reduced by 

means of through type response calibration. Perform the full double-port calibration to realize higher accuracy. For 

the amplifier, the response may vary with the temperature. Therefore, the test should be done at the working 

temperature of the amplifier. 

8.5.5 Steps of Group Delay Measurement 

1) Reset the analyzer. Adjust the source power of the analyzer to test the amplifier. 

a) Set the source power of the analyzer within the linear zone of the analyzer response (generally at least 10dB less 

than the 1dB input compression point). 

b) If required, connect one attenuator to the output port of the amplifier to fully attenuate the output power of the 

amplifier and prevent the receiver at the reception end of the analyzer from compression or burning. 

2) Connect the DUT, as shown in Fig. 8.16. 
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Fig. 8.16 Connection in Group Delay Measurement 

3) Select the S21 measurement mode. 

4) Select the settings corresponding to the DUT, including: 

a) Format: phase. 

b) Scale: automatic scale. 

c) Number of measurement points: select the appropriate number to avoid insufficient sampling. 

5) Remove and calibrate the DUT. 

6) Reconnect the DUT. 

7) Set the group delay display format and the scale of measurement display to realize the best observation effect. 

8) Increase the aperture and reduce the noise on the trace by the smoothing function of the analyzer. At the same 

time, keep meaningful details. Take the following steps to increase the aperture: 

a) Enable the smoothing function of the analyzer. 

b) Change the smoothing aperture (max. 25% of the frequency span). 

9) Read the group delay of the relevant frequency through the marker. 

10) Print or save the data. 

8.6 Absolute Output Power 

The absolute output power is the relationship between the displayed absolute power (dBm or W) and frequency. 

8.6.1 What is the absolute output power? 

The absolute output power is the power of the reception port of the analyzer. This is the absolute power, not based 

on the incident power or source power (or the ratio). The value indicated on the longitudinal axis of the grid is in 

dBm in the logarithm amplitude format. It is the power tested based on 1mW. 

0dBm=1mW 

-10dBm=0.1mW 

+10dBm=10mW 

The value indicated on the vertical axis of the grid in the logarithm amplitude format is in W. 

8.6.2 Why to measure the absolute output power? 

If the absolute power instead of the relative power must be used as the amplifier output, the absolute output power 

must be measured. In gain compression measurement, the absolution output power of the amplifier should be 

measured based on 1dB compression. In order to improve the measurement accuracy, considerations must be given 

to the following factors: 

1) If necessary, fully attenuate the output power of the amplifier. Too high power may lead to the following results: 

a) The output power is higher than the input compression level of the receiver of the analyzer, which may lead to 

inaccurate measurement results. 
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b) The receiver of the analyzer may be burnt. 

2) Attenuate the output power of the amplifier with the attenuator or coupler. 

3) The amplifier has different response values corresponding to temperature differences. The test must be done at 

the working temperature of the amplifier. 

8.6.3 Steps of Measurement of Absolute Output Power 

1) Reset the analyzer. 

2) Select the non-ratio power measurement (the source is set on Port 1 and Receiver B is used for input). 

3) Set the source power of the analyzer as 0dBm. 

4) As shown in Fig. 8.17, connect the amplifier and provide the DC bias. If necessary, use an external attenuator to 

fully attenuate the output power of the amplifier so as to prevent the receiver on Port 2 of the analyzer from 

compression or burning. 

 

Fig. 8.17 Connection in Absolute Output Power Measurement 

5) Select the analyzer settings corresponding to the amplifier to be tested. 

6) Remove the amplifier, and connect the attenuator and cable between two ports. Apply the trace operation 

function and save the data trace into the memory. Apply the data/saving function for normalization. If the 

attenuator and cable are used in amplifier measurement, they must be included in normalization measurement. 

7) Reconnect the amplifier. 

8) Set the scale of measurement display to realize the best observation effect. Read the absolute output power 

corresponding to the frequency through the marker. 

9) Print or save the data. 

8.7 AM-PM Transformation 

AM-PM transformation of the amplifier represents the phase deviation caused by system amplitude changes. 

8.7.1 What is AM-PM transformation? 

AM-PM transformation represents the unexpected phase deviation (PM) caused by system amplitude changes 

(AM). The unexpected phase deviation (PM) in the communication system may be caused for the following reasons: 

1) Accidental amplitude change (AM): 

a) Power fluctuation; 

b) Thermal drift; 

c) Multipath attenuation. 

2) Deliberate signal amplitude modulation: 

a) QAM (quadrature amplitude modulation); 

b) Sudden pulse modulation. 
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AM-PM transformation is generally defined as the output phase change in radian/dB, corresponding to 1dB 

increase of the sweep power applied on the input end of the amplifier (at the 1dB gain compression point). The 

phase response of the ideal amplifier is not associated with the power level of the input signal. 

8.7.2 Why to measure AM-PM transformation? 

AM-PM transformation is a key parameter in the following phase (angle) modulation system. 

1) FM 

2) QPSK 

3) 16QAM 

The unexpected phase deviation (PM) will result in deterioration of the analog signal performance or increase of 

the bit error rate (BER) of the digital communication system. It is easy to measure the bit error rate (BER) of the 

digital system, but this is not helpful to understand the root causes of bit errors. AM-PM transformation is one of 

the main factors resulting in bit errors. Therefore, it is critical to quantify this parameter in the communication 

system. The following I/O figure shows why bit errors are produced in AM-PM transformation. 

 

Fig. 8.18 Bit Errors in AM-PM Transformation 

1) The expected state change is from the small solid-line vector into large solid-line vector. 

2) As a result of AM-PM transformation, the large solid-line vector may end like that shown by the dotted line in 

the actual situation. This is caused by the phase shift arising from changes of the input power level. 

3) For the 64QAM signal (only the quadrant is drawn) shown in Fig. 8.18, bit errors occur in the statistics if the 

noise circles of each state are overlapped. 

8.7.3 Factors Related to Measurement Accuracy 

When the network analyzer is used to measure AM-PM transformation, the frequency of the amplitude modulation 

signal is approximate to the reciprocal of the sweep time. Even if the highest sweep power is set, the modulation 

frequency is low (generally less than 10Hz). This may result in slight temperature changes of the DUT in the sweep 

process, especially the thermal mass of the amplifier is small (typically for the unsealed device). If the nonlinear 

characteristic of the amplifier is sensitive to thermal changes, the measurement result obtained in this method may 

have errors. In order to improve the measurement accuracy, considerations should be given to the following factors. 

1) The amplifier response may vary with the temperature. The test must be done at the working temperature of the 

amplifier. 

2) If necessary, fully attenuate the output power of the amplifier. Too high power may lead to the following results: 

a) The output power is higher than the input compression level of the receiver of the analyzer, which may lead to 

inaccurate measurement results. 

b) The receiver of the analyzer may be burnt. 

3) Attenuate the output power of the amplifier with the attenuator or coupler. 

4) The influence of the frequency response of the attenuator or coupler must be taken into consideration during 

calibration. They are part of the test system and must be included in the calibration process. The influence of such 

accessories can be reduced or eliminated by the perfect technology of error correction. 
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5) The frequency response is an error which plays a dominant role in AM-PM transformation measurement. The 

through type response calibration can be applied to significantly reduce the error. 

8.7.4 Step of AM-PM Transformation Measurement 

1) Reset the analyzer. 

2) Select S21 measurement in the power sweep mode. 

3) Set the start and stop power level of power sweep of the analyzer. The start power level should be within the 

linear zone (generally at least 10dB less than the 1dB compression point) of the amplifier response, and the stop 

power level should be within the compression zone of the amplifier response. 

4) If necessary, use the external attenuator or coupler to fully attenuate the output power of the amplifier and 

prevent the receiver on Port 2 of the analyzer from compression or burning. 

5) As shown in Fig. 8.19, connect the amplifier and provide the DC bias. 

 

Fig. 8.19 Connection in AM-PM Transformation Measurement 

6) Select the analyzer settings corresponding to the tested amplifier so as to perform gain compression 

measurement in the power sweep mode at the selected frequency. See details in ―Appendix 5 Gain Compression 

Measurement of Amplifier‖. 

7) Remove and calibrate the amplifier. The attenuator, coupler and cable used in amplifier measurement must be 

included in calibration. 

8) Reconnect the amplifier, open the marker R and set the marker at the 1dB gain compression point of the 

amplifier. Open the second marker, activate the Δmarker mode, and set the stimulus value of the second marker as -

1dBm. 

9) Change S21 measurement from the logarithmic amplitude format into the phase format (requiring no re-

calibration). 

10) Read the phase difference between the markers. This value is the AM-PM transformation coefficient at the 1dB 

gain compression point. 

11) Print or save the data. 

8.8 Linear Phase Deviation 

The linear phase deviation refers to the phase distortion of the device. The electrical delay function of the analyzer 

is applied in measurement to eliminate the linear part of the phase shift and realize high-resolution nonlinear part, 

i.e. linear phase deviation. 

8.8.1 What is linear phase shift? 

The signal wavelength will decrease with the incident signal frequency increasing during signal transmission. In 

this case, the obvious phase shift will be produced. The phase shift is linear when the phase response of the device 

is proportional to the frequency. The trace indicating the relationship between the phase and frequency on the 

analyzer is an oblique line. The slope is proportional to the electrical length of the device. The phase shift must be 

linear for signal transmission without distortion. 
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8.8.2 What is linear phase deviation? 

In the actual cases, the delay time of many devices corresponding to some frequencies is longer than that 

corresponding to the other frequencies so as to form the nonlinear phase shift, including distortion of many 

frequency component signals. One method to determine the nonlinear phase shift is to measure the linear phase 

deviation. 

As phase distortion is caused by linear phase deviation, the linear part of the phase response should be removed in 

measurement. This can be realized by the electrical delay function of the analyzer. If the electrical length of the 

DUT is removed mathematically, the linear phase deviation or phase distortion will be left. 

8.8.3 Why to measure the linear phase deviation? 

Linear phase deviation measurement has the following advantages: 

a) The measurement result is the phase data, instead of the group delay data in second. The phase data may be more 

usable for the device transmitting modulation signals. 

b) Provide a measurement method with noise lower than that of group delay measurement. 

8.8.4 Use of Electrical Delay Function 

The electrical delay characteristic of the analyzer has the following functions: 

1) Simulate the transmission line of adjustable length and no loss to facilitate the installation in or removal from the 

signal path. 

2) Compensate changes of the electrical length of the DUT. 

3) Make the phase measurement trace on the analyzer flat, to realize the high-resolution observation of the trace 

and find nonlinear details of the phase. 

4) Provide a method to easily observe the linear phase deviation of the DUT. 

 

Fig. 8.20 Observation of Linear Phase Deviation by Electrical Delay Function 

See electrical delay details in ―6.5.1 Electrical Delay‖. 

8.8.5 Factors Related to Measurement Accuracy 

The frequency response is an error which plays a dominant role in linear phase deviation measurement. The 

through type response calibration can be applied to significantly reduce the error. In order to achieve higher 

accuracy, the full double-port calibration should be done. 

8.8.6 Steps of Linear Phase Deviation Measurement 

1) Reset the analyzer. Adjust the source power of the analyzer to test the amplifier. 

a) Set the source power of the analyzer to make the amplifier working within the linear zone (generally at least 

10dB less than the 1dB compression point). 

b) If necessary, use the external attenuator or coupler to fully attenuate the output power of the amplifier and 

prevent the receiver on Port 2 of the analyzer from compression or burning. 

2) Select the S21 measurement mode. 

3) Connect the DUT as shown in Fig. 8.21. 
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Fig. 8.21 Connection in Linear Phase Deviation Measurement 

4) Select the analyzer settings corresponding to the DUT, including the phase format. 

5) Remove and calibrate the DUT. 

6) Reconnect the DUT and set the scale of measurement display to facilitate observation. 

7) Change the electrical delay to make the phase trace flat. 

8) Read the linear phase deviation through the marker. 

9) Print or save the data. 

8.9 Reverse Isolation 

Reverse isolation aims to measure the reverse transmission response from the output to input of the amplifier. 

8.9.1 What is reverse isolation? 

The degree of isolation from the output end to input end of the device is measured in reverse isolation. Reverse 

isolation measurement is similar to positive gain measurement, but with the following differences. 

1) The stimulus signal is applied on the output port of the amplifier. 

2) The response signal is measured at the input end of the amplifier. 

3) The equivalent S-parameter is S12. 

8.9.2 Why to measure reverse isolation? 

The ideal amplifier should have infinite reverse isolation, and no signal is transmitted from the output end back to 

the input end. Actually, the signal may be transmitted through the amplifier in the opposite direction. This kind of 

unexpected reverse transmission may result in the interference of the reflected signal of the output port to the signal 

transmitted forwards. Therefore, it is important to quantify reverse isolation. 

8.9.3 Factors Related to Measurement Accuracy 

As the amplifier generally has high loss in the reverse direction, the attenuator or coupler is not required to protect 

the receiver of Port 1 in reverse transmission measurement. In case of no attenuator, the dynamic range and 

measurement accuracy will be improved. The source power can be increased to improve the dynamic range and 

accuracy. 

 
Warning 

The power must not be overloaded forward sweep or full double-port calibration. 

With the attenuator eliminated and RF power increased, the receiver of Port 2 of the analyzer may be burnt in 

forward sweep. Thus, forward sweep or full double-port calibration must not be done until the forward power is 

low enough, which cannot result in burning of the receiver of Port 2 of the analyzer. 

If the tested amplifier is highly isolated, the level of the reverse signal may be close to the base noise or crosstalk 

level of the receiver. In order to reduce the base noise, the averaging function can be applied. The dynamic range 

and accuracy of measurement can be improved by increasing the averaging times or reducing the intermediate 

frequency bandwidth, at the sacrifice of measurement velocity. 

1) If the measurement accuracy is affected by the crosstalk, the through type response and isolation calibration can 
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be implemented to reduce crosstalk errors. Use the same average factor and intermediate frequency bandwidth 

during calibration and measurement. 

2) The frequency response of the test is a main error source in reverse isolation measurement. It can be eliminated 

by through type response or through type response/isolation calibration. 

3) If the temperature varies, the amplifier response may be thoroughly difference. The test should be done at the 

working temperature of the amplifier. 

8.9.4 Steps of Reverse Isolation Measurement 

1) Reset the analyzer. 

2) Select the S12 measurement type. 

3) Connect the amplifier as shown in Fig. 8.22 and provide the DC bias. 

 

Fig. 8.22 Connection in Reverse Isolation Measurement 

4) Set the analyzer corresponding to the tested amplifier. 

5) Remove and calibrate the amplifier and perform through type response calibration or through type 

response/isolation calibration. 

6) Reconnect the amplifier and set the scale of measurement display to facilitate observation. 

7) Read the reverse isolation value at the corresponding frequency point through the marker. 

8) Print or save the data. 

8.10 Small Signal Gain and Flatness 

The small signal gain refers to the gain of the amplifier within the linear working zone. Generally, it is measured at 

the constant input power within the frequency sweep range. The gain flatness refers to the gain change within the 

specified frequency range. 

8.10.1 What is gain? 

The amplifier gain is defined as the power difference between the output signal and input signal of the amplifier 

(power unit: dBm), given that the input impedance of the amplifier is the same as the output impedance. It is the 

characteristic impedance of the system. 

1) The gain is referred to as S21 among the S-parameter terms. 

2) The gain is expressed as the logarithmic ratio of the output power and input power (dB). 

3) If the input level and output level are expressed in dBm (equivalent to the power 1mW), the gain can be 

calculated by subtracting the output level by the input level. 

4) The amplifier gain generally refers to the minimum gain within the working frequency range. Some amplifiers 

are provided with the minimum and maximum gain at the same time to prevent under-stimulus or over-stimulus at 

subsequent levels of the system. 

8.10.2 What is flatness? 

The flatness refers to the amplifier gain change within the specified frequency range. The amplifier gain change 

may result in distortion of the signal through the amplifier. 
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8.10.3 Why to measure the small signal gain and flatness? 

The gain deviation within the specified bandwidth may result in unequal amplification of frequency components of 

the signal and distortion of the transmitted signal. The small signal gain refers to the amplifier gain at the specific 

frequency of the 50Ω system and the flatness refers to the amplifier gain deviation within the specified frequency 

range of the 50Ω system. 

8.10.4 Factors Related to Measurement Accuracy 

1) If the temperature varies, the amplifier response may be thoroughly difference. The test should be done at the 

working temperature of the amplifier. 

2) If necessary, fully attenuate the output power of the amplifier. Too high output power may lead to the following 

results: 

a) The output power exceeds the input compression level of the receiver of the analyzer, resulting in inaccurate 

measurement results. 

b) The receiver of the analyzer may be burnt. 

3) The output power of the amplifier can be attenuated with the attenuator or coupler. As the attenuator or coupler 

is part of the test, the influence of mismatch and frequency response on the measurement accuracy must be taken 

into consideration in calibration. Proper error correction can be implemented to reduce the influence of such 

accessories. 

4) The frequency response of the test is the most important error source of small signal gain and flatness 

measurement. This kind of error can be reduced significantly by through type response calibration. The 

measurement accuracy can be improved by full double-port calibration. 

5) The dynamic range and accuracy can be improved by reducing the intermediate frequency bandwidth or using 

the measurement averaging function, but at the sacrifice of measurement velocity. 

8.10.5 Steps of Small Signal Gain and Flatness Measurement 

1) Reset the analyzer. 

2) Select the measurement parameter S21. 

3) Set the source power of the analyzer to make the amplifier working within the linear zone (generally at least 

10dB less than the 1dB compression point). 

4) If necessary, use the external attenuator or coupler to fully attenuate the output power of the amplifier and 

prevent the receiver on Port 2 of the analyzer from compression or burning. 

 

5) Connect the amplifier as shown in Fig. 8.23 and provide the DC bias. 

Fig. 8.23 Connection in Small Signal Gain and Flatness Measurement 

6) Set the analyzer corresponding to the tested amplifier. 

7) Remove and calibrate the amplifier. The attenuator, coupler and cable used in measurement must be included in 

calibration. 

8) Reconnect the amplifier. 
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9) Set the scale of measurement display to facilitate observation. Read the small signal gain at the corresponding 

frequency point through the marker. 

10) Observe the peak-peak ripple within the whole frequency range through the marker to measure the gain flatness. 

11) Print or save the data. 
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9 Remote control 

This chapter mainly describes the program control basics, program-control interface and configuration method and 

basic VISA interface programming method of 3672 series vector network analyzers, as well as the concept of I/O 

instrument driver library. to facilitate remote control of the user. Specific contents include: 

● Basis of remote control ····························································································································· 248 

● Remote control port and configuration ······································································································ 260 

● Basic VISA interface programming method ······························································································ 263 

● I/O library ················································································································································ 270 

9.1 Basis of Remote Control 

9.1.1 Remote Control Interface 

The instrument with the remote control function generally supports four kinds of remote control interface: LAN, 

GPIB, RS-232 and USB. Specific port models depend on the instrument functions. 

The remote control interfaces and associated VISA addressing character strings are shown in the following table. 

Table 9.1 Types and VISA Addressing Character Strings of Remote Control Interfaces 

Program Control Interface VISA Addressing Character String 
Description 

LAN 

(LocalAreaNetwork) 
VXI-11 protocol: 
TCPIP::host_address[::LAN_device_name][::INSTR] 

Original socket protocol: 
TCPIP::host_address::port::SOCKET 

Remote control can 

be realized by the 

connecting the 

instrument through 

the network port on 

the rear panel of the 

instrument. For 

details, refer to: 

9.2.1 LAN Interface 

GPIB 

(IEC/IEEEBusInterface) 

GPIB::primaryaddress[::INSTR] Remote control can 

be realized by the 

connecting the 

instrument through 

the port on the rear 

panel of the 

instrument. 

Comply with the 

IEC625.1/IEEE 418 

bus interface 

standard. 

 For details, refer to: 

9.2.2 GPIB interface 

9.1.1.1 LAN Interface 

The vector network analyzer can be controlled remotely by the 10Base-T and 100Base-T LAN computer. Various 

instruments in the LAN are combined into a system for unified control with the computer in the network. In order 

to realize the remote control within LAN, the vector network analyzer should be configured with the port connector, 

network card, network protocol and network service in advance. At the same time, the controlling computer in the 

network should be configured with the instrument control software and VISA library in advance. Three working 

modes of the network card: 

 10Mbit/s Ethernet IEEE802.3; 

 100Mbit/s Ethernet IEEE802.3u; 
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 1Gbit/s Ethernet IEEE802.3ab. 

Connect the controlling computer and vector network analyzer to the common TCP/IP network through the 

network ports. Use the RJ45 cable (shielded or non-shielded Class 5 twisted pair) between the computer and vector 

network analyzer. Use the packet transmission mode in data transmission, as the velocity of LAN transmission is 

high. Generally, the cable between the computer and vector network analyzer must be no more than 100m long 

(100Base-T and 10Base-T). For more details of LAN communication, visit http://www.ieee.org. LAN interfaces 

are introduced below. 

1) IP address 

Ensure that the physical connection is smooth for remote control of the vector network analyzer by LAN. Click 

[Start] in the Menu ->[Control panel]->[Network &Internet]->[Network & Shared service center]->[Change 

adapter setting]->[Local connection], right click [Property]. Open ―Local IP‖ in the menu of the vector network 

analyzer and set the address within the subnet. Example: if the IP address of the master control computer is 

192.168.12.0, the IP address of the vector network analyzer should be 192.168.12.XXX, where XXX is 1 to 255. 

Only the IP address is required to establish the network connector. The VISA addressing character string is as 

follows: 

TCPIP::hostaddress[::LANdevicename][::INSTR] or 

TCPIP::hostaddress::port::SOCKET 

Where： 

 TCPIP refers to the applied network protocol. 

 hostaddress refers to the IP address of the instrument or the host name, used to identify and control the 

controlled instrument. 

 LANdevicename refers to the handle number of the protocol and device (optional). 

– Select the VXI-11 protocol for No. 0 device. 

– Select a new high-velocity LAN instrument protocol for No. 0 high-velocity LAN instrument. 

 INSTR refers to the instrument source type (optional). 

 ―port‖ refers to the socket port number. 

 SOCKET refers to the original network socket resource class. 

Example: 

 If the IP address of the instrument is 192.1.2.3, the effective resource string of VXI-11 protocol is: 

TCPIP::192.1.2.3::INSTR 

 Use the following string for original socket connection: 

TCPIP::192.1.2.3::1024::SOCKET 

Prompt 

Identification of multiple instrument in remote control system 

If multiple instruments are connected in the network, distinguish them with the separate IP address and associated 

resource string. The respective VISA resource string is used by the master control computer to identify the 

instrument. 

2) VXI-11 protocol 

XI-11 standard is based on the ONCRPC (Open Network Computing Remote Procedure Recall) protocol and 

suitable for the network/transmission layer of the TCP/IP protocol. The TCP/IP network protocol and related 

network services are configured in advance. The connection-oriented communication complies with the sequential 

exchange requirements, and connection interruptions can be identified to prevent the loss of information. 

3) Socket communication 
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The TCP/IP protocol is connected to the network analyzer in the network through the LAN socket. Socket is a basic 

approach used in computer network programming, which enables network communication among applications 

employing different hardware and operating systems. In this method, the vector network analyzer is connected to 

the computer through the port for two-way communication. 

Socket is a kind of software specially programmed and has defined the information necessary for network 

communication such as IP address and device port number and integrated some basic operations of network 

programming. Socket can be used as long as the packaged libraries are installed in the OS. Berkeley Socket Library 

applied in UNIX and Winsock Library applied in Windows constitutes the two common socket libraries. 

The socket of the vector network analyzer is compatible with the Berkeley socket and Winsock through the 

application program interface (API). Besides, it is also compatible with other standard socket API. The command 

will be sent by the socket program to control the vector network analyzer through SCPI commands. The socket port 

number of the vector network analyzer must be set before the LAN socket is used. The socket port number of the 

vector network analyzer is 1024. 

9.1.1.2 GPIB Interface 

The GPIB is a kind of remote control interface which is widely applied at present. Various kinds of instruments can 

be connected through GPIB cables to form a test system with the master control computer. In order to realize 

remote control, the master control computer should be configured with the GPIB bus card, drive program and VISA 

library in advance. In the communication process, the controlled instrument is addressed by the master control 

computer according to the GPIB bus address, and the user can set the GPIB address and ID query string. The 

default GPIB communication language is SCPI command. 

Refer to ANSI/IEEE 488.1-1987 and ANSI/IEEE 488.2-1992 for detailed definitions and descriptions on GPIB and 

relevant interface operations. For details, visit the IEEE website http://www.ieee.org. 

The byte is used in information processing of GPIB. The data transmission rate can reach 8MBps. Therefore, the 

velocity of data transmission of GPIB is high. The data transmission velocity is limited by the distance between the 

equipment/system and computer, pay attention to the following items in GPIB connection. 

 At most 15 instruments can be connected through GPIB interfaces. 

 The total length of the transmission cable must not exceed 15m or twice of the number of instruments in the 

system. Generally, the maximum length of the transmission cable between devices must not exceed 2m. 

 For parallel connection of instruments, use ―or‖ connecting lines. 

 Connect the terminal of the IEC bus cable to the instrument or controlling computer. 

9.1.2 Message 

Messages transmitted through the data lines are divided into the following two types. 

1) Interface message 

The low attention line should be installed for communication between the instrument and master control computer, 

and then interface messages can be transmitted to the instrument through the data line. Interface messages must be 

transmitted by the instrument with the GPIB bus function. 

2) Instrument message 

For the structure and grammar of instrument messages, refer to ―5.1.4 SCPI Commands‖. According to the 

transmission direction, instrument messages can be divided into the command and instrument response. Unless 

otherwise specified, the same method should be applied for use of instrument messages with the remote control 

interface. 

a) Command: 

The command (programming message) is a kind of message transmitted by the master control computer to the 

instrument, used for remote control of the instrument function and query of the state information. Commands are 

divided into the following two types: 

 According to the influence on the instrument: 

– Setting command: change the instrument setting state, such as resetting, frequency setting, etc. 
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– Query command: inquire and return data, such as instrument identification or parameter query. The query 

command ends with a suffix question mark. 

 According to the definition in the standard: 

– General command: the function and grammar are defined in the IEEE488.2 standard, and this kind of 

command is suitable for all kinds of instruments, and if possible, used for standard state register management, 

resetting, automatic testing, etc. 

– Instrument control command: a kind of instrument characteristic command, used to realize the instrument 

functions. Example: frequency setting. 

The grammar should comply with the SCPI specifications. 

b) Instrument response: 

The instrument response (response message and service request) is a kind of query result message transmitted by 

the instrument to the computer. This kind of message includes the measurement result, instrument state, etc. 

9.1.3 SCPI Command 

9.1.3.1 SCPI Command Introduction 

SCPI (Standard Commands for Programmable Instruments) is a command set, which is established based on the 

IEEE488.2 Standard and suitable for all instruments. It mainly aims to apply the same programmed commands for 

the same functions to realize the universality of programmed commands. 

The SCPI command is composed of the command head and one or more parameter(s), which are separated by 

spaces. The command head includes one or more key field(s). The command with the suffix question mark is the 

query command. The command can be divided into general command and special command of different 

grammatical structures. The SCPI command has the following features: 

1) Program control commands are applicable to the test function, but not for instrument description. 

2) Program control commands can help to reduce the repetition of similar test functions and ensure the program 

compatibility. 

3) Program control messages are defined in the layer which is not related to the hardware of the physical layer in 

communication. 

4) Program control messages are not related to the programming method and language. The SCPI test program is 

easy to transplant. 

5) Program control commands are scalable to adapt to measurement control of various scales. 

6) The SCPI command is ―live‖ due to the extensibility. For more SCPI details, refer to: 

IEEE Standard 488.1-1987, IEEE Standard Digital Interface for Programmable Instrumentation. New York, NY, 

1998. 

IEEE Standard 488.2-1987, IEEE Standard Codes, Formats, Protocols and Comment Commands for Use with 

ANSI/IEEE Std488.1-1987.NewYork, NY, 1998. 

Standard Commands for Programmable Instruments (SCPI) VERSION 1999.0. 

For details of the program control command set, classification and specifications of 3672 series vector network 

analyzers, refer to: 

1) ―3 Program Control Commands‖ of the program control manual. 

2) ―Appendix A Table of Subsystem-based SCPI Command Classification‖ of the program control manual. 

9.1.3.2 SCPI Command Specifications 

1) General Terms 

The following terms are applicable to this section. In order to better understand the contents, you should know the 

exact definitions of such terms. 

Controller 
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Any computer used to communicate with SCPI devices. The PC, minicomputer or card in a card cage can be used 

as the controller. Also, some intelligent devices can be used as controller. 

Equipment 

Any device supporting SCPI. The majority of devices are electrical measurement or stimulus devices for 

communication through the GPIB interface. 

Program Message: 

A combination of one or more properly formatted SCPI commands. Programming messages instruct a device how 

to measure and output signals. 

Response Message 

A combination of data in specified SCPI formats. Response messages are always transmitted from a device to a 

controller or monitor. Response messages inform the controller of the internal state or measured values of a device. 

Command 

Any command compliant with SCPI standard. Messages control the combination of device commands. Generally, 

the commands consist of keyword, parameter and punctuation. 

Event Command 

Some commands are events and cannot be queried. Generally, there is no front panel key corresponding to the 

event command. The event command is used to trigger an event at the specific time. 

Query 

A special type of command. For query of control equipment, return to the response message conforming to the 

controller grammar requirements. Query string always end with a question mark. 

2) Command type 

The SCPI command is divided into two types: general command and special instrument command. Figure 5.2 

shows the differences of two types of commands. The general command is defined according to the IEEE488.2 

standard, used for macro and state register management, synchronization and data storage. It can be easily 

identified with the star mark in front of the command. For example, *IDN？ , *OPC and *RST are common 

commands. The general command is not the special instrument command and can be explained in the same method, 

regardless of the current path setting. 

The special instrument command is easy to identify with the colon (:). The colon is used at the beginning and 

between key words of the command expression, such as:SENS<cnum>:FREQuency[:CW？]. Based on the internal 

functional modules of the instrument, special instrument commands are divided into corresponding subsystem 

command subsets. For example, the power subsystem (:POWer) includes relevant power commands, and the state 

subsystem (:STATus) includes the state control register commands. 

 

Fig. 9.1 Types of SCPI Commands 

3) Grammar of special instrument command 

A typical command is made up of keywords prefixed with colons (:). The keywords are followed by parameters. 

The following is an example syntax statement: 

[:SOURce]:POWer[:LEVel]MAXimum|MINimum 
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In the above example, ―:POWer‖ is followed by [:LEVel], with no space. ―MINimum|MAXimum‖ behind [:LEVel] 

is the parameter part. A space is used between the command and parameter. For the other parts of the grammar 

expression, see Table 9.2 and 9.3. 

Table 9.2 Special Characters of Command Grammar 

Symbol Meaning Examples 

| 

The vertical line between the keyword 

and parameter means a variety of 

options. 

TRIGger[:SEQuence]:SCOPe 

ALL|CURRent 

―ALL‖ and ―CURRent‖ are optional. 

[] 

The square bracket means that the 

included keywords or parameters are 

optional in the command. 

 Even if the included keywords or 

parameters are ignored, the command 

will be executed. 

TRIGger[:SEQuence]:SCOPe 

ALL|CURRent 

Where, SEQuence is optional. 

<> 

The part in the angle brackets must not 

be used according to the literal meaning 

in the command. The angle brackets 

mean the necessary part. 

TRIGger[:SEQuence]:SCOPe 

<char> 

In this command, <char> must be replaced with the actual 

trigger range string. 

Example: ―:TRIG:SCOPALL‖. 

{} 

The braces mean that the parameter is 

optional. 

[:SOURce]:LIST:POWer 

<val>{,<val>} 

Example: LIST:POWer5 

Table 9.3 Command Grammar 

Character, Keyword and Grammar Examples 

Upper-case lettering indicates the minimum set of 

characters required to execute the command. 

[:SOURce]:FREQuency[:CW]?, FREQ is the short part 

of the command. 

The lowercase character part of the command is optional. 

This flexible format is known as ―flexible listening‖. For 

more information, refer to the ―Command Parameter and 

Response‖ section. 

:FREQuency 

:FREQ, 

:FREQuency or FREQUENCY, both of which are 

correct. 

If a colon is applied between two command mnemonics, 

the current path in the command tree will be moved to 

next layer. Refer to ―Command Tree‖ for more 

information on command paths. 

:TRIGger:OUTPut:POLarity? 

TRIGger is the keyword of the top layer of the 

command. 

Adjacent parameters in the command should be separated 

with commas. The parameters have no influence on the 

path layer and do not belong to the command path part. 

[:SOURce]:LIST:DWELl 

<val>{,<val>} 

The semicolon is used to separate two adjacent 

commands, with no influence on the current command 

path. 

 

:FREQ2.5GHZ;:POW10DBM 

The blank character, such as <space> or <tab>, is 

generally ignored when not used between or in keywords. 

 However, you must use the blank character to separate 

the command and parameter, with no influence on the 

current path. 

―:FREQuency‖ or ―:POWer:LEVel6.2‖ is not allowed. 

―:LEVel‖ and ―6.2‖ must be separated with the space. 

i.e. :POWer:LEVel6.2 

4) Command tree 

Special instrument commands are used in most of remote control programs. To analyze this kind of command, the 

SCPI structure should be similar to the file system, known as the command tree, as shown in Fig. 9.2. 
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Fig. 9.2 Schematic Diagram of Simplified Command Tree 

The top command is the root command, referred to as the ―root‖. Follow the specific path of the tree structure to 

next layer in command analysis. Example: :POWer:ALC:SOURce？ Where, ―:POWer‖ refers to AA, ―:ALC‖ 

refers to BB, and ―:SOURce‖ refers to GG. The whole command path is (:AA:BB:GG). 

The command interpreter, a module of the instrument software, is dedicated to analysis of each received SCPI 

command. It is used to divide the command into separate command elements according to a series of rules to 

distinguish command tree paths. The current command should be kept unchanged after analysis, so as to analyze 

the subsequent command more rapidly and efficiently as the same command keyword may be used in various paths. 

The current command path should be set as the root after the instrument is started or reset (*RST). 

5) Command parameter and response 

SCPI defines different data formats for use in program and response messages. It does this to accommodate the 

principle of forgiving listening and precise talking. Refer to IEEE488.2 for more information. Forgiving 

listening means the command and parameter formats are flexible. 

Example: power level command of the vector network analyzer: 

SOURce<cnum>:POWer<port>[:LEVel][:IMMediate][:AMPLitude]<num>,[src] 

The following commands are used to set the power level: 

:SOURce:POWer:LEVel:IMMediate:AMPLitude-5, :SOURce:POWer-5, 

:SOUR:POW:LEV:IMM:AMP-5, :SOUR:POW-5. 

Various parameter types correspond to one or more response data type(s). The numeric type of the parameter will 

change into the data type in query. Response data are accurate, strictly referred to as ―precise talking‖. 

For example, if the setting is -5dBm in the power level (:SOURce:POWer?) query, the returned response data will 

be -5.00000000000e+000 no matter the setting command is ―:SOUR:POW:LEV:IMM:AMP-5‖ or ―:SOUR:POW-

5‖. 

Table 9.4 SCPI Command Parameters and Response Types 

Parameter type Response Data Types 

Numeric Real or integer 

Extended Numeric Integer 

Discrete Discrete 

Boolean Numeric Boolean 

String String 

Piece 
Block with Definite Length 

Block of uncertain length 

Non-decimal Numeric 

Hexadecimal system 

Octal 

Binary system 

Numerical parameter 

Special instrument commands and general commands can be expressed as numeric parameters. All kinds of 
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common decimal counting can be applied for reception of numeric parameters, including the plus or minus, 

decimal and scientific counting methods. If one device can only receive the specific numeric type, such as the 

integer, the received numeric parameter will be automatically rounded. 

The following are examples of numeric parameters: 

0 no decimal point required 

100 fractional digits optional 

1.23 leading signs allowed 

4.56e<space>3 space allowed after the E in exponential 

-7.89E-01 use either E or e in exponential 

+256 leading + allowed 

5 digits left of decimal point optional 

Extended Numeric Parameters 

The numeric parameter is extended to specify the physical quantity in the majority of measurements related to 

special instrument commands. Extended numeric parameters accept all numeric parameter values and other special 

values as well. The extended numeric parameters include the MAXimum and MINimum. Other special values, 

such as UP and DOWN, are received depending on the analysis capability of the instrument. All effective 

parameters are listed in the SCPI command table. 

Note: The extended numeric parameters are not applicable to general commands or STATus subsystem commands. 

The following are examples of extended numeric parameters: 

101 Numerical parameter 

1.2GHzGHz can be used as the index (E009). 

200MHzMHz can be used as the index (E006). 

-100mV negative 100 millivolts 

10 degrees 10 degree 

MAXimum sets parameter to largest possible value 

MINimum sets parameter to smallest possible value 

UP a stepper up 

DOWN a stepper down 

Discrete Parameters 

Discrete parameters are used to identify a limited number of parameters to be set. Discrete parameters use 

mnemonics to represent each valid setting. Similar to the programmed command mnemonics, discrete parameter 

mnemonics are divided into long type, short type and uppercase/lowercase mixed type. 

Discrete parameters and commands are used together in the following examples. 

:TRIGger[:SEQuence]:SOURceBUS|IMMediate|EXTernal 

MANual Manual triggering 

IMMediate immediate triggering 

EXTernal external triggering 

Boolean Parameters 

The Boolean parameter represents one true or false binary condition, and only four possible values can be applied. 

The following are examples of Boolean parameters: 

ON boolean true 

OFF boolean false 

1 boolean true 

0 boolean false 
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String Parameters 

For the character string type, the ASCII character string is allowed to be transmitted as the parameter. Single and 

double quotes are used as delimiters. The following are examples of string parameters: 

―This is Valid‖ ―This is also Valid‖ ―SO IS THIS‖ 

Real Response Data 

Most of test data are of real type, in the basic decimal or scientific counting format. Both formats are 

supported by most of advanced program languages. 

The following are examples of real response data: 

1.23E+0 

-1.0E+2 

+1.0E+2 

0.5E+0 

0.23 

-100.0 

+100.0 

0.5 

Integer Response Data 

Integer response data are decimal representations of integer values including signs. For state register query, integer 

response data will be returned in most cases. 

Examples of integer response data: 

0 Signs are optional 

+100 leading + allowed 

-100 leading + allowed 

256 not any decimal point 

Discrete Response Data 

Discrete response data are essentially similar to discrete parameters. The major difference is that only the discrete 

response data in the short uppercase format are returned. 

Example of discrete response data: 

MLINear Display format is linear amplitude 

MLOGarithmic Display format is logarithm amplitude 

PHASe Display format is phase 

 

Numeric Boolean Response Data 

Boolean response data returns a binary numeric value of 1 or 0. 

String Response Data 

String response data are similar to string parameters. The main difference is that the double quotation marks instead 

of single quotation marks must be used as the separator of the string response data. Double quotation marks are 

allowed to be embedded in the string response data, with no character. Some examples of string response data are 

shown below. 

―This is a string‖ 

―one double quote inside brackets: (―‖)‖ 

6) System of numeric value of command 
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The command value can be entered in the binary, decimal, hexadecimal or octal format. An appropriate identifier 

should be applied in front of the value in the binary, hexadecimal or octal format. The identifier is not required in 

the decimal format (default). The entered value with no identifier will be saved in the decimal format. The 

following list shows the identifiers for the formats that require them: 

 #B means that the figure is a binary value. 

 #H means that the figure is a hexadecimal value. 

 #Q means that the figure is an octal value. 

The following are examples of SCPI command values and identifiers for the decimal value 45: 

#B101101 

#H2D 

#Q55 

In the following example, the hexadecimal value 000A is used to set the RF output power as 10dBm (or equivalent 

to the value in the selected unit, such as DBUV or DBUVEMF). 

:POW#H000A 

In the non-decimal format, the measurement unit such as DBM or mV is not used together with the value. 

7) Command line structure 

One command line may include multiple SCPI commands. The following methods can be applied to end the 

current command line: 

 Enter; 

 Enter key and EOI; 

 EOI and the last byte. 

Commands in the command line are separated by semicolons. Commands of different subsystems begin with the 

colon. For example: 

MMEM:COPY"Test1","MeasurementXY";:HCOP:ITEM ALL 

This command line includes two commands, the first of which is the MMEM subsystem command and the second 

of which is the HCOP subsystem command. If adjacent commands belong to the same subsystem and the command 

paths are subject to partial overlapping, the commands can be abbreviated. For example: 

HCOP:ITEM ALL;:HCOP:IMM 

This command line includes tow commands which belong to the same level of the HCOP subsystem. The second 

command is started at the level lower than the HCOP command, and the colon at the beginning of the command 

can be omitted. The command line can be abbreviated as follows: 

HCOP:ITEM ALL; IMM 

9.1.4 Command Sequence and Synchronization 

IEEE488.2 defines the difference of the overlapping command and continuous command. 

 The continuous command refers to the command sequence to be executed continuously. Generally, the 

velocity of command execution is high. 

 The overlapping command refers the command which is not executed automatically before execution of next 

command. The processing time of the overlapping command is generally long. The program is allowed to 

process other events synchronously. 

Even if one command line includes multiple setting commands, commands may not be executed according to the 

reception sequence. In order to execute each command according to a certain sequence, all the commands must be 

transmitted as a separate command line. 

Example: command line including setting and query commands. 
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If one command line includes query commands, query results are unpredictable. The returned value will be fixed if 

the following command is entered: 

:FREQ:STAR 1 GHZ; SPAN 100;:FREQ:STAR? 

Returned value: 1000000000(1GHz) 

The returned value will not be fixed if the following command is entered: 

:FREQ:STAR1GHz;STAR?;SPAN1000000 

The returned result may be the current start frequency of the instrument before command sending, as the commands 

will be executed one by one by the host program after command messages are received. The returned result may be 

1GHz in the case of execution after the commands are received by the host program. 

Prompt 

Setting commands and query commands are sent separately. 

General rules: setting commands and query commands should be sent in different program messages in order to 

ensure that the returned results of query commands are correct. 

9.1.4.1 Prevention of Overlapping Execution of Commands 

In order to prevent overlapping execution of commands, multiple threads or commands can be applied, including 

*OPC, *OPC? or *WAI. The three commands cannot be executed until the hardware is set. The computer may be 

forced to wait for a certain period to synchronize certain events in the programming process. The above methods 

are described below. 

 Use multiple threads in the control program. 

Multiple threads are used to complete waiting commands and synchronize the user interface and program, that is, 

the command ―*OPC?‖ is executed in each single thread, with no blockage of GUI or program threads. 

 The use of three commands in synchronous execution is shown in the following table. 

Table 9.5 Command Grammar 

Method Execution Action Programming Method 

*OPC 
After command execution, set the operation 

completion bit in the ESR register. 

Set ESEBIT0; 

Set SREBIT5; 

Send the overlapping command and *OPC; 

Wait for the service request signal (SRQ). 

The service request signal means that the overlapping 

command has been executed. 

*OPC? 

Stop executing the current command and 

return to 1. Only when the operation 

completion bit in the ESR register is set, the 

command will be returned, indicating that the 

previous command has been processed. 

End the current command processing before executing 

other commands. Directly send the command after 

processing of the current command. 

*WAI 

Before executing *WAI, wait for sending of 

all commands. Then process the uncompleted 

commands. 

End the current command processing before executing 

other commands. Directly send the command after 

processing of the current command. 

9.1.5 State Report System 

The state report system is used to save all operation state information and error information of the current 

instrument. The operation state information and error information are respectively saved in the state register and 

error queue and can be inquired through the programmed interface. 

9.1.5.1 Structure of State Register Organization 

Register categories are as follows: 

1) STB and SRE 
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The top register of the state report system is composed of the state byte (STB) and associated shielding register, i.e. 

service request enabling register (SRE). STB is used to collect the information of registers of the lower layers and 

save the general working conditions of the instrument. 

2) ESR and SCPI state register 

STB is used to receive the following register information: 

a) Relevant values of event state registers and event state enabling (ESE) shielding registers. 

b) SCPI state registers, such as STATus:OPERation and STATus:QUEStionable registers (defined by the SCPI 

standard), including specific operations of the instrument. All the SCPI state registers have the same internal 

structure (refer to ―2.1.5.2 Structure of SCPI State Register‖ of the program control manual). 

3) IST and PPE 

The separate bit of SRQ and IST sign (―IndividualSTatus‖) is composed of the combination of all states of the 

instrument. The STB data bit for the IST sign depends on the associated Parallel Poll Enable (PPE) Register. 

4) Output buffer zone 

The output buffer zone is used to save messages returned by the instrument to the controller. It does not belong to 

the state report system, but is decisive to the MAV bit of STB. For details of the above registers, refer to ―2.1.5 

State Report System‖ of the program control manual. Refer to Fig. 9.3 for the hierarchical structure of the state 

register. 

 

Fig. 9.3 Hierarchical Structure of State Register 

Prompt 
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SRE and ESE 

The Service Request Enable (SRE) register is used as the enabling part of STB. Similarly, ESE can be used as the 

enabling part of ESR. 

9.1.5.2 Application of State Report System 

The state report system is used to monitor the state of one or more instrument(s) in the test system. In order to 

properly realize the functions of the state report system, the controller in the test system must receive and evaluate 

the information of all instruments. Standard methods to be applied include: 

1) Service request (SRQ) sent by the instrument. 

2) Series query sent by the controlled to all instruments in the bus system, aiming to find the sender and causes of 

service request. 

3) Parallel query of all instruments. 

4) Query of specific instrument states with programmed commands. 

For specific operations, refer to ―2.1.5.4 Application State Report System‖ of the program control manual. 

9.1.6 Programming Precautions 

1) Initialize the instrument state before changing the setting. 

For instrument setting of remote control, initialize the instrument state (sending ―*RST‖, etc.) and then set the 

required state. 

2) Command sequence 

Generally, the setting command and query command should be transmitted separately. Otherwise, the returned 

value of the query command will change according to the current instrument operation sequence. 

3) Fault response 

The service request must be sent by the instrument. The controller of the test system should be programmed to 

guide the instrument to actively send the service request if required, so as to enable the corresponding service 

interruption program. 

4) Error queue 

The error queue instead of the state register should be inquired once the service request is processed by the 

controller program, so as to find more accurate causes. The queue should be always inquired in the controller 

program test phase to obtain the commands sent by the controller to the instrument. 

9.2 Programmed Port and Configuration of Instrument 

● LAN························································································································································· 260 

● GPIB ························································································································································ 262 

9.2.1 LAN 

The programmed LAN (Local Area Network) system is configured with SICL-LAN to control 3672 series vector 

network analyzer. 

Attention 

Use of USB master control port connector of the front panel: 

The Type-A connector of the front panel is a USB master control port connector. In the 3672 series vector network 

analyzer, this port is connected to the flash disc with USB1.1 interface to upgrade the software in the instrument. It 

can also be connected to the USB keyboard and mouse to control the vector network analyzer. It must not be used 

for program control of the instrument. 

9.2.1.1 Establish Connection 
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Connect the 3672 series vector network analyzer and external controller (computer) to LAN through network 

cables, as shown in Fig. 9.4. 

IP 地址

IP 地址

LAN

 

Fig. 9.4 Connection Diagram of LAN Interface 

 

Fig. 9.5 LAN Interface of Rear Panel of Instrument 

9.2.1.2 Interface Configuration 

Ensure that the physical connection is smooth for remote control of the vector network analyzer by LAN. As the 

DHCP, domain name access and WAN are not supported, the network programming of the vector network analyzer 

is relatively simple. In the menu shown in Fig. 9.6, set the ―IP address‖, ―Subnet mask‖ and ―Default gateway‖ to 

be within the subnet with the master controller. 

 

Fig. 9.6 LAN Interface Setting 

Attention 

Ensure normal physical connection of the vector network analyzer through the 10Base-TLAN or 100Base-
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TLAN cable. 

The vector network analyzer only supports the establishment of one LAN control system and static IP address 

setting, and does not support DHCP or access to the host through the DNS and domain name server. Therefore, it is 

not required to modify the subnet mask. The subnet mask of the instrument should be set as the fixed value 

255.255.255.0. 

9.2.2 GPIB 

9.2.2.1 Establish Connection 

Connect the 3672 series vector network analyzer to the external controller (computer) through the GPIB cable, as 

shown in Fig. 9.7. 

GPIB

GPIB 地址

 

Fig. 9.7 Connection Diagram of GPIB Interface 

 

Fig. 9.8 GPIB Interface of Rear Panel of Instrument 

9.2.2.2 Interface Configuration 

When the system is built with the vector network analyzer, the user may need to modify the GPIB address. The 

default local GPIB address is 16. Change the GPIB address as follows: 

Press [System] > [Configuration] > [GPIB address (G)...] to enter the interface shown in Fig. 9.9. Modify the GPIB 

address in the [Local GPIB address] input box through the keyboard and mouse or number keys of the front panel. 

 

Fig. 9.9 GPIB Interface Setting 
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9.3 Basic Programming Method of VISA Interface 

The following example shows the basic method of instrument programming with the VISA library. Take the C++ 

language as the example. 

● VISA library ············································································································································ 263 

● Initialization and default state setting ········································································································ 263 

● Sending of setting command ····················································································································· 265 

● Reading of measurement instrument state ································································································· 267 

● Reading of frequency marker ···················································································································· 268 

● Reading of trace data ································································································································ 268 

● Command synchronization ······················································································································· 269 

9.3.1 VISA Library 

VISA is a general term of the standard I/O function library and related standards. The VISA library is a set of 

functions which can be easily recalled. The core function can be used to control various kinds of devices, regardless 

of the interface type and I/O interface software operations. The function library is used to write the instrument drive 

program and complete command and data transmission between the computer and instrument to realize the 

programmed control of the instrument. The instrument connection with the program-controlled port (LAN, USB, 

GPIB, RS-232, etc.) can be established by initializing the address character string (―VISA resource string‖). 

The VISA library must be installed at first for remote control. The VISA library includes the transmission functions 

of the bottom VXI, GPIB, LAN and USB interface to facilitate direct recalling. The vector network analyzer 

supports the following programmed interfaces: GPIB, LAN and RS-232. Such interfaces are used with the VISA 

library and programming languages to remotely control the vector network analyzer. At present, AgilentI/OLibrary 

provided by Agilent is commonly used as the bottom I/O library. 

Fig. 9.10 shows the relationship between the programmed interface, VISA library, programming language and 

vector network analyzer, with GPIB interface as an example. 

 

Fig. 9.10 Programming Software and Hardware Layer 

9.3.2 Initialization and Default State Setting 

Initialize the VISA resource manager at the beginning of programming. Open the VISA library and establish the 

communication connection between the VISA library and instrument. Specific steps are as follows. 
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9.3.2.1 Generation of Global Variables 

At first, generate global variables to be recalled by other program modules, such as instrument handle variables. 

The following global variables are included in the program example. 

ViSession analyzer; 

ViSessiondefaultRM; 

Const char analyzerString [VI_FIND_BUFLEN] = "GPIB0::16::INSTR"; 

ConstanalyzerTimeout = 10000; 

The constant analyzerString refers to the instrument descriptor, ―GPIB0‖ refers to the controller, and ―16‖ refers to 

the instrument connected to the controller. Assuming that the instrument is connected LAN, the IP address is 

―192.168.1.1‖ and the port number is ―1024‖, the variable is: 

Const char analyzerString [VI_FIND_BUFLEN] = ―TCPIPO::192.168.1.1::1024::SOCKET‖; 

9.3.2.2 Controller Initialization 

The following example shows how to establish the communication connection between the VISA library and 

instrument (with the specified descriptor). 

//Controller initialization: open the default resource manager and return the instrument handle to the analyzer. 

voidInitController() 

{ 

ViState state; 

state = viOpenDefaultRM(&defaultRM); 

state = viOpen(defaultRM, analyzerString, VI_NULL, VI_NULL, &analyzer); 

} 

9.3.2.3 Instrument Initialization 

/*************************************************************************/ 

The following example shows the initialization of the default instrument state and clearing of the state register. ―\n‖ 

refers to the terminator. The character string of each command should be ended with ‗\n‘. This will not be described 

later. 

/*************************************************************************/ 

voidInitDevice() 

{ 

ViState state; 

longretCnt; 

state = viWrite(analyzer, "*CLS\n", 5, &retCnt); //reset state register 

state = viWrite(analyzer, "*RST\n", 5, &retCnt); //reset instrument 

} 

9.3.2.4 Query of Instrument Measurement Information 

/*************************************************************************/ 

The following example shows all measurements, windows and traces defined at present. 

/*************************************************************************/ 

voidQueryMesaurement() 

{ 
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ViState state; 

longretCnt; 

charrd_Buf_CW[VI_READ_BUFLEN]; // #define VI_READ_BUFLEN 20 

charrd_Buf_LVL[VI_READ_BUFLEN]; 

// query all measurements of Channel 1 

state = viWrite(analyzer, ": CALC:PAR:CAT?\n", 15, &retCnt); 

Sleep(10); 

state = viRead(analyzer, rd_Buf_CW, 50, &retCnt); 

// query all windows 

state = viWrite(analyzer, ": DISP:CAT?\n", 11, &retCnt); 

Sleep(10); 

state = viRead(analyzer, rd_Buf_CW, 20, &retCnt); 

// query all traces of Window 1 

state = viWrite(analyzer, ": DISP:WIND1:CAT?\n", 18, &retCnt); 

Sleep(10); 

state = viRead(analyzer, rd_Buf_CW, 20, &retCnt); 

} 

9.3.3 Sending of Setting Command 

9.3.3.1 Setting of Sweep Parameters 

/*************************************************************************/ 

The following example shows how to set the sweep parameters of 3672 series vector network analyzers. 

/*************************************************************************/ 

voidSweepSettings() 

{ 

ViState state; 

longretCnt; 

// selection of measurement 

state = viWrite(analyzer, ":CALC:PAR:SEL „CH1_WIN1_LINE1‟ \n", 50,&retCnt); 

 

// set the sweep type as linear sweep 

state = viWrite(analyzer, ":SENSe1:SWEep:TYPE LIN\n", 30, &retCnt); 

 

// set the intermediate frequency bandwidth as 3KHz 

state = viWrite(analyzer, " :SENSe1:BANDwidth 3000\n", 30, &retCnt); 

 

// set the start frequency as 1GHz and stop frequency as 10GHz 

state = viWrite(analyzer, ":SENS:FREQ:STAR 1e9\n", 30, &retCnt); 

state = viWrite(analyzer, ":SENS:FREQ:STOP 1e10\n", 30, &retCnt); 
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// set the number of sweep points as 401 

state = viWrite(analyzer, ":SENSe1:SWEep:POINts 401\n", 30, &retCnt); 

// automatic setting of sweep time 

state = viWrite(analyzer, ":SENSe1:SWEep:TIME:AUTO ON\n", 40, &retCnt); 

 

// set the output power as -10dBm 

state = viWrite(analyzer, ":SOUR:POW -10dBm\n", 22, &retCnt); 

} 

9.3.3.2 Setting of Display Parameters 

/*************************************************************************/ 

The following example mainly includes: 

Setting of data format; 

Display of trace, title and frequency notes; 

Automatic scaling of trace; 

Query of scale, reference level and reference position; 

Opening and setting of averaging; 

Opening and setting of smoothing. 

/*************************************************************************/ 

voidDisplaySettings() 

{ 

ViState state; 

longretCnt; 

charrd_Buf_Data[VI_READ_BUFLEN]; // #define VI_READ_BUFLEN 20 

 

// selection of measurement 

state = viWrite(analyzer, ":CALC:PAR:SEL „CH1_WIN1_LINE1‟ \n", 50,&retCnt); 

 

// set the data format as logarithmic amplitude format 

state = viWrite(analyzer, ":CALCulate1:FORMat MLOG\n", 30, &retCnt); 

 

// display the trace, title and frequency notes 

state = viWrite(analyzer, ":Display:WINDow1:TRACe1:STATe ON\n", 40, &retCnt); 

state = viWrite(analyzer, ":DISPlay:WINDow1:TITLe:STATe ON\n", 40, &retCnt); 

state = viWrite(analyzer, ":DISPlay:ANNotation:FREQuency ON\n", 40, &retCnt); 

 

// automatic scaling of trace 

state = viWrite(analyzer, ":Display:WINDow1:TRACe1:Y:Scale:AUTO\n", 50, &retCnt); 
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// query the scale, reference level and reference position 

state = viWrite(analyzer, ": DISPlay:WINDow1:TRACe1:Y:SCALe:PDIVision?"\n", 60, &retCnt); 

Sleep(10); 

state = viRead(analyzer, rd_Buf_Data L, 20, &retCnt); 

state = viWrite(analyzer, ":DISPlay:WINDow1:TRACe1:Y:SCALe:RLEVel?\n", 60, &retCnt); 

Sleep(10); 

state = viRead(analyzer, rd_Buf_Data, 20, &retCnt); 

state = viWrite(analyzer, ": DISPlay:WINDow1:TRACe1:Y:SCALe:RPOSition?\n", 60, &retCnt); 

Sleep(10); 

state = viRead(analyzer, rd_Buf_Data, 20, &retCnt); 

 

// open the averaging function and set the average factor as 5 

state = viWrite(analyzer, ": SENSe1:AVERage:STATe ON\n", 30, &retCnt); 

state = viWrite(analyzer, ": SENSe1:AVERage:Count 5\n", 30, &retCnt); 

 

// open the smoothing function and set the smoothing aperture as 20% 

state = viWrite(analyzer, ": CALCulate1:SMOothing:STATe ON\n", 40, &retCnt); 

 

state = viWrite(analyzer, " CALCulate1:SMOothing:APERture 20\n", 40, &retCnt); 

} 

9.3.4 Reading of Measurement Instrument State 

The following example shows how to read the setting state of the instrument. 

voidReadSettings() 

{ 

ViState state; 

longretCnt; 

charrd_Buf_CW[VI_READ_BUFLEN]; // #define VI_READ_BUFLEN 20 

charrd_Buf_LVL[VI_READ_BUFLEN]; 

 

// Querys the CW frequency 

state = viWrite(analyzer, "FREQ:CENT?", 10, &retCnt); 

Sleep(10); 

state = viRead(analyzer, rd_Buf_CW, 20, &retCnt); 

// query the amplitude 

state = viWrite(analyzer, "POW:ALC:LEV?", 12, &retCnt); 

Sleep(10); 

state = viRead(analyzer, rd_Buf_LVL, 20, &retCnt); 
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// print the commissioning information 

sprint("Cw is %s", rd_Buf_CW); 

sprint("LEVel is %s", rd_Buf_ LVL); 

} 

9.3.5 Reading of Frequency Marker 

/*************************************************************************/ 

The following example shows how to read the frequency scale information. 

/*************************************************************************/ 

voidReadMarker () 

{ 

ViState state; 

longretCnt; 

charrd_Buf_Marker[VI_READ_BUFLEN]; // #define VI_READ_BUFLEN 20 

 

// open the frequency marker 1 and query the frequency marker peak (frequency and amplitude) 

state = viWrite(analyzer, ":CALC:MARKER ON;MARKER:  FUNCtion:EXECuteMAXimum\n", 25, &retCnt); 

// read the X-axis information 

state = viWrite(analyzer, ":CALC:MARK:X?; ", 15, &retCnt); 

state = viRead(analyzer, rd_Buf_Marker, 30, &retCnt); 

// read the Y-axis coordinate information 

state = viWrite(analyzer, ":CALC:MARK:Y?; ", 15, &retCnt); 

state = viRead(analyzer, rd_Buf_Marker, 30, &retCnt); 

} 

9.3.6 Reading of Trace data 

/*************************************************************************/ 

The following example shows how to read the trace data of the vector network analyzer. 

/*************************************************************************/ 

voidQueryData () 

{ 

ViState state; 

longretCnt = 0; 

int points= 0 

// #define VI_READ_BUFLEN 1000000 

charrd_Buf_BigData[VI_READ_DATABUFLEN]; 

charrd_Buf_Data[VI_READ_BUFLEN]; // #define VI_READ_BUFLEN 20 

 

// selection of measurement 

state = viWrite(analyzer, ":CALCulate:PARameter:SELect ' CH1_WIN1_LINE1'\n", 25, &retCnt); 
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// obtain the number of sweep point 

state = viRead(analyzer, rd_Buf_Data, 30, &retCnt); 

9.3.7 Command Synchronization 

The method of command synchronization is introduced below, taking the sweep process as an example. 

voidSweepSync() 

{ 

ViState state; 

longretCnt; 

ViEventTypeetype; 

ViEventeevent; 

int stat; 

charOpcOk [2]; 

/*********************************************************************/ 

/* Command INITiate[:IMMediate] start single sweep ( closed in continuous sweepINIT:CONT OFF)*/ 

/* Execute next command of command buffer zone after single sweep */ 

/*********************************************************************/ 

state = viWrite(analyzer, "INIT:CONT OFF", 13, &retCnt); 

// Method 1 of waiting for stop of sweep: use *WAI 

state = viWrite(analyzer, "ABOR;INIT:IMM;*WAI", 18, &retCnt); 

 

// Method 2 of waiting for stop of sweep: use *OPC？ 

state = viWrite(analyzer, "ABOR;INIT:IMM; *OPC?", 20, &retCnt); 

state = viRead(analyzer, OpcOk, 2, &retCnt); //Wait for*OPC and return to ―1‖ 

 

// Method 3 of waiting for stop of sweep: use *OPC 

// To enable GPIB service request, set "Disable Auto Serial Poll" as "yes" 

state = viWrite(analyzer, "*SRE 32", 7, &retCnt); 

state = viWrite(analyzer, "*ESE 1", 6, &retCnt); // enable service request ESR 

// set event enabling bit to complete operation 

state = viEnableEvent(analyzer, VI_EVENT_SERVICE_REQ, VI_QUEUE, VI_NULL); 

// enable SRQ event 

state = viWrite(analyzer, "ABOR;INIT:IMM;*OPC", 18, &retCnt); 

// start sweep synchronously with OPC 

state = viWaitOnEvent(analyzer, VI_EVENT_SERVICE_REQ, 10000, &etype, &eevent) 

// wait for service request 

state = viReadSTB(analyzer, &stat); 

state = viClose(eevent); // close event handle 

// prohibit SRQ event 
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state = viDisableEvent(analyzer, VI_EVENT_SERVICE_REQ, VI_QUEUE); 

// main program continues…… 

} 

9.4 I/O Library 

9.4.1 Overview of I/O Library 

The I/O library is a library of pre-written software programs for the instrument, known as the instrument drive 

program, i.e. instrument driver. It is an intermediate software layer between the computer and instrument hardware 

equipment. It is composed of the function library, utility program, tool kit, etc., and is a set of software code 

modules. This set corresponds to a series of planned operations, such as instrument configuration, reading, writing, 

triggering, etc. It is installed the computer and used as a connecting bridge and link between the computer and 

instrument. With the easy-to-program high-level modular library, the user does not need to the complex special 

low-level programming protocol for the specific instrument. It is key to use the instrument driver to rapidly develop 

the test measurement application. 

From the functional perspective, one general instrument driver is composed of five parts: functional body, 

interactive developer interface, program developer interface, subprogram interface and I/O interface, as shown in 

Fig. 9.14. 

 

Fig. 9.11 Instrument Driver Structure Model 

Details are as follows: 

1) Functional body. This is the main functional part of the instrument driver and can be understood as the 

framework program of the instrument driver. 

2) Interactive developer interface. To facilitate use, the graphical interactive developer interface is generally set in 

the application environment supporting instrument driver development. For example, the function panel of 

Labwindows/CVI is a kind of interactive development interface. Each parameter of the instrument driver function 

in the function panel is expressed in the graphical control form. 

3) Programming developer interface. This is a software interface for the application program to recall the 

instrument driver function, such as the dynamic link library file of instrument driver.dll in the Windows system. 

4) I/O interface. It is used for actual communication between the instrument driver and instrument. It is allowed to 

use the special bus I/O software, such as GPIB and RS-232, or the general standard I/O software (VISAI/O) to be 

used over multiple buses. 

5) Subprogram interface. It is a software interface for the instrument driver to visit other supporting libraries, such 

as the data library, FFT function, etc. It will be used when other software modules, operating systems, program 

code libraries and analysis function libraries are recalled by the instrument driver after completion of tasks. 

9.4.2 I/O Library Installation and Configuration 

With applications in the test field, the I/O library has experienced various development phases from the traditional 
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instrument to virtual instrument. In order ensure the instrument interchangeability in the automatic test system and 

the reusability of the test program, the instrument drive program has also experienced various development phases. 

At present, the popular universal driver is an IVI (Interchangeable Virtual Instruments) instrument driver. Based on 

the IVI specification, the new instrument programming interface, inserted drive program and VPP architecture on 

VISA are defined, so that the test application program is fully independent of the instrument hardware. In addition, 

the unique functions of instrument simulation, range detection and state caching are added to improve the system 

operating efficiency and truly realize the instrument interchangeability. 

The IVI driver is divided into two types: IVI-C and IVI-COM. IVI-COM is based on the Microsoft component 

object model (COM) technology, in the COMAPI form, and IVI-C is based on ANSIC, in the CAPI form. The two 

types of drivers are designed in accordance with the instrument categories defined in the IVI specifications. The 

application development environments are the same, including Visual Studio, Visual Basic, Agilent VEE, 

LabVIEW, CVI/LabWindows, etc. 

The IVI driver of the vector network analyzer supports IVI-C. For specific installation and configuration, refer to 

the accompany files of the selected control card and I/O library. 

The installed IVI driver is divided into the IVI inherent function group and instrument function group (basic 

function group and extended function group). For specific functional classification, functions and attribute details, 

refer to the help file of the driver. 

Prompt 

Port configuration and I/O library installation: 

Before controlling the vector network analyzer with a computer, check whether the necessary port and I/O library 

are properly installed and configured. 

 

Prompt 

Use of I/O library: 

If the accompanying IVI-COM/C drive program installation package is installed, the function panel, help file and 

drive function example programs will be installed automatically to facilitate development and integration of the 

programmed functions. 

  



10 Fault Diagnoses and Repair 

10.1 Operating principle 

272  

 

10 Fault Diagnoses and Repair 

This chapter will introduce how to find out problems and receive the after-sale service. Error information of the 

network analyzer is also introduced. 

In case of any fault in operation of the purchased 3672 series vector network analyzer or when you need to 

purchase relevant component or accessory, please contact us as we provide complete after-sales services. 

In general, the trouble is caused by failure of hardware/software or users' misuse. Please contact us immediately in 

case of any trouble. For the vector network analyzer within the warranty period, we will implement free repair 

according to the commitments in the warranty; otherwise, we will charge the costs. 

● Operating principle ··································································································································· 272 

● Fault diagnosis and troubleshooting ·········································································································· 273 

● Error information ····································································································································· 275 

● Repair ······················································································································································ 288 

10.1 Operating principle 

10.1.1 Response of DUT to RF Signal 

The test signals generated by the signal source of the vector network analyzer are input into the DUT. Part of the 

test signals are reflected by the DUT and other signals are transmitted. Fig. 10.1 shows the response of the DUT to 

the test signals. 

 

Fig. 10.1 Response of DUT to Signals 

10.1.2 Overall Principle 

 

Fig. 10.2 Block Diagram of Overall Principle 

3672 series vector network analyzers are intelligent test instrument designed based on the modular concept, with 

the embedded industrial computer module as the control center. The design concept includes the ―embedded 
computer hardware platform based on the multi-processor + test module‖, realizing the perfect combination of the 

test instrument and industrial computer. The test control software with the Windows operating system can make the 
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human-machine interface of the instrument more friendly and the operation more convenient. The block diagram of 

modular design of the instrument is shown in Fig. 10.2. The system mainly includes the LO signal source module, 

signal source module 1, signal source module 2, frequency benchmark module, S-parameter tester module, mixed-

frequency receiver module, intermediate frequency signal processing module, digital signal processing module, 

embedded computer module, power supply module, display module, I/O interface module, software module, etc. 

The frequency benchmark module is locked to the internal or external 10MHz reference signal to produce the 

locking reference signal for the LO source and signal source and the synchronization signal for the whole 

instrument. 

The LO signal source module and stimulus signal source module are locked to the reference signal output by the 

frequency benchmark module, to produce the required LO signal and RF signal through the switching frequency 

doubling device, bandpass filter and automatic level control circuit (ALC). 

The S-parameter tester module is a signal separator to separate the incident signal, reflected signal and transmitted 

signal of the DUT. 

In the mixed-frequency receiver module, the incident, reflected and transmitted signals including the amplitude and 

phase information of the DUT are mixed with LO signals, and the generated intermediate frequency signals are 

transmitted to the intermediate frequency signal conditioning module for further processing. 

The intermediate frequency signals are conditioned by the intermediate frequency signal conditioning module to 

meet the requirements of the digital signal processing module for intermediate frequency signals. 

In the digital signal processing module, the analog intermediate frequency signals are transformed into digital 

signals, and then the digital signals are processed to obtain the amplitude and phase information of the DUT. 

Measurement results are transmitted to the main CPU through the high-velocity PCI bus. 

The system test control module run on the embedded PC platform is used to transform the amplitude and phase 

information of the DUT into various formats, and the results are transmitted to the display module. In addition, the 

system software is also used for management of various interfaces and scheduling of various processes of the 

instrument. 

10.2 Fault Diagnosis and Troubleshooting 

Prompt 

Fault diagnosis and guidance 

This section aims to guide simple judgment and disposal of faults of 3672 series vector network analyzers. If 

necessary, provide accurate feedback to the manufacturer to solve problems as soon as possible. 

If any information appears in the state indication zone of the user interface, view [Help] > [Error information] > 

[View error log] to know specific information. 

● System problems ······································································································································ 323 

● Curve display anomaly ····························································································································· 324 

● Sweep problems ······································································································································· 324 

● Display problems ····································································································································· 324 

● Response failure of front panel keys ········································································································· 324 

● Menu failure ············································································································································· 324 

10.2.1 System Problems 

10.2.1.1 The standby light is not ON. 

Check whether the 220V AC power input of the network analyzer is normal. The allowable maximum deviation is 

220V±10%. If the deviation is too large or small, the instrument may not work normally. In case of abnormality, 

check external wires for any failure; power on the instrument again and restart it after trouble-shooting. If the 220V 

AC power input is normal, check whether the power switch on the rear panel of the instrument is turned on. Under 

normal conditions, the power switch should be in the ―丨‖ state. If the fault is caused by the power supply of the 
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instrument, send the instrument to the manufacturer for repair. 

10.2.1.2 The system cannot be enabled after start-up. 

If the system cannot be enabled after start-up, first check whether the hard disc on the rear panel is loose. If the 

hard disc is loose, tighten the fixing screw or pull out and reinsert the hard disc. If the hard disc is not loose, 

recover the system. For specific steps, refer to ―3.1.2.1 System Recovery of Network Analyzer‖. 

10.2.1.3 The network analyzer software cannot be used after start-up. 

If the network analyzer software cannot be used after start-up and system enabling, double-click the desktop icon 

of the vector network analyzer or press the [Reset] key on the front panel or click [Start] > [Programs] > 

[Vector network analyzer] to start the program. If the software can be started smoothly, install the antivirus 

software to kill viruses and restart the instrument. If the software cannot be started automatically, download the 

vector network analyzer program and double-lick the vector network analyzer installation program in the root 

directory of Disc D or E. Reinstall the vector network analyzer program with reference to ―3.1.2.2 Updating of 

Network Analyzer‖. 

10.2.2 Curve Display Anomaly 

The curve display anomaly is caused for various reasons. At first, check whether the user reset state is saved. 

Click [System] > [Custom user reset state] in the menu bar to open the [Custom user state] window. 

Remove the tick in the check box in front of ―Save final state as user reset state‖ and ―Enable user reset state‖. 

Click OK to close the [Custom user state] window. Press [Reset] on the front panel. The S11 curve should be 

near 0 if the port is not connected with any load. 

If the curve is still abnormal after the above methods are applied, contact our technical support personnel for 

solutions. 

10.2.3 Sweep Problems 

10.2.3.1 Sweep seems stopped. 

The open-circuit curve of the port seems no sweep in the reset state. This is caused by high stability and sweep 

velocity of the vector network analyzer. Click [Stimulus] > [Sweep] > [Sweep Time], enter 20 and press ENTER. 

Then you can see the sweep marker. 

10.2.3.2 Sweep is stopped. 

Check whether the instrument is in the HOLD state. If the instrument is in the HOLD state, modify the trigger 

mode and press [Stimulus] > [Trigger] > [Continuous sweep] or open the [Trigger] dialog box and set the 

automatic trigger mode. 

10.2.3.3 The white sweep marker is in the lower part of the screen. 

Both ports should be swept for correction after full double-port calibration. If only the trace with the stimulus 

source on Port 1 is displayed, the white marker will appear in the lower part of the screen to sweep Port 2. This is a 

normal sweep state and no change is required. 

10.2.4 Display Problems 

If the display window is blocked by the task bar, right-click the task bar, click [Attribute], tick ―Automatic hide 

task bar‖ and click OK to close the dialog box. In this case, the task bar will be automatically hided and the test 

window will not be blocked. 

10.2.5 No Response of Front Panel Keys 

In case of no response of front panel keys, which is caused by damage of the instrument drive program, download 

the vector network analyzer and reinstall it. For specific steps, refer to ―3.1.2.2 Updating of Network Analyzer 

Program‖. Select the ―Complete‖ installation type and reinstall the drive program. If the problem still exists, 

recover the system. For specific steps, refer to ―3.1.2.1 System Recovery of Network Analyzer‖. 

10.2.6 Menu Failure 

In case of menu failure, at first check whether the GPIB state at the bottom of the window is LOCAL. If the 

program-controlled state is enabled, press the [Macro/Local] key on the front panel or connect the keyboard and 
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press [Esc] to recover the local state. 

10.3 Error Information 

Any error will be reported in the error queue of SCPI (remote control interface) and the error queue displayed on 

the front panel. Two queues are displayed and processed independently. For details of the error queue of the front 

panel, refer to the User Manual. 

If the SCPI (remote interface) error queue is used for access to messages, the error number and <Description> in 

the error queue will be displayed on the host terminal. 

The error information of the vector network analyzer can be displayed and recorded in the error file. The user can 

select to select or not to select the error information. 

10.3.1 Local Error Information 

10.3.1.1 Viewing of Error Information 

By interface operation: 

The error or warning prompt information in the test interface of the vector network analyzer in operation indicates 

operation or hardware problems. All prompt, warning and error events in operation are recorded in the error log of 

the vector network analyzer. Using the error log, the user can view the date, time, etc. of the concerned prompt, 

warning and error details, and click ―Help‖ for further information. Only one piece of error information can be 

displayed at the specific time. As the problems may occur at the same time, the following operations can help to 

view all the error prompt information: 

Step 1: press [Help] > [Error information] > [View error log]. The [Error log] window will pop up. 

Step 2: prompt information will be displayed in the window. 

Step 3: browse the error information with the mouse and close the dialog window. 

Step 4: click [Clear error list] to clear historical error information. 

10.3.1.2 Description of Error Information 

If any error is detected in measurement with the vector network analyzer, the warning or error information will be 

displayed in the test interface. In the default mode, error information will be displayed for a certain period of time. 

The user can keep error information displayed on the screen until ―OK‖ is pressed, or select not to display the error 

information. When the error information is displayed on the screen, you can click [Help] for further help 

information, as shown in Fig. 10.3. 

    

Fig. 10.3 [Information display mode] Dialog Box  



10 Fault Diagnoses and Repair 

10.3 Error Information 

276  

 

Table 10.1 Level Distinguishing with Fonts and Colors 

Color Error Level Error illustration 

Red Error Error in measurement, such as failure caused by data loss or improper setting. 

Blue Warning Irregular operation in measurement, such as failure of measurement as a result of mismatch 

of the instrument setting and displayed result or temporary disconnection with the external 

device. 

Black Prompt Step setting or measurement information. 
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10.3.2 Program Error Information 

Error information formats 

In the remote control mode, error information is recorded in the error log. Query the error information with the 

command ―SYSTem:ERRor?‖. Error information formats are as follows: 

"Time:" 

―Error No.:‖ 

―Error level:‖ 

―Error type:‖ 

Example: 

Time: 20:40:21, 2014/11/16 

Error No.: 1400 

Error level: wrong 

Error type: grammar error 

Program error information is divided into two types: 

 Negative error codes defined in the SCPI standard, not detailed here. 

 Positive error codes of instrument characteristics, with details shown in the following table. 

Table 10.2 List of Instrument Characteristic Error Information 

Error code Error Level Error illustration 

512 Prompt The secondary parameter (such as the power, intermediate frequency 

bandwidth, sweep time and step mode) of the calibration state has been changed. 

Type: 

Changes of such parameters after calibration may result in inaccurate measurement. 

513 Prompt Calibration cannot be done as a result of failure to complete all standard 

measurements. 

This may be caused by enabling of the error correction function before all standard 

measurements for calibration. 

515 Prompt The correction function cannot be enabled (no error correction data 

corresponding to Channel <x> or Measurement <x>). Perform calibration. 

No error correction data corresponding to the specified channel and measurement. 

516 Prompt The key parameters of the current instrument state do not match with the 

calibration set, and the correction function is shut down. 
Key parameters include the sweep type, start frequency, frequency span and point 

number. 

517 Prompt The correction function is shut down as the interpolation function is shut down 

and stimulus settings are changed. 
The original stimulus settings should be applied for the most accurate calibration. 

518 Prompt Shut down the interpolation function, enable the correction function and recover 

the previous stimulus settings. 

519 Prompt The stimulus range is beyond the original calibration settings, resulting in 

shutdown of the correction function. 
Correction data beyond the stimulus settings will not be generated. 

520 Prompt The calibration type of Channel <x> and Measurement <x> is “None”. Select the 

calibration type by the [Cal] menu or with the keys. 

Calibration will not be done if the calibration type is not selected or the invalid 

calibration type is set. This error is caused by no calibration or calibration without 

calibration type selection. 
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521 Prompt The calibration type does not match the selected measurement type. The 

correction function is shut down or correction is not allowed. 

Some kinds of calibration are only applicable to some S-parameters. For example, the 

Port 1 calibration for S11 is not applicable to Port 1 calibration of S22. 

522 Prompt More standard kits should be measured. 

524 Prompt Not full double-port calibration. 

525 Prompt Two calibration kits are used. 

526 Prompt No user calibration data suitable for the channel are found. 

Correction cannot be done as a result of no calibration. 

527 Prompt The standard calibration kit is not required for the calibration type. 
This error is caused if one undesired standard calibration kit is measured during 

calibration. 

528 Prompt The electrical calibration system cannot be configured. Check whether the 

module is connected properly.. 
Before electrical calibration, normal communication between the network analyzer 

and electrical calibration module should be established at first, and the module should 

be confirmed; otherwise, electrical calibration cannot be done. 

529 Prompt Out-of-limit data: beyond the design range. 
Key parameters include the sweep type, start frequency, frequency span and point 

number. 

530 Prompt Execution error: the data dimensions do not match. 

531 Prompt Execution error: the array cleared. 

532 Prompt Execution error: the array function is invalid. 

533 Prompt Execution error: the array subscript is wrong. 

534 Prompt Execution error: the array subscript is out of limit. 

535 Prompt Execution error: the matrix rank is wrong. 

536 Prompt Execution error: CPU. 

537 Prompt Execution error: the module cannot be deleted. 

538 Prompt Execution error: the module cannot be written. 

539 Prompt Execution error: no input. 

540 Prompt Execution error: the system is busy and the command is invalid. 

541 Prompt Electrical calibration: the module is not on the RF channel. Connect the module 

to the specified port. 

The RF channel is not connected to the electrical calibration module, and no signal is 

found in the corresponding calibration measurement. 

542 Prompt Execution error: no space for new calibration kit. Delete one calibration kit. 

Key parameters include the sweep type, start frequency, frequency span and point 

number. 

543 Prompt Execution error: the space is not enough. 

544 Prompt Execution error: other matrix errors. 

545 Prompt Execution error: unequal rank. 

546 Prompt Execution error: few constant ranks. 

547 Prompt Execution error: few variable ranks. 

548 Prompt Perform pre-calibration. 

549 Prompt Execution error: bug in the dynamic library of electrical calibration drivers or 

invalid module number. 

550 Prompt Execution error: accidental error from the electrical calibration driver. 

551 Prompt Execution error: error of the built-in driver. 

552 Prompt Hardware error: failure of access to the electrical calibration module. 
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553 Prompt Hardware error: failure to release the LPT port. Restart the instrument. 

554 Prompt Hardware error: error of the vector network analyzer. 

555 Prompt Hardware error: failure to read enough data from the electrical calibration 

module. 

556 Prompt Suspension of the master control computer. 

557 Prompt Suspension of user operation. 

558 Prompt Out-of-limit memory. 

559 Prompt Ended query: the message is abandoned. 

560 Prompt Unfinished query: incomplete application message. 

561 Prompt Unfinished query: no content. 

562 Prompt Queue overflow. 

563 Prompt Setting conflict: requiring the additional standard calibration kit. 

564 Prompt Setting conflict: the adapter cannot be calibrated. 

565 Prompt Setting conflict: the command queue is subject to overflow. 

566 Prompt Setting conflict: calibration is stopped, as a result of changes of analyzer settings. 

567 Prompt Setting conflict: calibration is not done. 

568 Prompt Setting conflict: the specified GPIB board cannot be found. 

569 Prompt Setting conflict: gpib32.dll cannot be found/installed. 

570 Prompt Setting conflict: sicl32.dll cannot be found/installed. 

571 Prompt Setting conflict: the network analyzer cannot be initialized (wrong address?). 

572 Prompt Setting conflict: the print port drive program or USB-driven dynamic library 

cannot be loaded. 

573 Prompt Setting conflict: the calibration canning mode is invalid. 

574 Prompt Setting conflict: the calibration type is invalid. 

575 Prompt Setting conflict: calibration is invalid. 

576 Prompt Setting conflict: the specified GPIB board number is invalid. 

577 Prompt Setting conflict: the specified GPIB board type is invalid. 

578 Prompt Setting conflict: the module state is invalid. 

579 Prompt Setting conflict: the state is invalid. 

580 Prompt Setting conflict: the LPT port must be 1-4. 

581 Prompt The electrical calibration system cannot be configured. Check whether the 

module is connected properly. 

582 Prompt Setting conflict: the specified LPT port does not exist. 

583 Prompt Setting conflict: use the frequency range in calibration. 

584 Prompt Setting conflict: use the step sweep type in calibration. 

585 Prompt Setting conflict: the analyzer address must be 0-30. 

586 Prompt Setting conflict: wrong print port driver or USB-driven dynamic library. 

587 Prompt Grammar error: the ECAL: DELAY must include two digits. 

588 Prompt Grammar error: incorrect grammar. 

589 Prompt Grammar error: unknown command. 

590 Prompt The module port on the RF channel is wrong. 

591 Prompt The module does not conform to the requirements described by the user. 

592 Prompt The source power calibration data corresponding to the current measurement 

channel and source port are not found. 
Try to enable the source power calibration function, but no calibration data are found. 

593 Prompt Failure of source power calibration sweep or correction of the channel and 
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source port corresponding to the current measurement. 
Try to enable the source power calibration function, but calibration data are not 

complete. 

594 Prompt Reserved. 

595 Prompt Reserved. 

596 Prompt The calibration function is enabled, but the calibration power is changed in 

source power calibration of Port 1 and Channel 2. The calibration function is 

not shut down, but the power value cannot be used to represent the calibration. 
The source power calibration may be inaccurate. 

597 Prompt The software version does not support the electrical calibration function. 

598 Prompt A circle cannot be properly fitted as a result of inappropriate sliding in 

measurement of the standard calibration kit for the sliding load. The original 

impedance of the standard calibration kit is used to determine the direction of 

one or more point(s). 

To accurately describe the standard calibration kit, the sliding load must be moved 

properly to ensure sufficient sampling along the plural circle or Smith chart. 

Insufficient sampling may result in inaccurate results. 

599 Prompt One unused channel is required but cannot be found. Release one channel and 

test it. 

600 Prompt Interpolation cannot be done to the original standard calibration kit in the 

segment sweep mode. Shut down the calibration function. 

601 Error Calibration is not complete (the standard calibration kit measurement is not 

completed). 

602 Error The correction function is not enabled. 

603 Error The power correction function cannot be enabled. Calibrate the power meter at 

first. 

604 Error The sweep state is changed, the power correction data are invalid, and the power 

correction function is shut down. 

605 Error The power correction function is shut down, and the original sweep state is 

recovered. 
Key parameters include the sweep type, start frequency, frequency span and point 

number. 

608 Error The calibration type is not set. 

Calibration can be done only when the calibration type is valid and the appropriate 

calibration type is selected. 

609 Error Fail to achieve the calibration characteristics. 

The specified calibration kit may be one of the optional calibration kits. For example, 

one standard calibration is required in response calibration, three in one-port 

calibration and 12 in full double-port calibration. 

610 Error The calibration class is invalid for the current calibration type. Select a different 

calibration class or type. 

611 Error The standard calibration data corresponding to the selected calibration type are 

not found. 
The original measurement data of the specified standard calibration kit is not found in 

the current measurement cache zone. 

612 Error Error item data corresponding to the selected calibration type are not found. 

No specified error item in the error correction cache zone (including all error 

coefficients of the current calibration). 

613 Error Reserved. 

The access to the calibration set is not successful. The calibration set may be deleted 

or destroyed. 

614 Error The specified measurement is not compatible with the current calibration. Select 
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a different measurement type or load a different calibration type or reinstall the 

calibration kit. 

Prevent measurement selection so as not to shut down the measurement calibration 

function. Some calibration types do not support all measurements. For example, 

S111-PORT calibration cannot be used in S12 calibration measurement. If the 

measurement which is not supported by the current calibration is selected, prompt 

information will be given, and the calibration function will be shut down. 

615 Error A new calibration set has been created. 
The newly created calibration set will be automatically named and sealed with the 

timestamp. Only the calibration set subject to calibration can be saved. In case of 

suspension or failure in completion of calibration, the calibration set will be deleted. 

617 Error The pre-calibration fails. 

620 Error The measurement state is changed, and the antenna and RCS calibration 

function is shut down. 

621 Error The measurement state is changed, and the antenna and RCS calibration 

function cannot be enabled. 

622 Error The calibration data are invalid, and the antenna and RCS calibration function 

cannot be enabled. 

634 Error Calibration set file: <x> loading failure. 

The calibration set file is a collection of calibration sets and saved in the hard disc. 

635 Error Calibration set file: <x> saving failure. 
File operation error and saving suspension. 

636 Prompt One calibration set is deleted. 

One calibration set is successfully deleted. This may be caused as a result of 

application or deliberate operation of the user. 

637 Error Calibration set file version: <x> is not compatible with the current 

measurement. 

The calibration set is not available as a result of version nonconformity. This may be 

caused by software upgrading. 

638 Error Incompatible calibration set: <x>of<y>, the saved calibration set is loaded. 
Some calibration sets in the calibration set file are wrong. 

639 Prompt Calibration set file: <x> is not found. A new file will be created. 

The calibration set file is saved in the hard disc. After start-up of the network 

analyzer, the file will be searched. If the file is found, it indicates that the file has 

been loaded; otherwise, a new file will be created, and the prompt will be provided. 

640 Error The specified calibration set is used at present. 

It indicates that several calibration set users are performing calibration tasks, resulting 

in conflicts. 

641 Error The specified calibration set cannot be opened. 
Many users are trying to visit the calibration set. 

642 Error Reach the maximum register number of the calibration set. Delete the old or 

useless calibration set before creating a new calibration set. 

The network analyzer can be configured with 100 calibration sets. 

644 Error Calibration must be effectively done once before enabling the error correction 

function. 

This generally indicates that the calibration is not completed or there is no calibration 

kit matching with the selected measurement type in the current calibration set. 

646 Error The calibration set is not loaded and the version is too new. 
The new calibration file is used in the old software. The version is not compatible. 

772 Error The DSP board drive program does not work. Check the hardware. Use 

simulation data in the software. 

Communication between the network analyzer and DSP board fails. The hardware or 
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drive program may be faulty. 

773 Error The serial bus of the instrument does not work properly. The serial EEPROM of the 

instrument may be all ―1‖ or ―0‖. This may be caused by hardware problems. 

774 Error Intermediate frequency overload. 

848 Error Locking failure <x>. 
The source phase can't be locked properly. This may be caused by hardware failure, 

poor calibration or data damage in serial EEPROM. 

849 Error Phase locking failure <x>. 

850 Error Unknown hardware error. 

The communication with DSP fails as a result of hardware problems. 

855 Error The source amplitude is not stabilized. 

The source amplitude cannot be properly stabilized at the required power. The 

indicated power is not accurate. 

856 Error The LO amplitude is not stabilized. 

859 Error YIG calibration fails. 

The internal auto-calibration tuning of the YIG oscillator fails. 

861 Error The simulation slope calibration fails. 

The internal simulation slope calibration fails. 

865 Error EEPROM writing fails. 
The storage of calibration data in EEPROM fails. This may be caused by hardware 

failure. 

867 Error Try to write the input or read-only I/O port. 

Try to write one input or read-only I/O port. 

868 Error Try to read the input or write-only I/O port. 
Try to read the input or write-only I/O port 

1025 Error The instrument cannot be shut down normally. The program is not stable. 

Restart the instrument. 

This is displayed when the vector network program crashes. If this message continues 

to appear, please consult the service center. 

1026 Error The limit segment type is wrong. 

Three limit segment types are provided: OFF. MAX and MIN. 

1027 Warning The group delay format must not be used in the CW or power sweep mode. 

The group delay format must not be used in the single-frequency sweep mode; 

otherwise, invalid data will be generated. 

1028 Warning The limit line test fails. 
The limit line test fails. 

1029 Prompt The limit line test is successful. 

The limit line test is successful. 

1030 Warning Exceed the maximum number of tests. 

At most 512 measurements can be created. 

1031 Error An error occurs inside the analyzer. An error occurs when new measurement is 

added. 

If this message continues to appear, please consult the service center. 

1032 Warning The selected measurement is not found. Operation cannot be performed. 

Conflict. 

1033 Warning Measurement of the same name cannot be created. 

1034 Warning The selected trace is not saved. Save the trace before trace operation. 

The trace must be saved before trace operation. 

1035 Prompt The averaging operation is completed. 
COM programming information. The sweep averaging is completed, and the value 
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reaches the set average factor. 

1036 Error The sweep averaging of resetting is completed. 

COM programming information. The sweep averaging is not completed, and the 

value does not reach the set average factor. 

1037 Prompt At least three points are required for time domain transformation and gate 

operation. If less than three points are provided, cancel the time domain 

transformation and gate operation. 

1038 Prompt The stepping type must be used in the low-pass time domain measurement mode. 

The band-pass must be used in the pulse stimulus type. 

1039 Warning Smoothing cannot be done as a result of insufficient points. 

1040 Warning If too may low-pass points in the time domain are beyond the frequency range, 

the system will automatically change into the band-pass mode. 

1041 Warning The low-pass frequency cannot be set in the current configuration. 

1103 Prompt The measurement name is repeated. 

1104 Error The number of measurements is out of limit. 

At most 512 measurements can be created. 

1105 Error The parameter is invalid. 

The measurement parameter entered in programming is invalid. 

1106 Error No measurement is found. 
Conflict. 

1107 Error The saved trace is invalid and cannot be operated. 
Save the trace before trace operation. 

1108 Error No reference marker. 

Try to create the △marker (only for COM) before creating the reference marker. 

1109 Error The data and saved trace do not match with each other. The trace operation is 

shut down. 
Warning: channel settings are changed in trace operation. 

1110 Error The data and saved trace do not match with each other. Measurement conditions 

of the memory and data traces should be similar in trace operation. 
Try to perform trace operation on the mismatching data and memory trace. 

1111 Error The marker bandwidth is not found. 
The trace conforming to the specified bandwidth standard cannot be found. 

1112 Error The peak value is not found. 

The trace conforming to the specified peak standard cannot be found. 

1113 Error The target search value is not found. 

The interpolation data point conforming to the search value requirements is not 

found. 

1114 Error One auxiliary port must be provided for reflection measurement (such as S11) to 

clearly identify the Port 2 measurement of the multi-port device. 

1115 Warning As a result of measurement type or source port changes, the receiver power 

calibration is invalid and shut down. 

1116 Warning The non-ratio power measurement is required for receiver power calibration. 

1117 Warning The source power calibration mode matching the channel and source port is not 

found in the current active measurement. Before receiver power calibration, 

calibrate the source power or recall one source power calibration type. 

1118 Error The operation is only applicable to standard measurement. 

1119 Error The custom measurement cannot be loaded as a result of mismatch with the 

hardware of the network analyzer. 



10 Fault Diagnoses and Repair 

10.3 Error Information 

284  

 

1120 Error The custom measurement cannot be loaded as a result of mismatch with the 

software of the network analyzer. 

1121 Error The custom measurement cannot be loaded for unknown reasons. 

1122 Error Custom measurement data processing is abnormal and will be terminated. The 

software of the network analyzer may be not steady. It is recommended to shut 

down the program and run it again. 

1123 Error The operation is only applicable to custom measurement. 

1124 Error The proposed custom measurements are unavailable. 

1125 Error The proposed custom algorithm does not exist. 

1126 Error Normalization fails, as the divisor storage zone is invalid in measurement. 

1127 Warning The original data for measurement cannot be provided. 

1128 Prompt Time domain transformation or “Add” gate operation are not allowed in the 

selected sweep type or prohibited. 

1284 Prompt The instrument state word is changed. 

1285 Prompt <x> error caused by the received SCPI command: “<x>”. 

1400 Warning <x> command error. 

1401 Warning The command parameter must be entered in <x>. 

1402 Warning The command parameter entered in <x> is not correct. 

1403 Error The command in <x> cannot be queried. 

1405 Error Too few parameters for the <x> command root. 

1406 Error Too many parameters for the <x> command root. 

1407 Error The type of the parameter entered in <x> is wrong. 

1408 Error The unit of the parameter entered in <x> is wrong. 

1409 Error The unit of the parameter entered in <x> does not match. 

1411 Error The parameter of the character string in <x> is wrong. 

1412 Error The integer parameter in <x> is wrong. 

1413 Error The floating parameter in <x> is wrong. 

1414 Error The char parameter in <x> is wrong. 

1415 Error No unit can be set behind the parameter in <x>. 

1416 Error The number of characters of the character string in <x> exceeds 50. 

1419 Error The command in <x> must be queried. 

1420 Error The actual character number entered in <x> does not conform to the 

requirements. 

1421 Error The entered ASCII code is wrong. 

1422 Error The scientific input in <x> is wrong. 

1425 Error The memory allocation fails. 

1427 Error The entered MIN or MAX parameter is wrong. 

1535 Prompt Command obtained by grammar analysis: <x>. 

1536 Warning Each window supports 8 paths at most. The trace <x> cannot be established in 

the window <x>. 

1537 Warning The number of data windows exceeds the limit (32), and the new window cannot 

be created. 

1538 Warning The data window does not exist, and measurement cannot be done. 

Try to create new measurement with no window displayed, by means of programmed 

SCPI operation. 

1539 Warning No data trace appears in the selected window, and operation cannot be done. 

1540 Warning The trace number exceeds the limit (<x> at most) for each window. The existing 
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measurements cannot be arranged in the <x> windows. 
The trace number exceeds the upper limit (8 at most) for each window. The existing 

measurement cannot be arranged in the specified window. Refer to the help 

information for arrangement of the existing measurements. 

1541 Warning Failure to establish the connection to the specified printer. 

1542 Prompt Cancel the printing output. 

1616 Error No window is found. 

The window specified in the program does not exist. 

1617 Error Copy the ID of the specified window. 

1618 Error The number of windows exceeds the limit (32 at most), and new window cannot 

be created. 

At most 32 windows can be set for each screen. 

1619 Error The trace number exceeds the limit (8 at most) for each window. The trace <x> 

cannot be created. 
At most 8 traces can be set for each window. Refer to the relevant help information of 

trace, channel and window setting. 

1620 Error No trace is found. 

1621 Error The printer cannot be identified by the operating system. 

1622 Error No active trace. 

1623 Error The trace exists. 

1624 Error The start value or stop value cannot be set in the “full bandwidth” state. 

1625 Error The specified marker does not exist. 

1626 Prompt The specified window exists. 

1792 Prompt Sweep is completed. 

1793 Prompt All trigger requests are completed. 

1794 Prompt The marker bandwidth is not found. 

The trace conforming to the specified bandwidth standard cannot be found. 

1795 Prompt At least one active segment with the sweep point number more than 0 should be 

included in the segment table so as to enable the segment sweep mode. 
Try to set the segment sweep mode with no segment defined or no sweep point in the 

defined segment. 

1796 Prompt Channel spam setting message. 

This message appears as channel settings are changed but the original settings are still 

used to obtain data. The message to clear channel waste will be generated if data are 

obtained according to new channel settings. 

1797 Prompt Channel spam clearing message. 

The previous setting message appears when channel settings are changed but the 

original settings are still used to obtain data. This clearing message will appear when 

new channel data are obtained. 

1798 Prompt The segment is not deleted properly. 

1870 Error Measurement is not selected. 

Measurement is not selected. 

1871 Error The channel number is beyond the range. 
The specified channel number is beyond the allowed range. 

1872 Error The channel is not found. 

An unknown channel is specified under the program control. 

1873 Error The proposed sweep segment is not found. 

An unknown sweep segment is specified under the program control. 

1874 Error The sweep segment table is  empty. 
At least one segment should be defined in the segment table sweep mode. This error 
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only occurs in remote control. 

1875 Error The number of sweep points of the active sweep segment table is 0. 

At least one sweep point with segment should be set in the segment table sweepmode. 

This error only occurs in remote control. 

1876 Error The specified source attenuation is invalid. 

Try to set channel attenuation properties to the vector network analyzer with no 

source attenuator. 

1877 Error There are too many sweep points and the logarithmic sweep mode fails. Reduce 

the number of sweep points. 

The maximum number of sweep points should be 401 in the logarithmic sweep mode. 

1878 Error The set point number is larger than the allowable number in the logarithmic 

sweep mode. 
The maximum number of sweep points should be 401 in the logarithmic sweep mode. 

2048 Error Options should be added based on the standard analyzer so as to enable this 

function. 

2049 Error The current measurement instrument does not have the function you need. 

2050 Error A conflict occurs between the required function and current instrument state. 

2051 Prompt The file <x> has been saved. 

2052 Error File <x> saving fails. 

2053 Error File opening fails or the file <x> is not found. 

2054 Error The <x> head is wrong. 

2055 Error The state file is invalid and cannot loaded! 

2056 Error Put forward the request to enter the sleep mode. 

2057 Error Wake up from the sleep mode. The PBT_APMRESUMEAUTOMATIC message 

is received. 

2058 Error Wake up from the standby state. The PBT_APMRESUMESUSPEND message is 

received. 

2059 Warning Wake up from the standby state. The PBT_APMRESUMECRITICAL message 

is received. 

2060 Warning Wake up from the unknown sleep mode. The NOPBT_Message message is 

received in allocation and trial recovery. 

2061 Error The file <x> already exists. The file is overridden. 

Only in remote application. 

2063 Error The file <x> has been restored. 
Only in remote application. 

2064 Error The <x> version is older than the current version. 

Try to restore an invalid file. 

2065 Error The <x> version is newer than the current version. 

Try to restore the latest file of the network analyzer. 

2066 Error The error occurs in reading of the file <x>. 
The file may have been damaged. 

2067 Error Window kernel error: <x>. 

2068 Error <x>GPIB: failure in REN setting and clearing. 

2069 Prompt Change the GPIB mode into the system controller mode. 

2070 Prompt Change the GPIB mode into the listening mode. 

2071 Prompt The GPIB system controller mode must be set in the local GPIB state of the 

network analyzer. Stop any remote control program and press [Macro/Local] to 

retest the network analyzer. 

Refer to the LCL and RMT operation. 
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2072 Error The range setting is wrong. 

2073 Error The configuration has been changed. Perform sweep again. 

The trace conforming to the specified bandwidth standard cannot be found. 

2074 Error The system controller mode of GPIB cannot be enabled. 

2075 Error IFC cannot be cleared by GPIB. 

2076 Error GPIB writing fails. 

2077 Error GPIB recalling fails. 

2078 Error EDVR: system error. 

2079 Error ECIC: the GPIB interface should be in the CIC mode according to the function 

requirements. 

2080 Error ENOL: no listener for GPIB. 

2081 Error EADR: GPIB interface address is not correct. 

2082 Error EARG: the parameter is invalid for this function. 

2083 Error ESAC: the GPIB interface is not in the required system controller mode. 

2084 Error EABO: I/O operation is canceled (timeout). 

2085 Error ENEB: GPIB interface does not exist. 
The trace conforming to the specified bandwidth standard cannot be found. 

2086 Error EDMA: DMA error. 

2087 Error EOIP: asynchronous I/O operations are performed. 

2088 Error ECAP: the operation fails. 

2089 Error EFSO: file system error. 

2090 Error EBUS: GPIB bus error. 

2091 Error ESTB: overflow of serial polling state byte queue. 

2092 Error ESRQ: query request signal blockage. 

2093 Error ETAB: table problems. 

2094 Error GPIB reading error. 

2095 Error The query is interrupted. 

2120 Error This method cannot be recalled by the late bound COM. 

2123 Error The weight is beyond the range. 

2124 Error File extension names are not consistent. 

2126 Error No file extension name. 

2127 Error The holder or file does not exist. 

2128 Error The specified file is not found. 

2129 Error WINNT anomalies occur in the automatic control layer. 

2130 Error Invalid port. 

2131 Error No printer is found. 

2132 Error Manual trigger is ignored. 

2133 Error Trigger setting fails. 

2134 Error Macro execution fails. 

2135 Error The macro definition is not complete. 

2136 Error Trigger is too quick, and redundant trigger is ignored. 

2137 Error The data block length is wrong. 

Refer to the relevant section on how to obtain data from the network analyzer. 

2139 Error The requested data are not found. 

2142 Error The provided parameter is beyond the range. Limit it within the range before 

application. 
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2144 Error The request fails. No permit is found. 

2145 Error Return result<x>after remote recalling of the front panel function. 

This indicates that the front panel may be faulty. 

2146 Error The data is beyond the range. 

2147 Error Reserved. 

2148 Error Reserved. 

2149 Error Reserved. 

2150 Error <x> is beyond the range. 

2152 Error Front panel <x>. 

2153 Error Front panel information. 

2154 Error Power supply service <x>. 

Many power supply service programs are running. Only one program can be applied. 

This is generally caused by operation of the installed program, especially CPU board 

upgrading. 

2155 Error Power supply service <x>. 

2156 Error GPIB drive cannot be loaded or unloaded. 

2157 Error GPIB drive cannot be loaded or unloaded. 

2158 Error GPIB drive is loaded but does not work properly. 

2163 Error The resetting function is executed by the network analyzer. 

2164 Error The access to the file is rejected. 

This means that the output file cannot be opened, like writing protection. 

2165 Prompt The file type is subject to structural storage. 

2166 Error Triggering fails. 

2167 Error The parameter is beyond the range. 

2168 Prompt The <x> file already exists. 

10.4 Repair 

10.4.1 Contact us 

In case of failure of 3672 series vector network analyzers, first check and save error information, analysis possible 

causes and perform early screening and troubleshooting with reference to ―10.2 Fault Diagnosis and 

Troubleshooting‖. If the problems are not solved, contact our service consultation center according to the following 

contact information, and provide the collected error information. We will assist you to solve the problems as soon 

as possible. 

Contact information: 

Free customer service telephone: 800-868-7041. 

Technical support: 0532-8688984786897262 

Fax: 0532-86889056 86897258 

Website: www.ei41.com 

Email: eiqd@ei41.com 

Postcode: 266555 

Address: 98 Xiangjiang Road, Economic and Technological Development Zone, Qingdao, Shandong, China 

10.4.2 Packaging and Mailing 

If you cannot solve the problem of the network analyzer, contact us by phone or fax. If it is confirmed that the 

network analyzer needs to be returned for repair, pack the network analyzer with the original packing material and 

box according to the following steps: 
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1) Write fault details of the network analyzer and place it with the network analyzer into the packing box. 

2) Pack the network analyzer with the original packing material to reduce possible damage. 

3) Set pads in the four corners of the outer packing box, and place the instrument into the outer packing box. 

4) Seal the opening of the packing box with a tape and strengthen the packing box with nylon straps. 

4) Mark ―Fragile!‖, ―No touch!‖ and ―Handle with care!‖on the box. 

6) Transport the network analyzer as a precision instrument. 

7) Keep the copies of all transport documents. 

Attention 

Pay attention to the packing of the network analyzer. 

The instrument may be damaged if packed with other materials. Do not pack the instrument with the polystyrene 

sphere; otherwise, the instrument cannot be fully protected, and the generated static electricity may be sucked into 

the fan to cause damage to the instrument. 

The network analyzer is heavy. In order to prevent damage in transportation, please give priority to the original 

packaging material and double-layer package. If you must package the instrument by yourself, please ensure that 

the instrument will not be damaged in transportation. 

 

Prompt 

Instrument packing and transportation 

Strictly observe the precautions in ―3.1.1.1 Unpacking‖ during transportation or handling of the instrument. 
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11 Technical Indicators and Measurement Methods 

This chapter describes the technical indicators and measurement methods of 3672 series vector network analyzers. 
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11.1 Technical Indicators 

This section lists the details of performance indicators and technical parameters of 3672 series vector network 

analyzers. By reading this section, the user will have an accurate understanding on main performance indicators of 

the product. Normal working conditions of the instrument include the ambient temperature of 0°C to +40°C and 1 

standard atmospheric pressure. 

Main technical parameters of 3672 series vector network analyzers are given below. The temperature of test 

environment should be 23±3°C, and the ambient temperature change must not exceed ±1°C after calibration. The 

pressure should be the atmospheric pressure. 

Attention 

Different models and options: 

3672A/B/C/D/E are respectively used to test the frequency of 13.5GHz/26.5GHz/43.5GHz/50GHz/67GHz. 

3672A/B/C/D/E of standard configuration can test the indicators of Port 1 and 2. The four-port type 

3672A/B/C/D/E can test the indicators of Port 1, 2, 3 and 4. 

11.1.1 Frequency Range 

Frequency range: 3672A: 10MHz to 13.5GHz 

3672B: 10MHz to 26.5GHz 

3672C: 10MHz to 43.5GHz 

3672D: 10MHz to 50GHz 

3672E:10MHz ~ 67GHz 

11.1.2 Frequency Accuracy 

Frequency accuracy: ±1×10
-7

 (23℃±3℃) 

11.1.3 Frequency Resolution 

Frequency resolution: 1Hz 

11.1.4 Port Output Harmonic Suppression 

Table 11.1-1 Indicators of 3672A/B Port Output Harmonic Suppression 

(Power setting: -5dBm, 2/3 harmonics) 

Frequency range 10MHz≤f≤4GHz 4GHz＜f≤26.5GHz 

Output harmonic suppression of 

Port 1 and 3 -48dBc -57dBc 

Output harmonic suppression of 

Port 2 and 4 -13dBc -18dBc 

 

 

Table 11.1-2 Indicators of 3672C/D/E Port Output Harmonic Suppression (continued) 
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(Power setting: -5dBm, 2/3 harmonics) 

Frequency range 10MHz≤f≤4GHz 4GHz＜f≤13.5GHz 13.5GHz＜f≤67GHz 

Output harmonic suppression of 

Port 1 and 3 

-48dBc -57dBc -57dBc 

Output harmonic suppression of 

Port 2 and 4 

-13dBc -18dBc -57dBc 

11.1.5 Maximum Output Power of Port 

Table 11.2-1 Maximum Output Power Indicator of 3672A/B Test Port 

Frequency range 

Standard Option 400  Options 201, 401, 402 

Maximum output power of 

Port 1 and 3 
Maximum 

output 

power of 

Port 2 and 

4 

Maximum output power of 

Port 1 and 3 
Maximum 

output 

power of 

Port 2 and 

4 

Filtering 

mode 
High power 

mode 
Filtering 

mode 
High power 

mode 

10MHz≤f≤50MHz 0dBm +9dBm +13dBm -1dBm +8dBm +12dBm 

0.05GHz＜f≤4GHz 0dBm +6dBm +13dBm -1dBm +5dBm +12dBm 

4GHz＜f≤7GHz +12dBm +10dBm +10dBm +9dBm 

7GHz＜f≤13.5GHz +8dBm +9dBm +6dBm +8dBm 

13.5GHz＜f≤20GHz +6dBm +6dBm +4dBm +5dBm 

20GHz＜f≤26.5GHz +4dBm +2dBm +2dBm 0dBm 

 

Table 11.2-2 Maximum Output Power Indicator of 3672C/D Test Port (continued) 

Frequency range 

Standard Option 400 Options 201, 401, 402 

Maximum output power of 

Port 1 and 3 
Maximum 

output 

power of 

Port 2 and 

4 

Maximum output power of 

Port 1 and 3 
Maximum 

output 

power of 

Port 2 and 

4 

Filtering 

mode 
High power 

mode 
Filtering 

mode 
High power 

mode 

10MHz≤f≤50MHz -1dBm +8dBm +11dBm -2dBm +7dBm +10dBm 

0.05GHz＜f≤4GHz 0dBm +5dBm +9dBm -1dBm +4dBm +8dBm 

4GHz＜f≤13.5GHz +5dBm +6dBm +3dBm +4dBm 

13.5GHz＜f≤40GHz +7dBm +7dBm +5dBm +5dBm 

40GHz＜f≤47GHz +5dBm +5dBm +2dBm +2dBm 

47GHz＜f≤50GHz -7dBm -7dBm -10dBm -10dBm 

Table 11.2-3 Maximum Output Power Indicator of 3672ETest Port (continued) 

Frequency range 

Standard Options 400 Options 201, 401, 402 

Maximum output power 

of Port 1 and 3 
Maximum 

output 

power of 

Port 2 and 4 

Maximum output power of 

Port 1 and 3 
Maximum 

output 

power of 

Port 2 and 

4 

Filtering 

mode 
High power 

mode 
Filtering 

mode 
High power 

mode 

10MHz≤f≤50MHz -1dBm +8dBm +8dBm -2dBm +7dBm +7dBm 

0.05GHz＜f≤4GHz 0dBm +5dBm +5dBm -1dBm +4dBm +4dBm 

4GHz＜f≤13.5GHz +1dBm +1dBm -2dBm -2dBm 

13.5GHz＜f≤26.5GHz +5dBm +5dBm +3dBm +3dBm 

26.5GHz＜f≤40GHz +3dBm +3dBm 0dBm 0dBm 

40GHz＜f≤67GHz +5dBm +5dBm 0dBm 0dBm 

11.1.6 Accuracy of Port Output Power 
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Accuracy of port output power (power setting: -5dBm): ±2dB10MHz≤f≤13.5GHz 

±3dB  13.5GHz＜f≤40GHz 

±4dB  40GHz＜f≤50GHz 

±4.5dB  50GHz＜f≤67GHz 

11.1.7Sweep Range of Port Output Power 

Table 11.3 Indicators of 3672 Power Sweep Range 

  

Frequency range 
Power Sweep Range 

3672A/B 3672C/D 3672E 

10MHz≤f≤50MHz 33dB 32dB 32dB 

50MHz＜f≤4GHz 30dB 29dB 29dB 

4GHz＜f≤7GHz 34dB 
28dB 

28dB 
7GHz＜f≤13.5GHz 31dB 

13.5GHz＜f≤20GHz 29dB 

30dB 
20GHz＜f≤26.5GHz 25dB 

26.5GHz≤f≤35GHz 

 

29dB 

35GHz≤f≤40GHz 26dB 

40GHz＜f≤47GHz 27dB 
25dB 

47GHz＜f≤67GHz 15dB 
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11.1.8 Linearity of Port Output Power 

Linearity of port output power (23℃±3℃): ±2.0dB （3672A/B/C/D  power setting:-25— -7dBm） 

±3.0dB （3672E  power setting:-20— -7dBm） 

±4.0dB （3672E power setting:-25— -20dBm） 

11.1.9 System Trace noise 

Table 11.4 Indicators of 3672A/B System Trace noise 

(Power setting: -5dBm; intermediate frequency bandwidth: 1kHz) 

Frequency range 
3672A/B 3672C/D 3672E 

Amplitude Phase Amplitude Phase Amplitude Phase 

10MHz≤f≤50MHz ≤0.050dB ≤0.200° ≤0.050dB ≤0.900° ≤0.050dB ≤0.900° 

50MHz≤f≤500MHz ≤0.007dB ≤0.051° ≤0.020dB ≤0.700° ≤0.020dB ≤0.700° 

500MHz＜f≤13.5GHz ≤0.002dB ≤0.042° ≤0.005dB ≤0.040° ≤0.005dB ≤0.040° 

13.5GHz＜f≤20GHz ≤0.003dB 
≤0.054° ≤0.004dB ≤0.050° ≤0.004dB ≤0.050° 

20GHz＜f≤26.5GHz ≤0.005dB 

26.5GHz＜f≤50GHz 
 

≤0.008dB ≤0.060° 
≤0.020dB ≤0.100° 

50GHz＜f≤67GHz  

 

11.1.10 Dynamic Range of System 

Table 11.5 Dynamic Range Indicators of System 

(Power setting: maximum port output power; intermediate frequency bandwidth: 1Hz; 23℃±3℃) 

Frequency range 
Dynamic Range of System 

3672A/B 3672C/D 3672C/D 

10MHz≤f≤1GHz 90dB 74dB 74dB 

1GHz＜f≤4GHz 120dB 

119dB 

90dB 

4GHz＜f≤10GHz 127dB 107dB 

10GHz＜f≤13.5GHz 
120dB 

110dB 
13.5GHz＜f≤20GHz 

115dB 20GHz＜f≤24GHz 115dB 

24GHz＜f≤26.5GHz 110dB 
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11.1.11 Indicators of Transmission Tracking, Reflection Tracking, Effective Source Matching 

and Effective Direction 

Table 11.6-1 Indicators of Transmission Tracking, Reflection Tracking, Effective Source Matching, Effective 

Direction and Effective Load Matching of 3672A/B 

(Power setting: -5dBm; intermediate frequency bandwidth: 10Hz, 23℃±3℃) 

Frequency range 10MHz≤f≤2GHz 2GHz＜f≤26.5GHz 

Transmission tracking ±0.10dB ±0.12dB 

Reflection tracking ±0.04dB ±0.05dB 

Effective direction; ≥48dB ≥44dB 

Effective source 

matching; 
≥40dB ≥30dB 

Effective load matching; ≥48dB ≥44dB 

 

 

Table 11.6-2 Indicators of Transmission Tracking, Reflection Tracking, Effective Source Matching, Effective 

Direction and Effective Load Matching of 3672C/D (continued) 

(Power setting: -5dBm; intermediate frequency bandwidth: 10Hz, 23℃±3℃) 

Frequency range 10MHz≤f≤2GHz 2GHz＜f≤13.5GHz 
13.5GHz＜f≤

40GHz 
40GHz＜f≤50GHz 

Transmission 

tracking 
±0.10dB ±0.10dB ±0.16dB ±0.20dB 

Reflection 

tracking 
±0.04dB ±0.04dB ±0.03dB ±0.04dB 

Effective 

direction; 
≥42dB ≥42dB ≥38dB ≥36dB 

Effective source 

matching; 
≥36dB ≥31dB ≥28dB ≥27dB 

Effective load 

matching; 
≥42dB ≥42dB ≥37dB ≥35dB 

Table 11.6-3 Indicators of Transmission Tracking, Reflection Tracking, Effective Source Matching, Effective 

Direction and Effective Load Matching of 3672E 

  

26.5GHz≤f≤35GHz 

 

110dB 100dB 

35GHz＜f≤47GHz 105dB 
90dB 

47GHz＜f≤50GHz 90dB 

50GHz＜f≤67GHz  75dB 
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(Power setting: -5dBm; intermediate frequency bandwidth: 10Hz, 23℃±3℃) 

Frequency range 10MHz≤f≤2GHz 2GHz＜f≤13.5GHz 
13.5GHz＜f≤

40GHz 
40GHz＜f≤50GHz 

Transmission 

tracking 
±0.10dB ±0.11dB ±0.16dB ±0.20dB 

Reflection 

tracking 
±0.05dB ±0.06dB ±0.08dB ±0.10dB 

Effective 

direction; 
≥35dB ≥41dB ≥34dB ≥32dB 

Effective source 

matching; 
≥35dB ≥31dB ≥28dB ≥25dB 

Effective load 

matching; 
≥35dB ≥41dB ≥33dB ≥30dB 

11.1.12 Port Damage Level 

Port damage level: 26dBm or 30VDC. 

 
Warning 

Limit level of port damage: +26dBm or 30VDC. If the input is beyond the above range, the instrument may 

be burnt. 

11.1.13 Range of Working Temperature and Storage Temperature 

Table 11.7 Range of Working Temperature and Storage Temperature 

Operating temperature range 0°C-40 ℃ 

Storage temperature range -30°C~70°C 

11.1.14 Number of Measurement Points 

The number of measurement points in each frequency sweep of 3672 series vector network analyzers can be set 

between 1 and 32001. 

11.1.15 Measurement Display Format 

3672 series vector network analyzers have the following measurement display options: logarithmic amplitude, 

linear amplitude, standing wave ratio, phase, group delay, real part, imaginary part, Smith chart, and polar 

coordinates. 

11.1.16 Display Window and Channel 

3672 series vector network analyzers are equipped with a 12.1-inch color LCD display, with the resolution of 

1280×800. At most 16 windows and 64 channels can be set. Each window supports 8 optional channels at most. All 

channels can be used for display at the same time. Each channel can be used to separately display basic S-

parameters such as S11 and S21. 

11.1.17 Averaging Factor 

Average factor range of 3672 series vector network analyzers: 1-1024. 

11.1.18Marker Function 

3672 series vector network analyzers are configured with 9 independent markers to read and display the value of 

the measurement curve. Specific functions are as follows. 

a) Marker search function: used for automatic search on the measurement curve, such as the maximum value, 

minimum value, right peak value, left peak value, etc. 

b) △ function: used to read the difference between the current marker and reference marker. 
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c) Marker function: used to set the current start value, stop value, center value, span, reference value and delay time 

as the active marker value. 

d) Bandwidth search function: used for automatic search to set the bandwidth (it can be set by the user, and the 

default value is 3dB) and calculate the Q value. 

11.1.19Sweep Type 

3672 series vector network analyzers are configured with 5 sweep types: 

a) Linear frequency: default sweep type of the instrument. The frequency linearity continuously covers the whole 

frequency range. 

b) Logarithmic frequency: the source frequency increases in the logarithmic step manner, and the frequency ratio of 

two adjacent frequency points is identical. 

c) Power sweep: used in the CW mode. 

d) CW: set the single sweep frequency of the analyzer, continuously and accurately sample measurement data 

according to the interval determined with the sweep time and measurement point number, and display measurement 

data changes over time. 

e) Segment sweep: set the enabling of sweep involving multiple segments. The power level, intermediate frequency 

bandwidth and sweep time of each segment can be defined separately. 

11.1.20 Intermediate Frequency Bandwidth 

Intermediate frequency bandwidth: min. 1Hz and max. 5MHz; stepping modes: 40 in total. 

11.1.21 Setting of Reference Level Amplitude 

Setting range: ±500dB 

Setting resolution: 0.001dB 

11.1.22 Setting of Reference Phase 

Setting range: ±500° 

Setting resolution: 0.01° 

11.1.23 Storage Function 

The following files can be saved: state calibration files (*.cst), state files (*.sta), calibration files (*.cal), data files 

(*.dat, *.cti, *.s1p, *.s2p, *.s3p and *.s4p), table files (*.prn) and graphical files (*.bmp and *.jpg). 

11.1.24 Port Type 

3672A/B:3.5mmstandard connector (male) 

3672C/D:2.4mmstandard connector (male) 

3672E:1.85mmstandard connector (male) 

11.1.25 Interface Types 

Peripheral interfaces include: GPIB interface, USB interface, monitor interface and LAN interface. 

11.2 Measurement Methods 

Detailed operation procedures for each index test are prepared according to test equipment used by 3672B. Test 

equipment and devices should be selected according to test frequencies and interface types. Test methods are the 

same with the one described below. If other equivalent test instrument is adopted, refer to the instructions of the test 

instrument for operation procedures. 

Reset instrument in test procedures refers to manufacturer's reset mode. If the instrument is under reset state 

defined by user, change it into manufacturer's reset state and then reset, ensuring original state of the instrument is 

known. 
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● Test of frequency accuracy ······················································································································· 297 

● Test of frequency resolution ····················································································································· 297 

● Test of port output harmonic suppression ·································································································· 298 

● Test of non-harmonic suppression of port output ······················································································· 299 

● Test of maximum output power of port ····································································································· 300 

● Test of port output power accuracy ··········································································································· 300 

● Test of sweep range of port output power ································································································· 300 

● Linearity of port output power ·················································································································· 300 

● Test of system trace noise ························································································································· 302 

● Test of dynamic range of system ··············································································································· 302 

● Test of transmission tracking, reflection tracking, effective source matching, effective direction and effective 

load matching ··········································································································································· 304 

11.2.1 Test of Frequency Accuracy 

11.2.1.1 Items of Frequency Accuracy Test 

Test the frequency accuracy indicators of frequency sweep signals output by 3672 series vector network analyzers. 

11.2.1.2 Instrument and Accessories for Test of Frequency Range and Accuracy 

1) Frequency meter HP5361B 

2) RF cable 1. 

 

Fig.11.1 Block Diagram of Frequency Accuracy Test 

11.2.1.3 Steps of Frequency Accuracy Test 

1) As shown in Fig. 11.1, connect the system and preheat is for 60min at least. 

2) Press [Reset] to set the initial state of 3672 series vector network analyzers. 

3) Press [Stimulus] > [Sweep] > [CW] > [Frequency], and enter 10GHz. Press [Stimulus] > [Trigger] > [Hold]. The 

reading of the frequency meter will be the frequency of the stimulus signal of the analyzer. 

 

11.2.2 Test of Frequency Resolution 

11.2.2.1 Items of Frequency Resolution Test 

Test the frequency resolution indicators of frequency sweep signals output by 3672 series vector network analyzers. 

11.2.2.2 Instrument and Accessories for Test of Frequency Resolution 

3672 series vector network 

 
Frequency meter 
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1) spectrum analyzer 4038 

2) BNC cable 1. 

3) RF cable 1. 

11.2.2.3 Steps of Frequency Resolution Test 

1) As shown in Fig. 11.2, connect the system and preheat is for 60min at least. 

2) Press [Reset] to set the initial state of 3672 series vector network analyzers. 

3) Press [Sweep] > [Sweep type] > [CW] > [Frequency], and enter 10GHz. Press [Stimulus] > [Trigger] > [Hold]. 

Record the measurement result of the spectrum analyzer. 

4) Change the center frequency by 1Hz. If the reading of the spectrum analyzer also changes by 1Hz, the frequency 

resolution conforms to the technical indicator requirements. 

 

Fig. 11.2 Block Diagram of Frequency Resolution Test 

11.2.3 Test of Port Output Harmonic Suppression 

11.2.3.1 Items of Test of Port Output Harmonic Suppression 

Test the harmonic suppression indicators of frequency sweep signals output by the port of 3672 series vector 

network analyzers. 

11.2.3.2 Instrument and Accessories for Test of Port Output Harmonic Suppression 

1) spectrum analyzer 4038 or R&SFSUP50 

2) RF cable 1. 

11.2.3.3 Steps of Test of Port Output Harmonic Suppression 

1) As shown in Fig. 11.3, connect the system and preheat is for 60min at least. 

2) Press [Reset] to set the initial state of 3672 series vector network analyzers. Click [Channel] > [Hardware 

configuration] > [Path configuration]. Select the filtering mode for the low-frequency segment of Port 1 and 3. 

Press [Power] > [-5] and the ENTER key. 

3) Press [Sweep] > [Sweep Time] > [10] and the ENTER key. 

4) Press [Sweep] > [Sweep type] > [CW] > [Frequency], and enter 10MHz. Set the corresponding test frequency of 

the spectrum analyzer and record the reading of the spectrum analyzer. Set the second harmonic frequency of the 

spectrum analyzer as 20MHz and record the reading of the spectrum analyzer. The difference of two readings is the 

port harmonic suppression indicator. Get difference between reading of second harmonic and reading of main 

signal. Indicators of 3672A/B are divided into two segments. The first segment covers 10MHz～4GHz. Choose 7 

test points (10MHz, 50MHz, 100MHz, 1GHz, 2GHz, 3GHz and 4GHz) within the band.  Input the worst harmonic 

suppression value out of theses points in the Performance Test Record. The second segment covers 4GHz～
26.5GHz. Choose 6GHz, 8GHz, 10GHz, 12GHz, 14GHz, 16GHz, 18GHz, 20GHz, 22GHz and 24GHz, 10 points 

in total,（3672A only uses the first 4 points） . Input the worst harmonic suppression value in the Record; 

3672C/D/E have three segments. The first one is the same with that of 3672A/B, the second part covers 4GHz～
13.5GHz. Choose 6GHz, 8GHz, 10GHz and 12GHz as test points, input the worst harmonic suppression value in 

3672 series vector network 

Spectrum analyzer 
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the Record; The third segments covers 13.5GHz～67GHz, choose 14GHz, 16GHz, 18GHz, 20GHz, 22GHz, 

24GHz, 26GHz, 28GHz, 30GHz and 32GHz as test points（3672C/D only uses the first 6 points）. Input the worst 

harmonic suppression value out of the ten points in the Record; 

5)Connect the RF cable to Port2/3/4, press【Meas】→【S22】/【S33】/【S44】, repeat Step（4）～（5）, 

they should meet relevant performance requirements.  

 

Fig. 11.3 Block Diagram of Test of Harmonic/Non-harmonic Suppression Test 

11.2.4 Test of Maximum Output Power of Port 

11.2.4.1 Items of Test of Maximum Output Power of Port 

Test the maximum output power indicators of the port of 3672 series vector network analyzers. 

11.2.4.2 Required Instrument and Accessories 

1) Power meter 2434 or ML2437A 

2) Power probe 71711 or MA2475A 

11.2.4.3 Steps of Test of Maximum Output Power of Port 

1) As shown in Fig. 11.4, connect the system and preheat is for 60min at least. 

2) Press [Reset] > [Power] > [+20] and the ENTER key. 

3) Press [Sweep] > [Sweep Time] > [20] and the ENTER key. 

4) Press [Frequency] > [Start frequency] and enter the start frequency 10MHz. Press [Stop frequency] and enter the 

stop frequency 50MHz. 

5) As shown in Fig. 11.4, calibrate/clear the power meter, connect the power probe to Port 1 and record the 

minimum reading. 

6) Successively change the sweep frequency of the 3672 series vector network analyzer. In the high power mode or 

filter mode required in the test, click [Channel] > [Hardware Configuration] > [Path Configuration]. Select the high 

power mode or filtering mode for the low-frequency segment of Source 1. The test result is the maximum output 

power of Port 1. 

7) Connect the power probe to Port 2/3/4. Click [Meas] > [S22]/[S33]/[S44]. Repeat Step (4) to (6) and measure the 

maximum output power of Port 2/3/4. 

 

 

 

 

 

 

3672 series vector network 

Spectrum analyzer 

Power meter 

3672 series vector network 
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Fig. 11.4 Block Diagram of Port Output Power Test 

11.2.5 Test of Port Output Power Accuracy 

11.2.5.1 Items of Test of Port Output Power Accuracy 

Test the port output power accuracy indicators of V3672 series vector network analyzers. 

11.2.5.2 Instrument and Accessories for Test of Port Output Power Accuracy 

1) Power meter 2434 or ML2437A 

2) Power probe 71711 or MA2475A 

11.2.5.3 Steps of Test of Port Output Power Accuracy 

1) As shown in Fig. 11.4, connect the system and preheat is for 60min at least. Press [Reset] > [Sweep] > [Sweep 

Time] > [10] and the ENTER key. Press [Power] > [-5] and the ENTER key; press [Sweep point]>[21] and ENTER 

key.  

2) Press [Freq] and input 10MHz as the start frequency and 13.5 as the stop frequency; 

3) As shown in Fig. 11.4, connect the power probe, and record the max and min readings. 

4) Calculate differences between the max., the min. value and the setting power. Choose the larger absolute value 

out of the differences as the power accuracy result and input it. Change the start and stop frequencirs and record 

measurement results.  

5) Connect the power probe to Port 2/3/4. Click [Meas] > [S22]/[S33]/[S44]. Measure the output power accuracy of 

Port 2/3/4. 

11.2.6 Test of Sweep Range of Port Output Power 

11.2.6.1 Items of Test of Sweep Range of Port Output Power 

Test the sweep range indicators of the port output power of 3672 series vector network analyzers. 

11.2.6.2  Instrument and Accessories for Test of Sweep Range of Port Output Power 

1) Power meter 2434 or ML2437A 

2) Power probe 71711 or MA2475A 

3) RF cable 1. 

11.2.6.3 Steps of Test of Sweep Range of Port Output Power 

1) As shown in Fig. 11.4, connect the system and preheat is for 60min at least. Press [Reset] > [Sweep] > [Sweep 

Time] > [20] and the ENTER key. Click [Channel] > [Hardware configuration] > [Path configuration]. Select the 

high power mode for the low-frequency segment of Source 1 and 3.Press[Power]>[Power and Attenuation…], 

remove the cross in the checkbox in the front of auto attenuation.  

2) Press [Freq] > [CW ON |OFF]]. Enable CW mode and input a frequency of 10MHz;  

3) Press [Power] and enter -25dBm, record the min. value of output power. Input 20dBm and record the max. 

output power;  

4) Take difference between the max. and the min value as the test result. Change frequency points in sequence and 

repeat Step (2) and (3). Record test results;  

5) Connect the power probe to Port 2/3/4. Click [Meas] > [S22]/[S33]/[S44]. Measure the output power sweep 

ranges of other ports. 

11.2.7 Linearity of Port Output Power 

11.2.7.1 Items of Test of Port Output Power Linearity 
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Test the port output power linearity indicators of 3672 series vector network analyzers. 

11.2.7.2 Instrument and Accessories for Test of Port Output Power Linearity 

1) Soft test cable Agilent 85131F  

11.2.7.3 Steps of Test of Port Output Power Linearity 

1) As shown in Fig. 11.5, connect the system and preheat is for 60min at least. 

2) Click [Reset] > [Response] > [Meas] > [Measurement...] and [Receiver]. Select [B] and [Port 1] under [Source] 

port and click [OK]. 

 

 

 

 

 

 

 

Fig. 11.5 Output Power Linearity of Test Port 

3) Press [Channel] > [More] > [Hardware setting] > [Graphical configuration]. Select [Low-band high-power mode] 

and click [OK]. 

4) Press [Power] > [-10] > [OK]. 

5) Press [Analysis] > [Save] > [Normalize]. 

6) Press [Power] > [-25] and the ENTER key to change the power into -25dBm. After sweep once, press 

[Analysis] > [Track statistics] > [Track statistics ON/OFF]. Read the maximum and minimum value. Calculate the 

differences of the (absolution maximum and minimum value+10) minus the set power. The larger absolute value of 

two results is the power linearity. 

7) Successively change the power and record the linearity values of all frequency bands at each power. 

11.2.8   System Trace noise Test 

11.2.8.1 Items of System Trace noise Test 

Test trace noise indicators of the output frequency sweep signal of 3672 series vector network analyzers. 

11.2.8.2 Instrument and Accessories for System Trace noise Test 

1) Soft test cable Agilent 85131F  

11.2.8.3 Steps of System Trace noise Test 

1) As shown in Fig. 11.6, connect the system and preheat is for 60min at least. 

2) Click [Reset] to set the 3672 series vector network analyzer into the initial state. Click [Power] > [-5] and the 

ENTER key. 

3) Press [Sweep] > [Sweep Time] > [10] and the ENTER key. 

4) Click [Sweep] > [Sweep type] > [CW], and enter the center frequency 10MHz. 

5) Click [Analysis] > [Track statistics] > [Track statistics ON/OFF]. 

 

 

 

 

3672 series vector network 

 test cable 

3672 series vector network 

 test cable 
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Fig. 11.6 Block Diagram of System Trace noise Test 

Measurement of S12 amplitude trace noise 

6) Click [Meas] > [S12]. 

7) Record the deviation displayed on the screen after sweep of the vector network analyzer. 

Measurement of S12 phase trace noise 

8) Click [Response] > [Format] > [Phase]. 

9) Record the deviation displayed on the screen. 

Measurement of S21 phase trace noise 

10) Click [Meas] > [S21]. 

11) Record the deviation displayed on the screen after sweep of the vector network analyzer. 

Measurement of S21 amplitude trace noise 

12) Click [Response] > [Format] > [Logarithmic amplitude]. 

13) Record the deviation displayed on the screen. 

14) Change the frequency value and repeat Step (4) to (13). Measure the trace noise value of other frequency points. 

11.2.9 Dynamic Range Test of System 

11.2.9.1 Items of Dynamic Range Test of System 

Test the indicators of the dynamic range of the system after response isolation calibration with 3672 series vector 

network analyzers. 

11.2.9.2 Instrument and Accessories for Dynamic Range Test of System 

1) 3.5mm coaxial calibration kit 31121 

2) Soft test cable Agilent 85131F 

11.2.9.3 Steps of Dynamic Range Test of System 

Test of dynamic range of Port 1: 

1) As shown in Fig. 11.7, connect the system and preheat is for 60min at least. 

2) Click [Reset] and set the 3672 series vector network analyzer into the initial state. Click [Power] > [+20] and 

press the ENTER key. Click [Channel] > [Hardware configuration] >[Path configuration]. Select the high power 

mode for the low-band segment of Source 1 and 3. 

3) Click [Meas] > [S12]. 

4) Click [Scale] > [Reference value] and enter -100. 

5) Click [Sweep] > [Number of sweep points], and enter 101. 

6) Click [Response] > [Avg] > [Intermediate frequency bandwidth], and enter 1Hz. 

7) Click [Cal] > [Non-guided calibration] and [Through type response and isolation]. 

8) Click [Selection of calibration kit](selection should match cal kit model in actual usage). choose[Through type] 

to start through type calibration. 

9) After through type calibration, as shown in Fig. 11.8, disconnect the tow cables and connect loads to two 

calibration cable ports. 
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10) Select [Load]. Select [Enable averaging] in the pop-up dialog box. Set the average factor as 8, and continue 

calibration. 

11) After all calibrations, click [OK]. Then click [Response] > [Avg] > [Average Factor] and enter 8 to enable the 

averaging function. 

12) After averaging, the maximum value of the displayed curve within each frequency range is the dynamic range 

of Port 1. 

 
 
 
 
 
 
 
 
 
 

Fig. 11.7 Block Diagram I of Dynamic Range 

Calibration Test of System 

Fig. 11.8 Block Diagram II of Dynamic Range 

Calibration Test of System 

Test of dynamic range of Port 2: 

13) Click [Meas] > [S21]. 

14) Repeat Step (7) to (12) to test the dynamic range of Port 2. 

Test of dynamic range of Port 3: 

15) As shown in Fig. 11.9, connect the system. 

16) Click [Meas] > [S34]. 

17) Click [Cal] > [Non-guided calibration] and [Through type response and isolation]. 

18) Click [Selection of calibration kit] > [31121] > [Through type] to start through type calibration. 

19) After through type calibration, as shown in Fig. 11.10, disconnect the tow cables and connect loads to two 

calibration cable ports. 

20) Select [Load]. Select [Enable averaging] in the pop-up dialog box. Set the average factor as 8, and continue 

calibration. 

21) After all calibrations, click [OK]. Then click [Response] > [Avg] > [Average Factor] and enter 8 to enable the 

averaging function. 

22) The maximum value of the displayed curve within each frequency range  is the dynamic range of Port 3. 
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Fig. 11.9 Block Diagram I of Dynamic Range 

Calibration Test of System 

Fig. 11.10 Block Diagram II of Dynamic Range 

Calibration Test of System 

Test of dynamic range of Port 4: 

23) Click [Meas] > [S43]. 

24) Repeat Step (18) to (22) to test the dynamic range of Port 4. 

11.2.10 Test of Transmission Tracking, Reflection Tracking, Effective Source Matching, 

Effective Direction, etc. 

11.2.10.1 Items of Test of Transmission Tracking, Reflection Tracking, Effective Source Matching, Effective 

Direction and Effective Load Matching 

Test the indicators of transmission tracking, reflection tracking, effective source matching, effective direction and 

effective load matching after the full double-port calibration with 3672 series vector network analyzers. 

11.2.10.2 Instrument and Accessories for Test of Transmission Tracking, Reflection Tracking, Effective 

Source Matching, Effective Direction and Effective Load Matching 

1) 3.5mm coaxial Calib   calibration kit 31121 

2) Soft test cable Agilent85131F 

11.2.10.3 Steps of Test of Transmission Tracking, Reflection Tracking, Effective Source Matching, Effective 

Direction and Effective Load Matching 

1) As shown in Fig. 11.11, connect the system and preheat is for 60min at least. 
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Fig. 11.11 Block Diagram I of Connection of Full Double-port Calibration 

2) Click [Reset] to set the 3672 series vector network analyzer into the initial state. Click [Power] > [-5] and the 

ENTER key. 

3) Click [Sweep] > [Number of sweep points], and enter 51. 

4) Click [Response] > [Avg] > [Intermediate frequency bandwidth], and enter 10Hz. 

5) Click [Cal]. Select [Non-guided calibration] > [Full double-port SOLT]. 

6) Click [Selection of calibration kit] > [31121]. 

7) Respectively connect the open-circuit device, short-circuit device and load to two ports. Select [Open-circuit 

device], [Short-circuit device] and [Load] and start calibration. 

8) After calibration, connect the system as shown in Fig. 11.12. Select [Through type] to start through type 
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calibration. 

9) After the full double-port calibration, click [OK] and disconnect the test cable calibration plane. 

10) Click [Marker] > [Marker search...]. In the pop-up [Marker search] dialog box, select ―User setting 1‖ in 

[Search Range], and set the start and stop value of [User Range]. Click [Execute] and respectively select ―Max‖ 

and ―Min‖ in [Search Type]. 

Test cable

3672 series network analyzers

 

Fig. 11.11 Block Diagram II of Connection of Full Double-port Calibration 

 

Test of transmission tracking of Port 1 

1) Click [Meas] > [S12]. 

2) Change the start and stop value of [User Range]. Search ―Max‖ and ―Min‖ in the set range. The larger absolute 

value is the transmission tracking value of Port 1. 

Test of transmission tracking of Port 2 

3) Click [Meas] > [S21]. 

4) Change the start and stop value of [User Range]. Search ―Max‖ and ―Min‖ in the set range. The larger absolute 

value is the transmission tracking value of Port 2. 

Test of effective load matching of Port 1 

5) Click [Meas] > [S11]. 

6) Change the start and stop value of [User Range]. Search the maximum value within the range. The maximum 

value is the effective load matching value of Port 1. 

Test of effective load matching of Port 2 

7) Click [Meas] > [S22]. 

8) Change the start and stop value of [User Range]. Search the maximum value within the range. The maximum 

value is the effective load matching value of Port 2. 

Test of reflection tracking of Port 1 

9 ) Connect the short-circuit device to the test cable end face of the test port 1. Click [Meas] > [S11]. Then click 

[Analysis] > [Memory] > [Normalize]. 

10) Change the range setting of [User Range]. Search the ―Max‖ and ―Min‖ within each frequency. The larger 

absolute value is the reflection tracking value of the test port 1. 

Test of effective source matching of Port 1 

11) Click [Analysis] > [Memory] > [Trace Operation] > [Data + memory]. 

12) Connect the open-circuit device to the test cable end face of the test port 1. Click [Scale] > [Reference value], 

and enter -50. 
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13) Change the start and stop value of [User Range]. Search the maximum value within the set range. The effective 

source matching value of the test port 1 is the difference of the obtained marker value minus 6. 

Test of effective direction of Port 1 

14) Connect the load to the test port 1. Click [Analysis] > [Memory] > [Trace Operation] > [Close]. 

15) Change the start and stop value of [User Range], and search the maximum value within the set range. The 

maximum value is the effective direction value of the test port 1. 

Test of reflection tracking of Port 2 

16) Connect the short-circuit device to the test cable end face of the test port 2. Click [Meas] > [S22]. Then click 

[Analysis] > [Memory] > [Normalize]. 

17) Change the start and stop value of [User Range]. Search the ―Max‖ and ―Min‖ within the set range. The larger 

absolute value is the reflection tracking value of the test port 2. 

Test of effective source matching of Port 2 

18) Click [Analysis] > [Memory] > [Trace Operation] > [Data + memory]. 

19) Connect the open-circuit device to the test cable end face of the test port 2. Click [Scale] > [Reference value], 

and enter -50. 

20) Change the start and stop value of [User Range]. Search the maximum value within the set range. The effective 

source matching value of the test port 2 is the difference of the obtained marker value minus 6. 

 

Test of effective direction of Port 2 

21) Connect the load to the test port 2. Click [Analysis] > [Memory] > [Trace Operation] > [Close]. 

22) Change the start and stop value of [User Range], and search the maximum value within the set range. The 

maximum value is the effective direction value of the test port 2. 

23) Refer to the full double-port calibration steps of the test port 1 and 2, i.e. Step (5) to (9), and calibrate Port 3 

and 4. 

Test of transmission tracking of Port 3 

24) Click [Meas] > [S34]. As shown in Fig. 13, reconnect the test cable to Port 3 and 4. 

25) Change the start and stop value of [User Range]. Search the ―Max‖ and ―Min‖ within the set range. The larger 

absolute value is the transmission tracking value of the test port 3. 

Test of transmission tracking of Port 4 

26) Click [Meas] > [S43]. 

27) Change the start and stop value of [User Range]. Search the ―Max‖ and ―Min‖ within the set range. The larger 

absolute value is the transmission tracking value of the test port 4. 

Effective load matching of test port 3 

28) Click [Meas] > [S33]. 

29) Change the start and stop value of [User Range]. Search the maximum value within the range. The maximum 

value is the effective load matching value of Port 3. 

Test of effective load matching of Port 4 

30) Click [Meas] > [S44]. 

31) Change the start and stop value of [User Range]. Search the maximum value within the range. The maximum 

value is the effective load matching value of Port 4. 

Test of reflection tracking of Port 3 

32) Connect the short-circuit device to the test cable end face of the test port 1. Click [Meas] > [S33]. Then click 

[Analysis] > [Memory] > [Normalize]. 
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33) Change the start and stop value of [User Range]. Search the ―Max‖ and ―Min‖ within the set range. The larger 

absolute value is the reflection tracking value of the test port 3. 

Test of effective source matching of Port 3 

34) Click [Analysis] > [Memory] > [Trace Operation] > [Data + memory]. 

35) Connect the open-circuit device to the test cable end face of the test port 3. Click [Scale] > [Reference value], 

and enter -50. 

36) Change the start and stop value of [User Range]. Search the maximum value within the set range. The effective 

source matching value of the test port 3 is the difference of the obtained marker value minus 6. 

Test of effective direction of Port 3 

37) Connect the load to the test port 3. Click [Analysis] > [Memory] > [Trace Operation] > [Close]. 

38) Change the start and stop value of [User Range], and search the maximum value within the set range. The 

maximum value is the effective direction value of the test port 3. 

Test of reflection tracking of Port 4 

39) Connect the short-circuit device to the test cable end face of the test port 4. Click [Meas] > [S44]. Then click 

[Analysis] > [Memory] > [Normalize]. 

40) Change the start and stop value of [User Range]. Search the ―Max‖ and ―Min‖ within the set range. The larger 

absolute value is the reflection tracking value of the test port 4. 

 

Test of effective source matching of Port 4 

41) Click [Analysis] > [Memory] > [Trace Operation] > [Data + memory]. 

42) Connect the open-circuit device to the test cable end face of the test port 4. Click [Scale] > [Reference], and 

enter -50. 

43) Change the start and stop value of [User Range]. Search the maximum value within the set range. The effective 

source matching value of the test port 4 is the difference of the obtained marker value minus 6. 

Test of effective direction of Port 4 

44) Connect the load to the test port 4. Click [Analysis] > [Memory] > [Trace Operation] > [Close]. 

45) Change the start and stop value of [User Range]. Search the maximum value within the set range. The 

maximum value is the effective direction value of the test port 4. 
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● Calibration ··············································································································································· 310 

● Connection of DUT ·································································································································· 311 

● Scale Adjustment and Data Analysis ········································································································· 311 

● Recording or Saving of Data ····················································································································· 312 

3672 series vector network analyzers are provided with various options and measurement settings are complex. 

Technological knowledge and practical experience are required to be skillful in operation of the instrument. In 

order to help you rapidly get familiar with the measurement process, the measurement attenuator is taken as an 

example below to introduce the process and relevant settings for measurement of ordinary double-port devices. 

Refer to Appendix 5 “Measurement of Amplifier Gain Compression” for the measurement of amplifier gain 
compression and Appendix 6 “Mixer Measurement” for the measurement of the mixer. 

Preparation before measurement: one 3672 series vector network analyzer, two 3.5mm test cable, one calibration 

kit (31121), DUT (attenuator) and adapter (if necessary). 

1.1 Startup, Preheating for 30min and Resetting of Analyzer 

 

Reset into the system reset state to ensure all settings are known. 

1.2 Frequency and Power Setting 

For more details, refer to ―4.3 Setting of Frequency Range‖ and ―4.4 Setting of Signal Power Level‖. 

Click [Freq] and [Power] on the front panel and [Modify] in the auxiliary menu bar. Enter the value through 

the input keys on the front panel. Click ENTER. Thus setting is completed. See the following figure: 



Appendix 

Appendix 1 Typical Measurement Example 

 309 

 

 

Prompt 

Frequency and power setting 

1) Default frequency range of the system: 10MHz-13.5GHz/26.5GHz/43.5GHz/50GHz/67GHz; power level: -

5dBm. 

2) The frequency range is set according to measurement needs. The power level is the power of the output port of 

the stimulus source. In principle, if the power of the output port of the DUT does not exceed +10dBm, 

measurement will not be affected by power level changes. 

1.3 Selection of Measurement Parameter and Creating of New Trace 

For more details, refer to ―4.2 Selection of Measurement Parameter‖. 

Right-click the title bar and select [Meas] to change the S-parameter of the current trace. Tick the S-parameter to be 

measured in the dialog box and click OK. 

Right-click within this range 

to change the S-parameter of 

trace measurement，adjust 

the scale， delete the trace，
etc.

 

Right-click the blank and select [New Trace] to add one measurement trace. Select the S-parameter to be added and 

click OK. 
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Right-click in the blank to 

create a new trace.

If [Create in New Window] 

is ticked, a new trace will be 

created in a new window.

 

1.4 Calibration. 

For more details, refer to ―7 Calibration‖. 

Press [Cal] on the front panel and click [Cal] in the auxiliary menu bar. 

 

Select [Guided Calibration(Smart 

Cal)] and click [Next].

 

Select [2-Port Cal] and click 

[Next].



Appendix 

Appendix 1 Typical Measurement Example 

 311 

 

 

Select the DUT connectors and 

Cal Kits and click [Next].

 

Connect the Cal Kits according to the 

animation and text, then click [Measure]. 

Automatically skip to next step after 

calibration. Finish step1-7.

 

Click [Done] after all calibration 

steps have been finished.

 

 

1.5 Connection of DUT 

 

1.6 Scale Adjustment and Data and Analysis 

For more details, refer to ―4.7 Setting of Data Format and Scale‖. 

If necessary, press [Response] on the front panel, click [Scale] in the auxiliary menu bar, and perform 

corresponding setting. 
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Press [Marker] on the front panel to open the marker. Rotate the knob and adjust the frequency corresponding to 

the marker. The marker reading is displayed in the upper right corner of the screen. 

 

 

 

 

 

 

 

 

 

 

1.7 Recording or Saving of Data 

For more details, refer to ―3.6 Data Output‖. 

Menu path: [File] > [Save Data As]. Select the saving path and type and click [Save]. 
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Statement: 

1) The state file and calibration file can be recalled by the main program, but cannot be edited and processed with 

other programs. 

2) The data file can be exported and printed or edited and processed with other kinds of software, but cannot be 

recalled. 

3) The graphical file can be exported and printed, but cannot be recalled. The default file saving path is 

C:\ProgramFiles\EI41\Network Analyzer\MemoryDocuments. The user can set the saving path according to the 

needs. 
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Appendix 2 Time Domain Measurement 

● Recording or Saving of Data ····················································································································· 314 

● Resolution and range of time measurement ······························································································· 316 
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● Band-pass and Low-pass Time Domain Mode ·························································································· 329 

● Setting of time domain transformation measurement ················································································· 331 

2.1 Principle of Time Domain Measurement 

If the analyzer is configured with the time domain option, you can observe the device response in the time domain. 

The analyzer displays the response of the DUT with frequency changes in general measurement. This is referred to 

as the frequency domain measurement. However, in the time domain measurement, the frequency domain data are 

subject to inverse Fourier transformation into the time domain data, the measurement results are displayed with the 

time as the X-axis, the response values appear at the discrete time points, and the characteristics and limitations of 

the DUT can be analyzed. The following figure shows the frequency domain and time domain reflection 

measurement results of the same cable with two bends. Each bend may result in transmission line mismatching or 

impedance change. 

 

Fig. 2.1 Frequency Range and Time Domain Measurement 

1) The S11 frequency range response measured at the input port shows the combined reflection response arising 

from mismatching of the cable with wave interactions. The exact physical location of cable mismatching cannot be 

determined easily. 

2) The time domain response shows the location and degree of each mismatch. It can be seen that the second bend 

of the cable mismatches obviously. 

In the time domain, the gate function can be used to filter undesired response, followed by transformation of time 

domain data into frequency range data. This function can be used to measure the response of specific signals in the 

measurement network and remove the influence of external devices such as the connector or adapter. 

The traditional time domain reflectometer (TDR) can be simulated by the time domain measurement function. Use 

TDR to send an impact or step signal to the DUT. Observe the reflected signal energy. The impedance change of 

the DUT can be determined by analyzing the amplitude, duration and waveform of the reflected signal. Actually, 

the incident impact or step signal is not produced by the network analyzer. Instead, frequency sweep measurement 

is done, and the time domain information is calculated by the Fourier algorithm based on the frequency domain 

measurement results. So far, the time domain transformation is measured with the S11 ratio for the majority of 

universal network analyzers. S11 reflection measurement is not simply to display the reflected signal measured by 

Receiver A or B. Instead, the measurement result of the ratio between the measurement receiver and reference 

receiver is displayed. In addition, system errors can be eliminated by calibration in the S11 ratio measurement. This 

is particularly important to time domain measurement. The measurement reference plane is established by 

calibration, and the calibration point is the zero point of the X-axis (time) and used as the reference point for all the 

time and distance data. Due to calibration, the time and amplitude data are accurate. The steps of time domain 

measurement of the analyzer are as follows: 

1) Collect the data of the original receiver (A and R). 

2) Perform ratio operation. 
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3) Perform calibration error correction. 

4) Transform the frequency domain data into the time domain data. 

5) Display the measurement result. 
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2.2 Resolution and Range of Time Domain Measurement 

This section discusses how to observe all effective time domain data of the DUT and how to perform setting to 

obtain the highest resolution and maximum measurement range. 

● Response resolution ·································································································································· 373 

● Display resolution ···································································································································· 375 

● Measurement range ·································································································································· 376 

2.2.1 Response Resolution 

● Concept of response resolution ················································································································· 373 

● Factors affecting time domain response resolution ···················································································· 373 

● Ways of optimization of response resolution ····························································································· 375 

2.2.1.1 Concept of Response Resolution 

The time domain response resolution of the analyzer refers to the capability to distinguish two adjacent responses. 

For the responses of the same amplitude, it is equal to the pulse width of the impact response defined at the 50% 

(6dB) amplitude point, or the rising time of the step response defined at 10% to 90% of the amplitude, as shown in 

Fig. 2.2. 

 

Fig. 2.2 Time Domain Response Resolution 

2.2.1.2 Factors Affecting Time Domain Response Resolution 

1) Frequency span 

Fig. 2.3 shows the influence of the frequency span on the response resolution. 

 

Fig. 2.3 Influence of Frequency Span on Response Resolution 

a) The response measured within the narrow frequency span is the pulse overlapping effect of separate impact 

responses. 

b) The analyzer can distinguish different responses during measurement within the wide frequency span. 

c) The frequency span is inversely proportional to the pulse width, that is, the wider the frequency span is, the 
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narrows the impact response pulse is, and the shorter the rising time of step responses is. 

2) Window width (β parameter) 

a) The response resolution is a function of the window width of time domain transformation. 

b) The approximate resolution can be calculated by the following equations. The equations are only applicable to 

responses of the same amplitude and are used to calculate the pulse width of 50% and the rising time of steps of 10% 

to 90%. 

 

The window width selection depends on the responses of the DUT. If the response is signals of the same level, the 

minimum window will be used to improve the resolution of measurement; otherwise, the maximum window will be 

used to improve the dynamic range of measurement. 

Prompt 

Calculate the pulse width in time domain transformation measurement. 

It is not required to manually calculate the pulse width in actual time domain transformation measurement. In the 

[Transform] dialog box, the analyzer will automatically calculate the pulse width according to the current settings. 

3) Time domain transformation mode 

The response resolutions measured in the low-pass and band-pass transformation mode are different. For the same 

frequency span and sweep point number, the resolution in the low-pass mode is higher. Compared with the band-

pass mode, the pulse width can be reduced by half. The following figure shows the resolution comparison of the 

two modes. 

 

Fig. 2.4 Influence of Transformation Mode on Resolution 

2.2.1.3 Ways of Optimization of Response Resolution 

1) In most cases, large frequency span is selected to obtain high time resolution. However, the frequency setting 

must conform to the working frequency requirements of the DUT. 

2) The resolution is affected by the frequency span, window width and time domain mode. 
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2.2.2 Display Resolution 

The time domain display resolution refers to the capability to accurately position one signal response over time. 

High display resolution can help to improve the positioning accuracy of the peak point and zero point of the 

response. The display resolution is affected by the time span and sweep point number. 

Display resolution = time span/(sweep point number-1) 

The display resolution can be adjusted in the following two methods: 

1) Reduce the time span. 

2) Increase the number of sweep points. 

Prompt 

Change of the number of measurement points may reduce the calibration accuracy. 

Fig. 2.5 shows the measurement results of the same DUT within different time spans. 

1) The resolution of 50ps can be obtained within the time span of 10ns. 

2) The resolution of 12.5ps can be obtained within the time span of 2.5ns. 

 

Fig. 2.5 Display Resolution 

Prompt 

1) Change of the time span has no influence on the capability of the analyzer to distinguish two close signals. 

2) Change of the sweep point number may result in change of the frequency span in the low-pass mode and also has 

certain influence on the response resolution. 

2.2.3 Measuring range 

In the time domain measurement, the measurement range is defined as the maximum time span which can be set. 

The response will not be repeated in measurement within the time span. The measurement range is inversely 

proportional to the response resolution. If one of them is increased, the other will decrease. 

As shown in Fig. 2.6, the time domain waveform is a periodic signal repeated over time. Therefore, the response 

will be repeated. The repeated response (false response) is not real response of the DUT, and only appears 

within the specific time interval (1/sweep point frequency interval). Therefore, the measurement range is 

determined by the frequency span △F of sweep points. 
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Fig. 2.6 Definition of Frequency Interval of Sweep Points 

In the time domain measurement, the maximum stop time can be set as 1/△F. The measurement range is 

proportional to (sweep point number-1) and inversely proportional to the frequency span. In order to improve 

the measurement range, the following two settings can be modified: 

1) Increase the number of sweep points. 

2) Reduce the frequency span. 

Attention 

All the above modifications must be done before calibration. 

The measurement range in m can be calculated by dividing the vacuum light velocity by the frequency 

interval △F. The physical length of the actual measurement range can be calculated by further multiplying the 

relative rage of the transmitted medium. The relative rates of some transmission mediums are as follows: 

1) V(polyethylene)=0.66 

2) V(PTFC)=0.70 

Physical length of actual measurement range＝V/△F×3×10
8
m/s 
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2.3 Window Filtering 

Affected by the side lobe and pulse width, the time resolution of time domain transformation is limited to a certain 

degree. The window filtering function can be applied to reduce the influence of such factor. The analyzer has the 

window function for time domain transformation to distinguish various responses more effectively. This function 

can be used to change the response pulse width, side lobe level and step response rising time. 

● Window filtering ······································································································································ 378 

● Correct setting of window value ··············································································································· 379 

● Window characteristics····························································································································· 379 

2.3.1 Window Filtering 

2.3.1.1 Concept of Window Filtering 

Sudden changes may occur to the start and stop frequency in the time domain measurement. This may cause over-

travel and ringing in the time domain step response. The window filtering function can be applied to reduce the 

influence of sudden changes of the frequency domain. The network analyzer also has the following disadvantages: 

1) Pulse width of impact response or rising time of step response: caused by the band limits of the system, 

limiting the capability of the analyzer to distinguish two adjacent response signals. The pulse width is inversely 

proportional to the frequency span of measurement. The frequency span should be increased to reduce the pulse 

width. 

2) Side lobe of impact response: caused by sudden changes of the stop frequency. The adjacent high-level 

response side lobe may result in hiding of low-level response signal, limiting the dynamic range of time domain 

measurement. The window filtering function can be used to inhibit the side lobe, as shown in Fig. 2.7. 

 

Fig. 2.7 Side Lobe Suppression by Window Filtering 

2.3.1.2 Advantages of Window Filtering 

1) The narrow window can be applied to reduce the pulse width of impact response, improve the response 

resolution and better distinguish two adjacent responses. 

2) The wide window can be applied to reduce the side lobe level of the impact response, improve the dynamic 

range and better measure the low-level response. 

2.3.1.3 Influence of Window Filtering 

 

Fig. 2.8 Influence of Window on Response Signal 

As shown in Fig. 2.8, the window filtering function of the analyzer for frequency domain measurement data has the 

following influence on the time domain measurement response of the DUT: 

1) It can influence the side lobe level and pulse width and improve the measurement resolution in the impact 

transformation mode. 
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2) It can reduce over-travel and ringing in the low-pass step transformation mode. 

2.3.2 Correct Setting of Window Value 

As shown in Fig. 2.9, the appropriate window value must be selected according to the response of the DUT. 

1) If the DUT has the response of the same amplitude: select the small window to obtain the small pulse width 

and improve the resolution of time domain measurement. 

2) If the DUT has the response of different amplitude: select the large window to obtain the low side lobe level 

and improve the dynamic range of time domain measurement. 

 

Fig. 2.9 Correct Setting of Window 

2.3.3 Window Characteristics 

The side lobe level is associated with the selected window in the time domain measurement, and the response 

resolution is associated with the frequency span and the selected window. Schedule 2.1 shows the window 

characteristic indicators within the frequency span of 2.997GHz. 

Schedule 2.1 Window Characteristic Indicators within Frequency Span of 2.997GHz 

Transformation 

Mode 
Window 

Response Resolution 
Side Lobe Level 

Step rising time Pulse width 

Low-pass step 

Minimum 150ps  -21dBc 

Standard 330ps  -60dBc 

Maximum 494ps  <-70dBc 

Low-pass impact 

Minimum  200ps -13dBc 

Standard  320ps -44dBc 

Maximum  481ps <-75dBc 

Band-pass impact 

Minimum  400ps -13dBc 

Standard  641ps -44dBc 

Maximum  941ps <-75dBc 

Schedule 2.2 Time Domain Waveform of Reflection Measurement of Short-circuit Device with Window 

 

2.4 Time Gate Filtering 

The time gate function can be used to select or remove one response in the time domain. Then the processed time 

domain data can be transformed by the analyzer into the frequency domain data for observation. In other words, the 

time domain transformation function can be shut down after time gate filtering of the time domain data. Observe 
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the frequency domain response of the DUT in the effective mode of the time gate function. For example, the time 

gate can be used to eliminate the influence of multi-path transportation in the transmission measurement. You can 

only observe one separate time domain response signal each time and analyze the influence of each separate 

response on measurement results in the frequency domain. 

● How to use gate function ·························································································································· 380 

● Gate setting ·············································································································································· 381 

● Gate shape ················································································································································ 381 

2.4.1 How to Use Gate Function 

The time gate function can be used in actual measurement according to the following steps. 

1) Measure the DUT in the frequency domain. 

2) Open the time domain transformation function. The time domain response of the DUT will be calculated by the 

analyzer. 

3) Select the gate shape. 

a) Band-pass: set the gate at the center of the response to be reserved, and open the gate function. The response 

beyond the gate will be removed from the displayed measurement by means of mathematical operation. 

b) Band resistance: set the gate at the center of the response to be removed, and open the gate function. The 

response within the gate will be removed from the displayed measurement by means of mathematical operation. 

4) Close the time domain transformation function. Observe the frequency domain response of the DUT to 

understand the influence of the removed response on the measurement result. Fig. 2.10 shows the measurement 

application of the band-pass time gate. 

 

Fig. 2.10 Measurement Application of Band-pass Time Gate 

2.4.2 Gate Setting 

Define the gate boundary and function by the following settings: 

1) Start and stop: define the gate cutoff time (-6dB). 

2) Center: define the center time of the gate. 

3) Span: equal to the difference of the stop time minus start time. 

4) Gate type: 

a)Band-pass: filter the response beyond the gate. 

b)Band resistance: filter the response within the gate. 

2.4.3 Gate Shape 

2.4.3.1 Gate Shape 

The gate, similar to the window filter, is shaped like a filter. You can select the reasonable filter shape (smallest, 
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standard, wide and largest) to optimize measurement. 

1) Smallest gate: the side lobe level of the filter is the highest, the edge drop is the steepest, and the passband 

ripple is the largest. 

2) Largest gate: the side lobe level of the filter is the lowest, the edge drop is the most gentle, and the passband 

ripple is the smallest. 

2.4.3.2 Passband Ripple 

The gate is a band-pass (band-resistance) filter. Filters of various shapes have different characteristics. The 

following figure shows passband ripples of four kinds of filters, in which the scale is 0.5dB/grid. It can be seen in 

Fig. 2.11 that the smallest gate has the largest ripple. 

 

Fig. 2.11 Passband Ripple of Various Gate Filters 

2.4.3.3 Side Lobe Level 

As shown in Fig. 2.12, four kinds of filters have different side lobe levels. The side lobe level and cutoff rate must 

be balanced in actual measurement. 

1) The smallest gate has the highest side lobe level and cutoff rate. It is applicable for removal of the unexpected 

response near the measured response. 

2) The largest gate has the lowest side lobe level and cutoff rate, the widest passband and the largest attenuation 

outside the gate band. 

 

Fig. 2.12 Side Lobe Levels of Various Gates 

2.4.3.5 Gate Characteristics 

Various gates have different characteristics. Schedule 2.3 lists the characteristic indicators of various gates. The 

gate characteristics are defined with the following indicators: 

1) Passband ripple and side lobe level: describe the gate shape. 

2) Cutoff time: the interval between the gate stop time (filter edge-6dB) and the first side lobe peak point. 

3) Minimum gate span: twice of the cutoff time. 
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Schedule 2.3 Characteristic Indicators of Various Gates 

Gate Shape Passband Ripple Side Lobe Level Cutoff Time Minimum Gate Span 

Minimum ±0.10dB -48dB 1.4/frequency span 2.8/frequency span 

Standard ±0.01dB -68dB 2.8/frequency span 5.6/frequency span 

Width ±0.01dB -57dB 4.4/frequency span 8.8/frequency span 

Maximum ±0.01dB -70dB 12.7/frequency span 25.4/frequency span 

Fig. 2.13 shows the complete gate shape and the meanings of characteristic indicators. 

1) T1 is the gate span, equal to the difference of the stop time minus start time. 

2) T2 is the time between the passband edge and the point of -6dB, indicating the filter cutoff rate. 

3) T3 is the time between the point of -6dB and gate resistance band edge. 

For all kinds of gates, T2 is equal to T3. Both sides of the filter center are completely symmetrical. 

 

Fig. 2.13 Schematic Diagram of Gate Shape 

2.4.3.6 Minimum Gate Span 

Each kind of gate is configured with a recommended minimum gate span for proper use. The minimum gate span is 

determined by the limited cutoff rate and provided by the following equation. In this case, the filter passband is 

equal to 0. 

 

If the set gate span is smaller than the minimum value, the analyzer will have the following effects: 

1) The gate shape is distorted, with no passband. 

2) The gate is distorted. 

3) The start time and stop time are not indicated correctly. 

4) The side lobe level may increase. 
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2.5 Time Domain Measurement Data 

In order to help the user understand device response within the time domain, this section shows the examples of 

various measurements. 

● Masking ··················································································································································· 384 

● Reflection measurement in band-pass mode ······························································································ 385 

● Transmission measurement in band-pass mode ························································································· 386 

● Error positioning of low-pass mode ·········································································································· 387 

● Reflection measurement in low-pass mode ······························································································· 387 

● Transmission measurement in low-pass mode ··························································································· 388 

2.5.1 Masking 

2.5.1.1 Masking Effect 

Masking can help the user to understand time domain measurement data, due to the influence on the response 

observed by the user in time domain measurement. 

1) Masking will occur in case of one interruption or one loss closest to the reference channel. Each concurrent 

interruption response will be affected by masking. 

2) The energy reflected or absorbed by the first interruption cannot reach the second or subsequent breaking point. 

3) The effect is that each interruption response is smaller than the first response which will occur but cannot be 

predicted. 

2.5.1.2 Masking arising from Energy Reflection 

Masking arising from reflection will occur in case of any major error configuration. As shown in Fig. 2.14, 

masking is displayed in the following example of linear impedance. 

1) Connect one 50Ω line to one 25Ω air line and then connect one 50Ω transmission line. 

2) The first breaking point is subject to reflection with the coefficient of 0.333 (equivalent to a 25Ω resistor). 

3) The response reflection coefficient is not 0.333 after the 25Ω terminal (equivalent to a 50Ω resistor). For the two 

△markers, the difference of the orders of magnitude is 35.355mU. This is because the energy reflected by the 

second pulse generation point is subject one-unit attenuation based on the reflection of the first out-of-tune point. 

 

Fig. 2.14 Influence arising from Energy Reflection on Measurement 

2.5.1.3 Masking arising from Energy Adsorption 

Masking arising from energy adsorption refers to the masking occurring in measurement of the circuit with loss. 

Fig. 2.15 shows an example of masking of next cable in the open loop. 

1) The return loss of the open-loop response on MARKER1 is -2.445dB (in the LOGMAG mode). 

2) The expected response is a typical value in the open loop. 
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3) The marker is a sum of forward and reverse path losses. 

 

Fig. 2.15 Influence of Influence arising from Energy Adsorption on Measurement 

2.5.2 Reflection Measurement in Band-pass Mode 

2.5.2.1 Data on Horizontal Axis 

The time for one pulse refers to the time from the test port to breaking point and then back to the test port. 

2.5.2.2 Data on Vertical Axis 

1) Refer to the return loss (dB) in the LOGMAG mode. 

2) Refer to the reflection coefficient in the LINMAG mode. 

Fig. 2.16 shows an example of reflection measurement in the band-pass mode. 

3) A pulse is at the zero point on the time axis, and refers to the time from the test port to the first breaking point. 

4) The concurrent pulse refers to next breaking point of the pulse. 

 

Fig. 2.16 Reflection Measurement in Band-pass Mode 

2.5.3 Transmission Measurement in Band-pass Mode 

2.5.3.1 Data on Horizontal Axis 

Refer to the transmission delay of the DUT. 

2.5.3.2 Data on Vertical Axis 

1) Refer to the transmission loss or gain in the LOGMAG mode. 

2) Refer to the transmission coefficient in the LINMAG mode. 
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Fig. 2.17 shows an example of transmission measurement in the band-pass mode. 

3) This example shows the information of multiple paths transmitted in the SAW (surface acoustic wave) filter in 

the selected mode. 

4) The pulse which is the closest to the time point 0 refers to the transmission time of on the shortest path from the 

output to input of the network analyzer. It may be or not be the largest pulse or best transmission path. 

5) Each concurrent pulse may be transmitted in other paths from the input to output. However, such paths are all 

longer than the shortest path. 

 

Fig. 2.17 Transmission Measurement in Band-pass Mode 

Prompt 

Observation of the main path of SAW filter response: 

In order to see the main channel of SAW filter response, you can set the gate to block all pulses except main pulses. 

Only the frequency response of the main path can be displayed in the frequency domain. 

2.5.4 Error Positioning of Low-Pass Mode 

The response of the time domain reflectometer (TDR) can be simulated in the low-pass test mode. It includes all 

useful and decisive information of the breaking point. The following figure shows the low-pass response of the 

known breaking point. The waveform of each circuit element is simulated corresponding to the S11 response of the 

low-pass time domain mode. You are allowed to observe the step response or pulse stimulus pulse in the low-pass 

mode. 

 

Fig. 2.18 Waveform of Low-pass Time Domain Response of Discontinuous Circuit 
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Prompt 

The step response can help you to easily understand the characteristics of the breaking point. This mode is 

closer to the traditional TDR measurement. 

2.5.5 Reflection Measurement of Low-Pass Mode 

2.5.5.1 Data on Horizontal Axis 

The data on the horizontal axis refers to the time from the test port to breaking point and then back to the test port. 

Note: Enter the appropriate velocity factor to confirm the actual physical length. 

2.5.5.2 Data on Vertical Axis 

Refer to the reflection coefficient (ρ) in the REAL mode. The following example shows reflection measurement of 

the pulse response and step response in the low-pass LOGMAG mode. 

 

Fig. 2.19 Reflection Measurement of Low-pass Mode 

The following example shows reflection measurement of two different cables in the low-pass REAL mode. 

1) The low-pass response includes the method of calibration of the impedance located at the breaking point, etc. 

 

Fig. 2.20 Low-pass Step Measurement Results of Different Cables 

2) Left measurement: refer to the capacitive breaking point of the response of the coiled cable. 

3) Right measurement: refer to the inductive breaking point of the response of the worn cable. 

2.5.6 Transmission Measurement of Low-pass Mode 

2.5.6.1 Data on Horizontal Axis 

1) Average time through the device within one frequency range. 

2) Electrical delay of one device over time. 

2.5.6.2 Data on Vertical Axis 

1) Refer to the real unit (such as the voltage) in the REAL mode. 

2) Refer to the transmission loss or gain (dB) in the LOGMAG mode (only for the pulse). 

The following figure shows the low-pass step response of the amplifier. 
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1) The average group delay within the whole measurement frequency range varies with the time for the step 

response and amplifier response. 

2) The stepping time of frequency range sweep refers to the balanced time to reach to the highest frequency point. 

The higher the frequency is, the shortest the rising time is. 

3) One suppression signal appears in the rise of the amplifier response. 

 

Fig. 2.21 Low-pass Step Measurement Result of Amplifier 

Prompt 

Application scope of vertical axis format: 

The REAL (radiation coefficient) mode is the most usable for the low-pass step response. It can be applied for the 

pulse response. In order to obtain the best dynamic range of the large or small breaking point which can be 

observed, it is recommended to the LOGMAG mode. 

 

2.6 Band-pass and Low-pass Time Domain Mode 

Select the time domain mode before setting the measurement value. 

● Mode comparison ····································································································································· 389 

● Mode selection according to DUT ············································································································ 390 

● Frequency range and data point number ···································································································· 390 

● Pulse and step response ···························································································································· 391 

● Use of data format ···································································································································· 391 

2.6.1 Mode Comparison 

2.6.1.1 Band-pass Mode 

1) It is a kind of simple application. 

2) It is only applicable to the band-pass device which cannot be operated down to 0Hz. 

3) The frequency with the set start and stop value can be measured. 

4) It is only applicable to the cases in which the pulse response excludes 0Hz as a result of data transformation in 

measurement. 

5) It can be used in reflection and transmission measurement. 

6) Errors are allowed. 

2.6.1.2 Low-pass Mode 

1) It can be used for the low-pass device which can be operated down to 0Hz. 
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2) The traditional time domain reflectometer (TDR) can be simulated. 

3) The frequency with a relationship to the case of 0Hz should be measured. The first new data point should be 

calculated in the frequency range. 

4) It can be applied in the cases including 0Hz due to data transformation in measurement. 

5) It is allowed to locate errors and verify the type of impedance (capacitive or inductive) at the breaking point. 

6) It can be used in reflection and transmission measurement. 

7) The response resolution of the low-pass mode is higher than (twice) the band-pass mode within the same 

frequency span. 

2.6.2 Mode Selection according to DUT 

1) Select the band-pass mode if the DUT is operated with the band-pass, band-resistance or high-pass filter. 

2) Select the low-pass mode if the DUT includes all frequencies, including 0Hz. Even if the device response is 

repeated at the lower limit of the frequency span, the low-pass mode is also applicable. 

2.6.3 Frequency Range and Data Point Number 

2.6.3.1 Band-pass Mode 

1) The user can select the start and stop frequency within some measurement ranges. 

2) The analyzer will obtain data from the start frequency and stop frequency. 

3) Only the pulse response is provided. 

 

Fig. 2.22 Band-pass Mode 

2.6.3.2 Low-pass Mode 

1) DC conditions which can be inferred from a few points at the beginning are required in the frequency range. 

2) The data point number should be equal to that of the space. 

3) The analyzer is configured with the harmonics of the start frequency for measurement. 

4) Fstop=N×Fstart (N=sweep point number). Each value of N is limited at the stop frequency. 

Attention 

F(start) and F(stop) parameter 

The minimum value of F(start) is 300kHz, F(stop) must be N×300kHz at least. 

2.6.4 Pulse and Step Response 

 

Fig. 2.23 Low-pass Mode 

The network analyzer will have this kind of time domain response in case of pulse or step stimulus of the DUT. 
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(1) Low-pass stimulus: voltage waveform from 0 to maximum and then back to 0. The pulse width is determined 

according to the frequency span in the frequency range measurement. 

2) Low-pass step: voltage waveform from 0 to maximum. The step rising time is determined according to the 

maximum frequency in the time domain frequency. 

Attention 

Application scopes of two low-pass time domain transformation modes: 

The low-pass step mode is the most easiest to explain time domain transformation of the breaking point. The TDR 

data of the general inductive and capacitive breaking point can be provided in the two modes. 

3) For the frequency response data, the analyzer depends on the selected transformation mode to calculate the step, 

pulse or band-pass response setting. 

4) The analyzer will display such data in the time domain response. For more information of the influence of the 

frequency span on the pulse width and rising time, refer to ―Response and Range‖. 

2.6.5 Use of Data Format 

2.6.5.1 Linear Magnitude 

1) For the reflection measurement mode, the average linear magnitude of the reflection coefficient within the 

measurement range will be displayed. 

2) For the transmission measurement mode, the average transmission coefficient of the transmission path within the 

measurement frequency range will be displayed. 

3) This format is applicable to observation of the responses close to the magnitude. 

2.6.5.2 Log Format 

1) For the reflection measurement mode, the unit response of the return loss (dB) will be displayed. The displayed 

value is the average value of return losses of the breaking point within the measurement frequency range. 

2) For the transmission measurement mode, the unit response of the transmission loss or gain (dB) will be 

displayed. The displayed value is the average loss of the transmission path within the measurement frequency range. 

3) This format is applicable to observation of the wide dynamic range of the transmission response. 

2.6.5.3 Standing Wave Ratio 

For the reflection measurement mode, the average standing wave ratio (SWR) of the breaking point within the 

measurement frequency range will be displayed. 

2.6.5.4 Format for the low-pass mode: REAL. 

1) The real unit response will be displayed in this format. 

2) The low-pass mode should be applied if the DUT has the response down to the DC value. 

3) The band-pass mode should be applied if the DUT has no measurement response to the DC value. 

2.7 Setting of Time Domain Transformation Measurement 

Menu path: [Analysis] > [Time Domain] > [Time Domain Transformation...]. The [Transform] dialog box will 

appear. 

Tick the [Transform] check box to enable the time domain transformation function. 

Click [Start], [Stop] or [Center], and [Span] box to set the range of time domain transformation. 

Select the transformation mode in the [Transform] zone: [Low Pass Impulse], [Low Pass Step] or [Band Pass]. 
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Fig. 2.24 Setting of Time Domain Transformation Measurement 

Setting of the window function: click [Transform] dialog box >[Window], and set the window filter in the 

following three methods. 

 Drag the slider with the mouse until the pulse width or side lobe level conforms to the requirements. 

 Click the [Kaiser Window β Parameter] box, and set the β value, until the pulse width or side lobe level 

conforms to the requirements. 

 Click the [Pulse Span] box and directly set the response pulse width. 

 

Fig. 2.25 Time Domain Transformation Measurement--Window Setting 

Setting of the time domain gate filtering function: click [Transform] dialog box >[Gate], and tick the [Gate] check 

box to enable the time domain gate filtering function. 

 Click [Start], [Stop] or [Center] and [Span] box to set the gate boundary. 

 Select the gate type in the [Gate Type] box: band-pass and band-resistance. 

 Select the gate shape in the [Gate Shape] box: smallest, standard, wide and largest. 
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Fig. 2.26 Time Domain Transformation Measurement--Gate Setting 

To observe the frequency range response of the DUT with the effective gate function, click the [Transform] button 

in the [Transform] dialog box and then clear the [Transform] check box. 

Ways of time domain transformation setting: 

 Enable the time domain transformation and gate functions, and close the [Transform] dialog box. Change the 

boundary settings of the time domain gate by dragging the mouse. The start and stop value of the gate are 

respectively represented by ― ‖ and ― ‖. Point the gate start and stop symbol with the mouse, left-click the 

mouse until the mouse pointer changes into the horizontal adjustment indicator ―↔‖. Drag the mouse and 

move the gate boundary indicator to the desired position. Release the left-click of the mouse. Thus gate start or 

stop settings are completed. 

 After setting the time domain measurement in the [Transform] dialog box, close the [Transform] dialog box. 

Open the time domain toolbar and adjust the settings of time domain measurement. Thus you can observe the 

influence of setting changes on measurement more clearly. For the setting of the time domain toolbar, refer to 

―Trigger Toolbar Display‖ of ―4.9 Setting of Analyzer Display‖. 

Attention 

Calibration of time domain measurement: 

If calibration is required before measurement in the low-pass time domain mode, you must select the low-pass 

measurement mode in the [Transform] dialog box or set the start frequency of measurement by clicking the [Set 

frequency--low-pass]. It is recommended to perform calibration after all time domain measurement settings. 
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Appendix 3 Frequency Offset Measurement 
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3.1 Setting of Frequency Offset Measurement 

In the frequency offset measurement mode, the source output power of the vector network analyzer is adjusted to 

different receiving frequencies. 3672 series vector network analyzers have the function of frequency offset 

measurement based on the hardware and software. Appendix 3 mainly introduces the basic settings of frequency 

offset measurement. 

1) Open the setting dialog box. 

 By the front panel: press [Stimulus] and click [Freq] > [Freq Offset] on the right side of the screen. 

 By the menu: click [Stimulus] > [Freq] > [Freq Offset] on the screen. 

 

Fig. 3.1 Opening of Measurement Setting Dialog Box 

2) After the above operations, the following setting dialog box will pop up. The stimulus and response in frequency 

offset measurement respectively correspond to the source and receiver. The source and receiver settings are divided 

into the following two types. Source 2 is used to provide the signal power for Port 3 and 4. Set the source frequency 

in the [Power and Attenuator] dialog box. For specific operations, refer to Section 4.4 in the text. Such operations 

are not repeated here. 

 Main coupling setting; 

 The separate source and receiver values can be set for non-coupling. 

 

Fig. 3.2 [Frequency Offset] dialog box 

Frequency Offset (on/OFF): enable the frequency offset measurement mode for all the current measurement 

channels. If the frequency offset mode is not enabled, all the measurement channels have the same signal 

frequency. 

Primary: set the current test channel. The source or receiver has the same sweep type as the main setting in the 

coupling mode. The coupling frequency setting range can be calibrated with the main setting value by the specified 

mathematical equation according to the multiplier and divisor settings (detailed in next section). In this method, the 
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source and receiver parameters can be changed by changing the main setting. The main setting parameter can be 

changed only in the frequency offset ON mode. 

The main setting cannot be used until the source and receiver are set in the coupling mode. The non-coupling mode 

is used more commonly. In this case, the source and receiver parameters can be set separately. Click [Stimulus] > 

[Power] > [Power and Attenuator] to set Source 2. 

Receiver: all the receivers in the channel, including the reference receiver, can be adjusted by the ―Setting‖ 

item to the specific frequency. 

Sweep type: set for each item. Pay attention to the following items: 

 Power canning and segment sweep cannot be applied at the same time; 

 Invalid data will be produced in case of source and receiver deviations in the non-coupling logarithmic 

frequency sweep mode; 

 The coupling logarithmic frequency sweep mode can be applied in the following two cases: 

1) Frequency offset=0, multiplier=1 and divisor=1. 

2) Multiplier=0. 

X-axis display: select the X-axis display mode in the window. 

Y-axis uniform interval display: for segment sweep. 

Attention 

Frequency offset function: 

If the frequency offset function is enabled, all receivers of channels, including the reference receiver, will be 

adjusted to the set value. In this case, the source frequency is different from the receiver frequency, resulting in 

inaccurate S-parameter measurement data of all receivers, including the reference receiver. Double-channel 

measurement must be applied to measure and display accurate results in the source and receiver frequency 

measurement. The frequency offset and loss can be calibrated by the equation editor. The calibration method is 

introduced in the following section. 

3.2 Setting of Coupling and Non-coupling Mode 

3.2.1 Setting of Coupling Mode 

Click [Stimulus] > [Power] > [Power and Attenuator] in the menu bar and open the [Frequency Offset] dialog 

box. Right-click the setting bar and click the pop-up [Edit] menu. The [Source coupling setting] dialog box will 

pop up, as shown in the following figure. 

 

Fig. 3.3 [Source 1 coupling setting] Dialog Box 

 Coupling equation: 

Start frequency=[main start frequency*(multiplier/divisor)]+frequency offset 

Stop frequency=[main stop frequency*(multiplier/divisor)]+frequency offset 



Appendix 

Appendix 3 Frequency Offset Measurement 

336  

 

 Frequency Offset: set the frequency offset in Hz. The deviation of mixer measurement is LO frequency. 
The frequency offset range is ±1000GHz. 

 Multiplier: set the multiplier, ±1000. 

a) If the multiplier is negative, the source sweep frequency is from high frequency to low frequency. For the lower 

variable-frequency mixer, the set value of input power should be lower than the LO frequency. 

b) If the set multiplier is 0, the start frequency is equal to the frequency offset. 

 Divisor: set the divisor value between 1 and 1,000. 

3.2.2 Setting of Non-coupling Mode 

 

Fig. 3.4 [Non-coupling setting] Dialog Box 

Various setting windows are set for different sweep types. The setting items of each kind of sweep frequency are 

respectively introduced below. 

 Lin and log sweep: select the start frequency or center frequency and set the number of sweep points. 

 Power sweep: set the center frequency and the number of sweep points. 

 CW: set the CW frequency and sweep time. 

 Segment sweep:  the flexible measurement configuration function is set for segment sweep in the non-

coupling mode. Pay attention to the following items in the segment sweep setting. 

 

Fig. 3.5 [Segment sweep setting] Dialog Box 

1) Click OK when the total number of sweep points of the effective segment is equal to the total number of channel 

sweep points. 

2) The independent intermediate frequency bandwidth and independent sweep time are valid for the main setting 

and non-coupling receiver and invalid for the source. 

3) The independent power is valid for the main setting and non-coupling source mode and invalid for the receiver. 
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3.3 Calibration of Frequency Offset Measurement 

In the traditional calibration process, errors are corrected through the measurement reference channel. The stimulus 

frequency is different from the response frequency in frequency offset measurement. Therefore, the traditional 

standard calibration mode cannot be used for error correction, such as the full double-port SOLT mode. The source 

and receiver power calibration mode should be applied for error correction in the frequency offset measurement. 

Click [Cal] > [Calibration...] > [Power calibration] on the front panel and open the [Power calibration] option. 

For details, refer to ―7 Calibration‖. 

1) Source power calibration 

 On the premise of no consideration to the receiver accuracy, set the accurate power corresponding to the 

stimulus frequency. 

 No channel copying function. 

2) Receiver calibration 

 Set a calibrated source. 

 No channel copying function. 

3) Mismatch error 

If the connector of different impedance is connected between measurement points, mismatch error will occur. The 

mismatch error can be eliminated by means of full double-port calibration in S-parameter measurement. This 

problem cannot be solved easily in frequency offset measurement. The simplest way is to connect a high-quality 

attenuator between the input end and the mixer output port. The ports can be matched effectively by adding one 

attenuator between ports, so as to increase the attenuation value to be more than twice. The larger the attenuation 

value is, the better the improvement effect is good, but the smaller the dynamic range of measurement is. 

4) LO accuracy and stability 

If the LO signal is not accurate or stable in the frequency offset measurement mode, the output signal will be 

beyond the edge or band-pass of the intermediate frequency filter. At the same time, the LO power also plays an 

important role in mixer measurement. Therefore, the LO power accuracy and stability must be ensured. 

3.4 Typical Application of Frequency Offset Measurement 

● Frequency transformation loss (gain) measurement ··················································································· 399 

● Frequency transformation compression measurement················································································ 400 

● Isolation measurement ······························································································································ 400 

● Harmonic distortion measurement ············································································································ 402 

● Return loss and standing wave ratio measurement ····················································································· 402 

3.4.1 Frequency Transformation Loss (Gain) Measurement 

The frequency transformation loss is defined as the power ratio of the output frequency and input frequency at the 

given LO power. The LO power has the influence on the frequency transformation loss. The frequency 

transformation loss reflects the energy conversation efficiency of the input signal of the mixer from the current 

frequency into the output frequency. If the frequency transformation loss is not flat within the measurement 

frequency range, part of valuable information of the output signal will be lost. 

Transmission measurement should be applied to measure the frequency transformation loss. The input signal power 

will be measured by entering the specific stimulus and LO signal power. If the output frequency is different from 

the input frequency, the frequency offset measurement must be applied. 
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Fig. 3.6 Schematic Diagram of Device Connection in Frequency Transformation Loss Measurement 

The following example briefly shows the measurement setting process. Assume that the RF signal frequency range 

is 1-2GHz, the fixed LO frequency is 500MHz, and the output frequency is 1.5GHz to 2.5GHz. At first, set the 

sweep frequency range as 1GHz to 2.5GHz and calibrate the source and receiver power. Open the frequency offset 

measurement mode. Set the source and receiver sweep frequency range according to the measurement requirements. 

Open the [Frequency Offset] mode and click OK. Click [Measure] > [Measurement...] > [Receivers]. Set the 

numerator of the measurement item as B and denominator as R1 to obtain the measurement curve. This curve 

represents the frequency transformation loss of the mixer. 

3.4.2 Frequency Transformation Compression Measurement 

The frequency transformation compression value refers to the maximum input signal power of the linear working 

zone of the mixer, and is similar to the gain compression value of the amplifier. In order to better understand the 

frequency transformation compression, first understand the physical meaning of frequency transformation loss, i.e. 

the ratio of the output signal power and input signal power. This ratio remains constant within a certain input power 

range. When the input signal power increases to the threshold, the constant will change. The input signal power 

value with the change ratio less than the constant ratio 1dB is referred to as the 1dB compression power value. 

The frequency transformation compression ratio represents the dynamic working range of the device. Therefore, 

the frequency transformation compression measurement is indispensable for the mixer. The measurement and 

connection are the same as those in the frequency transformation loss measurement. However, the power sweep 

mode should be set. The compression point of 1dB or 3dB can be found in the measurement curve through the 

marker. 

3.4.3 Isolation Measurement 

Isolation measurement is used to measure leakage signals between channels. If the degree of isolation of the mixer 

increases, the number of signals leaking into other parts will decrease. The signal frequency of isolation 

measurement is the same as the stimulus frequency, instead of the frequency after transformation. Therefore, the 

frequency offset measurement mode is not necessary in isolation measurement. Main measurement items include: 

LO/IF isolation, IF/RF isolation and RF/IF isolation. 

 

Fig. 3.7 Diagram of Signal Leakage of Mixer 

New signals will be generated by the signals leaking into the DUT and the expected signals, which will result in 

crosstalk. The unexpected signals cannot be easily filtered by the filter. The measurement connection is shown in 
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the following figure. Pay attention to the following two items in measurement. 

1) The isolation between the input port (IN) and output port (OUT) is closely related to the LO power. Therefore, 

the normal LO power should be provided in measurement. 

2) Except two test ports, the other should be connected to a terminal. The terminal may not be the load of specific 

impedance (50/75Ω). For example, if the output power of the mixer is connected to the filter, the filter can be used 

as the terminal in isolation measurement. 

 

Fig. 3.8 LO/RF Isolation Test 

 

Fig. 3.9 LO/IF Isolation Test 

 

Fig. 3.10 RF/IF Isolation Test 

3) The RF/IF leakage of the frequency converter is tested in the same method as that of the mixer test. However, 

the filter is always set on the output port of the frequency converter. Therefore, the vector network analyzer should 

have a large dynamic range. Some frequency converters are equipped with the built-in local oscillator. The LO/RF 

or LO/IN leakage can be measured in various methods. 

 Adjust the frequency of the vector network analyzer to be the same as the local oscillator. Connect the RF or 

IN port of the frequency converter to the receiver end of the vector network analyzer. Do not connect the 

source to any port. 

 The LO leakage can be measured with the frequency meter. The frequency of the spectrometer should be 

adjusted to the LO frequency. 
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3.4.4 Harmonic Distortion Measurement 

The harmonic signal is a multiple of the mixer RF input signal or LO signal. Harmonic distortion will occur to the 

mixer output port. It is may caused by nonlinear characteristics of the device. Harmonic distortion is different from 

intermodulation distortion arising from different signals. The intermodulation distortion is mainly caused by 

intermodulation signals produced with two or more signals in the mixer. 

Harmonics can be measured with the frequency offset measurement option of the vector network analyzer. Set the 

LO frequency of the mixer as 0, and then set the multiplier of the RF input to obtain the harmonic output. As the 

harmonic unit is dBc, the difference between RF signals and harmonics should be calculated. Calibrate the source 

and receiver within the whole frequency range before measurement. Enable the frequency offset mode, and set the 

multiplier as 2 for second harmonics and 3 for third harmonics. 

3.4.5 Return Loss and Standing Wave Ratio Measurement 

The return loss and standing wave ratio are measured in the linear reflection measurement. As the reflection 

frequency of the frequency converter does not change, the frequency transformation measurement is a kind of 

reflection measurement. If the return loss is large, the energy of the transmitted signal will be reduced, and the 

capability to carry information will be weakened. Therefore, the return loss should be strictly measured in actual 

operation. 

Set the measurement mode in the return loss or standing wave ratio mode. The connection is shown in the 

following figures. 

 

Fig. 3.11 Test of Return Loss of Mixer Input Port 

 

Fig. 3.12 Test of Return Loss of Mixer Output Port 
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Fig. 3.13 Test of Return Loss of Mixer LO Port 
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Appendix 4 Pulse Measurement 

● Time domain waveform ···························································································································· 342 

● [Pulse Measurement] dialog box ··············································································································· 342 

● Pulse envelope ········································································································································· 343 

● Broadband pulse measurement ················································································································· 344 

● Pulse generator/modulation configuration ································································································· 346 

4.1 Time Domain Waveform 

If required, the 3672 series vector network analyzer can be set into the pulse mode. In the pulse mode, the 

continuous wave is output after pulse modulation. The time domain waveform is shown in Fig. 4.1. 

  

a. Time Domain Waveform of Continuous Wave b. Time Domain Waveform of Pulse 

Fig. 4.1 Time Domain Waveform 

4.2 [Pulse measurement] Dialog Box 

Menu path: [System] > [Macro] > [Pulse]. 

The [Pulse measurement] dialog box is shown in Fig. 4.2. 

 

Fig. 4.2 [Pulse measurement] Dialog Box 
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1) PRF/IFBW configuration: if one parameter is changed, the associated parameters will change accordingly. 

a) Pulse Repetition Frequency (PRF): set the frequency of the pulse generated by the pulse generator. 

b) Pulse Repetition Interval (PRI): set the pulse generation interval of the pulse generator. 

c) Receiver IF bandwidth: set the intermediate frequency bandwidth of the analyzer, 1Hz to 10Hz. 

d) Fixed PRF: if this item is selected, PRF will not change with the receiver bandwidth. 

2) Modulation/Gates 

a) Width: pulse width. 

b) Delay: delay before pulse generation. 

3) Duty Cycle: if [Calculate] is pressed, the duty cycle of the source and each reception channel will be 

automatically calculated and displayed. 

a) Pulse Mode ON/OFF: if this option is selected, the pulse function will be enabled. 

b) Apply: if this button is pressed, all the configurations will take effect. 

Attention 

Setting of pulse duty ratio: 

The prerequisite of narrow-band pulse calculation is to set the pulse duty ratio no more than 90%. But the 

calculated pulse duty ratio may exceed 90%. In this case, the calculation result will prevail. 

4.3 Pulse Envelope 

Click the [Pulse Envelope] button in the [Pulse measurement] dialog box or click [View] > [Pulse Envelope] in 

the menu to recall the [Pulse Envelope] dialog box. If this dialog box is gray and unavailable, select [Pulse Mode 

ON/OFF] and click [Calculate] and [Apply]. The [Pulse envelope] dialog box is shown in Fig. 4.3. 

1) Time parameter 

a) Start and STOP time: determine the size of the pulse envelope display window. In order to display the 

complete pulse, the width between the start value and stop value must be no less than the sum of the source 

modulation width plus delay. 

b) Step: determine the interval of two adjacent trace points of the pulse envelope curve, i.e. trace point 

number=(stop value-start value)/step. If the trace point number increases, the calculation time will increase 

accordingly. 

2) Measurement parameters 

a) CW frequency: set the CW frequency. 

b) Source: select the output source. For the double-port analyzer, Port 1 is used to output the pulse modulation 

signal. For the four-port analyzer, Port 1 and 3 are used to output the pulse modulation signal. 

c) Parameters: select S-parameters to be measured in the drop-down list, including A, B, C, D, R, S11, S21, S31 and 

S41. 

d) Data format: logarithmic amplitude, linear amplitude and phase. 
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Fig. 4.3 [Pulse envelope] Dialog Box 

e) Display gate setup: if this button is clicked, the dialog box shown in Fig. 5.4 will appear. You can set the 

source modulation and gate. After setting, click [Apply gate] and [Hide gate]. Then the dialog box shown in 

Fig. 4.4 will appear again. 

 

Fig. 4.4 Display Gate Setting 

f) Measurement: click this button to start calculation according to the parameter settings and display the 

pulse envelope waveform. [Pulse Envelope Measurement] will appear in the calculation process. 

4.4 Wideband Pulse Measurement 
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Click the [Wideband pulse] option. The [Wideband Measurement] dialog box shown in Fig. 4.5 will appear. 

 

Fig. 4.5 [Wideband Measurement] Dialog Box 

1) Measurement Type 

a) Sweep frequency (frequency range): set the [Sweep Frequency] as the wideband measurement mode. In this 

case, the amplitude frequency response of each frequency point under pulse stimulus will be measured. Set the 

sweep frequency range with the start value and stop value. 

b) Envelope (time domain): set [Envelope measurement] as the wideband measurement mode. In this case, the 

pulse envelope characteristics under the specified CW frequency stimulus will be measured. 

c) Pulse point (time domain): set [Pulse point measurement] as the current pulse measurement mode. In this case, 

the frequency response characteristics of the specified pulse delay point at the specified CW frequency will be 

measured. 

2) Start, stop and CW value: set the frequency according to the current measurement type, the same as system 

settings. 

3) Points and Sweep Time: set the sweep point number and sweep time of the current measurement, the same as 

system settings. 

4) IF bandwidth-Auto: set the IF bandwidth of current digital processing. If ―Automatic‖ is selected, the system 

will automatically select the maximum intermediate frequency bandwidth of broadband pulse measurement. 

5) Modulation source: select the modulation signal source. If ―External‖ is selected, the source modulation signal 

is sent by Pin 8 of the pulse input port of the rear panel. If ―Pulse 1‖, ―Pulse 2‖, ―Pulse 3‖ and ―Pulse 4‖ are 

selected, the source modulation signal is sent by the internal 4-way pulse generator of the system. If ―OFF‖ is 

selected, the source modulation signal is OFF, and no signal is output by the source. If ―CW‖ is selected, the signal 

modulation is normally OFF, and the source outputs continuous waves. 

6) Pulse repetition interval, width and delay: set the width, delay and interval of the pulse generator. The sum of 

the delay and width of the pulse signal must be less than the pulse interval; otherwise, the system will be in a state 

of uncertainty. 

7) Enable 0-4: enable or disable the output of the internal 5-way pulse generator of the analyzer. Pulse 1-4 are used 

as the modulation source, and Pulse 0 is used to produce the pulse synchronization signal, the same as the 

synchronization function of the receiver and pulse generator in the [Pulse trigger] dialog box, to synchronize the 

data processing of the analyzer and the signal generation of the pulse generator. The default mode of broadband 
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pulse measurement is to enable the pulse generator 0. Disabling of the pulse generator 0 will result in distortion of 

processing data of the analyzer. 

8) Apply: apply the current setting to the current active channel. 

9) Minimize: minimize the [Pulse measurement] dialog box window. 

10) Close: close the [Pulse measurement] dialog box and exit the pulse measurement mode. To keep the current 

channel in the pulse measurement mode, you must not exit the [Pulse measurement] dialog box and select 

[Minimize] to hide the [Pulse measurement] dialog box. 

4.5 Pulse Generator/Modulator Configuration 

Click [Configuration] > [Pulse Generators/Modulators] in the menu (Fig. 4.6). The dialog box shown in Fig. 4.7 

will appear. 

1) Source modulation: select the internal pulse generator or the external pulse input of the rear panel as the 

modulation source. 

2) External pulse setting: this option is available if the [Internal pulse generator] option is not selected. 

a) GPIB address: set the GPIB address of the external pulse generator. 

b) Output: select the pulse output module. 

c) Common time base: the frequency (10MHz) of the network analyzer is used as the reference frequency of the 

external pulse generator. 

d) Pulse output: enable the [Pulse output] function. 

3) External gate/modulator setting 

a) High: set the high-level voltage of TTL. 

b) Low: set the low-level voltage of TTL. 

c) External impedance: set the impedance of the DUT (DUT). 

d) Effective low level: select it to make the low level of TTL effective; otherwise, the high level of TTL will be 

effective. 

4) Use of internal modulator: select it to set the instrument in the internal modulator protection state. 

5) Use of internal pulse generator: properly set the available items in this dialog box. 

6) Use of internal gate: select it to set the instrument in the internal gate protection state. 

 

Fig. 4.6 Configuration Menu 
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Fig. 4.7 Pulse Generator/Modulator Configuration 

7) Receiver gain: click [Configuration] >[Receiver Gain] (Fig. 4.8). The dialog box shown in Fig. 4.9 will appear. 

 

Fig. 4.8 Receiver Gain Control Menu 

a) Auto: the analyzer will automatically select the appropriate receiver gain. 

b) Low: about 30dB attenuation. 

c) Medium: about 15dB attenuation. 

d) High: about 0dB attenuation. 

 

Fig. 4.9 [Receiver gain configuration] Dialog Box 
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Appendix 5 Amplifier Gain Compression Measurement 

This chapter introduces the basic principle and measurement method of the two-dimensional sweep option of 

amplifier gain compression measurement. 

● Principle of amplifier gain compression ···································································································· 348 

● Overview of gain compression measurement ···························································································· 348 

● Steps of gain compression measurement ··································································································· 353 

5.1 Principle of Amplifier Gain Compression 

The amplifier has a linear gain zone, in which the input power level of the amplifier is linear to the output power 

level. The gain of this zone is referred to as the small signal gain (also known as the linear gain). While the input 

power increases to a certain level, the gain will decrease, making the amplifier in the approximately saturated state. 

The input power level at which the amplifier gain is 1dB less than the linear gain is defined as the input power of 

1dB gain compression. 

 

Fig. 5.1 Input and Output Characteristics of Amplifier 

1) The amplifier gain at any power level is the slope of the corresponding curve. 

2) When the amplifier works in the linear zone, the gain is constant and not related to the input power level. The 

gain in this zone is often referred to as the small signal gain. 

3) If the input power increases, the amplifier gain will decrease and the amplifier will work in the compression 

zone. 

4) The 1dB compression point is commonly used in the amplifier compression measurement. It is defined as the 

input power (sometimes output power) corresponding to the 1dB decrease of the amplifier gain (equivalent to the 

small signal gain of the amplifier). 

If the amplifier is driven by the sine signal, the amplifier output will not be the sine signal in compression. The 

output contains the harmonic component, in addition to the fundamental component of the input signal. If the input 

power increases, the amplifier will be saturated, but the output power remains unchanged. In this case, the output 

power does not change if the input power of the amplifier further increases. In some cases, such as the traveling 

wave tube (TWT) amplifier, the actual output power will decrease if the input power continues to increase in the 

saturated state. This means that the amplifier has negative gain. As the amplifier is expected to work in the linear 

zone, it is important to know the input signal of gain compression. 

5.2 Overview of Gain Compression Measurement 

● Terms of amplifier gain compression ········································································································ 413 

● Terms of amplifier gain compression ········································································································ 413 

● Gain compression parameters ··················································································································· 413 

● Compression method ································································································································ 414 

● Data acquisition mode ······························································································································ 415 

● Compression method of intelligent sweep ································································································· 417 

● Factors related to measurement accuracy ·································································································· 418 

5.2.1 Terms of Amplifier Gain Compression 
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 Linear power level 

Refer to the input power of the amplifier in the linear gain (also known as the small signal gain) zone. 

 Reference gain 

Refer to the gain for reference in calculation of the compression level. The specific meaning varies from the 

selected compression method. 

 Compression level 

Refer to the specific compression amount reduced relative to the reference gain. The value is generally 1dB. 

 Target gain 

Refer to the gain at the specific compression level (such as the 1dB compression). This item is not included in the 

parameters of amplifier gain compression measurement, however, it is important to understand various 

compression factors. 

For example, perform the following settings of linear gain compression: 

Linear gain (amplifier gain in the linear zone)=10.2dB 

Compression level (fixed value)=1dB 

Target gain=9.2dB 

The target gain refers to the gain close to 9.2dB, which is searched in amplifier gain compression. The value may 

not be exactly 9.2dB. 

 Compression point 

The gain measured at this point is the closest to the target gain. All compression parameter data are measured at this 

point, including the input power, output power and gain of the compression point. 

5.2.2 Parameter Curve of Gain Compression 

In the amplifier gain compression curve: 

1) The frequency value is displayed on the horizontal axis. The specified compression point is found by 

measurement and calculation of the power sweep curve at each frequency point. 

2) The specific parameters of the compression point are shown in the vertical axis. The linear S-parameters 

displayed by the amplifier gain compression channel are used for measure the transmission and reflection 

parameters of the amplifier in the linear zone. 

5.2.3 Gain Compression Parameters 

The parameters are determined based on the assumption that Port 1 is used for DUT input and Port 2 for DUT 

output. 

Schedule 5.1 Compression Parameters 

 Parameter Description 

Linear S-

parameter 

S11 Matching input 

S21 Gain 

S12 Reverse isolation 

S22 Matching output 

Compression 

parameter 

CompIn21 Input power of compression point 

CompOut21 Output power of compression point 

CompGain21 Gain of compression point 

CompS11 Matching input of compression point 

RefS21 Linear gain used to calculate the level. The specific meaning is associated with the 

selected compression method. 

DeltaGain21 Compression point gain--linear gain (logarithmic format) 
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5.2.4 Compression Method 

 Compression from linear gain 

The reference gain is the gain of the linear zone. The target gain is calculated by subtracting the specific 

compression level (1dB) from the linear gain. Example: 8.3dB-1dB=7.3dB. 

 Compression from maximum gain 

The linear zone of amplifier gain may not be fully linear. The maximum gain measured at various frequency points 

is used as the reference gain (S21). The target gain is calculated by subtracting the specific compression level (1dB) 

from the maximum gain. 

 Compression in the saturated state 

If the amplifier is measured in the nonlinear zone, this method can be used to better display the compression point, 

as shown in the following figure. 

 

Fig. 5.2 Schematic Diagram of Calculation of Compression in Saturated State 

The maximum output power can be found at each frequency*. Then the input power is decreased until the output 

power decreases by the specific value (1dB). This point is known as the compression point. 

 Compression from return point and X/Y compression 

The two compression methods are similar to each other. 

The difference of the linear zone and compression point of the input power (X-axis) are utilized in the two methods. 

For the Y axis: 

The gain is displayed on the Y axis in the compression from the return point. 

The output power is displayed on the Y axis in the X/Y compression. 

The methods to search the compression point are different in two-dimensional sweep and intelligent sweep. 

The following figure shows the calculation at the same frequency in the method of compression from the return 

point and X/Y compression. 

 

Fig. 5.3 Schematic Diagram of Calculation of Compression from Return Point 

Note: The compression point (in the yellow circle) is the point at which the input power is 10dB higher than that of 

the reference point (in the blue circle) and the gain is 1dB lower than that of the reference point. 
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Fig. 5.4 Schematic Diagram of Calculation of X/Y Compression 

Note: The compression point (in the yellow circle) is the point at which the input power is 10dB higher than that of 

the reference point (in the blue circle) and the output power is 9dB higher than that of the reference point. 

5.2.5 Data Acquisition Mode 

Three data acquisition modes are provided for amplifier gain compression: two two-dimensional sweep modes and 

one intelligent sweep mode. 

In order to observe the general power sweep at the signal frequency, compression analysis characteristics should be 

applied. 

In the two kinds of sweep modes: 

1) The S-parameter at the linear power level should be measured first in all amplifier gain compression 

measurements. Reflection parameters are measured after the full port calibration. 

2) The gain is calculated according to the measured frequency and power. 

3) The compression is found by searching after data measurement. Generally, the compression point is a point 

between two measurement points which are the closest to the target gain. 

4) The point will be marked in the corner at the left bottom of the current sweep program display and beside the 

channel indicator after each sweep process. 

Prompt 

Compression point of return compression and X/Y compression 

In the return compression and X/Y compression, the specified power range of amplifier gain compression is not 

regarded as the minimum return or X-axis value. The closest compression point will always be displayed. 

 Two-dimensional sweep mode 

1) The power is swept at each frequency point, that is, each frequency point is swept from the start power to stop 

power. It can be seen in the following example that the device reaches the highest power level (p3=power3) at the 

first frequency (f1=frequency1). In this case, the device will be heated early in measurement, which will affect 

compression results. 

The following example shows the values of three frequency points and three power points, and nine results are 

obtained. 

Schedule 5.2 Power Sweep Data of Various Frequency Points 
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2) The frequency is swept at each frequency point, that is, the frequency is swept from the start frequency to stop 

frequency at each power level. 

Schedule 5.3 Frequency Sweep Data of Various Power Points 

 

Observe and save the two-dimensional data. 

It is impossible to display all two-dimensional measurement data on the vector network analyzer. However, data 

can be saved in the ―*.csv‖ and read through the Excel. 

In addition, the compression analysis function can be used for observe all power sweep information at the selected 

frequency. 

 Intelligent sweep mode 

Intelligent sweep is generally the fastest and most accurate method of gain compression measurement. Different 

from the two-dimensional sweep mode, the specific frequency/power points are not measured in intelligent sweep. 

Instead, a series of fixed power values are searched. The ―intelligent assumption‖ of the input power of each 

frequency is made to find the compression level within the upper limit range. This assumption is more accurate 

than continuous power sweep. 

Intelligent sweep is repeated until one of the following cases occurs: 

1) All the data points are within the limit range. When the compression level of the data point reaches the specific 

limit, measurement is continued and the input power changes to improve the measured value within the limit range. 

2) The specific compression level of the residual frequency beyond the limit range cannot be obtained. This is 

because the start power is too high or the stop power is too low. 

The repeated maximum value can be obtained. If the measured gain is beyond the limit range before reaching the 

specified maximum limit, the final power sweep point will be used as the compression point. 

5.2.6 Compression Method of Intelligent Sweep 

The working mode varies according to the compression method in the intelligent assumption program. In the return 

and X/Y compression, the input power of DUT changes greatly in the repeated sweep. This will affect the DUT and 

measurement results. 

All the amplifier gain compression measurements are started from the S-parameter of the linear power level. The 

reflection coefficient cannot be measured until the double-port calibration function is available or the reflection 

parameter is displayed. 

1) Return and X/Y compression 

The linear zone and compression zone are separated in the two sweep methods. The signals within the same 

frequency range should be swept at different power levels in the repeated sweep. The first half of sweep aims to 

measure the DUT return of X-axis power level. The second half of sweep aims to measure the corresponding start-

stop power range of the DUT at the compression power level. At the beginning of the second half, the power level 

will increase if the return or X-axis value increases. The specific time is set as the DUT response to power level 

changes. The input power must not be reduced to the minimum value in safety sweep. Instead, safety sweep aims to 

prevent DUT from being greatly influenced by power changes. 
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2) Linear gain compression 

After the reference gain is measured in the linear input power zone, DUT can be pushed to the high-power 

compression level for repeated measurement. The power is increased or decreased according to the DUT power 

level in subsequent measurements to reach the expected compression level. Generally, the appropriate algorithm 

can be obtained after the third repeated sweep, so as to draw the curve and accurately find the compression point. 

Attention 

Influence of power sweep on measurement results 

DUI may change greatly in different sweep processes. The influence can be reduced by enabling safety sweep or 

carefully selecting the appropriate settings. 

1) Maximum gain compression 

The maximum gain of each frequency point will be saved to calculate the compression point. In the intelligent 

sweep mode, additional repeated sweep of each frequency point will not be done to search the possible maximum 

gain of the amplifier. 

2) Compression in saturated state 

The external maximum gain of each frequency point will be saved to calculate the compression point. In the 

intelligent sweep mode, additional repeated sweep of each frequency point will not be done to search the possible 

maximum gain of the amplifier. 

5.2.7 Factors Related to Measurement Accuracy 

The analyzer must have high power to drive the amplifier into the saturated zone. If the power level of the signal 

source of the analyzer does not conform to the requirements, a preamplifier should be set in front of the tested 

amplifier to improve the power level. The applied preamplifier must be included in calibration. If necessary, the 

output of the amplifier should be fully attenuated. Too high output power may cause the following results. 

a) The output power is higher than the input compression level of the receiver of the analyzer, which may lead to 

inaccurate measurement results. 

b) The analyzer receiver may be damaged. 

The output power of the amplifier can be attenuated by the attenuator or coupler. As part of the test, the influence 

of the attenuator or coupler must be taken into consideration. Proper error correction can help to reduce the 

influence of such accessories. 

a) The frequency response is a main error source of gain compression measurement. The error can be reduced 

significantly by means of through type response calibration. 

b) The amplifier has different response values corresponding to temperature differences. The test must be done at 

the working temperature of the amplifier. 

c) The dynamic range and accuracy can be improved by reducing the intermediate frequency bandwidth or using 

the measurement averaging function, but at the sacrifice of measurement velocity. 

5.3 Steps of Gain Compression Measurement 

● Resetting of analyzer ································································································································ 418 

● Enabling of gain compression measurement ······························································································ 418 

● Gain compression setting ·························································································································· 419 

● Calibration ··············································································································································· 422 

● Connection of DUT and provision of deviation ························································································· 424 

● Adding of track ········································································································································ 424 

● Printing or saving of data ·························································································································· 425 

5.3.1 Analyzer Resetting 
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5.3.2 Enabling of Gain Compression Measurement 

Menu path: [Response] > [Measure] > [Measurement Class]. Select [Gain Compression] and click [OK]. The 

default setting is Channel 1. To enable the gain compression measurement in a new channel, click [New Channel]. 

 

Fig. 5.5 Opening of Measurement Dialog Box 

5.3.3 Gain Compression Setup 

5.3.3.1 Frequency Setup 

Menu path: [Response] > [Measure] > [Gain Compression]. Click [Frequency] to set the frequency. After 

setting, click [OK] to close the dialog box. 

 

Fig. 5.6 [Frequency Setup] Dialog Box 

Notes of sweep setting: 

 Number of Points: the number of measured frequency points. The number of frequency point may be 

restricted by the number of power points. 

 IF bandwidth: set the IF bandwidth to obtain the acceptable trace noise in measurement at the linear 



Appendix 

Appendix 5 Amplifier Gain Compression Measurement 

 355 

 

power level. The trace noise is directly related to the measurement accuracy of the compression point. The 

small value (narrow intermediate frequency bandwidth) can help to improve the accuracy, but the 

measurement velocity will be reduced. 

 Start/Stop, Center and Span: set the frequency range to measure the gain compression. 

The data point number is limited. The maximum number of data points depends on the data acquisition method and 

compression method, shown as follows. 

Schedule 5.3 Limitations of Data Point Number of Two Sweep Modes 

Compressio

n Method 

Intelligent sweep 
(reduce the number of frequency points to 

ensure that the total number of data points 

is within the limited range) 

Two-dimensional sweep 

(reduce the number of power points to ensure that the 

total number of data points is within the limited range) 

Linear gain 

compression 

Data point number=frequency point 

number 

Maximum=20,001 
Data point number=frequency point number*power 

point number 

Maximum power=2,001 

Maximum data point number=20,000 

Maximum 

gain 

compression 

Data point number=frequency point 

number 

Maximum=20,001 

X/Y or 

return 

compression 

Data point number=2*frequency point 

number 

Maximum 20,001 

 

Attention 

Setting of frequency and power point number: 

Although you are allowed to enter any number in the dialog box, the entered value will be checked after the 

ENTER or OK key is pressed. The entered value beyond the limits will be reduced to the maximum allowable 

range to prevent error prompts. 

5.3.3.2 Power Setting 

Menu path: [Response] > [Measure] > [Gain Compression]. Click [Power] to set the power. After setting, click 

[OK] to close the dialog box. 

 

Fig. 5.7 [Power Setting] Dialog Box 
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Input port of the DUT: 

Refer to the analyzer port connected to the DUT input end. 

 Linear Input Power: refer to the input power to keep DUT in the linear zone. The linear gain is the 

reference value to calculate the linear compression gain. The matching input is also calculated at the power 

level. 

 Source Attenuator: refer to the attenuator which is closely related to the connected DUT input port. It is 

used to adjust the input power range of DUT. The attenuation values of continuous sweep of all vector 

network analyzer channels are the same. 

 Receiver Attenuator: refer to the attenuator which is closely related to the connected DUT output port. 
If the power of about +10dBm is input into the receiver test port, compression may be done by the receiver of 

the vector network analyzer. However, with the receiver attenuation, low input power may affect the accuracy 

of power measurement and result in high noise. Therefore, the intermediate frequency bandwidth should be 

decreased to reduce noise. 

 Source Leveling Mode: refer to the specific amplitude stabilization mode. The internal stabilized 

amplitude or open loop can be selected. The open loop must be used in broadband pulse measurement. 

DUT Output Port: 

Refer to the analyzer port connected to the DUT output end. 

 Reverse power: refer to the power level of reverse sweep of the analyzer port connected to the DUT 

output end. The port power will not be coupled automatically. This power value is valid only in the following 

cases. Otherwise, the setting is invalid. The output matching and reverse isolation are measured. 

The full double-port correction is done. The application of reverse power to DUT can be prevented by full double-

port calibration or enhanced response calibration. 

 Source Attenuator: refer to the attenuator specified as the port to be connected to the DUT output end. 
This device affects the power output range of DUT. 

 Receiver Attenuator: refer to the attenuator specified as the receiver to be connected to the DUT output 

port. 

 Source Leveling Mode: select the specified internal amplitude stabilization mode. 

Power sweep: 

 Power Points: refer to the number of power points required for two-dimensional sweep measurement. 
The power point number may be limited by the frequency point number. This item is not included in 

intelligent sweep, as the compression level is found based on sufficient power points in the intelligent sweep 

mode. 

 Start and stop power 

X/Y sweep: for the return, X/Y and maximum gain compression, the reference gain and compression point are 

measured within the power range. Therefore, the range should be wide enough to include the reference gain 

and compression point. For example, if the return level is 10dB, the power range must be more than 10dB. 

Otherwise, the closest reference gain and compression point will be used to determine the compression value in 

amplifier gain compression, which will lead to inaccurate results. In the linear gain compression, the reference gain 

is measured at the linear power level, and the start and stop power levels are used to find the compression point. 

Intelligent sweep: the power range is set to be larger than the compression point searched in amplifier gain 

compression. The reference gain found in compression is applied to the linear power level. The return and X-axis 

value are determined according to the compression method. The repeated sweep to find the compression point 

should be reduced. 

Prompt 

Low-band high-power mode 

If DUT needs higher input power to realize compression below 3.2GHz, the high power mode should be used. 
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Click [Path configuration] > [Low-band high-power mode]. 

 Power step: calculated according to the current start, stop and point number settings. It cannot be changed 

directly. 

Path configuration: 

Open the [Path configuration] dialog box. 

5.3.3.3 Compression Setting 

Menu path: [Response] > [Measure] > [Gain Compression]. Click [Compression] to set compression. After 

setting, click [OK] to close the dialog box. 

 

Fig. 5.8 [Compression setting] Dialog Box 

 

Compression Method 

 Compression from Linear Gain: the compression level is measured according to the linear compression 

level. The linear power level is used in linear compression measurement. 

 Compression from Max Gain: the compression level is measured according to the maximum 

compression level. In intelligent compression, the maximum compression value is updated after each 

repetition. 

 Compression from Back Off: this method is used to find the compression point according to the 

compression level and return point. 

 X/Y compression: this method is used to find the compression point with specific parameters (X and Y) 

as standards. 

 Compression from Saturation: similar to maximum gain compression. The specific compression level 

is measured according to the maximum power beyond the level. This method can be used to better find the 

compression point in measurement of the nonlinear gain amplifier. In intelligent sweep, the maximum power 

is updated in each repetition. In order to increase the possibility to measure the actual maximum value of the 

amplifier, low increments of accurate roughness should be applied in safety sweep. 

5.3.4 Calibration 

After setting, perform amplifier gain compression calibration. Click [Cal] > [Calibration...]. Complete all 

calibrations according to the guide. 

1) Select the connection type and calibration kit of the DUT. The selection must be based on the actual connector 

type of the DUT; otherwise, subsequent calibration will be affected. 
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Description of setting: 

Port 1: refer to the type of the port of the DUT connected to Port 1. 

Port 2: refer to the type of the port of the DUT connected to Port 2. 

Power meter: the same type as that of connection to Port 1. 

Calibration kit: model of the selected calibration kit. The inserted electronic calibration kit will be 

automatically detected by the analyzer and displayed. 

Power calibration port: set the amplifier input port as the power calibration port. 

Frequency offset: refer to the difference between the amplifier input power and calibrated power. It is 

generally caused by the adapter or attenuator between the calibration plane and power meter. In case of no 

frequency set, ignore this option. 

Tolerance: refer to the error tolerance of power calibration. 

Maximum reading times: sweep will be repeated automatically if the power calibration fails. The maximum 

reading times are the times of repeated sweep. If power calibration still fails after exceeding maximum 

reading times, sweep will not be repeated and next step will be started directly. 

Power meter configuration: select the power meter model/ if the USB power probe developed by the 41st 

Institute is inserted, the probe will be detected automatically and the options will be provided. 

 

Fig. 5.9 Selection of Connection Type of DUT and Calibration Kit 

2) Perform connection as shown in the figure. After connection, click [Measurement]. The analyzer will 

automatically skip to next step after measurement. After all measurements, click [Finish]. Thus all the calibrations 

are completed. 
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Fig. 5.10 Illustration of Calibration Steps 

5.3.5 Connection of DUT and Provision of Deviation 

As shown in Fig. 5.11, connect the amplifier and provide the DC deviation. 

 

Fig. 5.11 Connection of Gain Compression Measurement 

5.3.6 Adding of Track 

To obtain more measurement parameters, new traces should be added. Click [Trace] > [New Trace]. Tick the trace 

to be created, and click [OK] to close the dialog box. 

 

Fig. 5.12 [New Trace] Dialog Box 
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5.3.7 Printing or Saving of Data 

Click [File] > [Save As]/[Save Data As]. Select the saving format and path. 
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Appendix 6 Mixer Measurement 

● Overview of mixer measurement ·············································································································· 361 

● Scalar mixer measurement ························································································································ 361 

● Calibration of scalar mixer measurement ·································································································· 369 

● Vector mixer measurement ······················································································································· 372 

● Calibration of vector mixer measurement ·································································································· 374 

6.1 Overview of Mixer Measurement 

Mixer measurement mainly includes scalar and vector measurement. 

6.1.1 Comparison of Scalar/Vector Mixer Measurement 

Schedule 6.1 Comparison of Scalar/Vector Mixer Measurement 

 Scalar Measurement Vector Measurement 

Overall 

comparison 

 High accuracy of frequency 

transformation gain and loss 

measurement 

 Optional for phase measurement. 

 SOLT and power calibration 

 Simpler than vector measurement 

 High accuracy of phase and group delay 

measurement 

 Require the combination of SOLT calibration and 

interchangeable mixer/filter in calibration 

 Complete setting and calibration procedures 

 Easy converter measurement after calibration 

Measurement 

 Support forward and backward 

measurement. 

 The DUT can be connected to any 

port of the vector network analyzer. 

 Amplitude response VC21 

 Phase response 

 Group delay 

 The input end of the DUT must be connected to 

Port 1 of the analyzer. 

 The output end of the DUT can be connected to 

any port of the analyzer. 

Equipment 

requirements 

 Power meter and probe 
 Reference mixer 

 Calibration mixer/filter pair (S21=S12) 

Mechanical or electronic calibration kit 

6.1.2 Measurement Limitations 

Prompt 

Mixer measurement is not applicable in the following cases. 

 Analog frequency canning 

 Logarithmic frequency sweep 

 Non-ratio reception measurement 

 Electronic calibration described by the user. 

 Time domain 

 Balance measurement 

 Port extension 

 Some fixture features 

 External test setting 

6.2 Scalar Mixer Measurement 

6.2.1 Hardware Configuration 
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Fig. 6.1 Hardware Setting 

One power meter, two signal sources and one calibration kit are required in the scalar mixer measurement 

calibration. The calibration kit is divided into the mechanical calibration kit and electronic calibration kit. The 

electronic calibration kit inserted into the USB interface (as shown in the above figure) can be automatically 

identified by the analyzer. The DUT can be connected to any port of the instrument. For the four-port vector 

network analyzer, the internal source 2 can be used as the LO input end, so no external source is required. 

6.2.2 Setting of Measurement Type 

Menu path: [Response] > [Measure] > [Measurement Class]. Select [Scalar Mixer] and click [OK]. The default 

setting is Channel 1. For mixer measurement in a new channel, click the [New Channel] button. 

 

Fig. 6.2 Setting of Mixer Measurement 

6.2.3 Setting of Mixer Measurement 

Menu path: [Response] > [Measure] > [Mixer Setup]. Set the [Sweep Setup], [Power Setup], [Mixer frequency 

Setup], [Mixer Power Setup] and [Mixer Setup] in the pop-up dialog box. 



Appendix 

Appendix 6 Mixer Measurement 

 363 

 

 

Fig. 6.3 [Mixer setting] Dialog Box 

1) [Sweep Setup] dialog box 

a) Sweep type: see the detail in ―4.5.1 Sweep Type‖ in the manual. The default setting is [Linear Frequency]. 

Select [CW Time], [Segment Sweep] and [Power] in the dialog box. 

b) [X-axis Point Spacing] check box: the default setting is gray and unavailable. This option cannot be ticked until 

segment sweep is selected. 

c) [Avoid Spurs]: tick it to enable the stray signal suppression function of the host. 

d) [Number of Points] check box: set the frequency points to be measured. 

e) [if Bandwidth] check box 

Set the intermediate frequency bandwidth at the linear power level to obtain the acceptable trace noise. The trace 

noise is directly related to the measurement accuracy of the compression point. The small value (narrow 

intermediate frequency bandwidth) can help to improve the accuracy, but the measurement velocity will be reduced. 

f) Phase reference point 

A phase coupling relationship is provided by the phase measurement technology of scalar mixer measurement in 

each sweep from one frequency point to next frequency point. The phase measurement of the first point is random 

in each sweep. However, the initial phase deviation has no influence on measurement of the group delay, linear 

phase differential, etc. In order to keep the phase trace of the random phase, all phases should be normalized in 

sweep to obtain a stable and normalized phase curve. Generally, a measurement point of good signal-to-noise ratio 

is selected as the reference point of normalization. The phase of the selected point is generally 0. The setting will be 

applied in measurement and reference sweep. In the segment sweep mode, the reference point is the middle fixed 

point. 

 [Enable phase]: tick it to enable the phase coupling relationship. 

 [First point]: tick it to set the first frequency point of sweep as the phase reference point. 

 [Middle point]: tick it to set the middle frequency point of sweep as the phase reference point. 

 [Last point]: tick it to set the last frequency point of sweep as the phase reference point. 

 [Specify point]: specify one point within the sweep frequency range as the phase reference point through 

the drop-down box. 

2) [Power Setup] dialog box 

Power setting: click [Power] in the dialog box, and the following dialog box will appear. 
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Fig. 6.4 [Power Setting] Dialog Box 

a) [Power On (All Channels)] 

It is used to control the enabling and disabling of RF power of all channels. Tick it to enable the power; otherwise, 

the power will be OFF. 

b) [Port Powers Coupled] 

It is used to correlate the power levels of the DUT input and output port. If this option is not ticked, the power 

settings of two ports are relatively independent. 

c) DUT input/output port 

 [Input/Output Port] 

It is used to configure the measurement port for the DUT input and output end. In the vector mixer measurement 

mode, the reference mixer should be connected to Port 1. Therefore, the input end of DUT must be connected to 

Port 1 of the test instrument. 

 [Power Level] 

Set the level of the input and output port of DUT. 

 [Source Attenuator] 

If ―Automatic‖ is selected, the test instrument can select the attenuation value according to the actual measurement 

to meet test requirements. The attenuation value can be customized to meet the required input power. All ports 

must have the same attenuation value in the continuous sweep mode. 

 [Receiver Attenuator] 

Set the receiver attenuation of DUT port. 

 [Source Leveling Mode] 

Options: internal amplitude stabilization, open loop (only for the broad pulse measurement mode) and receiver. 

d) Power sweep of DUT input and output port (only when the power sweep mode is selected in the sweep 

bar) 

 [Start/Stop Power] 

Set the start and stop power of the input/output port. 

 [Number of Points] 

Set the number of sweep power points. 
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 [Power Step] 

The step value is calculated according to the current start frequency, stop frequency and sweep point number. 

e) [Path configuration] 

If this option is ticked, the following [Path configuration] dialog box will pop up. Set the configuration of the signal 

path to each port in the channel. 

 

Fig. 6.5 [Path configuration] Dialog Box 

3) [Mixer Frequency] dialog box 

Click [Mixer Frequency], and the following dialog box will pop up. 

 

Fig. 6.6 [Mixer frequency setting] Dialog Box 

a) Frequency setting mode 

 [Start/Stop] 

Select it in the drop-down box and respectively enter the start frequency and stop frequency in the frequency range. 

 [Fixed] 

Select it in the drop-down box and entered the fixed frequency in the frequency range. 
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 [Center/Span] 

Select it in the drop-down box and respectively enter the center frequency and stop frequency in the frequency 

range. 

b) Frequency calculation mode 

 [LO + input] 

If this option is selected, the output frequency will be the sum of the LO and input frequency. 

 [Input-LO] 

If this option is selected, the output frequency will be the difference of the input frequency minus LO frequency. 

 [LO-input] 

If this option is selected, the output frequency will be the difference of the LO frequency minus input frequency. 

 [Calc IN] 

When the LO and output frequency are set, click [Calc IN] to automatically calculate the input frequency. 

 [Calc OUT] 

When the LO and input frequency are set, click [Calc OUT] to automatically calculate the output frequency. 

 [Calc LO] 

When the input and output frequency are set, click [Calc LO] to automatically calculate the LO frequency. 

Prompt 

Frequency setting 

 Select [Start/Stop], [Fixed] and [Center/Span] in the drop-down box. [Fixed] must be selected. If the sweep 

mode in the [Sweep] dialog box is [CW] or [Power Sweep], the mixer frequency is [Fixed]. 

 It is not required to input all frequencies. Set two frequencies at first, and then click [Calculate] to obtain the 

third frequency. To set the input and output frequency range, click [Calc LO] to automatically calculate the 

LO frequency range. 

4) [Mixer Power] dialog box 

Click [Mixer power], and the following dialog box will pop up. 

 

Fig. 6.7 [Mixer power setting] Dialog Box 

a) Power On (All Channels) 

Tick it to open the internal sources of all channels of the vector network analyzer and clear it to remove the internal 
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sources of all channels. 

b) LO1 

The default setting is ―uncontrolled‖. Set the LO1 port in the [Mixer setting] dialog box. The corresponding port 

will be displayed. 

 [LO1 power] 

Set the power of LO1. 

 [Source Leveling Mode] 

Select [Internal], [Open loop] (only for the broad pulse measurement mode) and [Receiver] according to the 

actual measurement requirements. The default mode is [Internal]. 

c) LO2 

The default setting is ―uncontrolled‖. Set the LO 2 port in the [Mixer setting] dialog box. The corresponding port 

will be displayed. 

 [LO2 power] 

Set the power of LO2. 

 [Source Leveling Mode] 

Select [Internal], [Open loop] (only for the broad pulse measurement mode) and [Receiver] according to the 

actual measurement requirements. The default mode is [Internal]. 

d) Port setup 

 [Source Attenuator] 

Set the attenuation value of LO. 

 [Receiver Attenuator] 

Set the attenuation value of the receiver. 

d) Sweep Power 

The default mode is gray. If the [Power Sweep] mode is selected, the sweep power can be set. 

f) Path Configuration 

If this option is clicked, the [Path Configuration] will pop up. Configure the path. 

 

Fig. 6.8 [LO path configuration] Dialog Box 
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5) [Mixer] dialog box 

Click [Mixer], and the following dialog box will appear. 

 

Fig. 6.9 [Mixer setting] Dialog Box 

Converter Stages: click the drop-down box, and select the orders of the converter. The default mode is 1-

order. If the 2-order mode is selected, mixer conversion will be done twice, and the corresponding converter model 

is a 2-order model. 

 

Fig. 6.10 Mixer Mode Setting Dialog Box 

Converter model: set [Input port], [LO port] and [Output port] of the mixer in the model dialog box. If the 

LO and LO2 are not set, one external source can be used to provide the fixed LO; otherwise, the port must be 

configured. 

Fraction multiplier: 

The (numerator/denominator) combination is a decimal and multiplied by the input and output 

frequency. The default coefficient of the numerator/denominator of the multiplication base is 1, and the 

adjustable range is 1 to 10. The negative is not allowed. If the multiplication coefficient changes, the [Output 

frequency range] in the [Frequency setting] box will change accordingly. With the fraction multiplier, the 

receiver frequency can be tuned to the harmonics of the mixer. 
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6.3 Calibration of Scalar Mixer Measurement 

Perform calibration after mixer measurement setting. Menu path: [Cal] > [Calibration...]. Complete all 

calibrations according to the guide. 

1) Calibration setting 

 

Fig. 6.11 Calibration Setting 

a) Edit mixer: click it to modify the mixer settings. 

b) Calibrate the input and output end with the power meter (do not use the through type calibration mode). 

If the through type calibration mode is unavailable, tick this option. In this case, the input and output end can be 

calibrated with the power meter in the subsequent calibration. 

c)Waveguide/In-fixer/On-wafer Setup: the default mode is gray and unavailable. 

2) Select the DUT connection type and calibration kit. 

 

Fig. 6.12 Connector and Calibration Kit 

Select the specific connection type and calibration kit type of the DUT for various ports. If the connector of the 

DUT is of waveguide type, modify the system impedance into 10Ω before calibration. For setting steps, refer to the 

system impedance settings. 

a) Connection type of DUT 

 [Port 1]: the interface type of the DUT connected to Port 1. 

 [Port 2]: the interface type of the DUT connected to Port 2. 

 [Input power sensor]: the same type as that of connection to Port 1. 

b) Calibration kit: model of the selected calibration kit. The inserted electronic calibration kit will be 

automatically detected by the analyzer and displayed. 

c) [De-embedding of adapter of power sensor input end] 

If the connector type of the power sensor is different from that of the DUT, the adapter connected to the power 

sensor on the reference plane should be measured and modified to ensure accurate measurement. If this option is 

ticked, the adapter will be measured and corrected in the following calibration steps. 

d) Modification calibration: tick it and click [Next]. Then the [Modify through type calibration] dialog box 

shown in the following figure will appear. 

3) Modification of through type calibration 

 

Fig. 6.13 Modification of Through Type Connection 

a) Through type calibration: including [Zero-length through type calibration], [Custom through type 
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calibration] and [Unknown through type calibration]. Select one in the drop-down box. 

b) [Calibration type/calibration standard]: click it and the [Calibration type] dialog box in 6.6.5 will pop up. 

c) [Add through type calibration or remove through type calibration]: click [Add through type calibration] 

to add the through type calibration; and click [Remove through type calibration] to remove the unnecessary 

through type calibration. 

4) Port power calibration setting dialog box 

a) Power 

 Power calibration port: set the amplifier input port as the power calibration port. 

 Power deviation: refer to the difference between the amplifier input power and calibrated power. It is 

generally caused by the adapter or attenuator between the calibration plane and power meter. In case of 

no frequency offset, ignore this option. 

b) Accuracy 

 Tolerance: refer to the error tolerance of power calibration. 

 Maximum reading times: sweep will be repeated automatically if the power calibration fails. The 

maximum reading times are the times of repeated sweep. If power calibration still fails after exceeding 

maximum reading times, sweep will not be repeated and next step will be started directly. 

c) Power meter configuration: select the power meter model/ if the USB power probe developed by the 41st 

Institute is inserted, the probe will be detected automatically and the options will be provided. 

 

Fig. 6.14 Port Power Calibration Setting Dialog Box 

The power calibration level is generally 0dBm. The low power level may result in low-level calibration with noise. 

If additional elements are added between the test port and calibration reference plane, the power level of the power 

sensor can be adjusted properly to be slightly higher than 0dBm. 

5) Calibration steps 

Perform connection as shown in the figure. After connection, click [Measurement]. The analyzer will automatically 

skip to next step after measurement. After all measurements, click [Done]. Thus all the calibrations are completed. 
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Fig. 6.15 Dialog Box of Calibration Steps 

6) Trace adjustment 

Measure the DUT after calibration. To display more measurement parameters, Click [Trace] > [New Trace]. 

Select one parameter in the list. 

 

Fig. 6.16 [New Trace] Dialog Box 

The input port is for the frequency signal before frequency transformation, and the output port for the frequency 

signal after frequency transformation. The DUT input and output port can be connected to any port of the vector 

network analyzer. 

 

Fig. 6.17 Schematic Diagram of Measurement Parameters 

Mixer parameters are defined as follows. 

Schedule 6.2 Measurement Parameters of Scalar Mixer 

 Parameter Description 

Scale parameter 

S11 Matching input, indicating the input port stimulus and response (A/R1) 

S22 Matching output, indicating the output port stimulus and response (B/R2) 

SC21 
Frequency transformation loss, indicating the input port stimulus and output port 
response (B/R1) 

SC12 Reverse isolation, indicating the output port stimulus and input port response 
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(A/R2) 

Non-scalar 

parameter 

IPwr Input power, indicating the input port stimulus and response. 

RevIPwr Reverse input power, indicating the output port stimulus and response. 

OPwr Output power, indicating the input port stimulus and output port response. 

RevOPwr 
Reverse output power, indicating the output port stimulus and input port 

response. 

6.4 Vector Mixer Measurement 

1) Hardware setting of vector mixer measurement 

 

Fig. 6.18 Measurement Hardware Equipment 

a) Reference mixer 

The reference mixer is used to provide phase reference for measurement and connected between the input end and 

output end of the reference channel R1 of the vector network analyzer. 

As part of the test system, the reference mixer should be kept unchanged in the whole calibration and measurement 

process. The mixer is controlled by the switch. You can select whether to set the mixer in the measurement path of 

the instrument. For details, refer to the manual switching control of the mixer. 

The performance of the reference mixer is allowed to be different from that of the calibration mixer or test mixer, 

but the frequency range of the reference mixer must be the same as that of the test mixer. In short, it is necessary to 

select the reference mixer which can be used in various settings. For example, the broad-band mixer should be used 

instead of the narrow-band mixer. 

One low-pass filter is connected to the output end of the reference mixer, to eliminate LO signals leaking out of the 

mixer and prevent losses and errors caused by LO leakage. In a strict sense, it is necessary to set a filter. 

Connection of the reference mixer to the instrument: 

i. Connect the input end of the reference mixer to the output end of the reference source R1 

ii. Connect the output end of the reference mixer to the input end of the reference source R1 of the instrument. 

b) Calibration mixer/filter 

The calibration mixer/filter is a standard through type device in the vector mixer measurement calibration and must 

conform to the following requirements: 

i. The mixer should bidirectionally cover the whole range of the test mixer. This means that the amplitude and 

phase response are the same in the upper and lower transformation direction, as shown in the following figure. 
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Fig. 6.19 Two-way Amplitude and Phase Response 

ii. If the input frequency range and output frequency range are overlapped, the input/output isolation of the mixer 

should be at least 1dB higher than the frequency transformation loss of the frequency overlapping part. 

iii. The filter at the output end of the calibration mixer must be able to filter unnecessary mixing products and 

ensure the passing of required mixing products. 

c) Direction of calibration mixer/filter and reference mixer 

The direction of the reference mixer is always the same as that of the tested mixer to ensure that the output 

frequency is the same as that of DUT. The calibration mixer/filter can be used as the LO source at the upper and 

lower transformation frequency. The internal source 2 can be used as the LO signal. 

2) Establishment of vector mixer measurement 

a) By the front panel: press [Meas] >[Measurement Class]. 

b) Select [Vector mixer measurement] and click [Delete current measurement]. Then click [New Channel] to 

establish the measurement in a new channel. 

c) Set one VC21 measurement. The completion prompt will be displayed. 

d) To add other parameters, click [Trace] > [New Trace]. Select one parameter from the list. 

3) Parameters of vector mixer measurement 

The DUT input end is generally connected to Port 1, and the DUT output end can be connected to any port. 

a) VC21 VC31 and VC41: transformation loss or gain in the default mode, indicating the input end stimulus and 

output end response. 

b) S11: input end stimulus and response. 

c) S22, S33 and S44: output end stimulus and response. 

d) R1 or R: input end stimulus, and absolute power (not corrected) measured at the receiver end R1. 

e) B, C and D: input end stimulus, and absolute power (not corrected) measured at the output end. 

4) Setting of vector mixer calibration measurement 

Menu path: 

By the front panel: click [Frequency] > [Mixer]. 

By the mouse: click [Stimulus] > [Frequency] > [Mixer]. 

The following dialog box will appear on the screen. The mixer settings are the same as the scalar mixer settings. 
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Fig. 6.20 [Vector mixer measurement calibration] Dialog Box 

6.5 Vector Mixer Measurement Calibration 

The user can complete the calibration according to the guide. The first three steps describe the calibration mixer 

used for through type calibration. 

1) Use the mechanical or electronic calibration kit. Perform the full double-port SOLT calibration in the whole 

input and output frequency range of DUT. 

2) Add the LO calibration kit. Connect the open-circuit device, short-circuit device and load to the output 

terminal to describe the input and output matching of the calibration mixer/filter. Save the S2P file after 

calibration. If the same stimulus settings are applied, data can be recalled for vector mixer measurement 

calibration. 

3) Connect the reference mixer to Port 1 and between the input and output of the reference channel R of the 

front panel. Connect the output port of the calibration mixer/filter to Port 2. 

4) Use the calibration mixer/filter in the through type calibration. 

5) Calculate the errors and correct the phase measurement of the test mixer/converter. 

1) Use the mouse or front panel. 

a) By the front panel: click [Cal] > [Calibration Guide]. 

b) By the mouse: click [Response] > [Calibration Guide]. 

 

Fig. 6.21 Setting of Vector Mixer Calibration 

2) [Help] dialog box for mixer characteristic calibration 

Click [Next], and the following dialog box will appear. 

 

Fig. 6.22 Calibration Mixer Characteristics 

 Characterization (using the reference mixer): one mixer is used for characterization, in addition to 
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vector mixer measurement calibration. The mixer characterization file will be saved after calibration. 

Select this option if no characterization file needs to be loaded. 

 Characteristic loading from file: load one S2P calibration mixer characterization file by clicking 

[Browse]. 

Prompt 

Mixer characterization 

 One *.S2PX file should be loaded in segmented vector mixer measurement. 

 The frequency ranges of S2P files must be identical or wider than the frequency range of frequency 

transformation measurement. If the frequency range of the S2P file is larger, the interpolation method should 

be applied to match measurement. 

 The connection direction of the calibration mixer must be the same as that in the characterization file. As the 

direction is not specified in the file, connection should be done carefully. 

 The mixer characterization can be calibrated separately. 

3) Connection type of DUT 

 

Fig. 6.23 Connection Type and Calibration of DUT 

Select the specific connection type and calibration kit type of the DUT for each port. 

[Mixer Output]: connected to the filter output end of the calibration mixer. Specify the calibration 

kit/standard to measure the calibration mixer/filter. 

[Modify Calibration]: select it and click [Next] to modify the calibration dialog box. 

 

Fig. 6.24 Modification of Through Type Connection 

Through type calibration: including [Zero-length through type calibration], [Custom through type 

calibration] and [Unknown through type calibration]. Select one in the drop-down box. 

[Add through type calibration or remove through type calibration]: click [Add through type calibration] to 

add the through type calibration; and click [Remove through type calibration] to remove the unnecessary through 

type calibration. 

4) Dialog box of vector mixer calibration steps 

Respectively connect the open-circuit device, short-circuit device and load to Port 1 and 2 according to the prompts. 

Add the appropriate adapter between Port 1 and 2 for through type measurement. Connect the open-circuit device, 

short-circuit device and load to the output end of the image filter for respectively measurements. 
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Fig. 6.25 [Vector mixer calibration] Dialog Box 

5) [Help] dialog box for saving of mixer characteristics 

The vector network analyzer has the function to save characteristic data of the calibration mixer. After calibration, 

the mixer characteristic calibration file will be saved to the specified path. If the same calibration mixer is used in 

vector mixer measurement calibration, the saved S2P file can be recalled directly. 

 

Fig. 6.26 [Save characteristics] Dialog Box 

Browse: find the path to save the characteristic data of the calibration mixer. Use the default or custom name. 

Next: click [Next] to complete system calibration after saving the characteristics of the calibration mixer. 

6.6 Embedded LO Mixer Measurement 

A fixed LO is embedded in the tested mixer. The characteristics of the embedded LO can be applied in vector 

mixer, scalar mixer measurement, IMDX, IMXSpectrum, GCX and NFX measurement. 

It is challenging to measure such devices for the following two reasons. 

1) The reference mixer with the same LO frequency is required in vector mixer measurement. The independent 

internal source or external source must be used as LO of the reference mixer. At the same time, LO is controlled by 

the instrument. The measurement velocity is higher if the internal source 2 is used. 

2) All the embedded LO measurement must be adjusted with the analyzer receiver to the exact frequency to 

measure the mixer output. Thus the LO frequency must be accurate. 

1) How to measure the embedded LO? 

Enter the nominal frequency of the embedded LO in the [Mixer setting] dialog box, as the start point of 

measurement. 

Before measurement sweep of the DUT, start background sweep to determine the frequency of the embedded LO 

obtain the configurable accuracy. Background sweep: 

1) Broadband sweep: initially measure the embedded LO frequency, and add one frequency range near the selected 

data point. The input signal of the DUT must be selectively adjusted to CW. Receiver B is used to sweep the 

selected frequency range near the preset output frequency. Obtain the desired difference between the output signal 

and the found frequency, and apply the obtained result in adjustment. 

2) Accurate sweep: Receive B is used to measure the selected data point. Measure the ratio of the phase and time, 

and calculate the exact frequency offset, until reaching the allowable residual value or maximum degree of 

repetition. 

3) The reference mixer will be upgraded automatically if the LO frequency is determined in vector mixer 

measurement. 
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2) How to use the embedded LO to measure the DUT? 

1) Establish the vector mixer measurement, scalar mixer measurement, IMDx, IMx Spectrum, GCX or NFX 

measurement. 

2) Enter the nominal frequency of the embedded LO as the LO frequency in the [Mixer setting] dialog box. 

3) Perform calibration. 

4) Open and complete the [Embedded LO model] dialog box. 

5) Measure the vector mixer (frequency transformation amplifier). 

a) LO source of the reference mixer: 

1) Internal source 

2) One external source: controlled by the instrument. Use the 10MHz reference frequency to lock the instrument. 

b) Calibration precautions 

The LO source is commonly used by the reference mixer and calibration mixer in the calibration process. One 

power distributor should be added when the external source is used, as shown in the following figure. 

 

 

Fig. 6.27 Embedded LO Calibration 

The LO source is only used by the reference mixer in the measurement process. The LO port of the calibration 

mixer should be well matched, so that the LO port of the reference mixer remains unchanged after calibration. See 

the following figure. The above considerations are not necessary if the internal source 2 is used. 

 

Fig. 6.28 Embedded LO Measurement 

The embedded LO measurement needs no specific settings in the scalar mixer measurement, IMDX, IMxSectrum 

and NFX measurement. 

c) How to open [Embedded LO mode] dialog box 

With the mouse 

Click [Response]. 
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Then click [Measurement]. 

Click [Search LO]. The [Embedded LO Mode] dialog box will appear. 

 

Fig. 6.29 [Embedded LO mode] Dialog Box 

d) [Help] dialog box for embedded LO 

“Adjust setting”: to balance the LO measurement velocity and frequency. You can see that the accuracy will 

be reduced if noise appears on the measurement trace. 

“Enable embedded LO mode”: click it to enable the embedded LO measurement. 

“Set search frequency point”: select or specify the sweep data point of the mixer to find the embedded LO 

frequency. If one marker is activated, the data point can be used. For broadband and accurate sweep, select the 

point of the lowest noise in mixer sweep. Generally, the sweep center is selected. If the filter is used, select the 

filter center. 

“LO frequency difference”: measure the absolute difference between the embedded LO frequency and the 

LO setting in the [Mixer setting] dialog box. This value changes in each measurement of the LO frequency. This 

is a method to change the set frequency of the mixer and ensure that calibration is effective. 

“Reset”: set the LO frequency as 0Hz. 

“Start search”: set in the current dialog box and search and measure the actual LO frequency. Data will be 

displayed in the [Search state] box. 

“Set search conditions”: the ratio of the sweep time to the LO frequency measurement accuracy depends on 

the set conditions. You can see that the accuracy will be reduced if noise appears on the measurement trace. 

“Reset”: reset all settings into default settings. 

“Rough search and accurate search”: the whole tuning process is executed in background sweep each time. 

“Only accurate search”: broadband tuning is not executed in each sweep. This setting is used when the 

embedded LO is stable. 

“Disable automatic frequency search”: only the LO frequency difference measured previously is applied to 

the reference mixer LO and receiver. 

“Search bandwidth”: reduce the sweep span to limit the data point number of broadband sweep 

measurement and accelerate measurement. 

“Maximum search times”: maximum sweep point number for accurate sweep. If the search times reach the 

maximum times, use the final measurement result. 

“Error”: if two consecutive accurate measurements are within the error range, use the last measurement 

result. If the accurate measurement result is beyond the error range, use the last measurement result. 

“IF bandwidth of search”: refer to the IF bandwidth in the broadband and accurate tuning sweep. If the IF 

bandwidth increases, the sweep velocity will increase accordingly and the signal may not be found. 

“Sweep times within search interval”: set the interval and execute tuning within the interval. ―Sweep times 

within search interval: 3‖ means that tuning sweep is added once every three times of measurement sweep. If the 

embedded LO has drift or the DUT is changed frequently, set ―Sweep times within search interval: 1‖. 

“State search”: it is allowed to execute LO measurement sweep in the text or icon form. 

“Clear state”: remove the text information displayed currently. 
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“Display search interface”: enable the nearest graphical display sweep of embedded LO measurement. 

e) Connection of preamplifier 

The source power should be higher than the input power in mixer measurement. One high-frequency preamplifier 

can be used as an additional source. The following part describes how to establish and calibrate the scalar mixer 

measurement with the high-frequency preamplifier. 

Connect one high-frequency preamplifier between the source output of the front panel and the connection port of 

the coupler, as shown in the following figure. The specific diagram of the instrument may be different. 

 

Fig. 6.30 Schematic Diagram of Preamplifier Connection 

3) Measurement and calibration steps 

In the following steps: 

Test port power: refer to the power level of the source output end. 

Correction power: enter the required power level of the mixer input and output port. 

It is assumed in the following procedures that the stimulus source is applied to the mixer input port for SC11 and 

sc21 measurement and mixer output port for SC22 and SC12 measurement. 

1) Determine the gain of the high-frequency preamplifier. If the mixer frequency crosses the input and output range, 

the gain has the obvious slope. Check the high-frequency preamplifier with the gain slope. 

2) Determine the correction power of the mixer input and output port. 

3) Calculate the power of the two test ports. Reduce the input and output correction power level by the amplifier 

gain. 

4) Clear the port power coupling bar in the [Power] dialog box of the instrument. Various ports may have different 

power levels. 

5) Enter the calibration test power of each port. 

6) Select the connection type of the DUT and calibration kit according to the guide of scalar mixer measurement 

calibration. Click [View/Change Source] to open the [Source] dialog box. 

7) Enter the preamplifier gain in the [Power deviation] box. 

High-frequency preamplifier with gain slope: 

The scalar mixer measurement calibration is executed within the whole mixer input and output range. Therefore, 

the high-frequency preamplifier is limited by the deviation within the whole input and output power range of the 

mixer. In order to compensate the gain slope, one source attenuator should be added and the frequency offset and 

initial power should be set to prevent uneven distribution of the source power in the calibration process. 

Assuming that the low gain of the preamplifier is 30dB, and the high gain is 20dB. If the entered frequency offset is 

30dB and the actual gain decreases to 20dB, PNA may be beyond the ALC range. The source power of PNA will 

be increased corresponding to the 10dB gain decrease. Therefore, one deviation power value is added in the middle 

of the amplifier gain bandwidth. 

If possible, set one attenuator to keep ALC probably in the middle of the frequency range to obtain the desired IF 
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gain correction power. This means that the ALC power can be increased or decreased according to the gain slope. If 

the gain is too large and the source instability cannot be prevented by setting, one flatter high-frequency 

preamplifier must be used. 
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Appendix 7 Intermodulation Distortion Measurement 

This chapter includes the following contents: 

● Concept of intermodulation distortion ······································································································· 452 

● Parameters of intermodulation distortion··································································································· 453 

● Intermodulation distortion measurement of amplifier frequency sweep ····················································· 457 

● Intermodulation spectrum measurement of amplifier frequency sweep ······················································ 463 

7.1 Concept of Intermodulation Distortion 

If various frequency signals are input into one device or system at the same time, the output port will generate the 

signals of different frequency due to nonlinear characteristics of the DUT. The typical measurement method is to 

input two kinds of single-tone signals of different frequencies and the same power to test the spectrum of output 

signals. Several measurement methods can be used to determine the intermodulation distortion parameters of the 

DUT. 

Intermodulation distortion may result in signals of predictable frequency. The intermodulation frequency of one 

dual-frequency system is as follows: 

 

Where, m and n are natural numbers, and m+n is the orders of intermodulation distortion. The odd-order products 

(such as 3-order, 5-order, etc.) are close to the frequency of double-tone input signals and have potential effect on 

the nearby communication channel. Except 2-order products, the products of higher even orders are generally far 

away from the frequency of double-tone input signals and not taken into account. 

Fig. 7.1 shows the two double-tone input signals of the same power and approximate distortion products of 

intermodulation. It can be seen in Schedule 7.1 that the frequency of odd-order products is close to that of main 

signals. For most devices, the intermodulation distortion products are more obvious in the case of system 

compression distortion. 

 

Fig. 7.1 Intermodulation Product of Double-tone Signals (f1 and f2) and Odd Orders 

Schedule 7.1 Intermodulation Distortion Products Close to Main Signal Frequency 

Intermodulation Product Low Frequency High Frequency 

Main tone signal f1 f2 

100MHz 120MHz 

3-order intermodulation 2f1-f2 2f2-f1 

80MHz 140MHz 

5-order intermodulation 3f1-2f2 3f2-2f1 

60MHz 160MHz 

7-order intermodulation 4f1-3f2 4f2-3f1 

40MHz 180MHz 

9-order intermodulation 5f1-4f2 5f2-4f1 

20MHz 200MHz 

2-order intermodulation f2-f1 f1+f2 
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20MHz 220MHz 

7.2 Intermodulation Distortion Parameters 

This section mainly introduces the basic parameters of amplifier and mixer measurement. Such parameters can be 

extended to more than 150 intermodulation parameters by changing the intermodulation order, intermodulation 

sound position (high order, low order and average) and intermodulation sound measurement port. 

● Basic parameters ······································································································································ 453 

● Intermodulation distortion application ······································································································ 456 

7.2.1 Basic parameters 

7.2.1.1 Tone Power Parameter 

The tone power parameter is the absolute power of the main sound signals, odd-order products (up to 9 orders) and 

2-order products. The tone power of the input end and output end of the DUT can be measured. As intermodulation 

sound signals appear in pairs, the high order, low order or average of sound signals can be measured. 

The average tone power is calculated by the following equation: 

 

If the frequency difference of double-tone signals is less than 10MHz in measurement of 2-order products, the low 

order (f2-f1) will be below the lower frequency limit of the analyzer. Therefore, the low order of 2-order products 

cannot be measured in this case. 

7.2.1.2 Sound Gain Parameter 

The sound gain (in dB) refers to the tone power ratio of the output end and input end. As sound signals appear in 

pairs, the low order, high order or average value can be applied to calculate the sound gain. 

The sound frequency of the input end is different from that of the output end in intermodulation distortion 

measurement of the frequency converter. 

7.2.1.3 Intermodulation Distortion Parameters 

The intermodulation distortion parameters are used to describe the power difference between the distortion product 

and main sound signal and calculated according to the tone power. They can also be used to measure 2-order, 3-

order and 5-order intermodulation products. The input end and output end can be set as the measurement port. You 

can also select to measure the high order, low order or average value. The calculation equations of intermodulation 

distortion parameters are as follows: 

IMxLo = PwrxLo-PwrMainLo 

IMxHi = PwrxHi-PwrMainHi 

IMx = Pwrx-PwrMain 

IMxLoIn = PwrxLoIn-PwrMainLoIn 

IMxHiIn = PwrxHiIn-PwrMainHiIn 

IMxIn = PwrxIn-PwrMainIn 

Where: 

 x is the intermodulation distortion order (2, 3, 5, 7, and 9). 

 The suffix ―Hi‖ indicates high order, ―Lo‖ indicates low order and ―none‖ indicates the average value. 

 The suffix ―In‖ indicates the input end of measurement and ―none‖ indicates the output end. 

7.2.1.4 Intersection Point Parameters 

As shown in Fig. 7.2, the black curve and green curve respectively shows the main sound signal power and 

intermodulation sound output power. It can be seen that if the output power of the main sound signal increases, the 

intermodulation sound output power will increase at the predictable and steeper slope. The main sound output 
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power is equal to the intermodulation sound output power at a certain point. This point is generally defined as the 

intersection point. The intersection point cannot be directly measured with the test instrument. Instead, it is 

calculated by measuring the main tone power and intermodulation sound output power. 

 

Fig. 7.2 Schematic Diagram of Intersection Point Parameters 

The function of intermodulation distortion measurement can be used to calculate and display the theoretical 

intersection point power of the input end and output end of the DUT, i.e. input intersection point (IIP) and output 

intersection point (OIP). 

Measurement orders can be set in intersection point measurement: 2, 3, 5, 7, and 9. The sound positions include 

high order, low order and average. The measurement ports include the input end and output end. For the 2-order 

intersection point, only the low order and high order can be measured, and the average value is not supported. 

The calculation equations of intermodulation distortion intersection points are as follows: 

OIPxHi = PwrMain - IMxHi/(x-1) 

OIPxHiIn = PwrMain - IMxHiIn/(x-1) 

OIPxLo = PwrMain - IMxLo/(x-1) 

OIPxLoIn = PwrMain - IMxLoIn/(x-1) 

OIPx = PwrMain - IMx/(x-1) 

OIPxIn = PwrMain - IMxIn/(x-1) 

IIPxHi = PwrMainIn - IMxHi/(x-1) 

IIPxHiIn = PwrMainIn - IMxHiIn/(x-1) 

IIPxLo = PwrMainIn - IMxLo/(x-1) 

IIPxLoIn = PwrMainIn - IMxLoIn/(x-1) 

IIPx = PwrMainIn - IMx/(x-1) 

IIPxIn = PwrMainIn - IMxIn/(x-1) 

Where: 

 OIP refers to the output intersection point. 

 IIP refers to the input intersection point. 

 x=order (2, 3, 5, 7 and 9) 

 PwrMain=main sound signal of the input end or output end of the DUT. 

 IMx=main sound signal power-intermodulation tone power (from the intermodulation distortion parameter) 

7.2.1.5 Composite Triple Beat (CTB) 

According to the NCTA standard, CTB is defined as the modulation beat of target channel signal arising from the 

triple beat produced by nonlinear characteristics of the DUT. CTB is the ratio of the signal level of the target 



Appendix 

Appendix 7 Intermodulation Distortion Measurement 

384  

 

channel to the maximum average level of beat components. Here beat components are distributed around the carrier 

frequency of the target channel. Intermodulation distortion supports the following two types of CTB: 

 CTB: approximate value based on the beat of the middle part of the band. 

 CTBE: approximate value based on the beat of the edge part of the band. 

The calculation equation is as follows: 

CTB(dB)=-2(Pi-Ps)+6+10Log(3N2/8)+CTB Offset 

CTBE(dB)=-2(Pi-Ps)+6+10Log(N2/4)+CTB Offset 

Where: 

 Pi=power of 3-order intersection point of output end (dBm): OIP3 (Lo|Hi) 

 Ps: select according to the composite normalization mode: 

 PDBM or PDBMV mode: Ps=CompositeNormalizedCTBPower 

 NumberofCarriers mode: Ps=PwrMain (AVG)-10Log(N/2) 

 None mode: Ps=PwrMain (AVG) 

 CTBOFFset=calculated value of CTB 

 N=carrier number. 

Note: The CTB deviation and N value can only be set with the SCPI or COM command. 

7.2.1.6 Composite Second Order (CSO) Beat 

According to the NCTA standard, the CSO beat is defined as the modulation beat of the target channel signal 

arising from the second order beat of the DUT (as a result of nonlinear characteristics). It refers to the ratio of the 

signal level of the target channel and the maximum average level of beat components. Here beat components are 

distributed around the carrier frequency 0.75MHz and 1.25MHz of the target channel. The CSO beat refers to the 

ratio of the carrier level of the target channel to the peak level of the second order beat near 0.75MHz and 1.25MHz 

of the carrier frequency. Intermodulation distortion supports the CSO parameter test. The calculation equation is as 

follows: 

CSO(dB)=(Pi-Ps)+10Log(N)+CSO Offset 

Where 

 Pi=2-order intermodulation power of output end: OIP (Lo | Hi) 

 Ps: one of the following composite normalization modes: 

 PDBM or PDBMV mode: Ps = CompositeNormalizedCSOPower 

 NumberofCarriers mode: Ps = PwrMain (AVG) - 10Log(N/2) 

 None mode: Ps = PwrMain (AVG) 

 CSOOFFset=calculated deviation of CSO 

 N=number of distortion products 

Note: The CSOOFFset and N value can only be set with the SCPI or COM command. 

7.2.1.7 Intermodulation Distortion 

According to the NCTA standard, the signal of the stray channel is modulated to the target channel. Due to 

nonlinear characteristics of the DUT, intermodulation distortion will be caused. Intermodulation distortion refers to 

the power ratio of the modulation signal of the target channel to the stray interference modulation signal. 

Intermodulation distortion supports the XMOD parameter measurement by the following equation: 

XMOD=-2(Pi-Ps)+6dB+20Log(N) 

Where 
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 Pi=three-order intersection point power of output end: OIP3 (Lo|Hi) 

 Ps=carrier power: PwrMain (AVG) 

 N=carrier number. 

7.2.2 Intermodulation Distortion Application 

The intermodulation distortion function requires two main sound signals produced in the analyzer. Fig. 7.3 shows 

the schematic diagram of the four-port vector network analyzer with double sources and internal combiner. 

 

Fig. 7.3 Internal Configuration of Intermodulation Distortion 

According to the parameters to be tested and the sweep type, the source and receiver frequency of the analyzer are 

adjusted automatically through the intermodulation distortion program, to cover the power of all main sound 

signals and intermodulation sound signals required for measurement. For example, the power of the double-tone 

signal and the high order and low order of the three-order intermodulation sound should be measured in the three-

order intermodulation parameter measurement. 

7.2.2.1 Stimulus Setting Limitation and Out-of-range Intermodulation Sound 

Two double-tone signals produced by the internal source of the network analyzer are required for the 

intermodulation distortion function. Therefore, the frequency of the double-tone signal should be within the 

frequency range of the analyzer. In order to prevent the double-tone signal frequency f1 and f2 from being out of 

the upper and lower limit of the analyzer frequency, the parameter settings will be adjusted if necessary. 

However, the frequency of the intermodulation products may be lower than that of the network analyzer. For 

example, if the double-tone signal frequency is 10MHz and 15MHz, only the minimum frequency (10MHz) can be 

measured, although the measurement parameter IM3Lo (3-order (low) product) can be measurement. 

7.2.2.2 Limitations of Measurement Point Number 

At most 32,001 points can be measured in one sweep. However, according to the measurement parameters, 

background measurement may be executed several times by the analyzer. Therefore, the analyzer may require a 

long time of background measurement before data refreshing if the point number is large. 

7.3 Intermodulation Distortion Measurement of Amplifier Frequency Sweep 

This section includes the following contents: 

● Characteristics and limitations ·················································································································· 457 
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● Calling of intermodulation distortion measurement interface ····································································· 457 

● Setting of intermodulation distortion measurement parameters ·································································· 460 

● Simple intermodulation distortion calibration ···························································································· 462 

7.3.1 Characteristics and Limitations 

7.3.1.1 Characteristics 

 The distortion parameter measurement can be set rapidly and easily, and at most 9-order products can be 

measured. 

 The input and output of the DUT can be measured. 

 Support various double-tone sweep modes: linear and list frequency sweep (double-tone center frequency) 

mode, voice span sweep mode, power sweep mode and CW (fixed double-tone frequency) mode. 

 The network analyzer is configured with the high-power, high-linearity and low-harmonic signal source for 

rapid and accurate measurement. 

 Support calibration and correction. 

 The IF bandwidth for measurement of the main sound signal and intermodulation sound signal can be set 

separately. 

7.3.1.2 Limitations 

 The two ports do not support the transformation test. The measurement of the frequency converter will be 

introduced later. 

 The connection between the DUT and the port of the vector network analyzer is limited. Set [Power] to change 

the port connection. 

7.3.2 Recalling of Intermodulation Distortion Measurement Interface 

Menu path: [Response] > [Measures] > [Sweep IMD Setup]. 

 

Fig. 7.4 Intermodulation Distortion Setting with Mouse 

7.3.2.1 Intermodulation Setting of Frequency Sweep 

1) Frequency sheet 



Appendix 

Appendix 7 Intermodulation Distortion Measurement 

 387 

 

 

Fig. 7.5 [Intermodulation distortion frequency setting] Dialog Box 

 Linear sweep fc (center frequency) 

 

The sound span and power of the double-tone signal are fixed. Sweep the center frequency (fc) of the double-tone 

signal. Set the start and stop values of the center frequency of the signal, or specify the center frequency point and 

sweep width corresponding to fc. 

For the center frequency (fc), the receiver can be adjusted to measure all the tone power values. 

 Linear sweepDeltaF (sound span) 

 

The center frequency and power of the double-tone signal are fixed. The frequency difference (sound span) of the 

double-tone signal is the start difference to stop difference. 

 Power sweep 

 

The frequency of the main sound signal is fixed (set through f and f2 or fc and DeltaF). The main sound signal 

power is swept from the start frequency to stop frequency. The power f1 and f2 can be set separately (in [Power]) 

or in a coupled manner. 

 CW 

 

The frequency and power of the main sound signal are fixed. The analyzer will measure the data of specified points, 

and X axis shows the number of points. 
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 Segment sweep fc 

 

The segment table is edited in the same manner as the standard segment, like the center frequency of sweep. 

 intermediate-frequency bandwidth 

The intermediate frequency bandwidth can be set separately in the main sound signal and intermodulation sound 

measurement. The power of the main sound signal is generally high, so the large intermediate frequency bandwidth 

can be applied for rapid measurement. The power of the intermodulation sound signal is generally low, so the small 

IF bandwidth can be applied for accurate measurement. [Reduce intermediate frequency bandwidth at low 

frequency]: if the frequency is lower than 748MHz, the noise will become poor, especially when the frequency is 

10MHz to 45MHz. If this option is selected, the intermediate frequency bandwidth smaller than the set value in the 

interface will be applied in measurement of the frequency below 748MHz. 

2) Power table 

 

Fig. 7.6 [Intermodulation distortion power setting] Dialog Box 

Set the RF power of the intermodulation distortion measurement and the main tone power of frequency sweep. 

 Power ON/off (All Channels): enable or disable the function to measure the RF source power of all 

channels. 

 DUT Input Port 

 Input port:select Port 1 or 3. The external combiner is required for Port 3. 

 Source Attenuator: set the power attenuation value of Port 1. Otherwise, the input signal power range of 

the DUT will be affected. 

 Receiver Attenuator: protect Receiver A from burning. 

 DUT Output Port 

 Output Port: select Port 2 or 4. 

 Source Attenuator: improve the load matching of the output end of the DUT. If the output signal power is 

up to 10dBm, the attenuator power may be 0dB. If the output signal power increases by 10dBm, the 

attenuation value will increase by 10dB accordingly. 

 Receiver Attenuator: set the receiver attenuation value for Port 2. If the input power of the test port of the 

receiver is about 10dBm, receiver compression may occur. However, if the receiver attenuation value 

increases, the power will decrease in measurement, and high noise will be produced. In this case, the 
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intermediate frequency bandwidth of intermodulation sound can be decreased to reduce the influence of noise 

of intermodulation signal. 

 

 Tone Power 

 Coupled Tone Power: set the f1 power of the double-tone signal, that is, f2 is equal to f1. 

 f1 power: set the f1 power of the input or output signal of the DUT, within the range from -25dBm to 

20dBm. If the coupling power is selected, f1 and f2 can be set at the same time. 

 f2 power: if the coupling power is not selected, the f2 power of the input or output signal of the DUT can 

be set, within the range from -25dBm to 20dBm. 

 Start power, stop power, f1 step power and f2 step power: after the sweep type is selected, set the start 

and stop power of f1 and f2 or set the two signals at the same time in the coupled form manner. 

7.3.3 Parameter Setting of Intermodulation Distortion Measurement 

7.3.3.1 Adding of Intermodulation Distortion Parameters 

Menu path: [Trace] > [New Trace]. 

 

Fig. 7.7 Parameter Setting of Intermodulation Distortion 

Setting of new trace for intermodulation 

 

Fig. 7.8 Parameter Setting of Intermodulation Distortion Measurement 

Set intermodulation distortion parameters in the dialog box shown in Fig. 7.8. At most 5 parameters can be set at a 

time, click [Apply] to create a new trace. If the dialog box is not applied, more traces can be selected. The added 

traces and windows should conform to the analyzer limitation requirements. 

7.3.3.2 Parameter Setting of Intermodulation Distortion 

1) Type 

 Tone power: measure the absolute power of the specified sound signal. 
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 IMD relative power: measure the ratio of the f1 to f2 power of the intermodulation sound and main 

sound. 

 IIP power: calculate the theoretical intersection point power of the input end of the DUT, i.e. theoretical 

power corresponding to the same intermodulation sound and main tone power of the orders to be 

calculated. 

 OIP power: calculate the theoretical intersection point power of the output end of the DUT, i.e. 

theoretical power corresponding to the same intermodulation sound and main tone power of the orders to 

be calculated. 

 CTBE: composite triple beat distortion based on edge band, for three orders and output end. 

 CTB: composite triple beat distortion based on middle band, for three orders and output end. 

 CSO: composite second order beat distortion, for two orders and output end. 

 XMOD: three-order intermodulation distortion of output end. 

 Tone gain: measure the sound signal power and calculate the ratio of the signal power of the output end 

to input end. The frequency of the input signal is different from that of the output signal. 

2) Tone signal selection 

Select the tone signal to be measured and displayed. 

 High order: measure and display intermodulation signal with the frequency higher than the main sound 

frequency; 

 Low order: measure and display intermodulation signal with the frequency lower than the main sound 

frequency; 

 Average: measure and display average value of the intermodulation signal of main sound signals from 

the high-order and low-order end. 

 Maximum: measure and display the maximum value of the intermodulation signal of main sound signals 

from the high-order and low-order end. 

 Minimum: measure and display the minimum value of the intermodulation signal of main sound signals 

from the high-order and low-order end. 

Attention 

Precautions of two-order intermodulation 

 The two-order intermodulation sound may be beyond the frequency range of the network analyzer. In this 

case, the upper limit and lower limit of the frequency of the analyzer will be measured. 

 If the high-frequency signal or lower-frequency signal is beyond the frequency range of the network analyzer, 

the average value will not be measured. 

 The average value will not be measured in the two-order intermodulation sound, as the frequency difference of 

the high-order and low-order intermodulation sound is large. 

 Select [Include two-order intermodulation] in the [Cal] dialog box to calibrate 2-order sound. 

 

3) Order and measurement port selection 

 Select the orders of intermodulation products in the dialog box, including 1, 2, 3, 5, 7 and 9. If ―1‖ is selected, 

the main sound signal will be measured, and the parameter name is ended with the ―Main‖ marker; otherwise, 

the order number should be added behind the parameter name. 

 Measurement can be done at the input end or output end. If the input end is selected, add ―In‖ behind the 

parameter name, such as PwrMainIn. If the output end is measured, there is no additional marker behind the 

parameter name, such as PwrMain. The input end is tested with the reference receiver, and the output end is 
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tested with the measurement receiver. 

7.3.4 Simple Intermodulation Distortion Calibration 

7.3.4.1 Overview 

1. The source power calibration and receiver calibration interface is used in simple intermodulation 

distortion calibration. 

2. The intermodulation sound order can be selected in calibration. 

3. Port 1 is connected to the power meter to calibrate the reference receiver and measurement receiver. 

 The source and receiver frequency can be calculated with the vector network analyzer, including main signals 

and all intermodulation signals. 

 Port 1 is connected to the power meter. The reference receiver R1 can be calibrated in source and receiver 

calibration. 

 The reference receiver R1 is used to calibrate the main signal source. At first, calibrate the low-frequency 

power of Source 1 and then calibrate the high-frequency power of Source 2. Source 1 and 2 should be 

disconnected to ensure impedance matching. 

 Directly connect Port 1 and 2 and correct Receiver B by means of calibration. 

Attention 

If the main sound signals frequency changes, calibration may fail. 

Changes of the main sound signal frequency may result in failure of calibration. The state change may occur to the 

start/stop/center frequency, frequency span, sweep point number, sweep type, etc. 

7.3.4.2 Selection of Product Signal 

 Maximum calibration order: select the intermodulation product which can be measured (5 orders at 

most). Low-frequency and high-frequency signal and intermodulation products of smaller odd orders can be 

calibrated. For example, the main signals and high-order and low-order products (such as 3-order and 5-order 

products) can be calibrated in 5-order intermodulation measurement. 

 Include 2-order calibration: calibrate 2-order products, the frequency of which is always subject to 

large deviation from the main signal frequency. 

 

Fig. 7.9 Intermodulation Distortion Calibration Process 

 Power Level: execute the power calibration value of Port 1. As the standard calibration power of the power 

meter is 0dBm, 0dBm is generally selected as the power of source power calibration. If one component is 

added between the source and calibration reference plane, the calibration power should be adjusted to keep the 

power of the calibration port of the power meter at 0dBm. 

The pages of other calibration steps are the same as those of source calibration and receiver calibration, so they are 

not detailed here. 

7.3.4.3 Saving of Intermodulation Distortion Power Data of Frequency Sweep 

Only the logarithmic power amplitude in intermodulation distortion measurement data of frequency sweep can be 

saved in the ―*.csv‖ file. The file can be read with the Microsoft Excel program, and the data of last sweep will be 

saved in the ―*.csv‖ file. 

Menu path: [Save] > [Save Data As]. Click “File type=IMD sweep data (*.csv)”. 
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Attention 

Precautions for data saving 

 Save the power values of current parameters, including the power of the input end and output end. For the 

average, maximum and minimum type, all high-order and low-order data will be saved: 

UTAvg|OUTLo|OUTHi|INAvg|INLo|INHi. 

 All the displayed intermodulation products will be saved. 

 Only the power values of intermodulation products are saved, and the calculated values will not be saved. 

 If the calibration function is enabled before saving, all the data will be calibrated. At the same time, original 

data will be saved. 

7.4 Intermodulation Spectrum Measurement of Amplifier Frequency Sweep 

This section mainly introduces the intermodulation spectrum measurement, which can be done with frequency 

sweep intermodulation spectrum measurement at the same time. As the two measurements are greatly different 

from each other, intermodulation spectrum measurement is usually done separately. This section introduces the 

intermodulation spectrum measurement in the following parts. 

● Concept of intermodulation spectrum ······································································································· 463 

● Creating of intermodulation spectrum channel ·························································································· 464 

● Parameters of intermodulation spectrum trace ··························································································· 464 

● [Intermodulation spectrum setting] dialog box ·························································································· 465 

7.4.1 Concept of Intermodulation Spectrum 

The intermodulation spectrum channel of the vector network analyzer is configured with one traditional spectrum 

analyzer interface to measure the intermodulation distortion of the DUT. The intermodulation spectrum channel 

interface is different from the frequency sweep intermodulation distortion channel. As f1 and f2 of the main signal 

are fixed in intermodulation spectrum measurement, the receiver can receive the output signal of the DUT in the 

frequency sweep mode, and the display interface is shown in Fig. 7.10. 
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Fig. 7.10 Frequency Sweep Intermodulation Distortion Measurement Interface (upper figure) Intermodulation 

Spectrum Measurement Interface (lower figure) 

The vector network analyzer is different from the typical spectrum analyzer in that one signal source is set in the 

analyzer and no signal source is set in the spectrum analyzer. Therefore, the vector network analyzer can work in 

the intermodulation spectrum channel or frequency sweep intermodulation distortion channel. Main signals of 

different frequencies (f1 and f2) can be generated by setting the signal source. Setting items mainly include the 

frequency and power of main signals. 

Receiver setting 

The intermodulation spectrum receiver can be set to work only in the intermodulation spectrum channel. Setting 

items includes the intermodulation products of different orders (depending on the frequency range and center 

frequency) and bandwidth. 

The number of measurement channel points can be changed by selecting different bandwidths. The point number 

decreases with the bandwidth increasing. The corresponding relationship is as follows: 

N=(Span/ResBW)*3 

Each data point can be measured several times in the intermodulation spectrum channel to filter unnecessary image 

interference (produced inside the vector network analyzer). Therefore, the high-purity signal capture path will be 

provided, and no false response will be generated in measurement. 

7.4.2 Creating of Intermodulation Spectrum Channel 

The intermodulation spectrum channel can be created independently or together with the existing frequency sweep 

intermodulation distortion measurement channel which has been set. 
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Creating of Independent Spectrum Measurement Channel 

1. Front panel of the network analyzer: click [Meas] > [Measurement class]. 

2. Select the spectrum measurement type and click OK (delete the existing measurement channel), or [New 

channel] (create a new measurement channel). 

7.4.3 Intermodulation Spectrum Track Parameters 

Add intermodulation spectrum trace 

Menu path: [Trace] > [New Trace]. 

 

Fig. 7.11 [Class Trace] Dialog Box 

Output: observe the output signal of the DUT and the input signal of Port 2 (Receiver B) of the network 

analyzer. 

Input: observe the input signal (Receiver R1) of the DUT. This function is used to measure the frequency of 

intermodulation products so as to determine the power of the false signal of the DUT. 

Reflected: observe the reflection signal of the input end of the DUT, measured by Port 1 (Receiver A) of the 

network analyzer. 

7.4.4 [Intermodulation spectrum setting] Dialog Box 

This section introduces how to open the [Intermodulation spectrum setting] dialog box. The vector network 

analyzer is configured with the method of quick access. 

7.4.4.1 Use of Hard/Soft Buttons of Front Panel 

1. Click [Sweep]. 

2. Then click [Spectrum setting]. 

7.4.4.2 Mouse Operation Menu 

1. Click [Stimulus]. 

2. Then click [Frequency]. 

3. Select [Frequency]. 

 Frequency bar 
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Fig. 7.12 Frequency Bar Menu for Frequency Setting 

Attention 

Number of intermodulation spectrum channel points=3*spectrum span/resolution bandwidth. 

Transformation cannot be done directly. 

1. Sweep type: the intermodulation spectrum receiver is configured with various modes to display any frequency 

range and distortion products of different orders. 

 Linearity: the start/stop frequency, center frequency and span of the receiver can be freely set at the 

given value of f1 and f2. 

 2-order spectrum: in order to facilitation the observation of the high-frequency 2-order harmonics and 

surrounding spectrum, the settings coupled with the stimulus f1 and f2 are set within the frequency range 

of the receiver. Center frequency=f1+f2, and span=3*(f2-f1). 

 3-order spectrum: in order to facilitation the observation of the 3-order harmonics and surrounding 

spectrum, the settings coupled with the stimulus f1 and f2 are set within the frequency range of the 

receiver. Center frequency=(f1-f2)/2, and span=4*(f2-f1). 

 N-order spectrum: in order to facilitation the observation of the N-order main products, the settings 

coupled with the stimulus f1 and f2 are set within the frequency range of the receiver. Center 

frequency=(f1-f2)/2, and span=N*(f2-f1). 

2. Resolution bandwidth: the Gaussian filter instead of the standard intermediate frequency filter is used in the 

intermodulation spectrum channel to improve the functions similar to those of the traditional spectrum analyzer. 

Bandwidth options: 3MHz, 1MHz, 600kHz, 300kHz, 150kHz, 100kHz and 60kHz. 

3. Stimulus setting: this option can be used to set the frequency of the main sound signal when the tracking 

function is shut down. 

 fc (center frequency) =(f1+f2)/2; 

 DeltaF (frequency difference)=(f2–f1); 

 f1=low frequency of main tone signal; 

 f2=high frequency of main tone signal. 

4. Response setting: the frequency sweep range of the receiver can be set by setting the start/stop frequency and 

center frequency/span in the linear frequency sweep mode. 
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 Start frequency=the first frequency point of power spectrum sweep; 

 Stop frequency=the last frequency point of power spectrum sweep; 

 Center frequency=(start frequency+stop frequency)/2; 

 Frequency span=(stop frequency-start frequency). 

 Power bar 

 

Fig. 7.13 Power Bar of Spectrum Setting 

 Tracking bar 

 

Fig. 7.14 Track Bar of Spectrum Setting 

This dialog box is applied to the cases with the intermodulation distortion measurement channel, i.e. coexistence of 

two channels. 

1. Tracking Enable: if this option is selected, the stimulus frequency setting is invalid, and all the settings of the 

frequency sweep intermodulation distortion channel will be copied into the intermodulation spectrum channel, such 

as the frequency, power, attenuator setting and calibration settings. 
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Fig. 7.15 Intermodulation Spectrum Track (lower figure) Frequency Sweep Intermodulation Distortion Track 

(upper figure) 

 The upper figure of Fig. 7.15 shows the intermodulation distortion measurement window, in which the sweep 

range is 2GHz-3GHz, the sound span is fixed, and the center frequency of the double-tone sound is 2.5GHz. 

 The lower figure of Fig. 7.15 shows the intermodulation measurement window.  The receiver settings of the 

intermodulation spectrum channel are mainly used to measure the main sound signals and three-order, five-

order and seven-order intermodulation products. 

2. Step Mode: refer to the mode for intermodulation distortion channel tracking of the digital intermodulation 

spectrum measurement, when the tracking function is enabled. 

 Automatic step: automatically trace the frequency of the current data point of the IMD channel at the 

double-tone signal frequency of intermodulation spectrum measurement. After each spectrum 

measurement, the frequency of the double-tone signal will be automatically set as the frequency of next data 

point of the IMD channel. 

 Manual step: if this option is selected, the double-tone frequency of intermodulation spectrum 

measurement will be the same as the frequency of the specified data point of the IMD channel (the 

number of points is specified by the user). 

 


